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New and Changed Information
Reference Guide Changes
The following table describes significant new and changed information for the release of Tidal
Enterprise Orchestrator version 2.2. The highlighted features have been implemented to improve the
product functionality.
Table 1

TEO 2.2 Release Feature Changes

Feature

Location

New Security tab in Options dialog box which specifies the Chapter 1, Understanding the
Console
default owner when creating objects in TEO
New Change Request Task and Create Change Request
activity requests a modification to the configuration of an
object or system

Chapter 4, Managing Tasks

The following new triggers were created to improve how
processes can start

Chapter 8, Managing Triggers

•

Extended Property Value Updated

•

Started by Parent Process

•

Started by User

Appendix B, Task Activities

Access and development of Condition properties have been Chapter 10, Managing Conditions
reconfigured to allow ease of use
All global variables have been reconfigured to be created in Chapter 11, Managing Variables
a wizard style
New Service target which represents an IT or business
service

Chapter 13, Managing Targets

New extended target properties allow users to assign a
value to a specific target property.

Chapter 14, Managing Extended
Target Properties

New task rules are used to manage task assignment and
notifications for various customer-specific tasks.

Chapter 19, Managing Task Rules
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Table 1

TEO 2.2 Release Feature Changes

Feature

Location

Automation packs modified to allow objects within the
automation pack to be more customizable.

Chapter 22, Managing Automation
Packs

The following activities have been added to the Core
Functions Adapter

Appendix A, Core Activities

•

Calculate Time Difference—Calculates the time
difference between two different dates

•

Find Targets—Queries all defined targets

•

XPath Query—Queries information based on XML
path expressions

•

Wait for Task to Enter State—Waits for a task to match
a specific state before the activity continues

Appendix B, Task Activities

TEO Adapter Feature Changes
The following table describes significant new and changed information for the adapters of Tidal
Enterprise Orchestrator version 2.2. The highlighted features have been implemented to improve the
product functionality for TEO adapters.
Table 2

TEO 2.2 Release Feature Changes

Feature

Location

Improved Email activity functionality

Cisco TEO Adapter Guide for Email

•

Added new options on the email recipients

•

Added ability to save email as an HTML

•

Added Attachment tab to Email activity

The following new activities were added to the BMC
Remedy Adapter
•

Create Remedy Entry activity creates an entry in any
Remedy form

•

Create Remedy Relationship activity configures a
relationship between incidents and configuration items

•

Create Remedy Work Info activity Adds a new work
info entry to a Remedy incident

•

Delete Remedy Entry activity deletes an entry from a
Remedy item

•

Find Remedy Objects activity provides the ability to
find Remedy objects and configuration items

•

Get Remedy Entry Property Values activity retrieves
the properties for a Remedy entry

•

Update Remedy Entry activity updates properties for a
Remedy entry

Cisco TEO Adapter Guide for BMC
Remedy
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Table 2

TEO 2.2 Release Feature Changes

Feature

Location

Global adapter settings used for receiving SNMP Traps,
Cisco TEO Adapter Guide for
sending SNMP traps and executing Get/Set SNMP
SNMP
Requests activities have been removed and a single general
settings page displays which simply requires the trap
listening port number.
The SNMP User runtime user was renamed SNMP
Credential and contains additional privacy protocols
New SNMP (Device) Agent and SNMP (Device) Manager
targets which allow users to create targets on a per device
basis as well as per server.
The SNMP Trap Received trigger was modified to require
a target
The Destination field was removed in all SNMP activities
which now require a SNMP target.
The following activities have been renamed:
•

Correlate SNMP Trap activity was renamed Correlate
SNMP Trap Received activity

•

Publish SNMP Trap activity was renamed Generate
SNMP Trap activity

•

Publish Task as SNMP activity was renamed Generate
SNMP Trap from Task activity

New Expect templates allow reusable login expect
sequences for device targets and activities.

Cisco TEO Adapter Guide for
Terminal Adapter

Terminal adapter is now FIPS-compliant and allows users
to enable FIPS-compliant algorithms.
New host-based authentication on the adapter level allows
users to set up default public key and private key
authentication.
New public-key authenticated admin user provides the user
credentials required to allow public key authentication and
an administrative password.
New Network device module target configures the
connection information for the network device module
target.
Get/Put files activities contain slight modifications to the
layout of the activity property page.
Improved the process for configuring SSL certificates for
VMware

Cisco TEO Adapter Guide for
VMware

New browse option provides the ability to query objects in
hosts and virtual centers in activities based on defined
targets in TEO.
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Table 2

TEO 2.2 Release Feature Changes

Feature

Location

The following new activities have been created to improve
TEO’s cloud functionality using the VMware adapter.
•

Add Host Port Group

•

Add VM Hard Disk

•

Add VM Network Adapter

•

Create Folder

•

Create New VM

•

Customize Linux VM

•

Customize Windows VM

•

Enumerate Datastores

•

Enumerate Networks

•

Enumerate Resource Pools

•

Query Host Network Adapters

•

Query VM Devices

•

Remove VM Device

•

Update Host Port Group

•

Update VM Hard Disk

•

Update VM Network Adapter

New Web target allows execution against a web address
hosted by several machines

Cisco TEO Adapter Guide for Web
Service

Displays SOAP header methods for web service
Provides cookies support in HTTP header requests
Provides ability to format specific HTTP header request
output
New HTTPS Save Files activity saves HTTP files onto a
local TEO-hosted machine or network share
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Tidal™ Enterprise Orchestrator is designed to enhance the management and administration of SAP, SQL
Server and other databases, Microsoft Windows Server and Active Directory. Tidal Enterprise
Orchestrator’s powerful process automation engine provides the logical constructs necessary to support
even the most complex requirements to automate the administrative and operational tasks necessary to
manage these systems.
The product’s easy to use visual Process Editor allows processes to be rapidly designed and
deployed—all with a minimum of training. It’s powerful delegation model allows tasks that today
consume the time of senior staff members to be redirected to other staff members or even other
departments.
With TEO, your IT organization can attain higher levels of operational excellence by increasing the
deployment of operational and administrative best practices, improving the consistency with which
process and policy is followed, and improves service by reducing operational and administrative errors.

Organization
This guide includes the following sections:
Chapter 1

Understanding The Console

Provides overview of Console.

Chapter 2

Using TEO Web Console

Provides users with a web-based view of
the scaled-back Operations workspace on
the Console.

Chapter 3

Operations Workspace

Overview of the different workspaces
available to view tasks, processes,
activities, and auditing information to be
monitored on TEO.

Chapter 4

Managing Tasks

Provides information on the management
of the task functionality.

Chapter 5

Definitions Workspace

Provides overview of the type of
components that can be defined and
included in processes for execution.
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Chapter 6

Using the Process Editor

Provides detailed information on using
the Process Editor.

Chapter 7

Authoring Processes

Provides information viewing defined
processes, defining new processes,
modifying existing processes, and
executing a process.

Chapter 8

Managing Triggers

Provides instructions on specifying the
circumstances under which the process is
executed upon occurrence of another
action or event.

Chapter 9

Configuring Process Logic
Components

Details process components that are
inserted into a process to support or
provide control over the process
workflow logic execution.

Chapter 10

Managing Conditions

Conditions assigned to an activity or
process trigger specify when an action is
to be taken based on an evaluation of
conditions that have been defined.

Chapter 11

Managing Variables

Provides details on viewing and managing
defined variables to reference in process
and activity definitions.

Chapter 12

Managing Calendars

Details how a calendar can be used to
specify when a process should execute.

Chapter 13

Managing Targets

Provides information on viewing defined
targets that are available for execution by
a process.

Chapter 14

Managing Extended Target
Properties

Assigns a specific target property value to
a target and provides flexibility for others
to access the values to be used to
customize process behavior.

Chapter 15

Managing Target Groups

Provides information on viewing and
modifying defined target groups that are
available for execution by a process.

Chapter 16

Managing Runtime Users

Provides the ability to create runtime user
records to store the information about the
user security context and to pass this
information to the adapters.

Chapter 17

Managing Knowledge Base
Articles

Provide information on the results of an
activity including a brief summary of
what occurred, the cause, and suggestions
for resolution.
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Chapter 18

Managing Categories

Provides information on managing the
categories that can be used to organize
your processes based on your
organizational requirements.

Chapter 19

Managing Task Rules

Manages task assignment and
notifications for various
customer-specific tasks.

Chapter 20

Administration Workspace

Provides overview of administrative tasks
within TEO, including enabling time
zones to be used when configuring
processes and managing the adapters that
are installed in the product.

Chapter 21

Configuring TEO Security

Provides information on configuring the
delegation within TEO, including
creating security rules, roles, and
applying specific permissions.

Chapter 22

Managing Automation Packs

Provides users with the ability to view,
create or modify the TEO objects that are
contained in an automation pack.

Chapter 23

Configuring Reports

Provides details on the reports database
connection and executing reports for
viewing process execution history and to
audit process changes.

Chapter 24

Configuring Core Functions
Adapter

Contains the necessary information for
configuring the Core Functions adapter
settings.

Appendix A

Managing Core Activities

Provides instructions for defining the
activities provided by the Core Functions
adapter.

Appendix B

Task Activities

Provides information on defining task
activities provided by the Core Functions
adapter.

Appendix C

Using String Activities

Details string activities which allows
users to globally search, replace, and
modify string text and characters in TEO
objects.

Appendix D

Using Table Activities

Details the table activities which allows
users to modify the format for existing
defined table variables.
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Conventions
This guide uses the following conventions:
Convention

Indication

bold font

Commands and keywords and user-entered text appear in bold font.

italic font

Document titles, new or emphasized terms, and arguments for which you supply
values are in italic font.

[ ]

Elements in square brackets are optional.

{x | y | z }

Required alternative keywords are grouped in braces and separated by
vertical bars.

[x|y|z]

Optional alternative keywords are grouped in brackets and separated by
vertical bars.

string

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

courier

font

Terminal sessions and information the system displays appear in courier font.

< >

Nonprinting characters such as passwords are in angle brackets.

[ ]

Default responses to system prompts are in square brackets.

!, #

An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

Note

Means reader take note.

Tip

Means the following information will help you solve a problem.

Caution

Timesaver

Warning

Means reader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Means the described action saves time. You can save time by performing the action described in
the paragraph.

Means reader be warned. In this situation, you might perform an action that could result in
bodily injury.
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Product Documentation
Documentation Formats
Documentation is provided in the following electronic formats:
•

Adobe® Acrobat® PDF files

•

Online help

You must have Adobe® Reader® installed to read the PDF files. Adobe Reader installation programs for
common operating systems are available for free download from the Adobe Web site at www.adobe.com.

Guides and Release Notes
You can download the Adapter Guides, Getting Started Guides and Release Notes in PDF format from
the product CD.

Online Help
Online help is available and can be accessed using the following methods:
•

Click Help on any dialog box in the application to open the help topic in a pane to the right of the
dialog box.

•

In the Tidal Enterprise Orchestrator console:
– Click the

Help Pane icon on the toolbar to open the help topic in a pane to the right of the

Results pane.
– Click Help on the menu bar.

Open Source License Acknowledgements
Licenses and notices for open source software used in Tidal Enterprise Orchestrator can be found in the
Open Source License Acknowledgements found on the product CD. If you have any questions about the
open source contained in this product, please email external-opensource-requests@cisco.com.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
Subscribe to the What’s New in Cisco Product Documentation as a RSS feed and set content to be delivered
directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently
supports RSS Version 2.0.
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CH A P T E R

1

Understanding The Console
The Tidal Enterprise Orchestrator Console is the user interface that is used to access and manage the
product features. TEO ships with a trial license that is valid for a specified number of days. After the
trial license expires, the license has to be updated to continue using the product.
There are four user groups assigned to TEO. An employee should be a member of one of the user groups
before attempting to access the Console. If you do not have access or the appropriate rights, please
contact your local IT administrator.
Refer to the Viewing Pre-Defined Security Rules Assigned to Local User Groups, page 21-9 to see the
list of user groups assigned to TEO.
This chapter provides the following sections which contain instructions for launching the Console,
updating your license information, and navigating the Console.
•

Launching TEO Consoles, page 1-2

•

Console Overview, page 1-7

•

Understanding the Menus, page 1-8

•

Understanding the Toolbars, page 1-18

•

Understanding the Workspaces, page 1-20

•

Viewing the Results Pane, page 1-25

•

Viewing the Details Pane, page 1-26

•

Managing the Console, page 1-27
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Launching TEO Consoles
The following sections provide instructions on launching the TEO Console.

Launching the Console
When you first launch the Console, information about how much time remains on your trial license
displays. You can continue using the trial license until it expires or update the license information with
your permanent license.
To launch the Console, use the following steps:
Step 1

Choose Start > All Programs > Cisco > Tidal Enterprise Orchestrator > Tidal Enterprise
Orchestrator Console.
If you are still using a trial license, the Tidal Enterprise Orchestrator License Check dialog box displays.
Figure 1-1

Tidal Enterprise Orchestrator License Check Dialog Box

The License Check dialog box displays the length of time remaining on your trial license.
Step 2

Click OK to continue using the trial license or click Update to enter your permanent license (see
Updating Your Product License, page 1-5).
If you click OK, the Console displays.
Until the trial license has been updated to a permanent license, the Tidal Enterprise Orchestrator License
Check dialog box will launch and display how many days remain on the trial license. You must update
your license before the trial period expires.
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Launching Client-Only Consoles
The following instructions provide information on launching multiple Consoles on the same client
computer. The individual Console instances can be connected to the same or different server.

Launching Multiple Consoles with Same Server
To launch multiple Consoles with same server:
Step 1

Note
Step 2

Use one of the following methods:
•

If the server name was entered during the installation, to open the first Console, choose Start >
Programs > Cisco > Tidal Enterprise Orchestrator > Tidal Enterprise Orchestrator Console.
The Console is launched and automatically connects to the default server.

•

If the server name was not entered during the installation, choose Start > Programs > Cisco > Tidal
Enterprise Orchestrator > Tidal Enterprise Orchestrator Console. The Console is launched.
Click Connect to Server to manually connect to a server.

For additional information on connecting to a server, see Connecting to a Different Server, page 1-4.
Repeat, as necessary, to open additional Consoles connected to the same server.

Launching Multiple Consoles with Different Server
To launch multiple Consoles with a different server:
Step 1

After the first Console is launched, choose Start > Programs > Cisco > Tidal Enterprise Orchestrator
> Tidal Enterprise Orchestrator Console to launch an additional Console.
The additional Console opens connected to the same server.

Step 2

From the File menu, choose Connect to Server.
The Select Server dialog box displays.
Figure 1-2

Step 3

Note

Select Server Dialog Box

In the Server field, enter the appropriate server computer name or IP address.

If the Console was recently connected to the server, click the arrow to select the server from the
drop-down list.
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The Console display changes and retrieves the Console configuration for the selected server.
Step 4

Repeat, as necessary, to open additional Consoles.

Connecting to a Different Server
Use this process when connecting to a different server while working in an open Console.
To connect to a server:
Step 1

Use one of the following options:
•

From the File menu, choose Connect to Server.
-or-

•

From the toolbar, click the Connect to Server

tool.

The Select Server dialog box displays.
Step 2

Note

Step 3

In the Server field, enter the appropriate server computer name or IP address.

If the Console was recently connected to the server, click the arrow to choose the server from the
drop-down list.
Click OK.

Exiting the Console
There are no specific log out requirements. It is recommended that users save any processes before
exiting.
To exit the Console, use one of the following methods:

•

On the upper, right corner of the Console, click Exit.
-or-

•

From the File menu, choose Exit.
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Updating Your Product License
Tidal Enterprise Orchestrator is packaged with a trial license that is valid for a specified number of days.
The trial license can be used until the license expires or is updated with a permanent license.
After the trial license expires, the Update License dialog box displays requiring the user to enter the
appropriate license information to continue using the product. The license must be updated to a
permanent license to continue using the product.
To update your license:
Step 1

Use one of the following methods:
•

From the File menu, choose Update License.
-or-

•

On the License Check dialog box upon initial access, click Update.

The License Information panel displays.
Figure 1-3

Step 2

License Information Panel

In the following fields, enter the appropriate information and click Next.
Field

Description

Customer name

Name of the individual client or department. This field is
customer-specified and is not case-sensitive.

Company name

Name of the organization as provided by Cisco. The
company name must be entered exactly as provided by
Cisco. This field is case-sensitive.

License code

Product license code as provided by Cisco. The license
code must be entered exactly as provided by Cisco. This
field is not case-sensitive.
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The License Agreement panel displays.
Figure 1-4

Step 3

License Agreement Panel

Select the I agree radio button and click Next.
The Completing the Update License Wizard panel displays.
Figure 1-5

Step 4

Completing the Update License Wizard Panel

Click Finish.
The License was successfully updated message dialog box displays.

Step 5

Click OK to complete the procedure.
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Console Overview
The Console displays after completing the license check or updating your license (see Updating Your
Product License, page 1-5). The default view is the Operations view (see Operations Workspace,
page 1-20). After the initial access, the default view on the Console is determined by what is selected in
the Options Dialog Box—General Tab.
Figure 1-6

Tidal Enterprise Orchestrator Console

The Console consists of the following areas:
Area

Description

Menu bar

Contains options used to access the tasks associated with
the current item selected in the Navigation pane.

Toolbars

Provides shortcuts to general tasks within TEO as well as
specific tasks associated with the item currently selected in
the Navigation pane.

Navigation pane

Provides the navigation options to different groups of
features within TEO. The lower portion of the pane
consists of a group of workspace. When a workspace is
selected, the contents of the selected workspace display in
the upper portion of the Navigation pane.
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Area

Description

Results pane

Displays the contents of the item selected in the Navigation
pane.

Details pane

Displays the details of the selected item in the Results
pane.

Understanding the Menus
The Console menus provide general task items, such as feature customization options, which can be
performed throughout TEO. The following menus are displayed on the Console menu bar.
Figure 1-7

Console Menu Bar

Using the File Menu
File Menu Overview
The File menu contains general tasks related to the configuration of TEO. The File menu contains the
following items:
Menu Option

Description

Connect to Server

Launches the Select Server dialog box where you can
specify the server to which to connect.
The Server drop-down list displays the list of previously
connected servers to the Console. You can also enter the
specific server address to be connected.

Recent Servers

Displays the most recent server(s) that have been
connected to the Console.

Server Properties

Displays the Server Properties dialog box for the connected
server.
•

Name—Displays the name of the server

•

Version—Displays the version of the installed product
on the server

•

Description—Brief description of the server

•

Suspend automation—Suspends the connection to the
server.

•

Web Console location—Displays the URL to the web
Console
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Menu Option

Description

Update License

Launches the Update License Wizard to enter your product
license information.
See Updating Your Product License, page 1-5.

Exit

Closes the Console

Using the Edit Menu
The Edit menu contains the following items for modifying the configuration. The items displayed
depend on the objects selected.

Note

Menu Option

Description

Undo

Reverses last action by user

Redo

Reinstates previously reversed action

Copy

Copies the selected text or object to the clipboard

Paste

Pastes the previously copied item from the clipboard

Delete

Deletes the selected item

Select All

Selects all items on the dialog box or text field

Find

Launches the Find dialog box to locate specific text on a
dialog box.
•

Find what—Use text field to enter specific terms for
the search query.

•

Match case—Selected when searching for term using
the specific case in the Find what field

•

Use regular expressions—Choose this item to query
items that may contain special characters

•

Find Previous—Locates previous match in the search
query

•

Find Next—Locates next match in the search query

Items enabled under the Edit menu depend on the objects selected in the navigation and detail panes of
the Console.

Using the View Menu
The View menu contains items that determines how the information displays in the Results pane:
Menu Option

Description

Large Icons

Displays large icons with the associated item

Small Icons

Displays small icons with the associated name

List

Displays icons with the associated name in list format
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Menu Option

Description

Details

Displays icons with the associated name and details in list
format

Choose Columns

Opens the Choose Columns dialog box, which is used to
customize the displayed columns and the order in which
they display (see Configuring Columns, page 1-29).

Refresh

Updates the current view

Navigation Pane

Shows/hides the Navigation pane on the Console. When
hidden, the Results pane and the detail pane, if selected,
expand the width of the entire window

Detail Pane

Toggles the Details pane On or Off

Toolbars

Determines the toolbars (Standard Toolbar, Advanced
Toolbar, Actions Toolbar) to display on the Console. The
check mark to the left of the toolbar name indicates the
toolbar is selected.

Status Bar

Shows/hides the status bar that appears at the bottom of the
Console

Using the Go Menu
The Go menu contains the following shortcuts that allow you to navigate from one view to another on
the Console:
Menu Option

Description

Back

Returns to the previously selected view

Forward

Option is active if you have clicked Back to access a
previous view. Use this option to navigate to the next
navigation item in the list.

Go To

Sub-menu displays all previously selected views to which
you can return

Operations

Opens the Operations workspace

Definitions

Opens the Definitions workspace

Administration

Opens the Administration workspace

Folder List

Opens the Folder List workspace

Favorites

Opens the Favorites workspace

Cisco Tidal Enterprise Orchestrator Reference Guide

1-10

OL-24928-01

Chapter 1

Understanding The Console
Understanding the Menus

Using the Tools Menu
The Tools menu contains the following items that configure the appearance of the Console.

Customize Dialog Box
The Customize options launches the Customize dialog box where you can change the fonts and colors
that display in the Console.
Figure 1-8

Customize Dialog Box

The Customize dialog box includes the following fields and options:
Field

Description

Category

Drop-down list displays items available for customizing

Reset to Defaults

Returns the values for the selected Category to the default
values

Display items

The list of available items that can be modified for the
selected category

Font

Displays the available fonts. Check the check boxes to
modify the characteristics of the text viewed on various
dialog boxes

Size

Displays the available font sizes. The font size is limited to
the listed font sizes.

Foreground

Selects the foreground color to be used in window titles,
captions, cells, or selections

Gradient Start and Gradient End

Displays color options to be used for the background color
of window titles, captions, cells, or selections
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Field

Description

Custom

Button displays color options to be used to create custom
colors for text or backgrounds

Preview

Displays the effect of the dialog box changes

Options Dialog Box
The Options menu item launches the Options dialog box that is used to modify basic server interface
functions using the following tabs.
•

General Tab

•

Windows and Layout Tab

•

Dates & Times Tab

•

Refresh Tab

General Tab
Use the General tab to configure the server connection startup behavior.
Figure 1-9

Options Dialog Box—General Tab

The General tab specifies the following general server behavior:
Field

Description

Console startup behavior

Check the check box to automatically connect to the last
connected server upon startup. If the check box is not
checked, the Console will connect to the default server
specified during the installation, if there is one specified.
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Field

Description

Startup server connection behavior

Choose one of the following options for the behavior that
should occur when connecting to a new server:

Most recently used servers

•

Automatically select the group and item that you most
recently selected—Determines whether to select the
last displayed navigation view and selected item upon
startup

•

Always select the following group and item—Selects a
specific navigation view and item to be the default
upon startup

Determines the number of servers recently accessed to be
displayed on the File menu under Recent Servers

Security Tab
Use the Security tab to configure the specify the default owner when creating objects in TEO. User can
indicate the currently logged in Windows user as the default user or specify the a different default owner.
Figure 1-10

Options Dialog Box—Security Tab

The Security tab specifies the following information:
Field

Description

The current user

Select this radio button to use the user account that is
currently logged in to assign the owner on any new objects
created.

The specified user

Select this radio button and then click Browse to launch the
Select User or Group dialog box and specify the default
user for objects.
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Windows and Layout Tab
Use the Windows and Layout tab to specify how the user is to be prompted when a process is launched
and what is to be displayed after the process is launched.
Figure 1-11

Options Dialog Box—Windows and Layout Tab

The Windows and Layout tab specifies the following information:
Field

Description

When starting a process

Displays the following options to determine what action
occurs when a process is launched:
•

Always Launch Immediately with Default Input
Value—Launches the process immediately when the
process has specified or default values without
confirmation

•

Always Prompt to Confirm—Default option launches
Confirm Start Process dialog box to allow you to
confirm whether the selected process should be
launched or override the process start option

•

Only Prompt when Process has Inputs—Launches the
Confirm Start Process dialog box if the process has
input variables. If the process does not have input
variables, starts the process immediately without
confirmation.
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Field

Description

After a process is started

Choose one of the following options to determine what is
displayed after a process begins:

Reset User Preferences

•

None—Option does not display any process instances
after the process has started

•

Show Instances—Displays the processes initiated in
the Activities view on the Console

Resets the saved settings (size and location of dialog boxes,
selected property pages, visibility of toolbars and menu
items, etc.) to the system default.
Clicking this button automatically closes the Console and
requires the application to restart.

Dates & Times Tab
The Dates & Times tab specifies the time zone to be used when displaying the dates and times for various
objects within the product. The settings on this page determine how the date and time will be displayed.
Figure 1-12

Options Dialog Box—Dates & Times Tab

The following radio buttons determine how dates and times are displayed:

Field

Description

Current time zone of my computer

Displays the date and time zone settings of the computer on
which the Console is running.

The specified time zone

Choose the specific time zone to determine the date and
time settings to be displayed throughout the application.
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Refresh Tab
Use the Refresh tab specifies the refresh rate for the Task, Activity, and Process Views.
Figure 1-13

Options Dialog Box—Refresh Tab

The following options determine how dates and times are displayed:

Field

Description

Activity View automatic refresh rate Check this check box and enter the number of seconds to
determine the automatic refresh rate for any selected view
(in seconds)
within the Activity Views. (Default: 20 seconds)
Process Views automatic refresh
rate (in seconds)

Check this check box and enter the number of seconds to
determine the automatic refresh rate for any selected view
within the Process Views. (Default: 20 seconds)

Task View automatic refresh rate (in Check this check box and enter the number of seconds to
determine the automatic refresh rate for any selected view
seconds)
within the Task Views. (Default: 20 seconds)
Process instance viewer automatic
refresh rate (in seconds)

Note

This item determines the refresh rate (in seconds) for the
items that display in the status pane of the Process Viewer.
(Default: 1 second)

Use the scroll buttons to the right of the text fields to change the numeric display one second at a time.
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Using the Actions Menu
The Actions menu contains items that are used to perform specific tasks associated with the selected item
in the Navigation pane. The available items on the Action menu are dependant upon the selected item on
the Navigation pane.
For example, the options available when the Processes item is selected are different from those that are
available when Global Variables is selected.

Understanding the Help Menu
The Help menu contains the following items:
Menu Option

Description

Help

Displays dialog box-specific information in a separate pane
to the right. From the toolbar, you can also choose the Help
tool to display and hide the Help pane.

Contents

Displays the Table of Contents tab in the Tidal Enterprise
Orchestrator Help dialog box to navigate and view the
comprehensive help information.

Index

Displays the Index tab in the Tidal Enterprise Orchestrator
Help dialog box to navigate and view the indexed help
information.

Search

Displays the Search tab in the Tidal Enterprise Orchestrator
Help dialog box to enter search criteria and locate specific
information within the comprehensive help.

About Tidal Enterprise Orchestrator Displays the About Tidal Enterprise Orchestrator dialog
box, which contains the product version and license
information.
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Understanding the Toolbars
The Console has three toolbars (Standard Toolbar, Advanced Toolbar, Actions Toolbar), which can be
used to configure the selected navigation view, provide quick navigation between views, and perform
item-specific tasks.
Figure 1-14

Console Toolbars
Action Toolbar
Standard Toolbar
Advanced Toolbar

To enable or disable a toolbar:
From the View menu, choose Toolbars, and click the appropriate toolbar.
The toolbar displays or is disabled as appropriate.

Standard Toolbar
The Standard toolbar displays shortcuts to general tasks and functions. The following icons appear on
every view on the Console.
Icon

Name/Task
Connect to Server—Connects to the server to which you were last connected
Server Properties—Displays the properties for the connected server
Refresh—Updates the current view with the latest information from the server
Properties—Displays defined properties for the selected object. This icon is
unavailable if the current selection does not support property pages.
Cut—Cuts the selected text and/or objects to the clipboard
Copy—Copies the selected text and/or objects to the clipboard
Paste—Pastes the selected items to the location identified by the cursor
Delete—Deletes the selected object
Help—Displays or hides the Help pane for the selected view
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Advanced Toolbar
The Advanced toolbar displays shortcuts to general navigation and Console configuration icons.
Icon

Name/Task
Back—Returns to the previously accessed page. Choose the Left Arrow to
access the most recent history pages from the drop-down list.
Forward—Navigates forward to the next page in the recently accessed page.
Choose the Right Arrow to access the most recent forward-history pages. The
option does not become available until the Back icon has been accessed.
Navigation Pane—Displays or hides the Navigation pane.
Detail Pane—Displays or hides the Details pane.
Status Bar—Displays additional information about the selected item on the bar
across the lower portion of the Console.
Options—Displays the Options dialog box.

Actions Toolbar
The Actions toolbar displays options that are associated with the selected item in the Navigation pane or
Results pane. The available items on the Action toolbar are dependant upon the item selected.
For example, the options available when the Processes item is selected are different from those that are
available when Global Variables is selected.
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Understanding the Workspaces
The Console has five workspaces with each containing a group of items that perform specific actions
within the application. When a workspace is selected, the available contents are displayed.
This section provides a brief description of the navigation workspaces and the group of items contained
in each workspace.

Operations Workspace
The Operations workspace displays the status of processes and activities executing, scheduled or
recently executed by the application. This workspace also displays assigned tasks, such as alerts,
incidents, and approvals in the product. Additionally, the Operations workspace also displays system
messages about status and errors within the TEO server or adapters.
Figure 1-15

Operations Workspace—Getting Started View

For additional information on the Operations workspace, see Chapter 3, “Operations Workspace.”
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Definitions Workspace
The Definitions workspace displays the components that are used in processes.
Figure 1-16

Definitions Workspace—Getting Started View

For additional information on the Definitions workspace, see Chapter 5, “Definitions Workspace.”
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Administration Workspace
The Administration workspace displays configuration options for Tidal Enterprise Orchestrator.
Figure 1-17

Administration Workspace—Getting Started View

For additional information on the Administration workspace, see Chapter 20, “Administration
Workspace.”
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Folder List Workspace
The Folder List view displays a list of all the navigation items available from the Console. The items are
sorted according to the view displayed on the Console. The Results pane displays the view associated
with the selected item.
Figure 1-18

Folder List Workspace
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Favorites Workspace
The Favorites workspace displays shortcuts to user-selected navigation items. This view is used for
quickly accessing navigation items that are frequently used. Any item in the Navigation pane can be
added to the Favorites view.

Adding an Item to Your Favorites Workspace
To add an item as a favorite, highlight the item, right-click and choose Add to Favorites. A shortcut to
the item is added to the Favorites view.
Figure 1-19

Favorites Workspace
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Viewing the Results Pane
When a navigation item is selected on the Navigation pane, the information associated with that item
displays in the Results pane. By default, the information is presented in a details list view format. The
columns that display depend on the selected navigation item. You can customize the columns that display
using the Choose Columns menu item (see Configuring Columns, page 1-29).
When you select Processes or Global Variables in the Navigation pane, you can also filter the
information that displays using the Filter by Category drop-down list.
Figure 1-20

Definitions—Processes View—Results Pane

Results
pane
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Viewing the Details Pane
The Details pane provides additional information for a selected item in the Results pane. The tabs that
display depend on the item that is selected. Click the hyperlinks on the tabs to view the Properties dialog
box for the selected item.
To view the Details pane:
Use one of the following methods:
•

From the View menu, choose Details.
-or-

•

On the Advanced toolbar, click the Details Pane

tool.

The Details pane displays.
Figure 1-21

Definitions—Processes View—Results Pane

Details
pane
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Managing the Console
This section provides general procedures that can be used to configure the Console.

Connecting to a Server
This option may be useful when wanting to connect to a different server used for process monitoring.
To connect to a server:
Step 1

Use one of the following methods:
•

From the File menu, choose Connect to Server.
-or-

•

On the toolbar, click the Connect to Server

tool.

The Select Server dialog box displays.
Step 2

Note
Step 3

From the Server drop-down list, choose a previously connected server.

You can also enter the server name.
Click OK.
If the server is properly connected, then the Tidal Enterprise Orchestrator License Check dialog box
displays.
If the server does not properly connect, the Connect to Server error dialog box displays.

Displaying Recent Servers
This option displays all the servers recently accessed during the current session.
To display the recent servers:
From the File menu, choose Recent Servers. The list of recently accessed servers display.
Figure 1-22

Recent Server List
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Viewing Server Properties
This option is used to see a view of the connected server properties.
To view server properties:
Use one of the following:
•

From the File menu, choose Server Properties
-or-

•

Click the Server Properties

tool.

The Server Properties dialog box displays.
Figure 1-23

Server Properties Dialog Box

Suspending Server Automation
Use the Suspend Automation check box to suspend the execution of processes on the server. The enabled
check box suspends any new process from being created and the server will no longer create instance of
activities or processes.
To suspend server automation:
Step 1

From the File menu, choose Server Properties.
The Server Properties dialog box displays.

Step 2

Check the Suspend automation check box.
No new processes or activities will be generated. All new process and processes with additional activities
to execute will fail.
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Reinstating Server Automation
To reinstate server automation:
Step 1

From the File menu, choose Server Properties.
The Server Properties dialog box displays.

Step 2

Uncheck the Suspend automation check box.
All process execution will resume.

Note

All processes that were scheduled during the down time will have failed.

Refreshing the View
The refresh option updates the information on the current view. To refresh the current view, use one of
the following methods:
•

Press F5.

•

Click the Refresh

•

From the View menu, choose Refresh.

tool.

Configuring Columns
The Choose Columns dialog box determines which columns display for a selected navigation item and
the order in which the columns display. The available column headings vary depending on the selected
item.
To configure columns:
Step 1

On the Navigation pane, select the appropriate item.
The Results pane displays the information associated with the selected navigation item.

Step 2

In the Results pane, right-click and choose Choose Columns.
The Choose Columns dialog box displays.
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Figure 1-24

Step 3

Step 4

Choose Columns Dialog Box

Under Columns, use one of the following options to choose the appropriate column heading to display:
•

Check the check box for the column heading.

•

Highlight the column heading and click Show.

To remove a column heading from the display, use one of the following options:
•

Uncheck the check box.

•

Highlight the column heading and click Hide.

Step 5

To change the order in which a column appears in the Results pane, choose the column heading and click
Move Up or Move Down.

Step 6

To determine the width of a column, choose the column heading and specify a value in the Width of
selected column field.

Step 7

To reset the column settings to the default, click Reset.

Step 8

Click OK to save your settings and close the dialog box.
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Customizing the Fonts and Colors
The default formatting for the Console display can be updated through the Customize dialog box. The
available display items to update depend on the category selected.
To customize the product fonts and colors:
Step 1

From the Tools menu, choose Customize.
The Customize dialog box displays.
Figure 1-25

Step 2

Step 3

Customize Dialog Box

From the Category drop-down list, choose one of the following items:
Field

Description

Console

Updates the display of the Console panel captions

Navigator

Updates the display of the Navigation pane

Activity

Updates the displayed activities on the
Operations—Activity view

Calendar

Updates the display of the Calendar dialog box

Target

Updates the display of the color status on targets in the
Operations workspace.

Definition

Updates the color status of the processes in the Definitions
workspace

Task

Updates the color status of tasks in the Operations—Task
view

Under Display items, choose the item to be modified.
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Note
Step 4

The available items to update depend on the category selected.
Modify the following items, as necessary, and then click OK.
Field

Description

Font

Provides font and font size display options

Foreground

Provides list of colors to appear on different items in the
foreground.
Click Custom to define a color not displayed in the list.

Background

Provides list of colors to appear on different items in the
background.
Click Custom to define a color not displayed in the list.

Gradient Start

Provides list of colors to appear graded from top the
bottom.
Click Custom to define a color not displayed in the list.

Gradient End

Provides list of colors to appear graded from bottom to top.
Click Custom to define a color not displayed in the list.

Connecting to a Server upon Startup
To connect to the most recent server upon startup:
Under Console startup behavior, check the Automatically connect to most recent server check box and
click OK.
To always connect to the default server upon startup:
Under Console startup behavior, uncheck the Automatically connect to most recent server check box
and click OK.

Determining New Server Setup Connection Behavior
To determine new server connection behavior upon startup:
Under Startup server connection behavior, choose one of the following functions to occur when
connecting to a new server and click OK:
•

Automatically select the group and item most recently selected to open the last group and item
selected before the Console was closed.
-or-

•

Always select the following group and item from the drop-down list to specify the group and item
to open upon startup.

Modifying the list of Recent Servers
To adjust the number of recent servers displayed:
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Under Most recently used servers, in the Remember the [ ] text box, enter the number of servers to
display on the Recent Servers list on the File menu. For additional information, see Displaying Recent
Servers, page 1-27.

Modifying the Windows and Layout of the Console
Use the Windows and Layout tab to determine the action required when launching a process and reset
any user preferences.
Figure 1-26

Options Dialog Box—Windows and Layout Tab

Modifying Process Launch Settings
To set the Console behavior when starting a process:
Step 1

From the When starting a process drop-down list, choose one of the following:
Field

Description

Always Launch Immediately with
Default Input Value

Launches the process immediately when the process has
specified or default values without confirmation

Always Prompt to Confirm

Default option launches Confirm Start Process dialog box
to confirm whether the selected process should be launched

Only Prompt when Process has
Inputs

Launches the process only when it contains input values.
The Confirm Start Process dialog box displays a list of
defined values
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Step 2

Step 3

From the After a process is started drop-down list, choose one of the following options to determine what
is displayed after a process begins:
Field

Description

None

Does not display any process instances after the process
has started

Show Instances

Displays the processes initiated in the
Operations—Activities view on the Console

Click OK.

Restoring Console Default Settings
The Reset User Preferences button on the Windows and Layout tab restores the Console configuration
to the default value.
If the window position and size, columns and column sizes, and other configurations in the console have
been modified, this option restores the settings to the Console default settings. The product will
automatically close and restart when you reset user preferences.
To restore default configuration:
Step 1

From the Tools menu, select Options.
The Options dialog box displays.

Step 2

Click the Windows and Layout tab, under Saved user preferences, click Reset User Preferences and
click OK.
The console will close and restart automatically.
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Configuring the Console Date and Time Settings
Use the Date & Times tab on the Options dialog box to specify the time zone that will be displayed
throughout the application. These settings determine how the date and time will be displayed.
To adjust the Console date and time settings:
Step 1

On the Options dialog box, click the Dates & Times tab.
Figure 1-27

Step 2

Options Dialog Box—Dates & Times Tab

Under Show dates and times using, choose one of the following and click OK.
Field

Description

Current time zone of my computer

Select this radio button to display the date and time zone
settings of the computer on which the application is
installed.

The specified time zone

Select this radio button to select the time zone to be
displayed throughout the application

Configuring the Display Refresh Rate
The Refresh tab specifies the refresh rate for the Operations views.
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Figure 1-28

Options Dialog Box—Refresh Tab

To determine the automatic refresh rate:
Step 1

On the Options dialog box, click the Refresh tab.

Step 2

Under Refresh, select the appropriate instance refresh rate, and click OK:
Field

Description

Activity View automatic refresh rate Check this check box and enter the number of seconds to
determine the automatic refresh rate for any selected view
(in seconds)
within the Activity Views. (Default: 20 seconds)
Process Views automatic refresh
rate (in seconds)

Check this check box and enter the number of seconds to
determine the automatic refresh rate for any selected view
within the Process Views. (Default: 20 seconds)

Task View automatic refresh rate (in Check this check box and enter the number of seconds to
determine the automatic refresh rate for any selected view
seconds)
within the Task Views. (Default: 20 seconds)
Process instance viewer automatic
refresh rate (in seconds)

Note

This item determines the refresh rate (in seconds) for the
items that display in the status pane of the Process Viewer.
(Default: 1 second)

Use the scroll buttons to the right of the text fields to change the numeric display one second at a time.
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Using TEO Web Console
The Tidal Enterprise Orchestrator (TEO) Web Console provides users with a web-based view of the
scaled-back Operations workspace on the TEO Console. On the Web Console, users are able to view
tasks, processes they are able to run, and track the processes they have started from any web browser.
For the Web Console to work properly, Internet Information Services must be installed on the computer
on which the Web Console is installed. For information on installing and configuring IIS, refer to the
TEO Installation and Administration Guide.
Users cannot create or modify processes on the Web Console. To modify a process, users with the
appropriate security rights, must access the TEO console. If you think you should have access to the
expert TEO console, then contact your manager to authorize your access.
Use the following sections for instructions on navigating and performing tasks in the Web Console:
•

Web Console Requirements, page 2-2

•

Launching the Web Console from Web Browser, page 2-2

•

Navigating Web Console, page 2-5

•

Performing Web Console Tasks, page 2-10
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Web Console Requirements
The Web Console requires the following minimum components to successfully run:
Software

Requirement

ASP.Net

ASP.NET 2.0

Internet Information Service (IIS)
Manager

IIS 6.0 or later

Java SE Runtime Environment

JRE 6 Update 1.6 or later

Supported Browsers

Microsoft Internet Explorer 6.0 or later
Mozilla Firefox

Launching the Web Console from Web Browser
To use the TEO Web Console, users must log in using their Windows credentials. If the user has
Windows integrated authentication configured, then logging in may not be required.
Use the following steps to log in to the Web Console, if you have Web Console-only access.
To access the Web Console:
Step 1

On the Installation Wizard Setup Completed panel, write down the URL that is displayed.

Step 2

Launch the appropriate web browser.

Step 3

In the Address bar, enter the URL, and press Enter.
The Windows Authentication dialog box displays.
Figure 2-1

Step 4

Windows Authentication Dialog Box

Enter the following information and then click OK.
•

domain\username

•

password
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Note

If the Web Console is configured to use integrated authentication, then Step 4 may not be required.
The Web Console launches.
Figure 2-2

Tidal Enterprise Orchestrator Web Console

It is recommended that the user adds the URL to the Web Console as a favorite web site to their
bookmarks.

Launching the Web Console from TEO Console
For users with access to the TEO Console, launching the Web Console is a simple process.
To access the Web Console from the TEO Console:
On the Operations—Getting Started view, click Launch Web Console.
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Figure 2-3

Operations—Getting Started View

The Web Console launches.
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Navigating Web Console
To make sure the default search criteria is available after the initial search on the TEO Web Console, it
is recommended that users enable the cookies in their browser.

Understanding the Navigation Bar
The Navigation bar displays the menu items for the Web Console as well as the logged in user.
Figure 2-4

Web Console Navigation Bar

Menu

Description

My Tasks

Displays the tasks that have been assigned to the user or the group
of a user

Run Processes

Displays the processes the users are authorized to run in TEO

My Process History

Displays the processes the user has started and allows the user to
observe the current state of the process

User

Displays the accessed domain and user name of the authenticated
user

Refresh

Refreshes the current display

Help

Launches Web Console online help
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Understanding My Tasks Page
The My Tasks page displays all available tasks. The tasks can be filtered to display only those that are
assigned to the logged in user.
Figure 2-5

Web Console—My Tasks Page

Search Criteria
The following table provides the search criteria information:
Field

Description

Tasks created within the past

Searches for tasks created within the selected time
period

Task Assignment

Choose one of the options to filter the display
according to the task assignee:

Task state

Filter by type

•

View All Tasks—All assigned tasks in TEO

•

Me Only—Task assigned to currently logged in
user

•

Me and My Groups—Task assigned to the
currently logged in user or the user group

Choose the appropriate option to filter the display
according to the state of the task.
•

Not Completed—Displays only tasks that are not
resolved

•

Completed—Displays only resolved tasks

•

All—Displays all tasks in the list regardless of
task state

Filters the display according to the task type
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My Tasks Columns
The following table describes the columns that display on the My Tasks page. Click the column headings
to sort in an ascending or descending order.
Column

Description

Actions

Indicates what action the user can take with the task. Click View
Task to display the task details.

Name

Display name of the task

Type

Type of task

Status

Status of the task

Assigned To

User name of the person or group assigned to the task

Due Date

Date the task should be completed

Modified Time

Date and time the contents were last modified

Modified By

Object or user name that last modified the contents

Completed By

User name of the person who completed the task

Severity

Displays the severity of the task
•

Low

•

Medium

•

High

Understanding Run Processes Page
The Run Processes page displays the processes that the authenticated user can run in TEO. The available
processes are determined by the security role of the user. The user is able to filter the display of the
available processes.
Figure 2-6

Web Console—Run Processes Page
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Search Criteria
The following table provides the search criteria information:
Field

Description

Category

Filters the display according to the process category

Run Processes Columns
The following table describes the columns that display on the Run Processes page.
Column

Description

Actions

Indicates what action process can take. Click Start to start the
process

Name

Display name of the task

Description

Brief description of the process

Categories

Category to which the process has been assigned

Understanding My Process History
The My Process History page displays the processes that the authenticated user has run in TEO. The user
is able to filter the display of the processes the user has launched and the details of the processes.
Figure 2-7

Web Console—My Process History Page
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Search Criteria
The following table provides the search criteria information:
Field

Description

Processes started
within the past

Filters the display by a specific time frame. In the text box, enter the
appropriate number and then choose one of the following time units:

Process state

Category

•

Minutes

•

Hours

•

Days

Choose one of the options to filter the display according to the state
of the process:
•

View All

•

View Completed

•

View Incomplete

Filters the display according to the process category

My Process History Columns
The following table describes the columns that display on the Processes I Have Started page.
Column

Description

Actions

Indicates what action the user can take with the process. Click View
Details to display the process activity details.

Name

Display name of the process

State

Specifies the most recent state of the process activity (for example,
Succeeded, Running, Cancelled, or Failed-Not Completed)

Start Time

Date and time the process started

End Time

Date and time the process completed

Duration

Time taken for the process to complete

Target

Target on which the process executes

Description

Brief description of the process

Categories

Category to which the process is assigned
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Performing Web Console Tasks
This section provides steps that can be used to navigate and manage tasks in the Web Console.

Refreshing the Display
The Refresh option updates the information on the current web page.
To refresh the current view, use one of the following methods:
•

Press F5.

•

Click the Refresh tool.

•

On the navigation bar, click Refresh.

The display refreshes with the latest information generated from the TEO server.

Filtering My Tasks Display
Use the Search Criteria pane to modify the display of the tasks in the My Tasks page. The display options
consist of filtering the tasks according the assignee, group of the assignee, or by task type.
To filter the task list:
Step 1

Step 2

Note

From the View tasks assigned to drop-down list, choose one of the following options:
Field

Description

Me

Displays tasks assigned to user

Me and My Groups

Displays the tasks assigned to the user and his or group

View All Tasks

Displays all available tasks

To the right of Task State, in the drop-down list, choose the appropriate status associated with the tasks
in the list.

The <No Filter> option allows the page to display all tasks regardless of the assigned state.

Step 3

From the Filter by Type drop-down list, choose the appropriate task type to display.

Step 4

Click Search to filter the display.
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Viewing Task Details
The My Tasks page displays the tasks that the authenticated user has run in TEO.
To view task information:
On the My Tasks page, on the appropriate task, click View Details.
The Task Details page displays the following summary information for the process:
Column

Description

Display Name

Name of the task

Description

Description of the task

Alert Class

Numeric value indicating the class of the alert

Severity

Displays the severity of the task
•

Low

•

Medium

•

High

Created Time

Time at which the task was created

Priority

Indicates the priority of the task

Status

•

Low

•

Medium

•

High

Specifies the most recent state of the task
Note

For additional information, see Common Task
Statuses, page 4-6.

Automation Summary

Click View to view the related automation summary.

Duplicate Of

Hyperlink to the name of the duplicate task

Related Tasks

Related tasks associated with the task

Affected Target

Name of ITIL configuration item (IT component) which
the alert or incident describes

Affected Target CI

Name of the system on which the condition was detected

Configuration Item

Name of the configuration item (IT component) to which
the alert pertains.

Configuration Item Type

Type of ITIL configuration item (IT component) which the
alert describes.

Affected Organizations

Organizations that consume the IT service affected by the
alert or incident

Affected Services

IT Service affected by the alert or incident

External System

Name or IP address for the incident management server

External ID

ID of the incident which corresponds to the TEO incident

Due Date

Date the task should be completed
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Column

Description

Expiration Date

Date the task is set to expire
•

Local Time

•

Universal Time

Parameters

Hyperlink to any parameters associated with a specific task

Notes

Notes associated with the task

Assigned to

User name of the person assigned to the task

Completed by

User name of the person who completed the task

Owner

User name of the person or group who assigned the task

Filtering Run Processes
Use the Search Criteria pane to modify the display of the processes on the Run Processes page. The
display options consist of filtering the processes according the category.
To filter the display by category:
From the Category drop-down list, choose the appropriate category, and click Search. All processes
assigned to the selected category display.

Filtering My Process History
Use the Search Criteria pane to modify the display of the processes on the My Process History page. The
display options consist of filtering the processes according to the following criteria.
To filter the process list:
Step 1

To the right of Processes started within the past, in the text box, enter the appropriate number and then
choose one of the following time units to filter the display by a specific time frame. (ex. dd:hh:mm)

Step 2

To the right of Process State, in the text box, choose one of the options to filter the display according to
the state of the process:
Field

Description

View All

Displays all processes regardless of other criteria

View Completed

Displays only the processes which have succeeded

View Incomplete

Displays only the process which have failed

Step 3

To the right of Category, in the drop-down list, choose the appropriate category associated with the
processes in the list.

Note

The <No Filter> option allows the page to display all processes regardless of the assigned category.

Step 4

Click Search to modify the process list display.

Cisco Tidal Enterprise Orchestrator Reference Guide

2-12

OL-24928-01

Chapter 2

Using TEO Web Console
Performing Web Console Tasks

Resolving Tasks in Web Console
Use the following steps to resolve an assigned task from the Web Console.
To resolve a task:
Step 1

From the My Tasks view, use the search criteria to filter the tasks to the appropriate display.

Step 2

Under Actions, click View Details.
The [Selected Task] displays.

Step 3

Note

Review the details of the task.

For additional information on the properties in the list, see Common Task Properties, page 4-4.

Step 4

From the Status drop-down list, choose the appropriate status for the task resolution.

Step 5

In the Add Notes text box, if available, enter any notes related to the task resolution or status update.

Step 6

Click Submit to resolve the task.
The Task details page is updated and displays the user name of who resolved the task.

Taking Ownership of a Task
These steps are used when deciding to take ownership of a task that is unassigned or assigned to an entire
group of which the current logged in user is also included.
To take ownership of a task:
Step 1

On the open task, review the task details.

Step 2

In the Add Note text box, add notes to the task, as necessary.

Step 3

Check the Take sole ownership of this task check box, and click Submit.
The Task details page is updated and displays the user name of who resolved the task.
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Starting Processes in Web Console
All the processes that display on the Run Processes page are enabled and can be started by the
authenticated user. Only one process can be started at a time. When the process is started manually, all
conditions and triggers included in the process definition are ignored.
To start a process:
Step 1

On the appropriate process, click Start.
The name of the selected process displayed under Are you sure you want to launch the process?

Step 2

If No, then skip to Step 6.

Step 3

If the process has input variables, continue to the next step. If the process does not have any input
variables, then continue to Step 4.

Step 4

Under Start the process with the following parameters, verify or modify the value, as necessary:
Column

Description

Name

Name of the input variable

Value

Value assigned to the variable

Description

Brief description of the variable

Data Type

Type of variable
•

Boolean—Indicates whether the set of elements is true
or false

•

Hidden String—Holds data that must be protected
from other TEO users

•

Identity—Represents the value of a user identity

•

Numeric—A single whole or decimal number assigned
(positive and negative)

•

String—Sequence of characters, such as letters,
numbers, and punctuation marks displayed in a string
of text

•

Table—Used to store a set of records in a table format

Step 5

To start a process from a specific starting point, check the Start from start point check box and then
select the appropriate starting point from the drop-down list. The first activity after the specified starting
point will run first.

Step 6

Under This Process will execute against [Target Name]. Would you like to override?, choose one of the
following options:

Step 7

•

Yes—To specify a target or target group different from the defined process target

•

No—To continue with the process execution

Click Start to begin.
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The Process Results page displays and the process begins executing. The following information is
displayed.

Step 8

Column

Description

Name

Name of the process

Target

Name of the target executed against by the process

Start Time

Date and time the process was started

Click Observe to review to the process execution details.

Overriding Process Target
With the appropriate rights, a user can override the target of any manually started process before process
execution has begun. The Start Process page displays after the process is launched and is used to confirm
the process to be started, associated input variables, and the target against which the process is launched.

Note

Targets cannot be modified from the Web Console.
To override a process target:

Step 1

After the process is started from the Run Processes page, the Start Process page displays.

Step 2

Under This Process will execute against [Target Name]. Would you like to override?, choose one of the
following options:
•

Yes—To specify a target or target group different from the defined process target
– On the Targets drop-down list, choose the appropriate target.

-or– On the Target Group drop-down list, choose the appropriate target group.
•
Step 3

No—To continue with the process execution

Click Start to begin.
The Start Process Results page displays.
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Viewing My Process History
The My Process History page displays the processes that the authenticated user has run in TEO. The user
is able to filter the display of the processes the user has launched and the details of the processes.
To view process information:
On the My Process History page, on the appropriate process, click View Details.
The Process Details page displays the following summary information for the process:
Column

Description

Actions

Indicates what action the user can take with the
process.

Name

Display name of the process or activity

State

Specifies the most recent state of the process activity
(for example, Succeeded, Running, Canceled, or
Failed-Not Completed)

Start Time

Date and time the process started

End Time

Date and time the process completed

Duration

Time taken for the process to complete

Error Information

A description of the error that has occurred if the State
field displays Failed-Not Completed

Target

Target on which the process executes

Description

Brief description of the process

Categories

Category to which the process is assigned

Viewing Process Activity Details
The My Process History page displays the processes that the authenticated user has run in TEO. Use the
following steps to view additional information about the activities in the processes.
To view activity information:
Step 1

On the My Process History page, on the appropriate process, click View Details.
The Process Details page displays the following summary information for the process:
Column

Description

Actions

Indicates what action the user can take with the process.

Name

Display name of the process or activity

State

Specifies the most recent state of the process activity (for
example, Succeeded, Running, Canceled, or Failed-Not
Completed)

Start Time

Date and time the process started

End Time

Date and time the process completed

Duration

Time taken for the process to complete
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Column

Description

Error Information

A description of the error that has occurred if the State field
displays Failed-Not Completed

Target

Target on which the process executes

Step 2

To view general process information, see Viewing My Process History, page 2-16.

Step 3

To access the automation summary for a task, see Viewing Automation Summary, page 2-17.

Viewing Automation Summary
An automation summary is a collection of data summarizing the objects included in the process and the
data retrieved by the processing of the of the objects. On the web console, an automation summary can
be launched from the following locations:
•

Task Detail page—Displays the task details of the task

•

View Process Activities—Displays the details of the process activity

To view an automation summary:
Step 1

Launch the Web Console.

Step 2

Use one of the following methods:
•

To access the summary through the task detail page, on the My Tasks page, on the appropriate task,
click View Details.

•

To access the summary through the View Process Activities page, click View Summary.
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The Summary page displays summary of a specific task.
Field

Description

Report Location

Display only. Shows the file path for the automation
summary

Situation Analysis

After TEO requires action, it performs deep analysis based
on the type of situation identified.
During situation analysis, TEO captures volatile state and
diagnostic information that may otherwise be difficult or
impossible to capture manually.
The Situation Analysis section displays below the overview
information.
Click the link in the upper portion of the summary to
navigate directly to the Situation Analysis section or simply
scroll to the section.

Context Analysis

TEO analyzes all data points in context with each other to
identify a situation that may require action.
This information can be viewed in the Context Analysis
section of the summary. The Context Analysis displays the
symptom and possible causes.
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Operations Workspace
The Operations workspace is used to monitor the processes that are scheduled to execute, view processes
that are currently running, and verify that processes have successfully completed. The view also provides
auditing information relating to system event history for actions that have occurred within Tidal
Enterprise Orchestrator and process information generated when the defined processes are executed.
Use the following sections in this chapter for information on navigating the Operations Workspace:
•

Searching Tasks, page 3-4

•

Monitoring Tasks, page 3-10

•

Searching Work, page 3-13

•

Monitoring Activities, page 3-18

•

General Operation Views Procedures, page 3-25

•

Monitoring Processes, page 3-32

•

Monitoring Auditing Information, page 3-37
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Accessing the Operations Workspace
To access the Operations workspace, use one of the following methods:
•

In the Navigation pane, choose the Operations workspace.
-or-

•

From the Go menu, choose Operations.

The Getting Started—Operations Results pane displays.
Figure 3-1

Getting Started—Operations Dialog Box
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Using Getting Started—Operations
The Getting Started view displays task shortcuts to view process instances, process instance activities,
and the system activity.

Monitor Operations
The Monitor Operations option launches the Activity Views folder which includes the options to display
information about the activities that are in progress, scheduled or have been completed. For more
information about the Activity Views pane, see Monitoring Activities, page 3-18.

Monitoring Auditing
The Auditing View displays the system event history for actions that have occurred within TEO. For
more information about the auditing information being monitored, see Monitoring Auditing
Information, page 3-37.

Define New Objects
The Define New Objects option launches the Getting Started—Definitions Results pane which displays
the options for creating a new process and defining new objects to be associated with a process. For more
information on defining processes, see Chapter 6, “Using the Process Editor.”

Launch Web Console
Use the Launch Web Console option to display the TEO web console which provides users with a
web-based view of the scaled-back Operations workspace on the expert TEO console. For more
information on viewing the web console, see Chapter 2, “Using TEO Web Console.”
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Searching Tasks
The Operations—Search Tasks view displays the results of the query based on the specified filter
options. Users can search by the assignee, category, task type, and status.
This section provides instructions on viewing the information displayed in the Search Tasks View. For
additional information on modifying tasks, see Chapter 4, “Managing Tasks.”

Accessing Operations—Search Tasks View
On the Operations workspace, click Search Tasks.
Figure 3-2

Operations Workspace—Search Tasks

The Operations—Search Tasks view displays the default information about the queried task in the
following columns:
Column

Description

Display Name

Name of the task

Type

Type of task

Priority

Priority of the task

Status

Status of the task

Due Date

Date the task should be completed
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Note

Column

Description

Assigned to

User name of the person assigned to the task

Categories

Category assigned to task alert

Created Time

Time at which the task view was accessed

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the contents

Id

Task identifier

Notes

Notes associated with the task

Owner

User name of the person who assigned the task

Type Description

Brief description of the type of task

Expiration Date

Date the task is set to expire

Completed Time

Time the task was completed

Completed By

User who completed the task

Produced by

User who generated the alert or task

Related Tasks

Related tasks associated with the task

Parameters

Parameters of the task

Created By

User or object that created the task view

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Search Tasks Details Pane
The Search Tasks Details pane displays detailed information about the selected task. Information about
the selected task display the following details:
Column

Description

Subject

Name of the task

Type

Type of task

Description

Brief description of the task

Status

Status of the task

Assigned to

User name of the person assigned to the task

Priority

Priority of the task

Due Date

Date the task should be completed
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Customizing Search Tasks Header
Use the Select Search Filters dialog box to customize the query header options. If the check box to the
left of the option remains unchecked, then the filter option will not display on the designated Search
header.
To customize the search filter options:
Step 1

In the Operations—Search Tasks header, click Customize Options.
The Select Search Filters dialog box displays.
Figure 3-3

Step 2

Select Search Filters Dialog Box

Check the check box to the right of the appropriate option, and then click OK.
Filter Option

Description

Task assignee

Check the check box to display the list of task assignee options on
the header.

Created Time

Check the check box to display the time options to determine
which task to display

Modified Time

Check the check box to display the time options to determine the
time frame for which tasks to display.

Task Status

Check the check box to display the available statuses to filter.

Category

Check the check box to display the categories available for
filtering.

The selected search filters display in the Search Tasks header.
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Figure 3-4

Operations—Search Tasks Header

Query Tasks by Assignee
When performing a search query, users can search tasks by using all the default filters or they can modify
the query according to the individual filters. Use the following steps to query tasks according to the
assignee.
To query tasks by assignee:
Step 1

In the Search Tasks header, to the right of Task Assignee, choose one of the following options:
Task View

Description

View all tasks

Choose this option to query all tasks in progress.

View tasks explicitly assigned only
to me

Choose this option to query all tasks assigned to the
logged on user.

View tasks assigned to me or a group Choose this option to query all tasks assigned to the
logged in user and any groups containing the user.
that includes me
Step 2

Click Search to query the tasks by the selected assignee.
The results display in the Search Results pane.
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Query Tasks by Date/Time
Use the following steps to query tasks according to when the task was created.
To query tasks by created time:
Step 1

In the Search Tasks header, to the right of Created Time, choose the appropriate time filter options to
query the tasks. See Filter Display by Date/Time Options, page 3-21 for additional information.

Step 2

Click Search to query the tasks by the selected time filter options.
The results display in the Search Results pane.

Note

These steps can also be used for querying tasks according to their modified date or time.

Query Tasks by Status
Use the following steps to query tasks according to current state of the task.
To query tasks by status:
Step 1

Step 2

In the Search Tasks header, to the right of Task Status, from the drop-down list, choose one of the
following options:
•

Complete

•

Not Complete

Click Search to query the tasks by the selected state of completion.
The results display in the Search Results pane.
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Filtering Search Results
Use the Filter pane in the Tasks Views header to display selected tasks in the results pane. The
hyperlinked Filter by drop-down list in the Tasks Views header contains several options which can be
used for filtering tasks.
The default selection is <No Filter>. After the initial change to the selection, the last selected item
displays.
To filter task search results:
Step 1

Step 2

In the Search Tasks header, to the right of Category, from the drop-down list, choose the appropriate
category to query:
Option

Description

Category

Choose the appropriate category from the list

Name

Enter the name of the task

Description

Enter the description or class for the task

Type

Displays list of all task types

Status

Choose from the list of available statuses
•

Completed

•

Not completed

Click Search to query the tasks by the selected category.
The results display in the Search Results pane.
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Monitoring Tasks
The Operations—Tasks view displays all task activities and tasks that have been assigned to a specific
user or group. In addition, the task display can be filtered to display by category, task type, and status.
The user can determine which task view to display.
This section provides instructions on viewing the information displayed in the Tasks View. For
additional information on modifying tasks, see Chapter 4, “Managing Tasks.”

Accessing Tasks View Folders
On the Operations workspace, choose Task Views. The Operations—Tasks Views folder Results pane
displays information about each task folder in the following columns:
Field

Description

Name

Name of the task view

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the task

Description

Brief description of the task

Created Time

Time at which the tasks was created

Created By

User or object that created the task

Figure 3-5

Operations Workspace—Tasks—View All
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Displaying Tasks Views
From this view, detailed information is provided about all the alerts, incidents, and other tasks that are
assigned, in progress, or have been completed. Users with the appropriate security rights can modify
tasks from this view. For additional information on modifying tasks, see Chapter 4, “Managing Tasks.”
To access a task view:
Step 1

Step 2

To access detailed information about a task view, from the Tasks Views folder, choose one of the
following items:
Task View

Description

View User Tasks

Displays all tasks that require user action

View Alerts

Displays all task alerts

View Incidents

Displays all task incidents

View All

Displays all tasks that are assigned, in progress, or
have successfully completed

In the Tasks Views Header, choose the appropriate category and time period to display.
The selected view displays in the Results pane. The Results pane displays the following default summary
information for each of the four task views.
Column

Description

Display Name

Name of the task

Type

Type of task

Priority

Priority of the task

Status

Status of the task

Due Date

Date the task should be completed

Class

String or numeric value indicating the class of the alert or
incident

Assigned to

User name of the person assigned to the task

Related Tasks

Related tasks associated with the task

Categories

Category assigned to task alert

Target

Name of ITIL configuration item (IT component) which
the alert or incident describes

Target CI

Name of the system on which the condition was detected

Created Time

Time at which the task view was accessed

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the contents

Id

Task identifier

Notes

Notes associated with the task

Owner

User name of the person who assigned the task

Type Description

Brief description of the type of task
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Note

Column

Description

Expiration Date

Date the task is set to expire

Completed Time

Time the task was completed

Completed Date

Date task was completed

Produced by

User who generated the alert or task

Parameters

Parameters of the task

Affected Organizations

Organizations that consume the IT service affected by the
alert or incident

Affected Services

IT Service affected by the alert or incident

Configuration Item

Name of the configuration item (IT component) to which
the alert pertains.

Automation Summary

File path for the related automation summary

Created By

User or object that created the task view

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Tasks Details Pane
The Tasks Views Details pane displays detailed information about the selected task. Each hyperlink on
the Details pane launches a display-only view of the Task Properties dialog box. Information about the
selected task display the following details:
Column

Description

Display Name

Name of the task

Type

Type of task

Description

Brief description of the task

Status

Status of the task

Assigned to

User name of the person assigned to the task

Priority

Priority of the task

Due Date

Date the task should be completed
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Searching Work
The Operations—Search Work view displays the results of the query for processes and activities based
on the specified filter options. Users can search by the date/time, category, task type, and status.
This section provides instructions on viewing the information displayed in the Search Work view.

Accessing Operations—Search Work View
On the Operations workspace, choose Search Work.
Figure 3-6

Operations Workspace—Search Work
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The Operations—Search Work view displays the processes and activities that are scheduled to be
performed during the selected display time period. The default information about the queried process or
activity displays in the following columns:

Note

Column

Description

Display name

Name of the process instance or activity instance that
is scheduled, in progress, or completed

State

Current status of the operations activity
•

Succeeded

•

Running

•

Canceled

•

Failed (Canceled)

•

Failed (Not Completed)

Started By

User ID of the person who initiated the activity
instance

Start Time

Start time of the activity

End Time

End time of the activity as it completed or failed. If the
instance is in progress, 1/1/0001 12:00:00 AM is
displayed.

Duration

Amount of time taken for the activity to complete

Type

Type of activity

Executor

Target where the process or activity is executing

Runtime User

Runtime user of the activity

Categories

The category to which this process has been assigned
if applicable

Error

Brief description of any error that occurred

ID

Unique ID assigned to the activity instance

Description

Brief description of the process activity

Owner

Owner of the activity. This is typically the user name
of the person who created the activity.

Type Description

Brief description of the type associated with the
activity

Time Saved

Time taken to execute the process manually

Money Saved

Cost of manual process execution

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.
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Search Work Details Pane
The Search Work Details pane displays detailed information about the selected process or activity. The
following are the standard tabs that display when the process instance and activity instances are selected
from the Search Results pane:
Tab

Description

General

Displays general information about the process or activity instance

Run Options

Displays the target, runtime user, and triggers for the process or
activity instance

Workflow

Display only. Shows the process viewer when the process instance
is selected.

Knowledge Base

Displays a summary of any knowledge base entries associated with
the selected activity instance. The Knowledge Base tab only
displays when an activity instance is selected.

Customizing Search Work Header
Use the Select Search Filters dialog box to customize the query header options. If the check box to the
left of the option remains unchecked, then the filter option will not display on the designated Search
header.
To customize the search filter options:
Step 1

On the Operations—Search Work header, click Customize Options.
The Select Search Filters dialog box displays.
Figure 3-7

Select Search Filters Dialog Box
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Step 2

Click the check box to the right of the appropriate option, and then click OK.
Filter Option

Description

Created Time

Check the check box to display the time options to determine the
time period for which processes or activities to display

State

Check the check box to display the filtering option for the state of
the process or activity.

Advanced

Check the check box to display the Show advanced processes
check box for filtering.

The selected search filters display in the Search Work header.
Figure 3-8

Operations—Search Work Header

Query Work by Date/Time
Use the following steps to query according to when the process or activity was scheduled to run.
To query work by created time:
Step 1

On the Search Work header, to the right of Created Time, choose the appropriate time filter options to
query the processes or activities. See Filter Display by Date/Time Options, page 3-21 for additional
information.

Step 2

Click Search to begin the query.
The results display in the Search Results pane.
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Query Work by State
Use the following steps to create a query according to current state of the process or activity.
To query by state:
Step 1

Step 2

In the Search Work header, to the right of State, on the drop-down list, choose one of the following items:
•

Succeeded

•

Running

•

Canceled

•

Failed (Canceled)

•

Failed (Not Completed)

Click Search to begin the query by the selected state of completion.
The results display in the Search Results pane.

Query Work by Advanced Process Configuration
On the Search Work header, check the Show Advanced Processes check box to indicate whether to
display configured advanced process instances.
If the Show Advanced Processes check box remains unchecked, then the processes defined to show only
in an advanced view will not be displayed.
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Monitoring Activities
The Activity Views folder includes a set of predefined views that displays information about the status
of activities within the processes. From the Activity Views area, you can access all defined activities,
activities that have been triggered, executed adhoc, or scheduled. This section provides instructions on
viewing the information displayed in the Activity Views folders.

Accessing Activity View Folders
To access the Activity View folders:
On the Operations workspace, choose Activity Views.
Figure 3-9

Operations Workspace—Activity Views Folder

The Operations—Activity Views Results pane displays information about each activity folder in the
following columns:
Field

Description

Name

Name of the activity view

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the activity

Description

Brief description of the activity
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Field

Description

Created Time

Time at which the activity was created

Created By

User or object that created the activity

Viewing Activity Information
To view activity information:
Step 1

On the Operations workspace, choose Activity View.

Step 2

To access detailed information about an activity view, expand the Activity Views folder, and choose one
of the following items:

Note

Views

Descriptions

View Triggered

Displays all process or activity instances that were
executed (manually or automatically) and are in
progress, have successfully completed, or failed during
the selected time period

View Adhoc

Displays all process or activity instances that were
executed manually and are in progress, have
successfully completed, or failed during the selected
time period

View All

Displays all process, activity, and scheduled process
and activity instances that are in progress, have
successfully completed, or failed during the selected
display time period

View Scheduled

Displays all process or activity instances that are in
progress, have successfully completed, or failed and
are also scheduled to execute during the selected time
period

For information on the modifying the time period, see Filtering the Activity View, page 3-26.
The selected view displays in the Results pane. Certain columns display information about a process or
activity instance by default.
Column

Description

Display name

Name of the process instance or activity instance that
is scheduled, in progress, or completed
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Note

Column

Description

State

Current status of the operations activity
•

Succeeded

•

Scheduled

•

Running

•

Missed

•

Canceled

•

Failed (Canceled)

•

Failed (Not Completed)

Started By

User ID of the person who initiated the activity
instance

Start Time

Start time of the activity

End Time

End time of the activity as it completed or failed. If the
instance is in progress, 1/1/0001 12:00:00 AM is
displayed.

Duration

Amount of time taken for the activity to complete

Type

Type of activity

Executor

Target where the process or activity is executing

Categories

The category to which this process has been assigned
if applicable

Error

Brief description of any error that occurred

ID

Unique ID assigned to the activity instance

Description

Brief description of the process activity

Owner

Owner of the activity. This is typically the user name
of the person who created the activity.

Type Description

Brief description of the type associated with the
activity

Time Saved

Time taken to execute the process manually

Money Saved

Cost of manual process execution

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Activity Views Header
The Activity Views header is located at the top of the Results pane for each activity view. The header
provides options that formats the information displayed in the Results pane. The options on this header
are available only in the activity views, including the Activity View sub-pane in the Process View
folders.
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Filter Activity Display by [Object]
The hyperlinked Filter by drop-down lists displays the list of objects related to the item selected. The
following are the available objects that can be listed:
Option

Description

Category

Displays list of categories

Name

Enter the names of activity

Description

Enter description of activity

State

Enter the current state of the activity

The default selection is <No Filter>. After the initial change to the selection, the last selected item
displays. To filter the display by category, choose the appropriate category from the drop-down list.
Figure 3-10

Filter by Category Drop-down List

Filter Display by Date/Time Options
The Filter Display by Date/Time sub-pane displays the following options to modify the time frame in
which activities are displayed.
Figure 3-11

Activity View—Filter by Display by Date/Time

From Filtering Options
The following options determine the beginning of the time period for activities to display:
Filter

Description

Start

Provides the time frame options to define which activities are to be
displayed
Start

Uses the current date and time as the start time in which the
activities are displayed

Back

Start time precedes the current time by a defined number of hours

Forward

Start time follows the current time by a defined number of hours

Today

Now

Provides the date options to define which activities are to be
displayed
Current date and time
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Filter

Description

Today

Default option used to display activities on the current date
beginning at 12:00 AM

Before Today

Start date that precedes the current date by a defined number of days

After Today

Start date that follows the current date

Specific Date

Choose an exact start date from a calendar

To Filtering Options
The following options determine the end of the time period for activities to display.
Filter

Description

Start

Provides the end of the time period options used to define which
activities are to be displayed
Start

Uses the current date and time at the end of time period in which the
activities are displayed

Back

Start time precedes the current time by a defined number of hours

Forward

Start time follows the current time by a defined number of hours

Tomorrow

Provides the end of the date options to define which activities are to
be displayed

Tomorrow

Default option used to display activities beyond 24 hours after the
current date and time

Now

Sets the end of the period to the current date and time

Today

Current date beginning at 12:00 AM

Before Today

Start date that precedes the current date by a defined number of days

After Today

Start date that follows the current date

Specific Date

Choose an exact start date from a calendar

Status Indicators
The State column displays the status of the individual process and activity. The following indicators
definitions display in the Results pane.
Status

Description

Succeeded

Process has completed successfully

Scheduled

Processed is scheduled to run

Running

Process is in progress

Missed

Scheduled time for process was missed

Canceled

Displays when the process is canceled

Failed (Not
Completed)

Displays when the process has failed and did not complete the
process execution

Failed (Canceled)

Displays when the process is canceled manually
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Color Indicators
The default colors associated with the individual activities indicate the status of the process instances.

Note

Color Indicator

Description

Blue

Process is in progress

Green

Process has completed successfully

Red

Process has failed and did not complete the
process execution

Orange

Process has stopped

To modify the fonts and colors on the Activity View status display, see Customizing the Fonts and
Colors, page 1-31.

Calendar
Use the Back and Forward arrows on either side of the Calendar
and To options.

tool to navigate through the From

Activity View Details Pane
The Activity Views Details pane displays detailed information about the selected instance. Additional
detail pages may display depending on the activity instance selected. If the process-level instance is
selected, each hyperlink on the Details pane launches the Process Viewer.

Note

For more information on the Process Viewer, see Viewing Activity Instance Properties, page 3-31.
If the activity instance is selected, each hyperlink on the Details pane launches a display-only view of
the Activity Properties dialog box.
The following are the standard tabs that display when the process instance and activity instances are
selected:
Tab

Description

General

Displays general information about the process or activity instance

Run Options

Displays the target, runtime user, and triggers for the process or
activity instance

Workflow

Display only. Shows the process viewer when the process instance
is selected.

Knowledge Base

Displays a summary of any knowledge base entries associated with
the selected activity instance. The Knowledge Base tab only
displays when an activity instance is selected.
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Process Viewer
The Process Viewer is launched when a process instance is selected from the Activities view.
Figure 3-12

Process Viewer

The viewer contains a Status pane, Workflow pane, and Properties pane.
Display Pane

Description

Status Pane

Displays the current status and other detailed information about the
selected process and its activities

Workflow Pane

Displays the graphical workflow of the selected process and its
activities

Properties Pane

Display only. Shows the properties for the process and activity
instances

Viewing the Workflow Only
A graphical view of a process workflow can be viewed from the Process Views area after a process has
been launched.
To view the workflow:
Step 1

Choose any of the Process Views to display in the Results pane.

Step 2

Highlight the appropriate process instance, on the Process Views Details pane, click the Workflow tab.
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General Operation Views Procedures
This section contains procedures that can be used to modify the Operations display. Many of the
procedures described in this section are also available from the Process Instance Results pane.

Modifying the Activity View Format
Each of the activity views can display in one of three formats (Flat, Workflow, Activity).
Figure 3-13

Activity Views Display Formats

To change an Activity View format:
Highlight an activity instance, right-click and choose View > [Format].
Activity Format

Description

Flat

Displays all process instances and activity instances on the top-level
with no expandable tree view

Workflow (Default view)

Displays the process instances and only one related activity instance
(even if it has run multiple times) in an expandable tree-view format

Activity

Displays the process instances and all related activity instances (no
matter how many times it has run) in an expandable tree-view
format

The displayed activity view is modified.
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Filtering the Activity View
The filter options in the header determine the time period for which activities display in the Results pane.

Querying Activities by Start Time Period
The Start of menu to the left of To provides the starting time period options used to define which
activities are displayed. To use the current time as the start of the time period in which the activities are
displayed, do not make any changes to Time menu options.
To query by the start time:
Step 1

On the Activity Views header, to the right of From, click the Start hyperlink to display the start time
options.
The Start Time drop-down list displays.
Figure 3-14

Step 2

Start Time List

Choose one of the following options to modify the start time to display activities:
Option

Description

Start

Default option uses the current time on the console

Back

Adjusts the number of hours that precede the current
console time

Forward

Adjusts the number of hours ahead of the current console
time

Figure 3-15

Back Sub-Menu
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Figure 3-16

Forward Sub-Menu

The selected time displays on the Start Time hyperlink.

Querying Activities by the Date Range
Use the following instructions to modify the start and end date on the Activity Views header. The options
are located to the right of both the From and To sections. To the far right of From, click Today hyperlink
to display the start and end date options.
To query by the display date:
Step 1

On the Activity Views header, use one of the following methods:
•

To modify the start date, click the Today hyperlink to the far right of From, to display the start date
options.
-or-

•

To modify the end date, click the Tomorrow hyperlink to the far right of To, to display the end date
options.

The Date drop-down list displays.
Figure 3-17

Step 2

Date Drop-down List

Choose one of the following options to modify the display date:
Option

Description

Now

Displays activities beginning with the current Console date
and time

Today

Displays activities on the current date beginning at 12:00
AM

Tomorrow

Displays activities beyond 24 hours after the current date
and time

Before today

Adjusts the start date for activities to display before the
current console date by a defined number of days

After Today

Adjusts the start date to follow the current console date

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

3-27

Chapter 3

Operations Workspace

General Operation Views Procedures

Figure 3-18

Before Today Sub-Menu

Figure 3-19

After Today Sub-Menu

The selected date displays on the Date hyperlink.

Querying Activities by End Time Period
The Start menu to the right of To provides the end of the time period options used to define which
activities are displayed. To use the current time as the end of the time period in which the activities are
displayed, do not make any changes to Time menu options.
To query by the display ending time:
Step 1

On the Activity Views header, to the right of To, click Start.
The Start Time drop-down list displays.

Step 2

To adjust the results for activities to display that precedes the current ending time by a defined number
of hours, click Back and choose the appropriate number of hours.
Figure 3-20

Step 3

Back Submenu

To adjust the results for activities to display after the current ending time by a defined number of hours,
click Forward and choose the appropriate number of hours.
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Figure 3-21

Forward Submenu

The selected time displays on the End Time hyperlink.

Specifying Time Period to Offset Query
The More option on the Back and Forward sub-menus should be used when the number of hours and
minutes to offset is not on the predefined list. When selected, the More option launches the Select Time
Offset dialog box to enter the specific hours and minutes for the start and end time.
To query by specific time frame:
Step 1

On either the Back or Forward submenus, click More.
The Select Time Offset dialog box displays.
Figure 3-22

Step 2

Select Time Offset Dialog Box

Enter the following information and click OK:
Field

Description

Hour Offset

Specific number of hours to precede or follow the
current end time
To specify hours before the displayed value, select or
enter a negative number.

Minute Offset

Specific number of minutes to precede or follow the
current end time
To specify minutes before the displayed value, select
or enter a negative number.

The selected time displays on the hyperlink.
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Specifying Days to Offset Query
The More option on the Before today and After today sub-menus should be used when the appropriate
number of days to offset is not on the predefined list. When selected, More option launches the Select
Day Offset dialog box to enter a specific number of days for a start and end date.
To query by days to offset:
Step 1

From either the Before today or After today submenu, click More.
The Select Day Offset dialog box displays.
Figure 3-23

Step 2

Select Day Offset Dialog Box

In the Offset field, enter the number of days to precede or follow the current date and click OK.
The selected date displays on the hyperlink.

Selecting a Specific Date
To choose specific date from calendar:
Step 1

From the Start Date menu, choose Specific Date.
The Select Date dialog box displays.
Figure 3-24

Step 2

Select Date Dialog Box

On the Select Date dialog box, choose the appropriate date, and click OK.

Cisco Tidal Enterprise Orchestrator Reference Guide

3-30

OL-24928-01

Chapter 3

Operations Workspace
General Operation Views Procedures

Navigating the Current Time Period
The two navigation arrows located on each side of the Calendar
and Forward options on the Start Date and End Date sub-menu.

tool selects the next day on the Back

To navigate between the currently selected time:

On the Filter by Date/Time toolbar, click the appropriate navigation arrow next to the Calendar icon.
Navigation Option

Description

Back

Chooses the previous day prior to the currently selected day on the Back
submenu for the starting and ending dates

arrow

Example:
If Yesterday is currently selected, then clicking the Back
arrow changes the display selection to 2 days before today.

Forward

arrow

Chooses the day after the currently selected day
Example:
If Tomorrow is currently selected, then clicking the Forward
arrow changes the display selection to 2 days after today

The Activity View header automatically updates the displayed time frame.

Viewing Activity Instance Properties
The activity instance properties displayed from the Activity View are display-only.
To view activity instance properties:
Step 1

Choose any of the four activity views to display the process and activity instances in the Results pane.

Step 2

In the Results pane, expand the appropriate process instance to display the related activities.

Step 3

Highlight the appropriate activity, and use one of the following methods:
•

Double-click the appropriate activity instance.

•

Right-click and choose Observe.

•

On the Details pane, click the hyperlink of any item on tabs.

The Properties dialog box displays.
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Monitoring Processes
The Process Views folder includes all the defined processes and their associated activity instances that
are in progress, scheduled or have been completed. From this view, detailed information is provided
about all the processes that have been triggered, executed adhoc, or are scheduled for execution. This
section provides information on the Process Views display in the Operations workspace.

Accessing Process Views Folder
To access the Process View folders:
In the Operations workspace, choose Process Views. The Results pane displays the following default
summary information for each of the four process views:
Field

Description

Name

Name of the process view

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the
activity

Description

Brief description of the activity

Created Time

Time at which the process was created

Created By

User or object that created the process

Figure 3-25

Operations Workspace—Process Views—View All
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Viewing Process View Information
To view process information:
Step 1

On the Operations workspace, choose Process View.

Step 2

To access detailed information about an activity view, expand the Process Views folder, and choose one
of the following items:
Process View

Description

View Triggered

Displays all process or activity instances that were
executed (manually or automatically) and are in
progress, have successfully completed, or failed during
the selected time period

View Adhoc

Displays all process or activity instances that were
executed manually and are in progress, have
successfully completed, or failed during the selected
time period

View All

Displays all process, activity, and scheduled process
and activity instances that are in progress, have
successfully completed, or failed during the selected
display time period

View Scheduled

Displays all process or activity instances that are in
progress, have successfully completed, or failed and
are also scheduled to execute during the selected time
period

Step 3

On the Activity Views subheader, choose the appropriate category and time period to display.

Note

For information on the modifying the time period, see Filtering the Activity View, page 3-26.
The selected view displays in the Results pane. Certain columns display information about a process or
activity instance by default. To view the description for the activity instance columns, see Viewing
Activity Information, page 3-19.

Process View Results Pane
The Process View Results pane is divided into a split pane. In the upper Process View Results pane, all
process instances for the selected view are displayed. For more information on process instances
displayed in the process view Results pane, see Process Instance Results Pane, page 3-34.

Process View Header
The Filter by [Object] drop-down list displays s the list of objects related to the item selected and is
available in both the Activity and Process Views. The default selection is <No Filter>. After the initial
change to the selection, the last selected item displays.
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The following are the available objects that can be listed:
Option

Description

Category

Displays list of categories

Name

Enter the names of process

Description

Enter description of process

Automation Pack

Enter the name of the automation pack for the process

To filter the display:
From the Filter by drop-down list, choose the appropriate object. All processes assigned to the selected
object display.
The lower Process View Results pane displays activity instance information for a selected process
instance. For more information on the activity instances displayed on the sub-pane, see Monitoring
Activities, page 3-18.
Figure 3-26

Process View Results Pane

Process Instance Results Pane
The upper Results pane lists all the process instances. Information about each process instance can be
displayed in the following columns. To configure the Process View column headings, see Configuring
Columns, page 1-29.
Column

Description

Name

Name of the process instance that is scheduled, in progress, or
completed

Target

Name of the target the process runs against

Enabled

Specifies whether the process instance is enabled (True, False).
Process instances that are not enabled are unavailable for execution.

Categories

The category to which this process has been assigned if applicable

Most recent state

Current status of the operations activity [Ex. Succeeded, Running,
Failed (Canceled) or Failed (Not Completed)]

ID

Unique ID assigned to the process instance

Description

Brief description of the process instance
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Activity Instance Results Pane
The lower Results pane displays information each activity within the process instance selected in the
upper Results pane. For additional information on the results displayed, see Monitoring Activities,
page 3-18.

Process View Details Pane
The Process Views Details pane displays detailed information about the selected instance. Additional
detail pages may display depending on whether the process instance is selected or the activity instance
is selected.
If the process instance is selected, each hyperlink on the Details pane launches the Process Viewer. For
more information on the Process Viewer, see Managing Process Definitions, page 7-19.
If the activity instance is selected, each hyperlink on the Details pane launches a display-only view of
the Activity Properties dialog box. For more information on viewing activity instance properties, see
Viewing Activity Instance Properties, page 3-31.
The following are the standard tabs that display when the process instance and activity instances are
selected.
Tab

Description

General

Displays general information about the process or activity instance

Run Options

Displays the target, runtime user, and triggers for the process or
activity instance

Workflow

Display only. Shows the process viewer when the process instance
is selected

Knowledge Base

Displays a summary of any knowledge base articles associated with
the selected activity instance. The Knowledge Base tab only
displays when an activity instance is selected.

Viewing Process Instances
A graphical view of a process workflow can be viewed from the Process Views area after a process has
been launched. The information displayed on the Process Viewer is display-only.
To view process instances:
Step 1

Choose any of the four process views to display the process and activity instances in the Results pane.

Step 2

From the Process Instance Results pane, use one of the following methods to launch the Process Viewer:

Step 3

•

Double-click the appropriate process instance.

•

Highlight the appropriate process instance, on the Process Views Details pane, click the hyperlink
of any item on the General or Run Options tabs.

From the Activity Instance Results pane, highlight the appropriate process instance, right-click and
choose Observe.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

3-35

Chapter 3

Operations Workspace

Monitoring Processes

The Process Viewer displays.
Figure 3-27

Note

Process Viewer

For more information about the Process Viewer, see Process Viewer, page 3-24.
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Monitoring Auditing Information
The Auditing View displays the system logs for system events that have occurred within Tidal Enterprise
Orchestrator. This section provides information on each audit view displayed in the Results pane.

Accessing Auditing Logs
To access the auditing logs:
Step 1

In the Operations workspace, choose Auditing.
The Results pane displays the following default summary information for each of the auditing views:
Column

Description

Name

Name of the audit view

Description

Brief description of the audit view

Figure 3-28

Step 2

Operations—Auditing View

To access detailed information about the system event history, under the Auditing folder, choose System
to display system event activity, such as start and shut down time and error occurrences.
The selected view displays in the Results pane.
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The System Log Results pane contains the following column headings which show information about
each system log entry.

Note

Column

Description

Type

Type of event logged by the system

Created By

System-generated record, such as an error condition, or the user
name of the person who initiated the process

Created Time

Date and time the event occurred

Event

Number associated with a specific condition on the server for the
event

Description

Brief description of the state of a process or activity instance when
the event was logged

Category

Numeric ID assigned to the category for a process instance

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Auditing Details Pane
The Auditing Details pane displays additional information about a selected audit system event.
Figure 3-29

Auditing Details Pane

Field

Description

Type

Type of event logged by the system

Created Time

Date and time the event occurred

Created By

TEO service account or the user name of the person who initiated
the action

Description

Brief description of the event
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Viewing System Log Instance Properties
The activity instance properties displayed from the Auditing View are display-only.
To view auditing instance properties:
Step 1

On the Auditing folder, choose the System view.

Step 2

In the Auditing Log Results pane, use one of the following methods to launch the Audit Log Properties
dialog box:

Step 3

Highlight the appropriate activity, and use one of the following methods:
•

Double-click the appropriate audit log entry.

•

Highlight the appropriate log entry, right-click and choose Properties.

•

Highlight the appropriate log entry, navigate to the Details pane, click the hyperlink of any item on
the General tab.

The display-only Audit Log Properties dialog box displays detailed log entry information.
Figure 3-30

Audit Properties Dialog Box

The following information displays about the auditing properties.

Step 4

Field

Description

Type

Type of event logged by the system. For example, a Success
Audit, an Error, or an Information message

Created By

System-generated record, such as an error condition, or the
user name of the person who initiated the process

Created Time

Date and time the event occurred

Category

Category name for a process instance

Message ID

Number associated with a specific condition on the server
for the event

Message

Brief message of the event associated with the Message ID

Description

Brief description of the event

Click OK to close the properties dialog box.
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Managing Tasks
The Operations—Tasks view displays all task activities and tasks that have been assigned to a specific
user or group. The display can be filtered to display tasks by properties such as, category, task type, and
status. The user can determine which task view to display.
This chapter provides instructions on creating and managing tasks in the Operations—Task View. Tasks
that have been defined in the Process Editor and are run as part of an executed process will display in
the Operations—Activities View similar to other activities. The tasks will also display in the
Operations—Task View to await user action.

Note

To define a task activity, see the Appendix B, “Task Activities.”
Refer to the following sections for information on managing tasks in the Operations workspace:
•

Accessing Operations—Task Views, page 4-2

•

Creating Tasks, page 4-7

•

Creating an Alert Task, page 4-11

•

Creating an Approval Request Task, page 4-15

•

Creating a Change Request Task, page 4-18

•

Creating a Guided Operation Task, page 4-21

•

Creating an Incident Task, page 4-23

•

Creating an Input Request Task, page 4-27

•

Creating a Review Task, page 4-35

•

Managing Task Definitions, page 4-37
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Accessing Operations—Task Views
To access the Tasks view:
In the Operations workspace, choose Task Views > [Selected Task View].
The Results pane displays.
Figure 4-1

Operations Workspace—Tasks—View All

The selected view displays in the Results pane. The displayed columns depend on the selected task. Task
alerts and incidents view will display additional information.
Column

Description

Display Name

Name of the task

Type

Type of task

Priority

Priority of the task

Status

Status of the task

Due Date

Date the task should be completed

Class

String or numeric value indicating the class of the alert or
incident

Assigned to

User name of the person assigned to the task

Related Tasks

Related tasks associated with the task
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Note

Column

Description

Categories

Categories assigned to the task

Target

Name of ITIL configuration item (IT component) which
the alert or incident describes

Target CI

Name of the system on which the condition was detected

Created Time

Time at which the task was created

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the contents

Id

Task identifier

Notes

Notes associated with the task

Owner

User name of the person or group who assigned the task

Type Description

Brief description of the type of task

Expiration Date

Date the task is set to expire

Completed Time

Time the task was completed

Completed Date

Date task was completed

Produced by

Process which generated the task. This field will be empty
if the task was manually created.

Parameters

Parameters of the task

Affected Organizations

Organizations that consume the IT service affected by the
alert or incident

Affected Services

IT Service affected by the alert or incident

Configuration Item

Name of the configuration item (IT component) to which
the alert pertains.

Automation Summary

File path for the related automation summary

Created By

User or object that created the task

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Viewing Task Properties
To view task properties:
Step 1

On the Operations—Task Views, highlight the appropriate task, and use one of the following methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.
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Note

Step 2

The property pages may display as display-only if the task definition is shipped as part of the product or
the user does not have the appropriate rights.
Review the properties and click OK to close the dialog box.

Common Task Properties
The following properties are associated with the tasks managed in TEO. The properties that display
depend on the selected task. These properties can be updated using the [Update] activities as well as
published in a SNMP trap.
Task Property

Description

Affected Configuration Item

Name of the configuration item (IT component) to which the
alert pertains.
For example, the name of a database server which failed or
the name of a specific job which failed. A configuration item
is defined in ITIL as any component that needs to be
managed in order to deliver an IT Service. The true source of
the CI is in the CMDB, so the Configuration Item properties
reference a CMDB entry
•

Configuration Item Type—Type of ITIL configuration
item (IT component) which the alert describes. For
example, the type of the specific application element
which failed such as a server, database, host, or user.

•

Description—Brief description of the ITIL
configuration item (IT component) for the alert or
incident

•

Object Key—ID for the specific record in the CMDB
which contains the configuration item

•

Object Name—Name for the specific record in the
CMDB which contains the target configuration item

•

Source—Name for the specific record in the CMDB
which contains the configuration item.

Affected Organizations

Organizations that consume the IT service affected by the
alert or incident

Affected Services

IT Service affected by the alert or incident
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Task Property

Description

Affected Target Configuration Item

Name of ITIL configuration item (IT component) which the
alert or incident describes
•

Configuration Item Type—Type of ITIL configuration
item (IT component) which the alert describes

•

Description—Brief description of the ITIL
configuration item (IT component) for the alert or
incident

•

Object Key—ID for the specific record in the CMDB
which contains the target configuration item

•

Object Name—Name for the specific record in the
CMDB which contains the target configuration item

•

Source—Name of the specific CMDB containing the
target configuration item

Affects Configuration Item

Name of the configuration item (IT component) to which the
alert pertains.

Affects Target Configuration Item

Name of the system on which the condition was detected

Alert class

Numeric value indicating the class of the alert

Assignees

User name(s) or group assigned to the task

Automation Summary

File path for the related automation summary

Completed Time

Indicates the time period the task was completed
•

Local Time

•

Universal Time

Description

Brief description of the task

Due Date

Indicates the time period the task should be resolved
•

Local Time

•

Universal Time

Duplicate Task ID

Task ID of the duplicated alert

Expiration Date

Indicates the time period the task should expire
•

Local Time

•

Universal Time

Name

Display name of the task

Notes

Any notes related to the task

Parameter

Any parameters associated with a specific task

Priority

Indicates the priority of the task

Process Properties

•

Low

•

Medium

•

High

For the list of process columns, refer to Viewing Process
View Information, page 3-33.
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Task Property

Description

Process Target Properties

For information on the target properties, see Viewing
Activity Information, page 3-19.

Severity

Indicates the severity of the task
•

Low

•

Normal

•

High

Related Task IDs

Task ID of the related task

Task Status

Indicates status of the task. The statuses displayed depend on
the currently open task.
Note

Task URL

See Common Task Statuses, page 4-6 for additional
information.

URL of the task. This URL can be used to bring up the Web
Console for viewing and editing the task properties.
For example, this is the URL which could be placed in an
email to notify the user of the task, enabling them to connect
to the Web Console to view the task.

Web Form XSL File Name

Name of the source XML text file to transform the task XML
into HTML for viewing in the Web Console

Common Task Statuses
The following statuses are associated with the tasks managed in TEO. The statuses that display depend
on the currently open task.
Task Status

Description

Assigned

Task is assigned to a user

Bypassed

A step within the operation has been skipped

Canceled

Task has been canceled by the user

Closed

Task is closed

Completed

Task is completed and has been either approved or declined

Duplicate

Indicates whether the alert is a duplicate

Expired

Task due date is expired, but still needs to be completed

In Progress

User is working on the task

New

Indicates task is new

Not Resolved

Indicates task is not resolved

Past Due

Task is past due and still needs to be completed

Pending

Task is in a user's assigned task list

Resolved

Indicates task is resolved

Waiting

Waiting for more information
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Creating Tasks
The ability to create tasks is not applicable to everyone as only users with administrative rights can create
tasks from this view in TEO. The permission to create or modify a task in the Operations—Task view is
not available to all users.

Tasks Overview
The following table displays the tasks that are provided by TEO.
Tasks

Description

Alert

Alerts reflect potential problems that a user may want
to investigate and possibly diagnose the problem

Approval Request

Specifies the message and choices for the assignee
who is approving the task

Change Request

Requests a modification to the configuration of an
object or system

Guided Operation

Details the steps a user takes to complete an assigned
task

Incident

Task requires an operator to take action in order to
resolve an issue

Input Request

Task requires input from an individual or group

Review

Task assigns a document for review

Creating a Task from Task View
When creating a task in the Operations—Tasks Views, the task dialog box contains property pages that
are specific to the selected task as well as property pages that are common to all the tasks.
Use the following steps to define a task in the Operations—Tasks Views. Refer to the appropriate section
for instructions on completing the task property pages.
To create a task:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > [Selected Task].
-or-

•

From the Actions menu, choose New > [Selected Task].

The [Task Name] Properties dialog box displays.
Step 2

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display only. Shows the type of task
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Field

Description

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description
Step 3

Note

Step 4

Click the Properties
tool to show the
display-only view of the process.

Description of the task

Click the task-specific tab to enter the appropriate information for the task. Refer to the appropriate
section for instructions on creating the task.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Click the Assignment tab to modify the general assignment properties for the task.
Field

Description

Assigned to

User name(s) assigned to the task

Priority

Step 5

See Common Task Statuses, page 4-6 for
additional information.

•

Add—Click Add to launch the Select User or
Group dialog box to choose the name of the person
to assign to the task

•

Remove—Choose the user name and click this
button to remove the user from list.

Indicates the priority of the task
•

Low

•

Medium (Default)

•

High

Due date

Check the check box and choose appropriate date the
task should be completed from the drop-down
calendar.

Expiration date

Choose the appropriate date the alert should expire
from the drop-down calendar.

Click the Notification tab to specify the recipients to be notified about the task.
Button

Description

Add

Click this button to launch the Add Notification
Recipient Dialog Box to enter the appropriate recipient
and click Ok to add the recipient.

Modify

Highlight the appropriate recipient in the list to be
modified.
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Step 6

Button

Description

Remove

Highlight the appropriate recipient and click this
button to remove the recipient from the list.

Remove All

Click this button to remove all specified recipients
from the list.

Click the Parameters tab to define parameters for a specific task.
Field

Description

Parameter

Enter the appropriate parameter

Add

Adds new row for parameter to be added

Remove

Removes selected parameter from task

Step 7

Click the Notes tab to enter any notes related to the task in the text box.

Step 8

Click the Categories tab to assign a task to a category or modify an existing assigned category.
Tasks belong to the following categories:

Step 9

Column

Description

Display Name

The name of the category

Description

A description of the category

Type

Type of category

Use the following buttons to modify the list of categories:
Field

Description

Add

Click this button to launch the Select Categories dialog box
and select the category to which the process is to be
assigned.
For more information, see Assigning a Category to a Task,
page 4-41.

Properties

Click this button to view or modify the properties of
category.

Remove

Click this button to remove a category from the list.
For more information, see Removing a Category from a
Task, page 4-41.

Step 10

Click the Related tab to assign or modify an existing related task.
Field

Description

This task is a duplicate of the
following task

Display Only. Shows any duplicated tasks.
Click the Delete tool to remove the selected task from the
field. This action does not delete the task from the system.
Click this button to launch the Select Tasks dialog box and
select the task to add to the duplicate task field.
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Information about the tasks related to the selected task display in the following:

Step 11

Field

Description

Display Name

Name of the task

Description

Description of the task

Type

Type of task

Use the following buttons to modify the list of tasks:
Field

Description

Add

Launches the Select Tasks dialog box and select the
task to add to the Related task list.
After the task has been added to the list, it will no
longer be displayed in the Select Tasks dialog box.
For more information, see Adding a Related Task,
page 4-43.

Properties

Click this button to view or modify the properties of
task.

Remove

Click this button to remove a task from the list.
For more information, see Removing a Related Task,
page 4-43.

Step 12

Step 13

Step 14

Click the External tab to specify the external incident information to support the synchronization
between TEO and the system that the customer is using.
Field

Description

External System

Name or IP address for the incident management
server

External ID

ID of the incident which corresponds to the TEO
incident

Click the History tab to display the history of actions taken against the task. This tab remains blank until
after the initial task creation.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Click OK to close the dialog box.
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Creating an Alert Task
Use the Alert task to create an alert regarding any potential problems. An alert reflects potential
problems that a user may want to investigate and possibly diagnose the problem.
To create an alert:
Step 1

On the Operations—Task Views, use one of the following methods:
•

On the toolbar, choose New > IT Record > Alert.
-or-

•

From the Actions menu, choose New > IT Record > Alert.

The New Alert Properties dialog box displays.
Figure 4-2

New Alert Properties Dialog Box—General Tab
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Step 2

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description
Step 3

Note

See Common Task Statuses, page 4-6 for
additional information.
Click the Properties
tool to show the
display-only view of the process.

Description of the task

Click the Alert tab to continue.

The Required Value
a value.
Figure 4-3

icon displayed on a tab or page indicates that the field is required and is missing

New Alert Properties—Alert Tab
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Step 4

On the Alert tab, enter the criteria for the alert.
Field

Description

Alert class

String or numeric value indicating the class of the alert

Severity

Severity of the alert

Automation Summary

Step 5

•

High—Interruption to critical business processes

•

Normal—Interruption to the work of individual
employees

•

Low—Hindrance to the work of individual
employees, continuation of work possible by
means of a circumvented solution

Enter the file path for the related automation summary
that was performed on the alert.

Click the Affects tab to continue.
Figure 4-4

New Alert Properties −Affects Tab
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Step 6

On the Affects tab, specify the appropriate organizations and configuration item elements.
Field

Description

Target name

Name of the target affected by alert or incident

Configuration item name

Name of the configuration item (IT component) to which
the alert pertains. For example, the name of a database
server which failed or the name of a specific job which
failed.
A configuration item is defined in ITIL as any component
that needs to be managed in order to deliver an IT Service.
The true source of the CI is in the CMDB, so the
Configuration Item properties reference a CMDB entry.

Step 7

Object name

Name for the specific record in the CMDB which contains
the target configuration item

Type

Type of ITIL configuration item (IT component) which the
alert describes. For example, the type of the specific
application element which failed such as a server, database,
host, or user.

Source

Name for the specific record in the CMDB which contains
the configuration item

Key

ID for the specific record in the CMDB which contains the
configuration item

Affected services

IT Service affected by the alert or incident

Affected organizations

Organizations that consume the IT service affected by the
alert or incident

Complete the appropriate information in the following tabs, as necessary, and then click the OK tool to
complete the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Notification—Click the tab to specify the recipients to be notified about the task.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

External—Click the tab to specify the external incident information to support the synchronization
between TEO and the system that the customer is using.

•

History—Click the tab to display the history of actions taken against the task.
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Creating an Approval Request Task
Use the Approval Request task to specify the user or group required to approve a task including the
message associated for the approver.
To create an approval request:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > User Interaction > Approval Request.
-or-

•

From the Actions menu, choose New > User Interaction > Approval Request.

The New Approval Request Properties dialog box displays.
Figure 4-5

New Approval Request Properties Dialog Box—General Tab
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Step 2

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description
Step 3

Note

See Common Task Statuses, page 4-6 for additional
information.
Click the Properties
tool to show the
display-only view of the process.

Brief description of the task

Click the Approval tab to continue.

The Required Value
a value.
Figure 4-6

icon displayed on a tab or page indicates that the field is required and is missing

New Approval Request Properties—Approval Tab
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Step 4

On the Approval tab, enter the criteria for the approval request.
Field

Description

Message

Enter the message that informs the approver what is
being requested.

Approval choices

Displays the choices available to the approver

Choice
Step 5

•

Add—Enter approval choices in the Select
Approval Choice dialog box.

•

Remove—Choose an existing item in the Approve
Choice text box and then click Remove to remove
the approval item from the list.

Choose the appropriate approval choice for the task.

Complete the appropriate information in the following tabs, as necessary, and then click OK to complete
the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

External—Click the tab to specify the external incident information to support the synchronization
between TEO and the system that the customer is using.

•

History—Click the tab to display the history of actions taken against the task.
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Creating a Change Request Task
Use the Change Request task to request a modification to the configuration of an object or system. The
change requests are used to request system enhancements, report problems with a system, or report
changes from one system which affects another system.
To create a change request:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > IT Record > Change Request.
-or-

•

From the Actions menu, choose New > IT Record > Change Request.

The New Change Request Properties dialog box displays.
Figure 4-7

New Change Request Properties Dialog Box—General Tab
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Step 2

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description
Step 3

Note

See Common Task Statuses, page 4-6 for additional
information.
Click the Properties
tool to show the
display-only view of the process.

Brief description of the task

Click the Change Request tab to continue.

The Required Value
a value.
Figure 4-8

icon displayed on a tab or page indicates that the field is required and is missing

New Change Request Properties—Change Request Tab
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Step 4

On the Change Request tab, enter the criteria for the change request.
Field

Description

Change request identifier

TEO generated ID number for the change request task

Change request class

Numeric value indicating the class of the change
request

Reason for change

Describes the business justification for the request

Change timing

Enter the deadline date or time for the change

Severity

Severity of the change request

Automation Summary

Step 5

•

High—Interruption to critical business processes

•

Normal—Interruption to the work of individual
employees

•

Low—Hindrance to the work of individual
employees, continuation of work possible by
means of a circumvented solution

Enter the file path for the related automation summary
that was performed on the change request

Complete the appropriate information in the following tabs, as necessary, and then click OK to complete
the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Notification—Click the tab to specify the recipients to be notified about the task.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

External—Click the tab to specify the external incident information to support the synchronization
between TEO and the system that the customer is using.

•

History—Click the tab to display the history of actions taken against the task.
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Creating a Guided Operation Task
Use the Guided Operation task to provide detailed instructions for a user or group to perform a guided
operation task.
To create a guided operation task:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > User Interaction > Guided Operation.
-or-

•

From the Actions menu, choose New > User Interaction > Guided Operation.

The New Guided Operation Properties dialog box displays.
Figure 4-9

Step 2

New Guided Operation Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description

See Common Task Statuses, page 4-6 for
additional information.
Click the Properties
tool to show the
display-only view of the process.

Brief description of the task

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

4-21

Chapter 4

Managing Tasks

Creating a Guided Operation Task

Step 3

Note

Click the Guided Operation tab to continue.

The Required Value
a value.
Figure 4-10

Step 4

Step 5

icon displayed on a tab or page indicates that the field is required and is missing

New Guided Operation Properties—Guided Operation Tab

On the Guided Operation tab, enter the criteria for the guided operation.
Field

Description

Instructions

Enter the step-by-step process for handling a task.

Complete the appropriate information in the following tabs, as necessary, and then click OK to complete
the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

External—Click the tab to specify the external incident information to support the synchronization
between TEO and the system that the customer is using.

•

History—Click the tab to display the history of actions taken against the task.
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Creating an Incident Task
Use the Incident task to create a task which requires an operator to take action in order to resolve an
issue.
To create an incident:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > IT Record Incident.
-or-

•

From the Actions menu, choose New > IT Record Incident.

The New Incident Properties dialog box displays.
Figure 4-11

Step 2

New Incident Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

See Common Task Statuses, page 4-6 for
additional information.
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Field

Description

Produced by

Name of the process which generated the task.
Note

Description
Step 3

Note

Brief description of the task

Click the Incident tab to continue.

The Required Value
a value.
Figure 4-12

Step 4

Click the Properties
tool to show the
display-only view of the process.

icon displayed on a tab or page indicates that the field is required and is missing

New Incident Properties—Incident Tab

On the Incident tab, enter the criteria for the alert.
Field

Description

Incident identifier

ID of the incident

Incident class

String or numeric value indicating the class of the
incident

Reporting user

User name of the individual who reported the incident
and contact information of the user who called IT to
report the problem

Reporting user details

Contact information of the individual who reported the
incident

Cisco Tidal Enterprise Orchestrator Reference Guide

4-24

OL-24928-01

Chapter 4

Managing Tasks
Creating an Incident Task

Field

Description

Severity

Severity of the incident

Automation Summary

Step 5

•

High—Interruption to critical business processes

•

Normal—Interruption to the work of individual
employees

•

Low—Hindrance to the work of individual
employees, continuation of work possible by
means of a circumvented solution

Enter the file path for the related automation summary
that was performed on the incident.

Click the Affects tab to continue.
Figure 4-13

New Incident Properties—Affects Tab

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

4-25

Chapter 4

Managing Tasks

Creating an Incident Task

Step 6

On the Affects tab, specify the organizations and configuration item elements that triggered the target
for the task.
Field

Description

Target name

Name of the target affected by alert or incident

Configuration item name

Name of the configuration item (IT component) to which
the alert pertains. For example, the name of a database
server which failed or the name of a specific job which
failed.
A configuration item is defined in ITIL as any component
that needs to be managed in order to deliver an IT Service.
The true source of the CI is in the CMDB, so the
Configuration Item properties reference a CMDB entry.

Step 7

Object name

Name for the specific record in the CMDB which contains
the target configuration item

Type

Type of ITIL configuration item (IT component) which the
alert describes. For example, the type of the specific
application element which failed such as a server, database,
host, or user.

Source

Name for the specific record in the CMDB which contains
the configuration item

Key

ID for the specific record in the CMDB which contains the
configuration item

Affected services

IT Service affected by the alert or incident

Affected organizations

Organizations that consume the IT service affected by the
alert or incident

Complete the appropriate information in the following tabs, as necessary, and then click the OK tool to
complete the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

External—Click the tab to specify the external incident information to support the synchronization
between TEO and the system that the customer is using.

•

History—Click the tab to display the history of actions taken against the task.
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Creating an Input Request Task
Use the Input Request task to create a set of questions requiring a user or group response in order to
gather a large set of information.
To create an input request:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > User Interaction > Input Request.
-or-

•

From the Actions menu, choose New > User Interaction > Input Request.

The New Input Request Properties dialog box displays.
Figure 4-14

Step 2

New Input Request Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description

See Common Task Statuses, page 4-6 for
additional information.
Click the Properties
tool to show the
display-only view of the process.

Brief description of the task
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Step 3

Note

Click the Input Request tab to continue.

The Required Value
a value.
Figure 4-15

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

New Input Request Properties—Questions Tab

On the Questions tab, define the appropriate questions for the input request.
Field

Description

Input request message

Enter the introductory message for the input request.

Questions presented on the input
request

Displays the input request question properties
•

Label—Input request question

•

Type—Type of question (text, check box, select)

•

Default Value—Default answer for the question
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Step 5

Field

Description

New

Use this option to create a specific type of input request
question. Click New each time to create additional
questions for the input request.
•

Text—Launches the New Text Properties dialog box to
allow the user to define a text question. See Creating a
Text Question, page 4-30.

•

Hidden text—Launches the New Hidden Text
Properties dialog box to allow the user to define a
question requiring an encrypted value as a response.
See Creating a Hidden Text Question, page 4-31.

•

Check box—Launches the New Check box Properties
dialog box to allow the user to define a question
utilizing a check box. See Creating a Check Box
Question, page 4-32.

•

Select—Launches the New Select Properties dialog
box to allow the user to define a text question. See
Creating a Select Question, page 4-33.

Properties

Modifies the properties for the question

Delete

Removes the question from the list

Move Up

Highlight a question and click this button to move the
question up the list of questions

Move Down

Highlight a question and click this button to move the
question down the list of questions

Complete the appropriate information in the following tabs, as necessary, and then click OK to complete
the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

History—Click the tab to display the history of actions taken against the task.
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Creating a Text Question
A Text question in an Input Request task allows the user to enter a text or numeric value to the question.
Use the following steps to define a single text question for the Input Request task. Repeat the steps to
create additional questions for the task.
To create a text question:
Step 1

On the Input Request—Questions tab, click New > Text.
The New Text Properties dialog box displays.
Figure 4-16

Step 2

Step 3

New Text Properties Dialog Box

Enter the following information for the text question:
Field

Description

ID

Unique ID for the input request question (Default: Q1)

Question

Enter the question for the input request

Default value

Default value to be used for the question

Click Ok to create the new question.
The new question displays on Input Request—Questions tab under the Questions presented on the input
request area.
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Creating a Hidden Text Question
Use the Hidden Text Properties dialog to create or modify hidden text questions for an input request. An
example of an encrypted value includes values such as passwords.
An encrypted value will be available from the Insert Variable Reference dialog and can be used in
providing a response to the hidden text question. The encrypted value is only to be used when the
question type is an hidden text question.
Use the following steps to define a single hidden text question for the Input Request task. Repeat the
steps to create additional questions for the task.
To create a hidden text question:
Step 1

On the Input Request—Questions tab, click New > Hidden Text.
The New Hidden Text Properties dialog box displays.
Figure 4-17

Step 2

Step 3

New Hidden Text Properties Dialog Box

Enter the following information for the text question:
Field

Description

ID

Unique ID for the input request question (Default: Q1)

Question

Enter the question for the input request

Click Ok to create the new question.
The new question displays on Input Request—Questions tab under the Questions presented on the input
request area.
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Creating a Check Box Question
A Check box question in an Input Request task allows the user to check a specific selection to a defined
question. For example, a user would create this task type to allow assignees to respond with an answer
such as True/False or Yes/No to the question.
Use the following steps to define a single question for the Input Request task. Repeat the steps to create
additional questions for the task.
To create a check box question:
Step 1

On the Input Request—Questions tab, click New > Check Box.
The New Check Box Properties dialog box displays.
Figure 4-18

Step 2

Step 3

New Check Box Properties Dialog Box

Enter the following information to create or modify questions that contain a check box:
Field

Description

ID

Unique ID for the input request question (Default: Q1)

Question

Enter the question for the input request

Default value

Default value to be used for the question

Click Ok to create the new question.
The new question displays on Input Request—Questions tab under the Questions presented on the input
request area.
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Creating a Select Question
A Select question in an Input Request task allows the user to choose a single option from a list of answers
to a defined question.
Use the following steps to define a single question for the Input Request task. Repeat the steps to create
additional questions for the task.
To create a select question:
Step 1

On the Input Request—Questions tab, choose New > Select.
The New Select Properties dialog box displays.
Figure 4-19

Step 2

New Select Properties Dialog Box

Enter the following information to create or modify questions that contain a check box:
Field

Description

ID

Unique ID for the input request question (Default: Q1)

Question

Enter the question for the input request

Selections

Displays the input request question properties

New

•

Label—Input request question

•

Value—Default answer for the question

Use this option to launch the Select Choice dialog box
to create a selection for the input request question.
For additional information, see Adding an Option to
the Input Request Select Question, page 4-34.

Properties

Modifies the properties for the selected option

Delete

Removes the selected option from the list
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Step 3

Click Ok to create the new question.
The new question displays on Input Request—Questions tab under the Questions presented on the input
request section.

Adding an Option to the Input Request Select Question
Use the following steps to create options for the Select question. Repeat the steps for each additional
option.
To add an option:
Step 1

On the New Select Properties dialog box, click New.
The Input Request Select Choice dialog box displays.
Figure 4-20

Step 2

Step 3

Input Request Select Choice Dialog Box

Enter the following information:
Field

Description

Label

Enter the name of the selection

Value

Enter the value for the selection

Click Ok to create the new selection.
The new selection displays on the New Select Properties dialog box under the Selections area.
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Creating a Review Task
Use the Review task to submit a document for review as well as provide a message for the reviewer.
To create a review request:
Step 1

On the Operations—Tasks Views, use one of the following methods:
•

On the toolbar, choose New > User Interaction > Review.
-or-

•

From the Actions menu, choose New > User Interaction > Review.

The New Review Properties dialog box displays.
Figure 4-21

Step 2

New Review Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Types

Display Only. Type of task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Produced by

Name of the process which generated the task.
Note

Description

See Common Task Statuses, page 4-6 for
additional information.
Click the Properties
tool to show the
display-only view of the process.

Brief description of the task
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Step 3

Note

Click the Review tab to continue.

The Required Value
a value.
Figure 4-22

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

New Review Properties—Review Tab

On the Review tab, enter the information required to submit a document for review.
Field

Description

Message

Enter the message that informs the reviewer of why
document needs to be reviewed.

Document to review

Click Browse to locate document or automation
summary to be reviewed.
The following example is the display for the file path
for the document.
Example:
C:/Documents and Settings/user name/My
Documents/

Step 5

Complete the appropriate information in the following tabs, as necessary, and then click OK to complete
the task definition.
•

Assignment—Click the tab to modify the general assignment properties.

•

Parameters—Click the tab to define parameters for the task.

•

Notes—Click the tab to enter any notes.

•

Categories—Click the tab to assign a category or modify an existing assigned category.

•

Related—Click the tab to assign or modify an existing related task.

•

History—Click the tab to display the history of actions taken against the task.
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Managing Task Definitions
The ability to modify tasks is not applicable to everyone as only users with administrative rights can
update tasks from the Operations—Task view in Tidal Enterprise Orchestrator.
This section provides instructions on modifying tasks in the Operations—Task view.

Resolving a Task
Most users cannot resolve a task from the TEO console because they don’t have the rights to modify the
task. In general, the user will launch the web console when attempting to resolve the task.
Use the following steps to resolve an assigned task from the web console.
To resolve a task:
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose one of the
following:
•

Resolve

•

Select a choice

The Web Console launches and the selected task details displays.
Step 2

Note

Review the details of the task.

For additional information on the properties in the list, see Common Task Properties, page 4-4.

Step 3

From the Status drop-down list, choose the appropriate status for the task resolution.

Step 4

In the Add Notes text box, if available, enter any notes related to the task resolution or status update.

Step 5

Click Submit to resolve the task.
The Task details page is updated and displays the user name of who resolved or updated the task.
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Viewing Automation Summary
The automation summary details the analysis that TEO performed to identify the situation that may
require action. The summary also shows relevant diagnostic and state information captured while
performing the situation analysis.
To view an automation summary:
On the Operations—Tasks Views, highlight the appropriate task, right-click and choose View
Automation Summary.
The automation summary launches in a web browser.
Field

Description

Report Location

Display Only. Shows the file path for the automation
summary

Situation Analysis

After Tidal Enterprise Orchestrator puts all data points in
context to identify a situation that requires action, it
performs deep analysis based on the type of situation
identified.
During situation analysis, Tidal Enterprise Orchestrator
captures volatile state and diagnostic information that may
otherwise be difficult or impossible to capture manually.
The Situation Analysis section displays below the overview
information.
Click the link in the upper portion of the summary to
navigate directly to the Situation Analysis section or simply
scroll to the section.

Context Analysis

Tidal Enterprise Orchestrator analyzes all data points in
context with each other to identify a situation that may
require action.
This information can be viewed in the Context Analysis
section of the summary. The Context Analysis displays the
symptom and possible causes.
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Manually Changing the Status
Use the following steps to modify the state of the task.
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose Properties.
The [Task] Properties dialog box displays.

Step 2

On the General tab, modify the task status, as necessary.
Field

Description

Display name

Name of the task

Status

Choose the appropriate status of the task. The statuses
displayed depend on the currently open task.
Note

Description
Step 3

See Common Task Statuses, page 4-6 for
additional information.

Brief description of the task

Click OK to close the dialog box.

Modifying the Assignment Properties for a Task
Use the following steps to change the assignee or other assignment properties for the task. This includes
taking ownership of the task, if necessary.
To modify the assignment properties:
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose Properties.
The [Task] Properties dialog box displays.

Step 2

Click the Assignment tab to modify the assignment properties for the task.

Step 3

Under Assigned to, click one of the following to change the list owners for the task.
Field

Description

Add

Click Add to launch the Select User or Group dialog
box to search for the name of the person.

Remove

Choose the user name and click this button to remove
the user from list.
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Step 4

Step 5

To modify the task priority and the date the task should be completed, modify the following information:
Field

Description

Priority

Indicates the priority of the task
•

Low

•

Medium (Default)

•

High

Due date

Check the check box and choose the appropriate date
the task should be completed from the drop-down
calendar.

Expiration date

Choose the appropriate date the task should expire
from the drop-down calendar.

Click OK to close the dialog box.

Specifying Parameters for a Task
A single task can include up to 10 parameters. Use the following steps to modify the parameters for a
task.
To modify the list of parameters:
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose Properties.
The [Task] Properties dialog box displays.

Step 2

Click the Parameters tab to modify the parameters properties for the task.

Step 3

Click Add to add a new field for a parameter.

Step 4

Enter the appropriate information for the task.

Step 5

Click OK to close the dialog box.

Removing Parameters from a Task
The Remove button removes the last parameter added to the list. For example, the user cannot remove
Parameter 4 without removing Parameter 5 from the list.
If the user wants to keep Parameter 5, then update Parameter 4 with the information from Parameter 5,
and then click Remove to remove Parameter 5 from the list.
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Assigning a Category to a Task
Use the following steps to assign a category to a task.
To assign a category to a task:
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose Properties.
The [Task] Properties dialog box displays.

Step 2

Click the Categories tab to modify the list of categories assigned to the task.

Step 3

Click Add to launch the Select Categories dialog box.
Figure 4-23

Step 4

Step 5

Note

Select Categories Dialog Box

Use one of the methods to choose a category:
•

To select a single category, highlight the appropriate category.

•

To select multiple categories, press CTRL and hold the key while making the appropriate selections.

When completed selecting the categories, click OK to close the dialog box.

For information on managing the categories, click Chapter 18, “Managing Categories.”

Removing a Category from a Task
Use the following steps to remove an assigned category from a task.
To remove an assigned category
On the Categories tab, highlight the appropriate category, and then click Remove.
The Remove button removes the category from the list, but it does not delete the category from the
system. For more information on deleting categories, see Chapter 18, “Managing Categories.”
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Assigning a Duplicate Alert
On the Related tab, the This task is a duplicate of the following task display-only field may be
auto-populated if the duplicate task criteria defined in either the Create Alert activity has been met.
Use the following steps to indicate the task is a duplicate of an existing task:
To assign a duplicate task:
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose Properties.
The [Alert] Properties dialog box displays.

Step 2

Click the Related tab to indicate the task is a duplicate of another task.

Step 3

Click Browse to launch the Select Tasks dialog box.
Figure 4-24

Step 4

Step 5

Select Tasks Dialog Box

Use one of the following to choose a duplicate task:
•

To choose a single task, highlight the appropriate task.

•

To choose multiple tasks, press CTRL and hold the key while making the appropriate selections.

•

Click New to create a new task.

Click OK to accept the selections and then close the dialog box.

Removing an Assigned Duplicate Task
On the Related tab, click the Delete tool to remove the selected task from the field. This action does not
delete the task from the system.
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Adding a Related Task
Related tasks could be duplicates of one another or the resolution of the task is dependant on the solution
of the existing task.
Use the following steps to add a related task:
Step 1

On the Operations—Tasks Views, highlight the appropriate task, right-click and choose Properties.
The [Task] Properties dialog box displays.

Step 2

Click the Related tab to modify the list of tasks related to the opened task.

Step 3

Click Add to launch the Select Task dialog box.

Step 4

Use one of the methods to choose a category:

Step 5

•

To choose a single category, highlight the appropriate category.

•

To choose multiple categories, press CTRL and hold the key while making the appropriate
selections.

•

Click New to create a new related task.

Click OK to close the dialog box.

Removing a Related Task
To remove a related task:
On the Related tab, highlight the appropriate task, and then click Remove.
The Remove button removes the task from the list, but it does not delete the task from the system. For
more information on deleting a task, see Deleting a Task.

Deleting a Task
To delete a task:
Step 1

In the Operations—Task view, highlight the appropriate task, right-click and choose Delete.
The Confirm Delete dialog box displays.

Step 2

Click Yes to confirm.
The task is deleted from the system.
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Viewing Task History
Use the History tab to view a history of changes that have been made to the task.
To view task history:
Step 1

In the Operations—Task view, highlight the appropriate task, right-click and choose Properties.
The [Task] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the task.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Definitions Workspace
The Definitions workspace displays all the components that are used in defining and executing
processes. The Definitions workspace contains navigation items that define the various components that
are used in a process.
The following sections provides information on navigating the Definitions workspace:
•

Getting Started—Definitions, page 5-2

•

Navigation Menu, page 5-4
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Getting Started—Definitions
The Getting Started—Definitions work area displays task shortcuts used to view the status of processes,
view currently defined processes, and create new processes. All of the items in the Getting
Started—Definitions Results pane are available from the actions toolbar and menu.
Figure 5-1

Getting Started—Definitions

Results Pane
The Results pane displays task shortcuts information in the Results pane that guides you through using
the features in the Definitions view. The following tasks can be performed from this view:
Option

Description

View Current Processes

Displays the Definitions—Processes view where users can
view and manage defined processes.
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Option

Description

Create a New Process

Launches the Process Editor, which is used to view and
define the properties for a new process as well as construct
the process workflow.
For additional information on the Process Editor, see
Chapter 6, “Using the Process Editor.”

View Operations

Displays the Operations workspace that shows what
processes are in progress, scheduled or have been
completed.
For additional information on the work areas displayed, see
Chapter 3, “Operations Workspace.”

Details Pane
The Details pane displays additional information about the selected object. The hyperlinks on each of
the detail pages launch the properties dialog box for the selected object.
Tab

Description

General

Displays general information about the object including the name
of the object, a brief description, input and output information,
and the category to which the object is assigned

Run Options

Displays the target, runtime user, and triggers for an object

Workflow

Display only. Shows the process viewer for a process

Attributes

Displays the dates, times and process owner associated with the
creation and modification of an object
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Navigation Menu
The Definitions workspace contains navigation items that define the various components that are used
in a process. Process definition items are displayed in the Definitions workspace. Each component can
be used in a process.
The Processes Results pane contains the following column headings.
Navigation Item

Function

Processes

View the defined processes or create new processes for
automating key business activities
See Chapter 6, “Using the Process Editor.”

Global Variables

View, create, and manage global variables.
Global variables are used to reference information that is
used on a regular basis to avoid having to specify the same
information in several instances.
See Chapter 11, “Managing Variables.”

Target Properties

[Need Information]
See

Calendars

Displays the calendars that can be associated with a specific
process.
When defining a process, the calendars feature can specify
when the process will execute according to a schedule, time,
or condition.
See Chapter 12, “Managing Calendars.”

Targets

View, create, and manage targets. A target is where a process
will be executed.
See Chapter 13, “Managing Targets.”

Target Groups

View, create, and manage target groups. A target group
consists of one or more targets where a process will be
executed.
See Chapter 15, “Managing Target Groups.”

Runtime Users

View and define runtime user records for storing information
about the user security context passed to the adapters.
See Chapter 16, “Managing Runtime Users.”

Knowledge Base Articles

The knowledge base articles provide information to help
understand the results of an activity.
This includes a summary of what has occurred, the possible
cause of the result, and suggested actions to take to resolve
issues with an activity.
See Chapter 17, “Managing Knowledge Base Articles.”
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Navigation Item

Function

Categories

View, create, or manage categories. You can organize
processes into categories to simplify process management.
See Chapter 18, “Managing Categories.”

Task Rules

Allows users to create rules which perform routine activities
on tasks, such as notification and assignments, on
newly-created tasks.
See Chapter 19, “Managing Task Rules.”
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Using the Process Editor
On the Definitions workspace, the Processes view displays the defined processes, provides options to
edit existing processes, and define new processes. From the Processes View, you can also execute
processes and view the status of the process as it in progress.
Processes can be viewed from the Operations and Definitions workspaces. The Operations workspace
displays scheduled and running processes. The two views displayed include the Activity Views and
Process Views. Both views display the execution progress of the process instances.
The following sections provide information on using the process editor:
•

Monitoring Processes in Operations View, page 6-2

•

Definitions—Processes, page 6-3

•

Accessing the Process Editor, page 6-7

•

Navigating the Process Editor, page 6-8

•

Using the Process Editor, page 6-13
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Monitoring Processes in Operations View
The Process Views folder in the Operations workspace include process instances and their associated
activity instances that are in progress, scheduled or have been completed. From this view, detailed
information about all the processes that have been triggered, executed ad hoc, or are scheduled for
execution is displayed. For additional information on viewing processes from the Operations view, see
Monitoring Processes, page 3-32.
Figure 6-1

Operations—Processes View Folder
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Definitions—Processes
The Definitions—Processes view displays all the defined processes that are in the application.
Additional features available from this work area include executing a process ad hoc and viewing process
properties. The New option launches the Process Editor to begin defining a new process.

Accessing Definitions—Processes
Use the Definitions—Processes view to display the defined processes. This section is used to provide
instructions on how to access process definitions.
To access the processes views:
On the Definitions pane, choose Processes.
The Results pane displays.
Figure 6-2

Note

Definitions—Processes View

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.
Information about each process can be displayed in the following columns:
Column

Description

Display Name

Name assigned to the process

Triggers

Name of the trigger associated with the process
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Column

Description

Enabled

Specifies whether the process is enabled (True) or
disabled (False). A disabled process is unavailable for
execution.

Target

The specific environment where the process runs

Runtime User

The name of the runtime user record assigned to the
process. The runtime user record stores information
about the user security context and passes this
information to the adapters when running certain
activities.

Categories

Category to which the process is assigned

Owner

The owner of the process. This is typically the creator
of the process.

Last Modified Time

Time the process was last modified

Last Modified By

User name of the person who last modified the process

Id

Unique identification number of the process

Description

Brief overview of process

Time Saved

Amount of time saved by running the process and
workflow

Created Time

Time the process was created

Created By

User or object that created the process

Automation Pack

Name of the automation pack

Customizable

Indicates the customization setting for the object in the
automation pack

Actions Menu and Toolbar Options
The Processes Actions menu and toolbar provide options to manage existing processes. If there are no
processes selected, the only option available on both is New. The New option is used to define a new
process. The New option is available by right-clicking Process on the Definitions workspace.
Figure 6-3

Definitions—Processes Actions Menu and Toolbar
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When a process is selected, the options on the Processes Actions toolbar and menu change to the
following options:
Option

Description

Start Process

Start any enabled process displayed in the Process Results
pane.
For more information on starting a process, see Starting a
Process, page 7-22.

Enable

A process cannot start or execute until is enabled.
For more information on enabling a process, see Enabling
a Process, page 7-21.

Disable

Prevents a process from executing.
For more information on disabling a process, see Disabling
a Process, page 7-21.

Processes Details Pane
The Details pane displays additional information about the selected object. The hyperlinks on each of
the detail pages launch the properties dialog box for the selected object.
Figure 6-4

Processes Details Pane—General Tab

Tab

Description

General

Displays general information about the process including the name
of the process, a brief description, input and output information, and
the category to which the process is assigned

Run Options

Displays the target, runtime user, and triggers for the process

Workflow

Display-only. Shows the process viewer for a process

Attributes

Displays the dates, times and process owner associated with the
creation and modification of the process
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Viewing Process Properties
Tidal Enterprise Orchestrator ships with automation pack(s) that contains built-in process definitions
that cannot be modified. When one of the shipped processes is selected, a limited version of the Process
Editor displays with only the workflow pane and properties pane available. The Toolbox pane in the
Process Editor is not displayed.
To view process properties:
In the Definitions—Processes view, highlight the appropriate process, and use one of the following
methods:
•

Right-click and choose Edit.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Process Viewer displays.
Figure 6-5

Process Viewer

The following information displays:
Pane

Description

Status Pane

Displays the current status and other detailed
information about the selected process and activity

Workflow Pane

Displays the graphical workflow of the selected
process and its activities

Properties Pane

Display-only. Shows the properties for the process and
activity instances
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Accessing the Process Editor
The Process Editor is used to view and modify the properties of an existing process. The editor is also
used to define properties and construct a workflow for a new process. The procedure the user follows to
access the editor depends on the task to be performed.
To access the Process Editor:
Step 1

Note

Step 2

If you are creating a new process, use one of the following options:
•

On Definitions—Processes, right-click and choose New > Process.

•

From the Actions menu, choose New > Process.

•

On the Actions toolbar, choose New > Process.

The New button on the Actions toolbar is not available if a process is highlighted in the Processes Results
pane.
If you are modifying an existing process, on the Processes Results pane, right-click the appropriate
process and then choose Edit.
The Process Editor opens.
Figure 6-6

[Process Name]—Editor
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Navigating the Process Editor
Understanding the Process Editor Menu Bar
The following menus contains tasks that can be performed in the editor.

File Menu
The File menu contains the following items:
Menu Option

Description

Save

Saves the process workflow

Save Copy As

Saves a copy of the process workflow under a different name

Validate

Verifies whether the process has variables that are actually used in
the process

Revert

Returns the workflow to the previous saved version

Print

Prints the contents of the workflow pane

Process Properties

If an activity properties pane is displayed, the option toggles to the
process properties pane

Exit

Closes the editor

Edit Menu
The Edit menu contains items to be used for modifying the process in the workflow pane. For
information on using this menu, refer to Using the Edit Menu, page 1-9.

View Menu
The View menu contains the following items:
Menu Option

Description

Collapse All

Collapses all the activities in the workflow pane

Expand All

Expands all the activities in the workflow pane

Zoom In

Increases the size of the contents of the workflow pane

Zoom Out

Decreases the size of the contents of the workflow pane

Zoom Default

Resizes the contents of the workflow pane according to the default
zoom value

Zoom Fit

Resizes the workflow to fit the size of the pane

Zoom Fit Selection

Resizes the selected item in the workflow pane to the size of the
pane

Toolbar

Displays the Editor toolbar

Status Bar

Displays the status bar at the bottom of the Editor
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Menu Option

Description

Toolbox

Displays the toolbox pane

Properties

Displays the process properties pane

Tools Menu
The Tools menu contains the following items that allow you to configure the appearance and behavior
of the editor.
Menu Option

Description

Customize

Launches the Customize dialog box where users can change the
fonts and colors that display in the editor.
For information on using this dialog box, refer to Customizing the
Fonts and Colors, page 1-31.

Options

Launches the Options dialog box which is used to configure basic
user interface behavior.
For information on using this dialog box, refer to Connecting to a
Server upon Startup, page 1-32.

Actions Menu
The Actions menu contains the following items that apply to a selected item in the workflow pane:
Menu Option

Description

Move Back

Moves the position of an activity in the workflow back one position
at a time.

Move Forward

Moves the position of an activity in the workflow forward one
position at a time.

Add Result Handler

Inserts a condition branch into the workflow. A condition branch is
executed only if the specified condition is met.

Expand

Expands the selected activity

Collapse

Collapses the selected activity

Help Menu
The Help menu contains information that provides documentation assistance to work in TEO. For
information on using this menu, refer to Understanding the Help Menu, page 1-17.

Process Editor Toolbar
The toolbar displays icons to be used as shortcuts for performing tasks in the workflow pane. To display
the toolbar, choose Toolbar from the View menu.
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Icon

Description
Saves the process
Prints the contents of the Workflow pane
Copies the selected information to the clipboard
Pastes the selected information to the location identified by the cursor
Deletes the selected item
Collapses the contents of the workflow pane
Expands the contents of the workflow pane
Resizes the contents of the workflow pane according to the default zoom value
Increases the size of the contents of the workflow pane
Decreases the size of the contents of the workflow pane
Resizes the workflow to fit the size of the pane
Resizes the selected item in the workflow pane to the size of the pane
Displays or hides the Help pane
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Toolbox Pane
The toolbox pane is on the left side of the editor and includes three views (Activities View, Processes
View, Logic View). The navigation items displayed in the toolbox depend on the view that is selected.
View

Description

Activities

The Activities view displays the list of activities that are used to
construct the process workflow.
The activities that display depend on the adapters that are
installed.

Processes

The Processes view displays the list of defined processes that can
be included in other processes.
To add an existing process to a new process, drag and drop the
appropriate process onto the workflow pane and define the criteria
for execution of the process.

Logic

The Logic view displays the list of workflow construction
components that support or define the workflow logic and provide
control over the execution of the workflow logic.
For information on configuring the logic components, see
Chapter 9, “Configuring Process Logic Components.”

Workflow Pane
The Workflow pane is a canvas located in the center portion of the Process Editor. This area is used to
create processes by dragging and dropping activities, other processes, and components from the toolbox
onto the canvas.
Figure 6-7

Process Editor—Workflow Pane
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Process Properties Pane
The Process Properties pane is located on the right side of the editor and displays the properties for the
selected process.

Note

The Required Value
a value.
Figure 6-8

Note

icon displayed on a tab or page indicates that the field is required and is missing

Process Editor—Process Properties Pane

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box.
Use the properties pane to define the process properties.
Property Page

Description

General

Specifies general information about the process

Options

Specifies execution and storage options about the process

Target

Specify which target or target group the process can execute.

Credentials

Specifies the runtime user for the process

Variables

Used to store or pass a value between executions of a process
or between steps within a single process

Triggers

Used to determine how or when the process will be executed

Categories

Used to organize processes and categories

Used By

Displays the objects that directly reference the selected
process

History

Displays the history of changes made to the process
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Using the Process Editor
The following sections contain procedures on performing basic tasks on the Process Editor menu items.

Saving Processes
To save a process, use one of the following steps:
•

On the Editor toolbar, click the Save

tool.

-or•

From the File menu, choose Save.

Renaming a Process
To rename a process:
Step 1

Open the process in the Process Editor.

Step 2

On the General tab, in the Name field, enter the new name for the process and then click the Save

tool.

Saving a Copy of a Process
Use the following steps when leveraging an existing process as a template to create a new process.
To save a copy of a process:
Step 1

Open the process in the Process Editor.

Step 2

From the File menu, choose Save Copy As.
The Save Process As dialog box displays.
Figure 6-9

Save Process As Dialog Box
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Step 3

In the Name of Copy field, enter the name of the new process, and click OK.
The new process name displays in the Display name field.

Reversing the Process Changes
This item is used when changes have been made to the process definition, but are no longer necessary.
This option deletes all changes made since you last saved the process. If you have saved the process and
have not made any additional changes, then no action will be taken.
To reverse process changes:
From the File menu, choose Revert.
The process reverts back to the last saved version of the process. All activities, components, and other
changes are removed from the process definition.

Printing Process Workflows
Process workflows can be printed from the Process Editor. The following steps print the graphical
workflow of a process from the Process Editor.
To print a process workflow:
Step 1

On an existing process displayed in the Console, right-click and choose Edit.
The Process Editor opens.

Step 2

Use one of the following methods:
•

On the toolbar, click the Print

tool.

-or•

From the File menu, choose Print.

The Print dialog box displays.
Figure 6-10

Step 3

Print Dialog Box

Modify the print settings as necessary and click OK.
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The process workflow prints exactly as it displays in the workflow pane.

Toggling the Process Editor View
In the Process Editor view, you can toggle the view between the process property pages and the activity
view pages.
To switch to the process properties, use one of the following methods:
•

From the File menu, choose Process Properties.
-or-

•

In the Workflow pane, click anywhere outside of the activities in the workflow.

The process properties display in the Properties pane.

Collapsing the Workflow View
The following steps collapse all the activities displayed in the Workflow pane.
To collapse the activities in the Workflow pane, use one of the following methods:
•

From the View menu, choose Collapse.
-or-

•

On the toolbar, click the Collapse

tool.

The activities in the workflow collapse.

Expanding the Workflow View
The following steps expand all the activities displayed in the workflow.
To expand the workflow, use one of the following methods:
•

From the View menu, choose Expand.
-or-

•

On the toolbar, click the Expand

tool.

The activities in the workflow expand.
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Resizing the Workflow View
The Process Editor contains the following options that are used to assist in viewing the process
workflow.
To resize the display in the Workflow pane, from the View menu, choose the appropriate view:
View

Description

Zoom In

Increases the size of the contents of the workflow pane

Zoom Out

Decreases the size of the contents of the workflow
pane

Zoom Default

Resizes the contents of the workflow pane according to
the default zoom value

Zoom Fit

Fits the contents of the workflow pane to the size of the
pane

Zoom Fit Selection

Fits the selected contents of the workflow pane to the
size of the pane

The Workflow pane resizes according to the selection.

Changing the Process Display Icon
The following steps provide instructions on how to change the icon for the process that displays in the
Process Views.
To change the process view icon:
Step 1

On the Process Properties pane, click the Options tab.

Step 2

Under Display, check the Use custom icon check box and then click Select Icon.
The Select Images dialog box displays

Note

The currently selected icons display to the right of the of the fields.
Figure 6-11

Step 3

Select Images Dialog Box

To the right of both Image fields (Small or Large), click Browse to change the icon for the image that
displays next to the process.
The Select Image dialog box displays.
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Figure 6-12

Step 4

Select Image Dialog Box—Common Tab

Use one of the following methods:
•

To choose from the display of default icons, on the Common tab, click the appropriate icon and then
click OK.
-or-

•

To choose an icon from a different location, click the Custom tab.

Figure 6-13

Select Image Dialog Box—Custom Tab

– To the right of the Image path field, click Browse to insert the file path to the appropriate icon.
– In the Display Name field, enter the name of the icon and click OK.
Step 5

On the Select Images dialog box, the corrected icon is inserted into the appropriate image field.

Step 6

Click OK.
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Authoring Processes
Tidal Enterprise Orchestrator allows the automation of IT processes based on organizational
requirements using a workflow format. The TEO shipment also includes pre-defined processes for the
most commonly used processes.
The following sections provide information on creating a process:
•

Defining Process Properties, page 7-2

•

Adding Activities to the Process, page 7-14

•

Adding Child Processes, page 7-17

•

Adding Process Logic Components, page 7-19

•

Managing Process Definitions, page 7-19
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Defining Process Properties
A process includes activities and components that are defined and configured to perform specific actions.
Before constructing a process workflow, it is recommended that components, such as global variables,
calendars, targets, and target groups are predefined. The option to create a new component is available
within the property page.
This section defines the process used to construct a process definition.
To view a process workflow:
Step 1

On the Definitions—Processes view, use one of the following methods:
•

Right-click and choose New > Process.

•

On the Actions toolbar, choose New > Process.

•

From the Actions menu, choose Actions > New > Process.

The Process Editor displays.
Figure 7-1

Step 2

Process Editor—New Process

On the Properties pane, click the following tabs and define the properties as necessary:
Property Page

Description

General

Default tab used to provide general description of the
process.
See Defining General Process Information, page 7-4.
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Property Page

Description

Options

Specify execution and storage options about the
process.
See Defining General Process Information, page 7-4.

Target

Specify which target, target group, or triggering event,
the process can execute
See Specifying Process Targets, page 7-7.

Credentials

Specify the runtime user for the process
See Specifying the Process Runtime User, page 7-9.

Variables

Use this tab to add variables to the process. With the
appropriate rights, defined variables can be viewed and
modified from this page.
See Specifying Process Variables, page 7-10.

Triggers

Use this tab to add or modify process triggers to
determine how or when the process will be executed.
See Specifying Process Triggers, page 7-12.

Categories

Assigns the process to a category
See Assigning a Category to Process, page 7-13.

Step 3

To add activities to the process, on the Toolbox—Activities view, drag and drop the appropriate activities
to the Workflow pane. For information on adding an activity, see Adding Activities to the Process,
page 7-14.

Step 4

To add an existing process as a child of the primary process, on the Toolbox—Processes view, highlight
and drag the appropriate process to the Workflow pane. For information on adding a child process, see
Adding Child Processes, page 7-17.

Step 5

To add logic components to the process, on the Toolbox—Logic view, highlight and drag the appropriate
logic component to the Workflow pane. For information on adding a logic component, see Adding
Process Logic Components, page 7-19.

Step 6

Click the Save

tool.
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Defining General Process Information
Use the following steps to define the general process options. These property pages allow the user to
process name, process owner, as well as the archival process instance options.
To define the general process options:
Step 1

Launch the Process Editor.
On the Properties pane, the General tab displays by default.
Figure 7-2

Step 2

New Process Properties—General Tab

On the General tab, complete the following information, as necessary:
Field

Description

Display Name

Name of the process

Owner

User name of the owner of the object. This is typically
the person who created the object.
Click Browse to launch the Select User or Group
dialog box to change the owner.

Group

Name of the user group in which the process is
grouped

Description

Brief description of the process

Time saved by the execution of this
process

The amount of time it would take to run this process
manually. This value helps determine the your return
on investment by automating the process.
Specify a value and click the time unit link (seconds,
minutes, hours) to indicate the cost of running this
process manually.
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Field

Description

Notes

Enter notes about the process.

Enabled

Check the Enabled check box to enable the process.
The check box is selected by default.
If the check box is unchecked, the process is disabled
and will be unavailable for execution.

Step 3

Click the Options tab to continue.
Figure 7-3

Step 4

New Process Properties—Options Tab

On the Options tab, specify the execution and storage options about the process, as necessary:
Field

Description

Use custom icon

Check the check box and click Select Icon to launch the
Select Images dialog box to be used to change the icon and
icon size that displays next to the process in Processes
view.
Note

For information on changing the process icon, see
Changing the Process Display Icon, page 6-16.
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Field

Description

Do not start if already running

Check this check box to indicate that a process should not
run if an existing process is already running using one of
the following:
•

On the same target—Indicates that the process may run
only if no other processes are being run against the
same target. If other processes are running against a
different target, then the process can continue.

•

On any target—Indicates that the process cannot run if
other processes are already running, regardless of the
target

If this check box is unchecked, then the process may run
regardless of whether other processes are running no matter
the target.
Resume execution if interrupted Check this check box to indicate that the process execution
should resume if the TEO service is interrupted while the
process is running.
If the check box remains unchecked, the process will stop
upon the service interruption and the process will require
the user to restart the process.
Archive completed instances

Check this check box to indicate that the process should be
stored upon completion.
If the check box remains unchecked, the process will not be
stored.

Step 5

Click the Save

tool to save the process properties.
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Specifying Process Targets
Use the Target tab to specify which target or target group, the process can execute. The target or target
group specified on this page can also be used to execute any activity added to the process.
To specify process target;
Step 1

On the Properties pane, click the Target tab.
The default target checked is Automation Service.
Figure 7-4

Step 2

New Process Properties—Target Tab

Under Permitted Target types, check the check box of the appropriate target types to be available target
types for process execution.
If the check box is unchecked, then the target type will not be available in the list of targets for execution.
The Automation Service target is checked by default.

Step 3

Click Select All to check all the available target type check boxes. Click Unselect All to uncheck the
selected target types availability for the process.

Step 4

Under Default Targets, choose the appropriate target, target group, or triggering event that the process
will execute against by default.
Field

Description

Execute on the triggering event
target

Select this radio button to execute the process on the target
of a defined trigger.
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Field

Description

Execute on the target specified at
start time

Select this radio button to execute the target at runtime.

Execute on this target

Select this radio button to choose a specific target on which
to execute the process. The targets that display in the
drop-down list are those targets that have been defined in
the Targets view.

The target is not required to be specified during the initial
process definition. However, at the start time, the user will
be required to specify the target for execution.

Note

Execute on this target reference

To view the properties for the selected target, click
the Properties
tool. To create a new target,
click New > [Target]. Refer to Chapter 13,
“Managing Targets.”

Select this radio button and then click the Reference tool
launch the Insert Variable Reference dialog box.
On the Insert Variable Reference dialog box, expand
Process > Target > Properties, select the appropriate target
reference property, and click OK.
Note

Execute on this target group

Select this radio button to choose a specific target group on
which to execute the process. The target groups that display
in the drop-down list are those that have been defined in the
Target Groups view.
Note

Step 5

The selected target reference property displays in
the text field. Refer to Chapter 14, “Managing
Extended Target Properties.”

To view the properties for the selected target group,
click the Properties
tool. To create a new target
group, click New > [Target Group]. Refer to
Chapter 15, “Managing Target Groups.”

If the process is to execute on a target group, under Run process on, choose one of the following radio
buttons to further specify the target group.
Field

Description

All targets in this group

Runs the process on all members of the selected target
group

Choose a target using this algorithm Runs the process on a specific member of the target group
or a random target in the target group. Choose one of the
options from the drop-down list.
Note

Step 6

Click the Save

For descriptions of the algorithms, see Target
Algorithms, page 13-6.

tool to save the target specification properties.
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Specifying the Process Runtime User
Use the Credentials tab to specify the runtime user for the process. Many operating systems and
application activities require a user security context for proper execution.
A runtime user record is used to store the information about the user security context and to pass this
information to the adapters.
The process run time user can also be used as the default runtime user for any activities within the
process. If required, the runtime user can be specified on a per activity basis.

Note

For additional information, see Chapter 16, “Managing Runtime Users.”
To specify runtime user credentials:

Step 1

On the Properties pane, click the Credentials tab to specify the runtime user for the process.
Figure 7-5

Step 2

New Process Properties—Credentials Tab

Under Permitted runtime user, check the check box for the appropriate runtime user types to be included
with the process.
If the check box is unchecked, then the runtime user will not be available in the list of runtime users to
be used for execution.

Step 3

Click Select All to check all the available runtime user check boxes. Click Unselect All to uncheck the
selected runtime users availability for the process.

Step 4

Under Default runtime users, choose the appropriate runtime user that the process will run on by default.
Option

Description

Use target's default runtime user Select this radio button to execute the process using the
target runtime user
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Option

Description

Use the following runtime user

Select this radio button and then choose the runtime
user record from the drop-down list.
Note

Step 5

Click the Save

To view the properties for the selected user,
click the Properties
tool. To create a new
runtime user, click New > [Runtime user].
Refer to Chapter 16, “Managing Runtime
Users.”

tool to save the target specification properties.

Specifying Process Variables
Use the Variable tab to add variables to the process definition. Process variables can also be used to store
or pass a value between executions of a process or between steps within a single process.
With the appropriate rights, defined variables can be viewed and modified from this page.
Variables created within a process are only applicable to the process. To create a variable for use with
multiple TEO objects, it is recommended that you use a global variable.

Note

For additional information on creating global variables which can be used in multiple processes, see
Chapter 11, “Managing Variables.”
To specify a process variable:

Step 1

On the Properties pane, click the Variables tab.
Figure 7-6

New Process Properties—Variables Tab
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Step 2

On the Variables tab, click New > [Variable Name] to add a variable to the process. For additional
information on defining process variables, see Chapter 11, “Managing Variables.”

Step 3

After the selected variable is defined, the following information is displayed on the Variables tab.

Step 4

Field

Description

Display name

Name assigned to the variable. The name must be unique
within the scope of the variable.

Data type

Type of data used to specify the variable
•

Boolean—Determines whether a set of elements
should be interpreted as true or false

•

Hidden String—Holds data that must be protected
from other TEO users and from auditing operations
performed by TEO

•

Identity—Determines the value to insert into a table
without an identity column

•

Numeric—Single whole or decimal number (positive
and negative) that does not change

•

String—Defines a variable containing a standard small
string of text

•

Table—Stores a set of records in a table format

Value

Value assigned to the variable. The specified value must be
valid for the data type that is selected

Description

Brief description of the variable

Click the Save

tool to save the target specification properties.
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Specifying Process Triggers
Use the Trigger tab to add or modify process triggers which are used to determine how or when the
process will be executed. Multiple triggers can be added that can be initiated when certain conditions are
met.
Defining a trigger is an optional task and is not required if the process is intended for manual execution
only. For additional information on creating triggers, see Chapter 8, “Managing Triggers.”
To specify a trigger:
Step 1

On the Properties pane, click the Triggers tab.
Figure 7-7

New Process Properties—Triggers Tab

Step 2

On the Trigger tab, click New > [Trigger Name] to specify that the process is executed upon occurrence
of another action or event.

Step 3

After the selected trigger is defined, the following information is displayed on the Triggers tab.

Step 4

Field

Description

Display Name

Name assigned to the trigger

Target

Target which is initiated by the trigger

Click the Save

tool to save the target specification properties.
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Assigning a Category to Process
Use the Categories tab to assign the process to a category. Categories are used to organize the processes.
For information on creating or modifying a new category, see Chapter 18, “Managing Categories.”
To assign a category:
Step 1

On the Properties pane, click the Categories tab.
Figure 7-8

Step 2

New Process Properties—Categories Tab

On the Categories tab, click Add to specify the categories to which the process belongs.
The Select Categories dialog box displays.

Step 3

Select the appropriate category from the list, and click OK.

Step 4

After the category or categories are selected, the following information is displayed in the Category tab.

Step 5

Field

Description

Display Name

The name of the category

Type

A description of the category

Description

Type of category

Click the Save

tool to save the changes.
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Adding Activities to the Process
The activity properties consist of common tabs and an activity-specific tab associated with the selected
activity.
To add activities to the process:
Step 1

In the Toolbox pane, under the Activities view, drag and drop the appropriate activity onto the workflow
pane.
The selected activity displays in the workflow pane.

Step 2

On the activity property pages, define the following property pages, as necessary.

Step 3

On the General tab, enter the following information:

Step 4

Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the activity-specific tab to define the properties for the activity.

Note

The Required Value
icon displayed on a tab or page indicates that the field is required and is missing
a value.
tool to choose a defined variable or reference an object within the process from
Click the Reference
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.

Step 5

Click the Target tab to specify whether the process target should be used or overridden with a different
target:
Field

Description

Execute on process target

Select this radio button to use the same target that was
specified in the process definition.

Execute on activity target

Select this radio button to specify a target different from
the process definition target. The selected target overrides
the target specified in the process definition.

Execute on this target

Select this radio button to choose a specific target on which
to execute the process. The targets that display in the
drop-down list are those targets that have been defined in
the Targets view.
Note

To view the properties for the selected target, click
the Properties
tool. To create a new target,
click New > [Target]. Refer to Chapter 13,
“Managing Targets.”
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Field

Description

Execute on this target reference

Select this radio button and then click the Reference tool
launch the Insert Variable Reference dialog box.
On the Insert Variable Reference dialog box, expand
Process > Target > Properties, select the appropriate target
reference property, and click OK.
Note

Execute on the target selected this
algorithm

Select this radio button to execute the target selected by one
of the target algorithm displayed in the drop-down list.
Note

Execute on this target group

The selected target reference property displays in
the text field. Refer to Chapter 14, “Managing
Extended Target Properties.”

The available algorithms that display depend on the
selected activity. See Target Algorithms, page 3-4
for target algorithm descriptions.

Select this radio button to choose a specific target group on
which to execute the process. The target groups that display
in the drop-down list are those that have been defined in the
Target Groups view.
Note

To view the properties for the selected target group,
click the Properties
tool. To create a new target
group, click New > [Target Group]. Refer to
Chapter 15, “Managing Target Groups.”

Choose a target using this algorithm Select this radio button to execute the process using one of
the options from the drop-down list.
Note

Step 6

For algorithm descriptions, see Target Algorithms,
page 3-4.

Click the Credentials tab to specify the runtime user whose credentials should be used for process
execution:
Field

Description

No runtime user

Select this radio button when no runtime user is required to
run this activity

Use target's default runtime user

Select this radio button to use the default runtime user for
the target that is specified in the activity

Use Process runtime user

Select this radio button to use the credentials for the
runtime user that was specified in the process properties

Override process runtime user

Select this radio button to specify a runtime user whose
credentials are different than what was specified in the
process properties. The selected runtime user overrides the
runtime user that was specified for the process.
Note

To view the properties for the selected runtime
user, click the Properties
tool. To create a
runtime user record for the process, click New >
[Runtime User]. For additional information on
creating a runtime user, see Chapter 16, “Managing
Runtime Users.”
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Step 7

Click the Knowledge Base tab to assign a knowledge base article to the object.
Knowledge Base Field Options

Description

Text field

Display-only. Display name for the selected knowledge base
article(s)

Delete

Highlight the appropriate knowledge base article and click the
Delete
tool to remove the knowledge base article from the
display.

Browse

Click Browse to launch the Select Knowledge Base dialog box
for a list of existing knowledge base articles.
For additional information on knowledge base articles, see
Chapter 17, “Managing Knowledge Base Articles.”
Highlight the appropriate knowledge base article and click the
Properties
tool to view and/or modify the properties of the
defined knowledge base article.

Properties

The following information is displayed on the Knowledge Base tab.

Step 8

Step 9

Field

Description

Summary

Brief description of the issue

Possible Cause

Explanation of the condition that may be causing the issue

Possible resolution

List of actions that can be performed to attempt to resolve
the issue

Related information

Additional information related to the issue

On the Result Handlers tab, click one of the following buttons to manage the condition branches on the
workflow, as necessary:
Button

Description

Add

Adds a condition branch

Remove

Removes the condition branch from the activity

Move Up

Moves the condition up one position in the list of conditions

Move Down

Moves the condition down one position in the list of
conditions

Click the Save

tool to save the activity definition.
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Adding Child Processes
The Processes workspace on the Toolbox contains the processes that have been previously created. The
processes added to another process from this workspace are considered child processes. Use the
following instructions to add and modify the child process properties that is included within another
process.
To add a child process:
Step 1

In the Toolbox, under the Processes view, choose the appropriate process, then drag and drop the
appropriate process to the Workflow pane.
The [Child Process Name] Properties dialog box displays.
Figure 7-9

Step 2

[Child Process] Properties—General Tab

On the General tab, modify the following information, as necessary:
Field

Description

Display name

Name of the child process

Types

Display-only. Shows the name of the child process.
Click Browse to launch the Select Process dialog box to
choose a different process or add more processes.
Changing the process also changes the display in the
process.
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Field

Description

Execute Asynchronously

Check this check box to instruct the parent process to
launch the child process, and continue executing the
process without waiting for the results of the child process.
When running asynchronously, the activities in the process
that follow the child process will execute immediately.
If you uncheck the check box, the activities that follow the
child process will wait for the child process to complete
before executing.

Notes

Note

Enter any notes relevant to the process

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

tool to choose a defined variable or reference an object within the process on
Click the Reference
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
Step 3

Note

Click the Inputs tab to continue.

If the process does not have any input variables, the page will be blank.
Figure 7-10

Step 4

[Child Process] Properties—Inputs Tab

On the Inputs tab, in the [Variable Name] field, modify the parameters for executing the child process.
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Step 5

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Target—Specify the target on which to monitor for events that will trigger the process. See Step 5
in Adding Activities to the Process.

•

Credentials—Specify the runtime user whose credentials should be used for the activity. See Step 6
in Adding Activities to the Process.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 7 in Adding Activities to the Process.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 8 in Adding Activities to the Process.

Adding Process Logic Components
Process logic components are used in the Logic view to define the process logic workflow.
Step 1

From the Toolbox—Logic view, drag and drop the appropriate component onto the Workflow pane.
The selected component displays in the Workflow pane and the component property pages display in the
Properties pane.

Step 2

Note

On the component property pages, define the properties, as necessary, and then click the Save

tool.

For information on defining logic component properties, see Chapter 9, “Configuring Process Logic
Components.”

Managing Process Definitions
The following instructions are used to modify the process and activity properties used to define a
process.

Common Wildcard Expressions
These expressions are not applicable for every activity. The following table displays the most commonly
used wildcard characters.
Character

Description

*

Match Any Character

#

Match Any Single Digit

?

Match Any Single Character
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Modifying Process Properties
Process definitions are modified in the Process Editor. With the appropriate rights from the Operations
view, the Process Editor is launched when accessing the process properties. When user rights are
restricted, the Process Viewer is launched with the properties displaying a display-only view.
To modify process properties:
Step 1

Note

On the Definitions—Processes view, highlight the appropriate process, right-click and choose Edit.

TEO core processes cannot be modified. When a core process is selected, only the Process Viewer is
displayed.
The Process Editor displays. The process properties display by default.

Step 2

Select the appropriate process property page and modify the items, as necessary.

Step 3

Click the Save

tool to save the changes.

Modifying Activity Definition Properties
Modifying a process does not automatically modify an activity. Activity definitions are included in a
process definition and the activity properties must be modified separately from the process properties.
Activities can only be modified in the Process Editor. With the appropriate rights from the Operations
view, the Process Editor is launched when accessing the process properties.
When user rights are restricted, the Process Viewer is launched with the properties displaying a
display-only view determining that the user cannot edit the activity.
To modify an activity:
Step 1

Use one of the following methods:
•

On the Definitions—Process view, highlight the appropriate process, right-click and choose Edit.
-or-

•

On the Operations workspace, choose a process from any of the four process views, right-click and
choose Edit.

The Process Editor displays.
Step 2

On the Workflow pane, choose the appropriate activity, modify activity properties, as necessary, and
click Save.

Step 3

Make any additional changes, as necessary, and click Exit to close the Process Editor.
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Enabling a Process
A process is enabled by default. If a process is manually disabled, the process must be enabled before it
can begin executing.
To enable a process:
On the appropriate process view, highlight the process, right-click and choose Enable. The Enabled
status on the Results pane changes to True. If necessary, click the Refresh
tool to update the view.

Disabling a Process
Disabling a process instance on the process view prevents the item from executing. It is not removed
from the list of process instances on the Results pane.
To disable a process:
On a process view, highlight the process, right-click and choose Disable. The Enabled status on the
Results pane changes to False. If necessary, click the Refresh
tool to update the view.

Inserting Variable References
The Reference
tool to the right of a text field indicates that the field can be populated by referencing
a defined variable or the property of another activity or process. Use the Insert Variable Reference dialog
box to choose a defined variable or object to populate a field.
Only variables valid for the selected field can be selected in this dialog box. The OK button does not
activate until a valid property or variable is selected.
To insert a variable reference:
Step 1

To the right of a field on a property page, click the Reference tool.
The Insert Variable Reference dialog box displays.
Figure 7-11

Insert Variable Reference Dialog Box
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Note

Step 2

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Check the Show Advanced check box to display all items that are available for referencing.
If the check box is not selected, then only the most commonly-used items are displayed for activities,
processes or events.

Step 3

Expand the appropriate top level items to locate the appropriate variable:
Reference Option

Description

Adapters

Displays the list of variable objects that are associated with
the installed adapters.
Click the Expand (+) next to each adapter to display the list
of objects and properties that can be selected within the
adapter displayed.

Categories

Displays the list of categories that are associated with the
installed adapters.
Click the Expand (+) to display the list of categories and
associated properties that can be selected.

Global Variables

Click the Expand (+) to display the list of defined global
variables and their associated objects and properties in the
product.

Process

When the Process option is expanded, the list of available
objects, properties, and variables associated with the process
are displayed.
Click the Expand (+) to display the specific object types.

Server

Displays the list of properties that are associated with the
TEO server.
Click the Expand (+) to display the list of TEO automation
server properties that can be selected.

Workflow

Step 4

Click the Expand (+) to display the list of activities and
processes currently in the Workflow pane from which users
can choose a variable, object, or property.

From the list of available of items, select the appropriate property or variable and click OK.
The related text field populates with the selected value.

Starting a Process
With the appropriate rights, a user can start any enabled process displayed on a Process View. Only one
process can be manually started at a time. A process can display in the Process View, but it must be
enabled before it can be executed. To enable a process, see Enabling a Process, page 7-21.
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Note

When a process is started manually, all conditions and triggers included in the process definition will be
overridden.
To start a process:

Step 1

On a process view, highlight the appropriate process, right-click and choose Start Process.
The Confirm Start Process dialog box displays.
Figure 7-12

Confirm Start Process Dialog Box

Step 2

If the process has any input variables, verify the variables associated with the process in the Parameters
table. To update the variable, highlight the variable, and click Edit to modify the value.

Step 3

To start a process from a specific starting point, check the Start from start point check box and then
select the appropriate starting point from the drop-down list. The first activity after the specified starting
point will run first.

Step 4

To specify a target different from the defined process target, check the Override target (Target name)
check box and select a target from the drop-down list.

Note

Step 5

To create a new target for this process, click New. For additional information, see Managing Targets,
page 13-1.
Click OK to confirm.
The Start Process Results dialog box displays and the process begins executing.
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Figure 7-13

Note
Step 6

Start Process Results Dialog Box

To view the process workflow on the Process Viewer, double-click the process instance.
Click Close to return to the Console.

Deleting a Process
Deleting a process removes it and all related activity instances from the list of processes on the Results
pane. Before deleting a process, access the properties, and click the Used By tab to view where objects
are being used by the variable. This ensures that deleting the process does not affect any other processes
or activities. With the appropriate rights, processes can be deleted from the system.
To delete a process:
Step 1

On the Definitions—Processes view, highlight the appropriate process, and use one of the following
methods:
•

On the toolbar, click the Delete

tool.

-or•

Right-click and choose Delete.

The Confirm Process Delete dialog box displays.
Figure 7-14

Step 2

Confirm Process Delete Dialog Box

Click Yes to delete the process.
The process instance is deleted from the process view. If necessary, click the Refresh
the view.

Note

tool to update

Click No to cancel the process instance deletion and return to the previous view.
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Viewing Used By Properties
Use the Used By tab to display the objects that directly reference the selected process in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

Click the Used By tab to view the objects used by the process.

Step 2

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 3

Click OK to close the dialog box.

Viewing the History tab
Use the History tab to view a history of changes that have been made to the process. This is a
display-only tab and does not require any user interaction.
To view process history:
Step 1

Click the History tab to view the changes made to the process.
The following information about the history of the process is displayed:
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action

Type

The action that occurred

Description

Information about the action that was performed

Step 2

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 3

Click OK to close the dialog box.
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Managing Triggers
Triggers determine how or when the process will be executed. Multiple triggers can be added that can
be initiated when certain conditions are met. Process triggers are available for viewing within the Process
Editor. The process trigger tab displays all triggers associated with the process. On this tab, users are
able to create new triggers, modify the properties of a trigger, and delete triggers.
The following sections provide instructions on defining triggers in TEO:
•

Accessing Trigger Properties, page 8-2

•

Defining an Extended Property Value Updated Trigger, page 8-6

•

Defining a Schedule Trigger, page 8-10

•

Defining a Started by Parent Process Trigger, page 8-12

•

Defining a Started by User Trigger, page 8-13

•

Defining a Task Trigger, page 8-14

•

Defining a Task Changed Trigger, page 8-16

•

Defining a Variable Updated Trigger, page 8-19

•

Managing Trigger Definitions, page 8-21

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

8-1

Chapter 8

Managing Triggers

Accessing Trigger Properties

Accessing Trigger Properties
Process triggers are available for viewing within the Process Editor. The trigger tab displays all triggers
associated with the process. The Triggers displays all the existing defined targets. You also use this view
to create new targets, modify the properties of a target, and delete targets.
If a process contains a trigger, a user will be able to view display-only trigger properties in the process
instance views as well as in the Process Editor.
Use the following steps to view trigger properties in the Process Editor:
Step 1

On the Definitions—Processes view, use one of the following methods:
•

Highlight the appropriate process, right-click and choose Edit.
-or-

•
Step 2

On the Navigation pane, choose Processes, right-click and choose New.

After the Process Editor displays, click the Triggers tab.
Figure 8-1

Process Editor—Triggers Tab

Information about the trigger is displayed in the following columns:

Step 3

Column

Description

Display Name

Name assigned to the trigger

Target

Target which the trigger monitors to determine if it needs
to execute

On the Triggers tab, highlight the appropriate trigger, and click Properties.
The Trigger Properties dialog box displays.
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Step 4

Step 5

Click the appropriate tab to review the properties. The tabs displayed depend on the selected trigger.
Tab

Description

General

Displays general information about the trigger

Trigger-Specific

Displays the properties of the selected trigger

Target

Target on which to monitor for events that will trigger the
process.

Credentials

Runtime user whose credentials should be used to
monitored for events that will trigger the process.

Knowledge Base

Knowledge base article to be associated with the trigger

Conditions

Specifies when an action is to be taken based on an
evaluation of conditions that have been defined

Click OK to close the dialog box.

Trigger Descriptions
Tidal Enterprise Orchestrator provides several triggers which determine how or when the process will
be executed. The following table provides a list of the triggers that are associated with the product. The
available triggers are dependent upon the installed adapters.
Trigger

Description

CCMS Alert

Specifies the properties of the monitoring tree element
(MTE) that must be monitored before an alert is generated.
For additional information, see Cisco TEO Adapter Guide
for SAP ABAP.

Cisco UCS Fault

Specifies the fault criteria to monitor in the Cisco UCS
Manager target.
For additional information, see Cisco TEO Software
Adapter Guide for Cisco UCS.

Email Event (Simple)

Specifies basic criteria to match for the trigger to execute
For additional information, see the Cisco TEO Adapter
Guide for Email.

Email Event (Advanced)

Specifies more advanced criteria to match for what to do
with the message after the trigger executes
For additional information, see the Cisco TEO Adapter
Guide for Email.

Extended Property Value
Updated

Specifies the target properties which will cause an event to
trigger
See Defining an Extended Property Value Updated Trigger,
page 8-6.
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Trigger

Description

Remedy Incident Updated

Specifies the criteria for the Remedy server to be
monitored for incidents when the status is updated.
For additional information, see the Cisco TEO Adapter
Guide for BMC Remedy.

SAP Server Down

Specifies the server that must be down to trigger a process.
For additional information, see the Cisco TEO Adapter
Guide for SAP ABAP.

Schedule

Specifies the date and time for when a process is triggered.
See Defining a Schedule Trigger, page 8-10.

SCOM 2007 Alert

Specifies the SCOM alert source and severity to trigger a
process.
For additional information, see the Cisco TEO Adapter
Guide for Microsoft System Center Operations Manager
2007.

SNMP Trap Received

Specifies the criteria for the incoming traps from all SNMP
agents through the port specified in the SNMP adapter.
For additional information, see the Cisco TEO Adapter
Guide for SNMP.

Started by Parent Process

Allows any process to use the newly created process.
See Defining a Started by Parent Process Trigger,
page 8-12.

Started by User

Allows process to be started manually by user.
See Defining a Started by User Trigger, page 8-13.

Task

Specifies the criteria to match within the specific task
trigger
•

Task Changed—Trigger criteria launches the specified
process when the matching task has been modified

•

Task Created—Trigger criteria launches the specified
process when a matching task has been created

•

Task Expired—Trigger criteria launches the specified
process when a matching task expires

•

Task Past Due—Trigger criteria launches the specified
process when a matching task becomes past due

See Defining a Task Trigger, page 8-14 and Defining a
Task Changed Trigger, page 8-16.
Variable Updated

Specifies the variable conditions which trigger a process
See Defining a Variable Updated Trigger, page 8-19.
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Trigger

Description

VMware

Specifies the criteria to match to the VMware trigger
•

VMware Host Performance Event—Specify the
performance criteria for the ESXi server to be
monitored

•

VMware VM Performance Event—Specify the
performance counter criteria for the virtual machine of
the ESXi server to be monitored

•

VMware VM Power Event—Specify the criteria for
the Virtual Center to monitor the power state of a
virtual machine changes

For additional information, see the Cisco TEO Adapter
Guide for VMware
Windows Event

Specifies the criteria for an event that must be matched to
trigger the process.
For additional information, see the Cisco TEO Adapter
Guide for Microsoft Windows.
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Defining an Extended Property Value Updated Trigger
Use the Extended Property Value Updated trigger to specify the target properties to be used as a trigger
when the value of the target property changes. This trigger will be especially important when managing
cloud content using TEO. For example, a process may change the status in the target property value on
a service target to Provisioned. This change could then trigger a process which may start notifying other
applications about the new service being online.
An extended property value trigger will execute when the following actions occur by either a process or
activity.
•

New target property value is defined for a target (the old value listed in the event will be the default
target property value)

•

Target property value is changed to one value to a different value

•

Target property value is deleted for a target (the new value listed in the event will be the default
target property value).

An extended property value trigger will NOT execute when the following action(s) occur, even if the
target does not have a target property value defined and uses the default from target property definition.
•

Default target property value is changed from one to another

•

Target property definition is changed to exclude a specific target type, which deletes all existing
target property values

To define an extended property value updated trigger:
Step 1

On the Process—Triggers tab, click New > Extended Property Value Updated.
The Extended Property Value Updated Properties dialog box displays.

Note

The Required Value
a value.
Figure 8-2

icon displayed on a tab or page indicates that the field is required and is missing

Extended Property Value Updated Properties −General Tab
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Step 2

On the General tab, specify the following information:
Field

Description

Display Name

Name of the trigger

Type

Display-only. Type of trigger

Property

This is a non-editable text field and cannot be manually
updated.
Click Browse to launch the Select Extended Target
Property dialog box. The selected target property displays
in the field.
To view or modify the properties for the selected target
tool. For additional
property, click the Properties
information on creating extended target properties, see
Chapter 14, “Managing Extended Target Properties.”

Description

Brief description of the trigger

Enabled

The Enabled check box is checked by default. The checked
box indicates the trigger is available to launch process
execution.
Clear the check box to disable the trigger. If the check box
is unchecked, the trigger is disabled and cannot trigger
execution of a process
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Step 3

Click the Target tab to specify the target or target group on which to monitor for events that will trigger
the process:
Field

Description

Monitor on this target

Select this radio button and then click Browse to launch the
Select Targets dialog box to select a specific target to
monitor other than the target specified in the process
properties.
The targets that display in the Select Targets dialog box are
targets already defined in TEO.
Note

Choose a target reference

To view the properties for the selected target, click
the Properties
tool.

Select this radio button and then click the Reference tool
launch the Insert Variable Reference dialog box.
On the Insert Variable Reference dialog box, expand
Process > Target > Properties, select the appropriate
target reference property, and click OK.
The selected target reference property displays in the text
field.

Monitor using this target group

Select this radio button and then click Browse to launch the
Select Target Group dialog box to select a specific target
group on which to monitor.
The target groups that display in the Select Target Group
dialog box are target groups already defined in TEO. Select
the appropriate target group from the drop-down list.
Note

To view the properties for the target group, click
the Properties
tool.

Monitor for events on

Select one of the following radio buttons to determine which members of the target group the
trigger will monitor for events.
All targets in this group

Select this radio button to indicate the trigger will monitor
events on all targets in the target group.

Choose a target using this algorithm Select this radio button to monitor for events on a specific
member of the target group or a random target in the target
group.
Select the appropriate option from the drop-down list to
determine the target member parameters.
For algorithm descriptions, see Target Algorithms,
page 3-4.
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Step 4

Click the Conditions tab, and then the appropriate panel, to specify the conditions on which the trigger
will execute a process. The trigger will only launch when the specified conditions are met.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.
Step 5

Click the Knowledge Base tab to assign a knowledge base article to the object.
Knowledge Base Field Options

Description

Text field

Display-only. Display name for the selected knowledge base
article(s)

Delete

Highlight the appropriate knowledge base article and click the
Delete
tool to remove the knowledge base article from the
display.

Browse

Click Browse to launch the Select Knowledge Base dialog box
for a list of existing knowledge base articles.
For additional information on knowledge base articles, see
Chapter 17, “Managing Knowledge Base Articles.”

Properties

Highlight the appropriate knowledge base article and click the
Properties
tool to view and/or modify the properties of the
defined knowledge base article.
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The following information is displayed on the Knowledge Base tab.

Step 6

Field

Description

Summary

Brief description of the issue

Possible Cause

Explanation of the condition that may be causing the issue

Possible resolution

List of actions that can be performed to attempt to resolve
the issue

Related information

Additional information related to the issue

Click OK to complete the trigger definition.

Defining a Schedule Trigger
The Schedule trigger is used to specify the dates and times to be used when the process executes.
To define a schedule trigger:
Step 1

On the Process Properties pane, click the Triggers tab.

Step 2

Click New > Schedule from the drop-down list.
The Schedule Properties dialog box displays.
Figure 8-3

Schedule Properties Dialog Box—Schedule Tab
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Step 3

On the Schedule tab, specify the following information, as necessary:
Field

Description

Display Name

Name for the schedule

Type

Display-only. Type of trigger

Description

Brief description of the schedule

Calendar

Choose a calendar from the drop-down list.
Note

To view the properties for the selected calendar,
click the Properties
tool. To create a new
calendar, click New and see Chapter 12,
“Managing Calendars” for additional information
on creating specific schedules.

Time Zone

The local time zone is selected by default. To use another
time zone for this schedule, choose the time zone from the
drop-down list.

Start Time

Enter or choose the time when this schedule should begin.

Number of times to run the
process

Enter the value for how often the process is to run.

Time Interval

Choose the time to wait between the subsequent process
executions. This value is used only if the number of times
to run the process is greater than one.

Display error if no matching
targets

Check this check box to indicate an error should display if
there are no matching targets after the trigger has executed.
To disable the option, uncheck the check box.

Enabled

Step 4

Check this check box to enable the trigger. To disable the
trigger, uncheck the check box.

Complete the following tabs, as necessary, and then click OK to complete the procedure.
•

Condition—Specify when an action is to be taken based on an evaluation of the defined conditions.
See Adding Conditions to a Trigger, page 8-24.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the trigger. See
Step 5 in Defining an Extended Property Value Updated Trigger, page 8-6.

The new Schedule trigger displays in the Trigger property page.
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Defining a Started by Parent Process Trigger
Use the Started by Parent Process to indicate that a child process included in the Workflow pane can start
by the parent process. When a process tries to start a child process, if the child process does not have the
Started by Parent Process, then an error will occur and the parent process will fail.
The information used to start the child process will also be included in the automation summary.
To define a started by parent process trigger:
Step 1

On the Process Properties pane, click the Triggers tab.

Step 2

Click New > Started by Parent Process from the drop-down list.
The Started by Parent Process Properties dialog box displays.
Figure 8-4

Step 3

Step 4

Started by Parent Process Properties Dialog Box—General Tab

On the General tab, specify the following information, as necessary:
Field

Description

Display Name

Name for the trigger

Type

Display-only. Type of trigger

Description

Brief description of the trigger

Enabled

Check this check box to enable the trigger. To disable the
trigger, uncheck the check box.

Complete the following tabs, as necessary, and then click OK to complete the procedure.
•

Condition—Specify when an action is to be taken based on an evaluation of the defined conditions.
See Adding Conditions to a Trigger, page 8-24.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 5 in Defining an Extended Property Value Updated Trigger, page 8-6.

Cisco Tidal Enterprise Orchestrator Reference Guide

8-12

OL-24928-01

Chapter 8

Managing Triggers
Defining a Started by User Trigger

The new trigger displays in the Trigger property page.

Defining a Started by User Trigger
Use the Started by User trigger to indicate the process can start manually by a user. This trigger is added
by default to a process, but can be removed.
If a user attempts to manually start a process which does not have the ad-hoc trigger (or the user is
restricted from starting the process in the ad-hoc trigger), an error message will be displayed and the
process will be prevented from launching.
The Started by User trigger will expose all the typical trigger properties, as well as some additional
properties which allows the user to determine exactly how the process was manually started:
To define a started by user trigger:
Step 1

On the Process Properties pane, click the Triggers tab.

Step 2

Click New > Started By User from the drop-down list.
The Started by User Properties dialog box displays.
Figure 8-5

Step 3

Started by User Properties Dialog Box—General Tab

On the General tab, specify the following information, as necessary:
Field

Description

Display Name

Name for the trigger

Type

Display-only. Type of trigger

Description

Brief description of the trigger

Enabled

Check this check box to enable the trigger. To disable the
trigger, uncheck the check box.
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Step 4

Complete the following tabs, as necessary, and then click OK to complete the procedure.
•

Condition—Specify when an action is to be taken based on an evaluation of the defined conditions.
See Adding Conditions to a Trigger, page 8-24.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the trigger. See
Step 5 in Defining an Extended Property Value Updated Trigger, page 8-6.

The new trigger displays in the Trigger property page.

Defining a Task Trigger
The Task trigger is used to specify the criteria to match within the task to trigger the process. When the
value of the task matches the criteria, the process will be triggered. The following provides the steps used
to execute a task trigger based on whether the specified task properties were created, expired, or past due.
To define a task trigger:
Step 1

On the Process—Triggers tab, click New > Task and then choose one of the following task triggers.
Task Trigger

Description

Task Created

Specifies criteria to trigger when a matching task has been
created

Task Expired

Specifies criteria to trigger when a matching task expires

Task Past Due

Specifies criteria to trigger when a matching task becomes
past due

The [Trigger] Properties dialog box displays.

Note

Step 2

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

On the General tab, specify the following information:
Field

Description

Display Name

Name of the trigger

Type

Display-only. Type of trigger

Description

Brief description of the trigger

Enabled

The Enabled check box is checked by default. The checked
box indicates the target group is available for execution.
Uncheck the check box to disable the object. If the check
box is unchecked, the object is disabled and will be
unavailable for execution.

Step 3

Click the Criteria tab to continue.
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Figure 8-6

Step 4

Step 5

Task Created Properties Dialog Box—Criteria Tab

On the Criteria tab, click one of the following buttons to modify the list of properties for the task criteria.
Button

Description

Add

Click this button to add new property fields to be used as
criteria for the trigger.

Remove

Removes the selected property from the trigger

After the Properties pane displays, define the following information, as appropriate:
Field

Description

Property

Choose the appropriate property in the to match within the
task.
Note

Operators

The displayed operators depend on the selected property.
Note

Value
Step 6

For additional information on the properties in the
list, see Common Task Properties, page 4-4.
For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter the appropriate value for the property

Complete the following tabs, as necessary, and then click OK to complete the procedure.
•

Condition—Specify when an action is to be taken based on an evaluation of the defined conditions.
See Adding Conditions to a Trigger, page 8-24.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the trigger. See
Step 5 in Defining an Extended Property Value Updated Trigger, page 8-6.

The new trigger displays in the Trigger property page.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

8-15

Chapter 8

Managing Triggers

Defining a Task Changed Trigger

Defining a Task Changed Trigger
The Task trigger is used to specify the criteria to match within the task to trigger the process. When the
value of the task matches the criteria, the process will be triggered. Use the following steps to specify
the criteria necessary to trigger when a matching task has been modified.
To define a task trigger:
Step 1

On the Process—Triggers tab, click New > Task > [Task Changed] and then choose one of the
following task triggers.
The Task Changed Properties dialog box displays.

Step 2

On the General tab, specify the following information:
Field

Description

Display Name

Name of the trigger

Type

Display-only. Type of trigger

Description

Brief description of the trigger

Enabled

The Enabled check box is checked by default. The checked
box indicates the target group is available for execution.
Uncheck the check box to disable the object. If the check
box is unchecked, the object is disabled and will be
unavailable for execution.

Step 3

Note

Click the Original Task Criteria tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure 8-7

Task Changed Properties Dialog Box—Original Task Criteria Tab

Note

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.

Step 4

On the Original Task Criteria tab, click one of the following buttons to modify the list of properties for
the task criteria.

Step 5

Button

Description

Add

Click this button to add new property fields to be used as
criteria for the trigger.

Remove

Removes the selected property from the trigger

After the Properties pane displays, define the appropriate original task properties to query:
Field

Description

Property

Choose the appropriate property in the to match within the
task.
Note

Operators

The displayed operators depend on the selected property.
Note

Value
Step 6

For additional information on the properties in the
list, see Common Task Properties, page 4-4.
For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter the appropriate value for the property

Click the Revised Task Criteria tab to continue.
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Figure 8-8

Task Changed Properties Dialog Box—Revised Task Criteria Tab

Step 7

To define the revised properties to match to the original task properties before executing the trigger,
repeat Step 4 and Step 5.

Step 8

Complete the following tabs, as necessary, and then click OK to complete the procedure.
•

Condition—Specify when an action is to be taken based on an evaluation of the defined conditions.
See Adding Conditions to a Trigger, page 8-24.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the trigger. See
Step 5 in Defining an Extended Property Value Updated Trigger, page 8-6.

The new trigger displays in the Trigger property page.
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Defining a Variable Updated Trigger
The Variable Updated trigger is used to specify the variable to be used as the process trigger. When the
value of a defined variable changes, the process will be triggered.
To define a Variable Updated trigger:
Step 1

On the Process—Triggers tab, click New > Variable Updated.
The Variable Updated Properties dialog box displays.

Note

The Required Value
a value.
Figure 8-9

Step 2

icon displayed on a tab or page indicates that the field is required and is missing

Variable Updated Properties −General Tab

On the General tab, specify the following information:
Field

Description

Display Name

Name of the trigger

Type

Display-only. Type of trigger

Variable

This is a non-editable text field and cannot be manually
updated.
Click Browse to launch the Select Global Variables dialog
box. The selected global variable displays in the field.
To view or modify the properties for the selected global
variable, click the Properties tool.
When the value assigned to this variable changes, it causes
the conditions that have been set on the associated
Conditions tab to be examined.
The process will only execute if the settings on the
Conditions tab are met.
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Field

Description

Description

Brief description of the trigger

Enabled

The Enabled check box is checked by default. The checked
box indicates the target group is available for execution.
Clear the check box to disable the object. If the check box
is unchecked, the object is disabled and will be unavailable
for execution.

Step 3

Complete the following tabs, as necessary, and then click OK to complete the procedure.
•

Condition—Specify when an action is to be taken based on an evaluation of the defined conditions.
See Adding Conditions to a Trigger, page 8-24.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the trigger. See
Step 5 in Defining an Extended Property Value Updated Trigger, page 8-6.

The new trigger displays in the Trigger property page.
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Managing Trigger Definitions
The information in this section provide instructions on modifying trigger properties. Use the
Process—Triggers property page to perform the following functions:
•

Enable/Disable triggers

•

Modify triggers properties

•

Delete the trigger

Enabling a Trigger
A trigger is enabled by default. If a trigger is manually disabled, the trigger must be enabled before it is
available for execution.
To enable a trigger:
On the Process—Trigger view, highlight the trigger, and then right-click and choose Enable.
The trigger becomes enabled in the trigger list.

Disabling a Trigger
Disabling a target prevents the item from being available for execution. The disabled trigger is not
removed from the list of triggers in the Triggers tab.
To disable a trigger:
On the Process—Trigger view, highlight the trigger, and then right-click and choose Disable.
The trigger becomes disabled in the trigger list.

Modifying Triggers
Use the Triggers tab to modify the configured triggers. After the initial creation, not all fields are
available for updating.
To modify a trigger:
Step 1

On the Triggers tab, highlight the appropriate the trigger, and click Properties.
The selected trigger dialog box displays.

Step 2

Modify the information on the trigger tabs, as necessary, and click OK.
The modified trigger displays in the Trigger tab.
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Selecting an Extended Target Property
Use the following steps to add a target property to a trigger. Extended target properties cannot be created
from a trigger dialog box, however the properties of the target property are configurable.
To select a target property:
Step 1

On the Triggers tab, use one of the following methods:
•

Click New > Extended Property Value Updated.
-or-

•

Highlight the appropriate the trigger, and click Properties.

The Extended Property Value Updated properties dialog box displays.
Step 2

On the General tab, to the right of the Property field, click Browse.
The Select Extended Target Property dialog box displays.
Figure 8-10

Step 3

Note

Select Extended Target Property Dialog Box

Select the appropriate target property from the dialog box, and click OK.

To select multiple objects, press CTRL and holding the key while making the appropriate selections.
The modified trigger displays in the Trigger tab.
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Selecting a Global Variable
Use the following steps to add a global variable to a trigger. Global variables cannot be created from a
trigger dialog box, however the properties of the variable are configurable and can be modified by
right-clicking on the variable and selecting Properties.
To select a variable:
Step 1

On the Triggers tab, use one of the following methods:
•

Click New > Variable Updated.
-or-

•

Highlight the appropriate the trigger, and click Properties.

The Variable Updated properties dialog box displays.
Step 2

On the General tab, to the right of the Property field, click Browse.
The Select Global Variable dialog box displays.
Figure 8-11

Step 3

Note

Select Global Variable Dialog Box

Select the appropriate global variable from the dialog box, and click OK.

To select multiple objects, press CTRL and holding the key while making the appropriate selections.
The modified trigger displays in the Trigger tab.
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Adding Conditions to a Trigger
To add a condition to a process trigger:
Step 1

On the Process Properties pane, click the Triggers tab.

Step 2

Use one of the following methods, as necessary:
•

Click New > [Trigger Name].
-or-

•

Highlight an existing trigger and click Properties.

The appropriate trigger dialog box displays.
Step 3

Click the Conditions tab.

Step 4

To add a specific condition, click the appropriate panel.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.
Step 5

Click OK to close the trigger dialog box.
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Defining Target Criteria for Trigger
When defining a trigger on a target type, users can specify whether the target group should be triggered
when specific criteria is matched.
The Target Selection Criteria dialog box is launched from the Browse button on the Target property page
on the selected trigger. Use the Target Selection Criteria dialog box to specify the matching criteria for
the selected target group.
To define the target selection criteria:
Step 1

On the Trigger Target property page, select the Monitor on this target group radio button and the
appropriate target group.

Step 2

Under Monitor for Events on, select the Choose a target using this algorithm radio button and then
choose Choose the target that satisfies the specified criteria.

Step 3

Click Browse to launch the Target Selection Criteria dialog box.
Figure 8-12

Step 4

Target Selection Criteria Dialog Box

On the Properties pane, specify the following information, as necessary:
Field

Description

Text field

Choose the appropriate property to match within the target.
Click the Reference tool to select the variable from the
Insert Variable Reference dialog box.

Operators

The displayed operators depend on the selected property.
Note

Value

For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter the appropriate value for the target
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Step 5

Step 6

To modify the list of Properties pane containing target criteria, click one of the following buttons:
Button

Description

Add

Click this button to a new Properties pane to complete with
criteria for the target.

Remove

Click this button to remove the selected last Properties
pane in the display

Click OK to return to the Trigger—Target property page.
The defined criteria displays in the display-only box.

Deleting Triggers
To delete a trigger:
On the Triggers tab, highlight the appropriate the trigger, and click Delete.
The selected trigger is removed from the Trigger tab.

Cisco Tidal Enterprise Orchestrator Reference Guide

8-26

OL-24928-01

CH A P T E R

9

Configuring Process Logic Components
Process logic components are components that are inserted into a process to support or configure the
process logic and provide control over the process execution. Use the Logic pane to add components that
support or define process logic.
This chapter provides the following sections to define and manage the process logic components in the
Process Editor.
•

Process Logic Components, page 9-2

•

Defining the Completed Logic Component, page 9-3

•

Defining the Condition Block Logic Component, page 9-4

•

Defining the Condition Branch Logic Component, page 9-7

•

Defining the For Each Component, page 9-9

•

Defining the Parallel Block Component, page 9-10

•

Defining the Sequential Block Component, page 9-12

•

Assigning an Activity Starting Point, page 9-14

•

Defining the While Component, page 9-15
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Process Logic Components
The following table describes the available logic components.
Field

Description

Completed

Specifies the status that signals the completion of an
activity and terminates the process.
See Defining the Completed Logic Component, page 9-3.

Condition Block

Executes two or more condition branches in a process.
See Defining the Condition Block Logic Component,
page 9-4.

Condition Branch

Creates a branch in the process and executes the branch
only if the specified condition is met.
See Defining the Condition Branch Logic Component,
page 9-7.

For Each

Used to add the activities to the process that should be
executed one time for each item in the target source.
See Defining the For Each Component, page 9-9.

Parallel

Used to run two or more branches of a process
simultaneously.
See Defining the Parallel Block Component, page 9-10.

Sequence

Used to run one or more activities sequentially.
See Defining the Sequential Block Component, page 9-12.

Start Point

Indicates the points within a process in which a user can
start the process
See Assigning an Activity Starting Point, page 9-14.

While

Allows the process to execute a sequence of child activities
(contained in the while loop activity) that continues as long
as a specified condition is true.
See Defining the While Component, page 9-15.
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Defining the Completed Logic Component
Use the Completed logic component to specify the stop process execution and specify the process
completion status. The component ends the workflow and sets the state of the workflow to Succeeded,
Failed (Completed), or Failed (Not Completed).
Figure 9-1

Completed Component in Workflow Pane

To define a Completed component:
Step 1

On the Toolbox—Logic pane, choose Completed and drag and drop the component onto the Workflow
pane.
The Completed [Status] property page displays.
Figure 9-2

Completed [Status] Property Page—General Tab
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Step 2

Step 3

On the General tab, specify the following information:
Field

Description

Completion type

In the drop-down list, choose the status with which the
activity should complete the process
•

Succeeded

•

Failed (Completed)

•

Failed (Not Completed)

Result message

Check the check box and in the enabled text box, enter the
information to display in the Workflow pane upon
completion.

Notes

Information about the activity, process, or logic component

Click the Save

tool to save the changes to the process.

Defining the Condition Block Logic Component
Use the Condition Block component to execute two or more condition branches. It checks conditions for
each of the branches in order from left to right and executes the first condition branch whose condition
is true.
Figure 9-3

Condition Block Component in Workflow Pane
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To define a Condition Block:
Step 1

On the Toolbox—Logic pane, choose Condition and drag and drop the component onto the Workflow
pane.
The Condition Block property page displays.
Figure 9-4

Step 2

Step 3

Condition Block Property Page—General Tab

On the General tab, specify the following information:
Field

Description

Display name

Name of the condition block

Notes

Information about the component, activity or process

Click the Branches tab to continue.
Any branch that is added will contain an additional condition. When selected in the Workflow pane, the
property page for the selected condition displays and can be modified accordingly. The first condition
that matches from left to right will be the path the process follows.

Note

For additional information on modifying conditions, see Chapter 10, “Managing Conditions.”

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

9-5

Chapter 9

Configuring Process Logic Components

Defining the Condition Block Logic Component

Figure 9-5

Step 4

Conditions Block Property Page—Branches Tab

On the Branches tab, click one of the following buttons as necessary.
Button

Description

Add

Adds a condition branch to the Workflow pane

Remove

Removes a selected condition branch from the condition
block

Move Up

Moves a selected condition branch up to a new position in
the list of branches

Move Down

Moves a selected condition branch down to a new position
in the list of branches

Step 5

Choose the Condition Branch on the Workflow pane and specify the appropriate information.

Step 6

Click the Save

tool to save the changes to the process.
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Defining the Condition Branch Logic Component
Use the Condition Branch component creates a branch in the process and executes the branch only if the
specified condition is met.
Figure 9-6

Condition Branch Component in Workflow Pane

To add a condition to the process:
Step 1

On the Toolbox—Logic pane, choose Condition Branch and drag and drop the item onto the workflow
pane.
The Condition Branch properties pane displays.
Figure 9-7

Step 2

Condition Branch Properties Pane—General Tab

In the Display Name field, enter the name of the new condition branch.
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Step 3

To add a specific condition, click the appropriate panel.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.

Note

For additional information on creating conditions, see Chapter 10, “Managing Conditions.”

Step 4

In the Notes box, enter the appropriate notes for the condition.

Step 5

Click the Save

tool to save the changes to the process.
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Defining the For Each Component
Use the For Each logic component to add the activities to the process that should be executed one time
for each item in the source variable collection.
Figure 9-8

For Each Component in Workflow Pane

To define a For Each component:
Step 1

On the Toolbox—Logic pane, choose For Each and drag and drop the component onto the Workflow
pane.
The For Each property page displays.
Figure 9-9

For Each Property Page—General Tab
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Step 2

On the General tab, specify the following information:
Field

Description

Display Name

Name of the logic component

Source variable collection

Collection of objects that will be iterated through for this
For Each component.
The sub-activities of this node will be executed for each
object that is in this collection

Notes

Note

Step 3

Information about the activity, process, or logic component

Click the Reference
tool to launch the Insert Variable Reference dialog box and choose a variable
from the list. For additional information, see Inserting Variable References, page 7-21.
Click the Save

tool to save the changes to the process.

Defining the Parallel Block Component
Use the Parallel Block component to run two or more branches of a workflow simultaneously. The
component consists of two or more sequential block components that execute their activities in parallel.
Figure 9-10

Parallel Block Component in Workflow Pane

To define a Parallel Block:
Step 1

On the Toolbox—Logic pane, choose Parallel and drag and drop the component onto the Workflow
pane.
The Parallel Block property page displays.
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Figure 9-11

Step 2

Step 3

On the General tab, specify the following information:
Field

Description

Name

Name of the parallel block

Notes

Information about the component, activity or process

Click the Branches tab to continue.
Figure 9-12

Step 4

Parallel Block Property Page—General Tab

Parallel Block Property Page—Branches Tab

On the Branches tab, click one of the following buttons as necessary.
Button

Description

Add

Adds an empty sequential block to the workflow diagram

Remove

Removes a selected sequential block and all of its activities
from the workflow
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Button

Description

Move Up

Moves a selected sequential block up to a new position in
the list of branches

Move Down

Moves a selected sequential block down to a new position
in the list of branches

Step 5

Choose the Sequential Block on the Workflow pane and specify the appropriate information.

Step 6

Click the Save

tool to save the changes to the process.

Defining the Sequential Block Component
Use the Sequence component o execute activities within a block in a sequential order.
Figure 9-13

Sequential Block Component in Workflow Pane

To define a Sequential Block:
Step 1

On the Toolbox—Logic pane, choose Sequence and drag and drop the component onto the Workflow
pane.
The Sequential Block property page displays.
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Figure 9-14

Step 2

Step 3

Sequential Block Property Page—General Tab

On the General tab, specify the following information:
Field

Description

Name

Name of the sequence workflow component

Notes

Information about the activity, process, or logic component

Click the Save

tool to save the changes to the process.
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Assigning an Activity Starting Point
Use the Start Point logic component to indicate the points within a process in which a user can start the
process.
The user will always be able to start the process from the beginning. However, if a process contains a
Start Point component, then the user can start the process from the location of the Start Point within the
process.
Figure 9-15

Start Point Component in Workflow Pane

To assign a Start Point component:
Step 1

On the Toolbox—Logic pane, choose Start Point and drag and drop the component onto the Workflow
pane.
The Start Point property page displays.
Figure 9-16

Start Point Property Page—General Tab
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Step 2

Step 3

Note

On the General tab, specify the following information:
Field

Description

Name

Name of the Start Point component

Notes

Information about the activity, process, or logic component

Click the Save

tool to save the changes to the process.

For information on starting a process with a Start Point logic component, see Starting a Process,
page 7-22.

Defining the While Component
Use the While logic component to execute a sequence of child activities (contained in the while loop
activity) that continues for as long as the specified condition is true.
The While logic component is allowed to loop continuously 5000 times before it is considered stuck and
the process is stopped.
Figure 9-17

While Block Component in Workflow Pane
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To define a While Block:
Step 1

On the Toolbox—Logic pane, choose While and drag and drop the component onto the Workflow pane.
The While Block property page displays.
Figure 9-18

While Block Property Page—General Tab

Step 2

In the Display Name field, enter the name of the new While Block.

Step 3

To add a specific condition, click the appropriate panel.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.
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Panel

Description

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.

Note

For additional information on creating conditions, see Chapter 10, “Managing Conditions.”

Step 4

In the Notes box, enter the appropriate notes for the condition.

Step 5

Click the Save

tool to save the changes to the process.
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Managing Conditions
The conditions assigned to an object within a process specify when an action is to be taken based on an
evaluation of conditions that have been defined. This chapter provides instructions on creating and
modifying condition properties from within a trigger as well as modify conditions added from the Logic
workspace in the Process Editor.
•

Accessing Condition Properties, page 10-2

•

Adding Basic Conditions to an Object, page 10-4

•

Adding Advanced Conditions to an Object, page 10-6

•

Managing Condition Definitions, page 10-16
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Accessing Condition Properties
Condition property pages can be accessed from the task rule dialog box as well as two different locations
within the Process Editor. A Conditions tab is available on the Task Rules dialog box. On the Process
Editor, they can be found and used are within the individual trigger property pages as well as through
using the Condition Branch logic component.

From Task Rules View
Use the following steps to access the condition property pages from within a trigger.
On the Definitions—Task Rules view, use one of the following methods, as necessary:
•

Click New > [Task Rules Name].
-or-

•

Highlight an existing task rule and click Properties.

The appropriate task rules dialog box displays.

From Triggers View
Use the following steps to access the condition property pages from within a trigger.
Step 1

On the Process Properties pane, click the Triggers tab.

Step 2

Use one of the following methods, as necessary:
•

Click New > [Trigger Name].
-or-

•

Highlight an existing trigger and click Properties.

The appropriate trigger dialog box displays.
Step 3

Click the Conditions tab.

From Condition Branch
Use the following steps to access the condition property pages from the Logic workspace.
On the Toolbox—Logic view, choose Conditions Branch, then drag and drop the component onto the
Workflow pane.
The Condition Branch property pages display.
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Condition Descriptions
The following table provides a list of conditions that are associated with the product. For additional
information on creating a condition, refer to the appropriate section.
Condition Type

Description

Compound Condition

Specifies when an action is to be taken based on an
evaluation of conditions that have been defined.
See Creating a Compound Condition, page 10-8.

Prior Process Instance

Indicates that when a process has occurred within a specific
time interval, the condition will evaluate to false.
See Creating a Prior Process Instances Condition,
page 10-10.

Time Condition

Specifies a condition based on a defined calendar.
See Creating a Time Condition, page 10-12.

Variable Condition

Specifies a variable to be used as the condition under which
the variable should evaluate as true.
See Creating a Variable Condition, page 10-14.

Comparison Operators
The following table contains operators that may display throughout TEO.
Operator

Description

Contains

Iterates through the contents of the collection and
determines if the specified item exists (if this is a string
collection, this is case-insensitive)

Contains (case-sensitive)

Iterates through the contents of the collection and
determines if the specified item exists (same as above, but
a case-insensitive version)

Contains only

Iterates through the contents of the collection and
determines if the only item in the collection is the specified
item (if this is a string collection, this is case-insensitive)

Contains only (case-sensitive)

Iterates through the contents of the collection and
determines if the only item in the collection is the specified
item (same as above, but a case-insensitive version)

is empty

Determines if there are items in the collection or not

Equals

Determines if the left side equals the right side (if this is a
string comparison, this is case-insensitive)

Not Equals

Determines if the left side does not equal the right side

Matches Regular Expression

Determines if the left side matches the regular expression
specified on the right side

Matches wildcard

Determines if the left side matches the wildcard specified
on the right side

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

10-3

Chapter 10

Managing Conditions

Adding Basic Conditions to an Object

Operator

Description

Equals (case-sensitive)

Determines if the left side equals the right (this is the
case-sensitive version of Equals for string)

Less Than [<]

Determines if a value is less than another value

More Than [>]

Determines if a value is greater than another value

Equal [=]

Determines if a value is equal to another value

Not Equal [>]

Determines if a value is not equal to another value

Greater than or Equal [>=]

Determines if a value is greater than or equal to another
value

Less than or Equal [<=]

Determines if a value is less than or equal to another value

Adding Basic Conditions to an Object
Use the Basic panel to create simple conditions using variables to match to operator criteria.
To add a new condition to an object:
Step 1

On the [Object] property page or dialog box, click the Conditions tab.
The Conditions tab displays.
Figure 10-1

Step 2

Conditions Tab—Basic Panel

Under Conditions, click the True/False link to determine when the object should execute against the
specified conditions.
Option

Description

TRUE

Click this link to indicate the conditions should always be
satisfied before the object executes.
A single condition is listed by default and is set to True. If
no other conditions are specified, this condition will
remain and cannot be deleted by the user.

FALSE

Click this link to indicate the object can execute if the
conditions are never satisfied.
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Step 3

Step 4

Click the appropriate button to modify the condition properties used to execute the object.
Button

Description

New

Click New to add a Properties pane to the condition.

Delete

Click Delete to remove the last Properties section in the list
of properties.

Each time the New button is clicked, a Properties section is displayed for the condition. The following
table displays the fields for the Properties section.
Button

Description

Text field

Data for this field cannot be manually entered.
Click the Reference tool to select a property variable to use
as a condition.

Operators

Select the operator to be used to evaluate the variable
expression. The displayed operators depend on the selected
property.
Note

Value
Step 5

For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter value for the property

Click OK to save the object.
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Adding Advanced Conditions to an Object
Use the Advanced panel to create a TEO-based condition. Users have the ability to define the properties
of the conditions within the Advanced panel, as well as within the Properties dialog box.
The conditions specified on the Basic panel can also be configured on the Advanced pane, because they
transition to simple TEO-level variable conditions. All other TEO conditions on the Advanced panel
cannot transition to the Basic panel and will not display.
To add an advanced condition to an object:
Step 1

On the [Object] property page or dialog box, click the Conditions tab.
The Conditions tab displays.

Step 2

Click the Advanced panel to continue.
Figure 10-2

Conditions Tab—Advanced Panel

Variable Condition
Time Condition
Prior Process Condition
Compound Condition

Step 3

Under Conditions, click the True/False link to determine when the object should execute against the
specified conditions.
Option

Description

TRUE

Click this link to indicate the conditions should always be
satisfied before the object executes.
A single condition is listed by default and is set to True. If
no other conditions are specified, this condition will
remain and cannot be deleted by the user.

FALSE

Click this link to indicate the object can execute if the
conditions are never satisfied.
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Step 4

Click the appropriate button to modify the condition properties used to execute the object.
Button

Description

New

Click New > [Condition] to add a single condition to
Advanced panel. Repeat this step to add additional
condition properties to the Conditions tab.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.
See Creating a Compound Condition, page 10-8.

Properties

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances. See Creating a Prior
Process Instances Condition, page 10-10.

•

Time Condition—Specify a condition based on a
defined calendar. See Creating a Time Condition,
page 10-12.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true. See Creating a Variable Condition, page 10-14.

Click anywhere around the appropriate condition. After the
area around the condition is shaded blue, click Properties
to launch the condition properties dialog box.
Note

Delete

Condition properties can be modified on the tab or
within the conditions properties dialog box.

Highlight the appropriate condition and then click Delete
to remove the condition from the object.

After the first condition is added, the following operators are displayed. The operator is set to AND by
default.
Operator

Description

AND condition (All conditions must Click this option if an action is to be taken only when all
be met)
conditions in the list are true.
OR condition (One condition must
be met)
Step 5

Click this option if an action is to be taken when one
condition in the list is true.

Click OK to save the object.
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Creating a Compound Condition
A compound condition is a condition that compiles other conditions (time condition, prior process
instance condition, variable condition, or another compound condition) into a single condition.
Compound conditions can be continually nested within other conditions. Once created, the compound
condition can be nested within another compound condition.
Example:

AND
OR
Age < 10
Age > 20
OR
AND
FirstName = 'John'
LastInitial = 'S'
AND
FirstName = 'Jane'
LastInitial = 'S
Compound conditions can be assigned to a task rule, condition branch, or process trigger.
To create a compound condition:
Step 1

On the Conditions tab, click New > Compound Condition.
The True/False link displays on the Conditions tab.
Figure 10-3

Conditions—Advanced Panel—Compound Properties
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Step 2

Step 3

Click the appropriate option to determine when the object should execute against the specified
conditions.
Option

Description

TRUE

Click this link to indicate the conditions should always be
satisfied before the object executes.

FALSE

Click this link to indicate the object can execute if the
conditions are never satisfied.

Click New [Condition] to include another condition in the compound condition.
The appropriate condition properties section displays.

Note

Refer to the appropriate section to define the condition properties.
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Creating a Prior Process Instances Condition
Use the Prior Process Instance condition to indicate that when a process has occurred within a specific
time interval, the condition will evaluate to false.
If no process instance is selected, then the trigger will search for all process instances.
Step 1

On the Conditions tab, click New > Prior Process Instance Condition.
The Prior Process Instances Condition properties display.
Figure 10-4

Step 2

Conditions—Advanced Panel—Prior Process Instance Condition Properties

On the properties section, modify the following properties.
Option

Description

No Process instance of any kind
(Hyperlink)

Click this link to launch the Prior Process Instance dialog
box and select one of the following:
•

No Process instance of any kind—Select this radio
button to indicate that no process instances should be
used to evaluate the condition.

•

No process instance of specific process—Select this
radio button to indicate that no process instances of a
specific process should be used to evaluate the
condition.
Only one process can be selected per prior process
instance condition.

Time period

Enter the appropriate time frame for the condition to
match.
Note

Click the time unit link to change the time interval
(seconds, minutes, hours, days).
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Step 3

To modify the properties in the Prior Process Instances Condition dialog box, click anywhere on the line
of properties.
The Prior Process Instances Condition dialog box displays.
Figure 10-5

Step 4

Prior Process Instances Condition Dialog Box

Complete the following information to define the criteria to match, as necessary.
Column

Description

No Process instance of any kind

Select this radio button to indicate that no process instances
should be used to evaluate the condition.

No process instance of specific
process

Select this radio button to indicate that no process instances
of a specific process should be used to evaluate the
condition.
Only one process can be selected per prior process instance
condition.

Started within the prior

Enter the appropriate time frame for the condition to
match.
Note

Note

The Required Value
a value.

Click the time unit link to change the time interval
(seconds, minutes, hours, days).

icon displayed on a tab or page indicates that the field is required and is missing

tool to choose a defined variable or reference an object within the process on
Click the Reference
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
The new prior process instance condition is displayed on the Condition dialog box.
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Creating a Time Condition
The Time Condition is used to used to define conditions that evaluates to true on the days in the specified
calendar and between the specified start and end time. Time conditions can be assigned to a calendar,
process, activity, and a process trigger.
Use the following steps to create a time condition based on a defined calendar.
Step 1

On the Conditions tab, click New > Time Condition.
The Time Condition properties display.
Figure 10-6

Step 2

Conditions—Advanced Panel—Time Condition Properties

On the properties section, modify the following properties.
Option

Description

Calendar

From the drop-down list, choose a calendar on which to
base the condition.
Note

To view the properties for the selected calendar,
click the Properties
tool. To create a new
calendar for the condition, click New. For
additional information, see Chapter 12, “Managing
Calendars.”

Start Time

Time the condition should begin. Enter or click the scroll
button to modify the time.

End Time

Time the condition should end. Enter or click the scroll
button to modify the time.
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Step 3

To modify the properties in the Time Condition dialog box, click anywhere on the line of properties.
The Time Condition dialog box displays.
Figure 10-7

Step 4

Time Condition Dialog Box

Complete the following time condition properties, as necessary, and then click OK.
Field

Description

Calendar

From the drop-down list, choose a calendar on which to
base the condition.
Note

To view the properties for the selected calendar,
click the Properties
tool. To create a new
calendar for the condition, click New. For
additional information, see Chapter 12, “Managing
Calendars.”

Time Zone

Time zone that should be used for the time condition

Start Time

Time the condition should begin

End Time

Time the condition ends

Condition

Display-only. Shows properties used to define the time
condition

The time condition is displayed on the Conditions tab.
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Creating a Variable Condition
The Variable Condition is used to specify a variable to be used as the condition under which the variable
should evaluate as true.
To create a variable condition:
Step 1

On the Conditions tab, click New > Variable Condition.
The Variable Condition properties display.
Figure 10-8

Step 2

Conditions—Advanced Panel—Variable Condition Properties

On the properties section, modify the following properties.
Button

Description

Text field

Data for this field cannot be manually entered.
Click the Reference tool to select a property variable to use
as a condition.

Operators

Select the operator to be used to evaluate the variable
expression. The displayed operators depend on the selected
property.
Note

Value

For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter value for the property.
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Step 3

To modify the properties in the Variable Condition dialog box, click anywhere on the line of properties.
The Variable Condition dialog box displays.
Figure 10-9

Step 4

Variable Condition Dialog Box

Complete the following variable condition properties, as necessary, and then click OK.
Field

Description

Variable

tool to choose a defined variable
Click the Reference
or reference an object within the process on the Insert
Variable Reference dialog box.
For additional information, see Inserting Variable
References, page 7-21.
Note

The variables that display in this list are those that
were defined in the Global Variables view. For
additional information, see Chapter 11, “Managing
Variables.”

Comparison Operator

From the drop-down list, choose the comparison operator
to use for comparing the value of the selected variable and
the expression.

Expression

Enter the expression to be evaluated against the boolean
type variable to determine whether the condition is true.
The information in this field is case-sensitive.

The condition is displayed on the Conditions tab.
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Managing Condition Definitions
This section provides general instructions on viewing and condition properties.

Adding Conditions to a Condition Branch
To add a new condition to the process:
Step 1

On the Toolbox—Logic view, choose Condition Branch and drag and drop the item onto the Workflow
pane.
The Condition Branch Properties pane displays.
Figure 10-10

Step 2

Condition Branch—General Tab

In the Display Name field, enter the name of the new condition branch.
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Step 3

To add a specific condition, click the appropriate panel.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.
Step 4

In the Notes box, enter the appropriate notes for the condition and click the Save
Editor.

tool on the Process

Modifying Conditions
To modify condition properties:
Step 1

On the object, click Conditions tab.

Step 2

Highlight the appropriate condition, and use one of the following methods:
•

Modify the condition properties within the Conditions tab.
-or-

•

Click Properties to launch the Conditions dialog box and modify the properties within the dialog
box.

The modified condition displays in the object tab.
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Deleting Conditions from Task Rules
Use the following steps when deleting a condition from a task rule. If the user deletes the task rule, that
automatically deletes the condition.
Step 1

On the Definitions—Task Rule view, highlight an existing task rule, right-click and click Properties.
The appropriate task rule dialog box displays.

Step 2

Click the Conditions tab, highlight the appropriate condition, and click Delete.
The selected condition is deleted from the task rule.

Deleting Conditions from Triggers
Use the following steps when deleting a condition from a trigger. If the user deletes the trigger from the
process properties, that automatically deletes the condition.
Step 1

On the Triggers tab, highlight the appropriate the trigger, and click Properties.
The selected trigger dialog box displays.

Step 2

Click the Conditions tab, highlight the appropriate condition, and click Delete.
The selected condition is deleted from the trigger.

Step 3

On the trigger property page, click OK.
The modified trigger displays in the Trigger tab.

Deleting Conditions from Condition Branch Component
Use the following steps to delete a condition from a condition branch component. If the user deletes the
condition branch from the Workflow pane, that automatically deletes the condition.
On the Workflow pane, choose Condition Branch, and then use one of the following methods:
•

Right-click and then choose Delete to remove the condition branch and all associated conditions.
-or-

•

On the Condition Branch General tab, highlight the appropriate condition, and click Delete.

The selected condition is removed from the condition branch.
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Managing Variables
The variables feature provides a storage area for information that is used on a regular basis to avoid
having to specify the same information in several instances. Data stored in a variable can be altered to
affect process execution behavior.
This chapter provides information on managing process and global variables. Process variables are
created from within a process and can only be used or executed against by the process. Global variables
are accessible from every function within Tidal Enterprise Orchestrator and can be modified by every
function.
Refer to the following sections for more information:
•

Global Variables Overview, page 11-3

•

Defining Global Variables, page 11-5

•

Process Variables Overview, page 11-18

•

Defining Process Variables, page 11-21

•

Managing Variable Definitions, page 11-32

Common Uses of Variables
The most common types of variables in TEO are identity variables and process or activity property
variables.

Process or Activity Property Variables
In a process or activity definition, you can refer to the process properties or the properties of a prior
activity in the process. In this scenario, the properties of the process or activity may also refer to
associated objects.
One of the most common uses of variables is to define activity configuration. Any field in an activity
with a Reference tool can refer to a variable value rather than an explicit value.

Status Tracking
Another common use of variables is to track state. For instance, a user can use variables as a loop
counters to store the number of times a loop has executed and know the current loop iteration running.
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Summary Variables
Users can also use a variable to build up a 'summary' message. For each thing event happens, users can
append 'what just happened' to the variable. At the end of a process, the result will be the contents of this
variable as an entire summary of the process.

Name Variables
The most common use of variables is a name that has a changeable value. For example, a global variable
can be used to store information used in processes such as:
•

Locations of files and directories

•

Email addresses

•

Order numbers

•

User names

Variable Descriptions
The following table provides a listing variable types supported by the product. Variables are available
for defining from within the Definitions—Global Variables view and in the Process Editor—Variables
tab.
For information on defining process variables or global variables, see the appropriate section included
later in this chapter.
Variable

Description

Boolean

Indicates whether a set of elements should be true or false

Hidden String

Holds data that must be protected from other TEO users
and from auditing operations performed by TEO

Identity

Represents the value of a user identity

Numeric

Single whole or decimal number (positive and negative)

String

Defines a variable containing a string of text

Table

Stores a set of records in a table format
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Global Variables Overview
The Definitions—Global Variables view displays all the defined global variables in the console.
Additional features from this view include creating a new global variable, modifying and deleting a
global variable.

Accessing Definitions—Global Variables
To access the Global Variable view:
On the Definitions pane, choose Global Variables. The Results pane displays.
Figure 11-1

Definitions—Global Variables

Information about the defined variables is displayed in the following columns:
Column

Description

Display name

Name assigned to the variable

Description

Description of the variable

Value

Value assigned to the variable

Data type

Type of variable being used for the parameter value
(Boolean, Hidden String, Identity, Numeric, String, or
Table)

Last Modified Time

Time the global variable was last modified

Last Modified By

User name of the person who last modified the variable
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Note

Column

Description

Id

The unique identification number of the variable definition

Owner

User name of the owner of the variable

Created Time

The time at which the variable was created

Created By

The user name of the person who created the variable

Automation Pack

Name of the automation pack associated with the variable.
This field may be empty if the variable does not belong to
an automation pack.

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Actions Menu
The Global Variables Actions menu and toolbar provide the option to create new global variables. The
New item is also available by right-clicking Global Variables on the Definitions workspace.

Details Pane
The Global Variables Details pane displays additional information about the selected item. The
hyperlinks on each of the detail pages launch the property pages for the selected global variables.
Tab

Description

General

Displays general information about the item including the
name, type, value, and a description of the global variable

Attributes

Displays the dates, times and process owner associated
with the creation and modification of the global variable
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Defining Global Variables
Variables can be used as a reference value used for multiple objects. They can also be used to store or
pass a value between executions of a process or between steps within a single process.
Use the following steps to define a global variable. The property pages displayed depend on the type of
global variable selected.
To define a global variable:
Step 1

Note

On the Definitions—Global Variables view, right-click and choose one of the following global variables.
Variable

Description

Boolean

Indicates whether a set of elements should be true or false

Hidden String

Holds data that must be protected from other TEO users
and from auditing operations performed by TEO

Identity

Represents the value of a user identity

Numeric

Single whole or decimal number (positive and negative)

String

Defines a variable containing a string of text

Table

Stores a set of records in a table format

Each variable has specific panels on the wizard, see the appropriate sections for information on defining
the individual properties.
The New [Name] Variable Wizard launches.

Note

Step 2

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

On the General Information panel, specify the appropriate information, and click Next.
The [Name] Variable Value panel displays.

Step 3

On the Variable Value panel, specify the appropriate value for the variable, and click Next.
The Completing the New [Name] Variable Wizard panel displays.

Step 4

Click Finish to complete the procedure.
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Viewing Global Variable Properties
To view global variable properties:
Step 1

On the Definitions—Global Variables view, highlight the appropriate variable, and use one of the
following methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.

Note

Step 2

The property pages may display as display-only if the global variable definition is shipped as part of the
automation pack or the user does not have the appropriate rights.
Review the properties and click OK to close the dialog box.

Creating a Boolean Variable
Use the Boolean variable to define a value that should be interpreted as true or false. The variable
information is stored as a reference value that is used for multiple objects.
To create a boolean variable:
Step 1

On the Definitions—Global Variables view, right-click and choose New > Boolean Variable.
The New Boolean Variable Wizard launches.
Figure 11-2

New Boolean Variable Wizard—General Information Panel
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Step 2

On the General Information panel, specify the following information, and click Next.
Field

Description

Display name

Name assigned to the variable

Description

Brief description of the variable

The Variable Value panel displays.
Figure 11-3

Step 3

New Boolean Variable Wizard—Variable Value Panel

On the Variable Value panel, specify whether the value should be interpreted as true or false and click
Next.
Field

Description

Value

Value assigned to the variable (e.g. true, false)

The Completing the New Boolean Variable Wizard panel displays.
Step 4

Click Finish to complete the procedure.
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Creating a Hidden String Variable
Use the Hidden String variable to define a variable which holds data that must be protected from other
TEO users and from auditing operations performed by TEO.
The encryption protection provided by TEO extends only to the adapter level. The values are not visible
anywhere in TEO during the definition or execution stages. In the audit logs, the user cannot see the
values of the hidden string variables or encrypted activity properties. After the values reach the adapter
levels, the level are then required to handle the hidden strings with care.
To create an hidden string variable:
Step 1

On the Definitions—Global Variables view, right-click and choose New > Hidden String Variable.
The New Hidden String Variable Wizard launches.
Figure 11-4

Step 2

New Hidden String Variable Wizard—General Information Panel

On the General Information panel, specify the following information, and click Next.
Field

Description

Display name

Name assigned to the variable

Description

Brief description of the variable

The Variable Value panel displays.
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Figure 11-5

Step 3

New Hidden String Variable Wizard—Variable Value Panel

On the Variable Value panel, specify the security-sensitive text for the value, and click Next.
Field

Description

Value

Enter the security-sensitive string value(s) for the global
variable.

The Completing the New Hidden String Variable Wizard panel displays.
Step 4

Click Finish to complete the procedure.
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Creating an Identity Variable
Use the Identity variable to store the value of a user or group identity.
To create an identity variable:
Step 1

On the Definitions—Global Variables view, right-click and choose New > Identity Variable.
The New Identity Variable Wizard launches.
Figure 11-6

Step 2

New Identity Variable Wizard—General Information Panel

On the General Information Panel, specify the following information:
Field

Description

Display name

Name assigned to the variable

Description

Brief description of the variable

The Variable Value panel displays.
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Figure 11-7

Step 3

New Identity Variable Wizard—Variable Value Panel

On the Variable Value panel, specify the user or group identity for the value, and click Next.
Field

Description

Value

Value assigned to the value.
Click Browse to launch the Select User or Group dialog
box to select the identity to assign to the value.

The Completing the New Identity Variable Wizard panel displays.
Step 4

Click Finish to complete the procedure.
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Creating a Numeric Variable
Use the Numeric variable to define a variable containing a single whole or decimal number (positive and
negative).
To create a numeric variable:
Step 1

On the Definitions—Global Variables view, right-click and choose New > Numeric Variable.
The New Numeric Variable Wizard launches.
Figure 11-8

Step 2

New Numeric Variable Wizard—General Information Panel

On the General Information panel, specify the following information:
Field

Description

Display name

Name assigned to the variable

Description

Brief description of the variable

The Variable Value panel displays.
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Figure 11-9

Step 3

New Numeric Variable Wizard—Variable Value Panel

On the Variable Value panel, specify the user or group identity for the value, and click Next.
Field

Description

Value

Numeric value assigned to the value

The Completing the New Numeric Variable Wizard panel displays.
Step 4

Click Finish to complete the procedure.
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Creating a String Variable
Use the String variable to define a variable containing a string of text.
To create a string variable:
Step 1

On the Definitions—Global Variables view, right-click and choose New > String Variable.
The New String Variable Wizard launches.
Figure 11-10

Step 2

New String Variable Wizard—General Information Panel

On the General Information panel, specify the following information, and click OK.
Field

Description

Display name

Name assigned to the variable

Description

Brief description of the variable

The Variable Value panel displays.
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Figure 11-11

Step 3

New String Variable Wizard—Variable Value Panel

On the Variable Value panel, specify the user or group identity for the value, and click Next.
Field

Description

Value

Enter the default string of text value(s) for the global
variable.
Note

Check the Multiline check box to expand the text
box and add more lines to the string.

The Completing the New String Variable Wizard panel displays.
Step 4

Click Finish to complete the procedure.
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Creating a Table Variable
Use the Table variable to define a table that is used to store a set of records. Use the Table tab to define
the table columns and rows for the table variable.
For information on modifying the format of the tables, see Appendix D, “Using Table Activities.”
To create a table variable:
Step 1

On the Definitions—Global Variables view, right-click and choose New > Table Variable.
The New Table Variable Wizard launches.
Figure 11-12

Step 2

New Table Variable Properties Dialog Box—General Tab

On the General Information panel, specify the following information, and click Next.
Field

Description

Display name

Name assigned to the variable

Description

Description of the variable

The Variable Values panel displays.
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Figure 11-13

Step 3

Note

New Table Variable Wizard—Variable Values Panel

On the Variable Value panel, define the values to be included in the cells of a table as well as add new
rows and columns for the table.

The table must contain at least one column before a row can be added.
Field

Description

Rows

Click Rows to modify the number of rows to be included in the table.

Columns

•

Add—Adds a new row to the table. See Adding a Table Row,
page 11-34.

•

Remove—Removes selected rows from table. The Remove option is
enabled when the user chooses one or more rows within the data
table.

Click Columns to modify the columns to be included in the table.
•

Add—Launches the Table Columns Properties dialog box to allow
the user to define the name and data type for the new column. See
Adding a Table Column, page 11-33.

•

Edit—Allows the user to modify the name for the selected column.
The Edit option is enabled when the user has one column or one cell
in the table selected.

•

Remove—Removes the selected columns from the table. The
Remove option is enabled when the user chooses one or more
columns within the table.

Note

Step 4

Menu items under the Columns option are not available if the
variable belongs to a third-party automation pack.

Click Finish to complete the procedure.
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Process Variables Overview
Variables can be defined for individual processes in the Process Editor. These variables are only
available from within the defined process and cannot be accessed or referenced by objects outside of the
process.
The Process—Variables tab displays all the defined variables for the open process. This section provides
information on creating a new variable, modifying and deleting a process variable.

Process Variable Types
The following table describes the type of variable available that may be available to a process.
Variable Type

Description

Definition

Definition scoped variables are available to all instances of
a process. There is only one value shared by all instances
of the same process definition and that value persists from
one execution of a process to the next.
If the value of a definition scoped variable is altered by a
process instance, then all other process instances will see
the new value.

Input

Input variables can and must be specified by the parent
process. An input variable is available only to a process
instance. The process instance gets its own copy of the
input variable.
This type of variable must be specified before a process
instance can be started. An input variable must be unique
within all process instance variables and process definition
variables for a process.

Output

An output variable is available only to a given process
instance. Its value is preserved after successful termination
of a process. An output variable must be modified by the
activities within a process.
Unlike other process instance variables, the values of
output variables are stored after the process instance
terminates successfully and are available to be read by the
parent process.

Local

Local scoped variables are available only to a given process
instance. They will not persist across process instances.
They cannot be written or read by a parent process.
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Accessing Process—Variables
Step 1

To access the Process Variable view, use one of the following methods:
•

On the Definitions workspace, choose Process > New.
-or-

•

On the Definitions—Process view, double-click the appropriate process.

The Process Editor displays.
Step 2

Click the Variables tab.
Figure 11-14

Process Editor Dialog—Variables Tab

Information about the defined variables is displayed in the following columns:

Note

Column

Description

Display name

Name assigned to the variable. The name must be unique
within the scope of the variable.

Data type

Type of variable being used for the parameter value
(Boolean, Hidden String, Identity, Numeric, String, or
Table)

Value

Value assigned to the variable

Description

Brief overview the variable

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.
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Viewing Process Variable Properties
To view process variable properties:
Step 1

On the Process—Variables tab, highlight the appropriate variable, and use one of the following methods:
•

Right-click and choose Properties.
-or-

•

Click Properties.

The [Variable] Properties dialog box displays.

Note

Step 2

The property pages may display as display-only if the process variable definition is shipped as part of
the automation pack or the user does not have the appropriate rights.
Review the properties and click OK to close the dialog box.
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Defining Process Variables
Process variables can be used as a reference value to store or pass a value between executions of a
process or between steps within a single process. Process variables can also be used to collect input
parameters from the user or parent process.
Use the following steps to define a process variable. The property pages displayed depend on the type
of variable selected.
To define a process variable:
Step 1

Note

On the Variables tab, click New > [Variable].

Each variable has an associated property page, see the appropriate sections for information on defining
the individual properties.
The [Variable] Properties dialog box displays.

Note

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Step 2

On the General tab, enter the appropriate variable-specific information.

Step 3

Click OK to close the dialog box.
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Creating a Boolean Variable
Use the Boolean variable to define a value that should be interpreted as true or false.
To create a boolean variable:
Step 1

On the Process—Variables tab, click New > Boolean Variable.
The New Variable Properties dialog box displays.
Figure 11-15

Step 2

New Variable Properties Dialog Box—General Tab

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the variable

Data type

Display-only. Data type used to specify the variable value

Variable type

Type of variable:
•

Definition—Definition scoped variables are available
to all instances of a process.

•

Input—Input variables can and must be specified by
the parent process.

•

Output—An output variable is available only to a given
process instance.

•

Local—Local scoped variables are available only to a
given process instance.

Note

For additional information on the process variable
types, see Process Variable Types, page 11-18.
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Step 3

Field

Description

Default value

Value assigned to the variable (e.g. true, false)

Description

Brief description of the variable

Click OK to close the dialog box.

Creating a Hidden String Variable
Use the Hidden String variable to define a define a variable which holds data that must be protected from
other TEO users and from auditing operations performed by TEO.
The encryption protection provided by TEO extends only to the adapter level. The values are not visible
anywhere in TEO during the definition or execution stages. In the audit logs, the user cannot see the
values of the hidden string variables or encrypted activity properties. After the values reach the adapter
levels, the level are then required to handle the hidden strings with care.
To create an hidden string variable:
Step 1

On the Process—Variables tab, click New > Hidden String Variable.
The New Variable Properties dialog box displays.
Figure 11-16

Step 2

New Variable Properties Dialog Box—General Tab

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the variable

Data type

Display-only. Data type used to specify the variable value

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

11-23

Chapter 11

Managing Variables

Defining Process Variables

Field

Description

Variable type

Type of variable:
•

Definition—Definition scoped variables are available
to all instances of a process.

•

Input—Input variables can and must be specified by
the parent process.

•

Output—An output variable is available only to a given
process instance.

•

Local—Local scoped variables are available only to a
given process instance.

Note

Step 3

For additional information on the process variable
types, see Process Variable Types, page 11-18.

Default value

Value assigned to the variable

Description

Brief description of the variable

Click OK to close the dialog box.
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Creating an Identity Variable
Use the Identity variable to store the value of a user or group identity.
To create an identity variable:
Step 1

On the Process—Variables tab, click New > Identity Variable.
The New Variable Properties dialog box displays.
Figure 11-17

Step 2

New Variable Properties Dialog Box—General Tab

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the variable

Data type

Display-only. Data type used to specify the variable value

Variable type

Type of variable:
•

Definition—Definition scoped variables are available
to all instances of a process.

•

Input—Input variables can and must be specified by
the parent process.

•

Output—An output variable is available only to a given
process instance.

•

Local—Local scoped variables are available only to a
given process instance.

Note

For additional information on the process variable
types, see Process Variable Types, page 11-18.
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Field

Description

Default value

Value assigned to the variable.
Click Browse to launch the Select User or Group dialog
box to define the identity associated with the variable.

Description
Step 3

Brief description of the variable

Click OK to close the dialog box.

Creating a Numeric Variable
Use the Numeric variable to define a variable containing a single whole or decimal number (positive and
negative).
To create a numeric variable:
Step 1

On the Process—Variables tab, click New > Numeric Variable.
The New Variable Properties dialog box displays.
Figure 11-18

Step 2

New Variable Properties Dialog Box—General Tab

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the variable

Data type

Display-only. Data type used to specify the variable value
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Step 3

Field

Description

Variable type

Type of variable:
•

Definition—Definition scoped variables are available
to all instances of a process.

•

Input—Input variables can and must be specified by
the parent process.

•

Output—An output variable is available only to a given
process instance.

•

Local—Local scoped variables are available only to a
given process instance.

•

For additional information on the process variable
types, see Process Variable Types, page 11-18

Default value

Value assigned to the variable

Description

Brief description of the variable

Click OK to close the dialog box.
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Creating a String Variable
Use the String variable to define a variable containing a string of text.
To create a string variable:
Step 1

On the Process—Variables tab, click New > String Variable.
The New Variable Properties dialog box displays.
Figure 11-19

Step 2

New Variable Properties Dialog Box—General Tab

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the variable

Data type

Display-only. Data type used to specify the variable value

Variable type

Type of variable:
•

Definition—Definition scoped variables are available
to all instances of a process.

•

Input—Input variables can and must be specified by
the parent process.

•

Output—An output variable is available only to a given
process instance.

•

Local—Local scoped variables are available only to a
given process instance.

Note

For additional information on the process variable
types, see Process Variable Types, page 11-18.
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Field

Description

Default value

Value assigned to the variable
Note

Step 3

If the Multiline check box is checked, press Enter
to add a new line to the string.

Description

Brief description of the variable

Multiline

Check this check box to indicate the string value can
contain multiple lines of text.

Required

Check this check box to indicate that the variable requires
the value to be specified when the process is started.

Click OK to close the dialog box.

Creating a Table Variable
Use the Table variable to define a table that is used to store a set of records. Use the Table tab to define
the table columns and rows.
For information on modifying the format of the tables, see Appendix D, “Using Table Activities.”
To create a table variable:
Step 1

On the Process—Variables tab, click New > Table Variable.
The New Variable Properties dialog box displays.
Figure 11-20

New Variable Properties Dialog Box—General Tab
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Step 2

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the variable

Data type

Display-only. Data type used to specify the variable value

Variable type

Type of variable:
•

Definition—Definition scoped variables are available
to all instances of a process.

•

Output—An output variable is available only to a given
process instance.

•

Local—Local scoped variables are available only to a
given process instance.

Note

Description
Step 3

Brief description of the variable

Click the Value tab to continue.
Figure 11-21

Step 4

For additional information on the process variable
types, see Process Variable Types, page 11-18.

New Table Variable Properties Dialog Box—Value Tab

On the Value tab, define the values to be included in the cells of a table as well as add new rows and
columns for the table.
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The table must contain at least one column before a row can be added.
Field

Description

Rows

Click Rows to modify the number of rows to be included in
the table.

Columns

Step 5

•

Add—Adds a new row to the table. See Adding a Table
Row, page 11-34.

•

Remove—Removes selected rows from table. The
Remove option is enabled when the user chooses one
or more rows within the data table.

Click Columns to modify the columns to be included in the
table.
•

Add—Launches the Table Columns Properties dialog
box to allow the user to define the name and data type
for the new column. See Adding a Table Column,
page 11-33.

•

Edit—Allows the user to modify the name for the
selected column. The Edit option is enabled when the
user has one column or one cell in the table selected.

•

Remove—Removes the selected columns from the
table. The Remove option is enabled when the user
chooses one or more columns within the table.

Click OK to close the dialog box.
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Managing Variable Definitions
The following sections provide instructions on modifying variable definitions from the
Definitions—Global Variables view and modifying variables defined in the Process Editor.

Modifying Variable Properties
Use the following steps to modify existing variable properties.
Step 1

Use one of the following methods, as necessary:
•

On the Definitions—Global Variables view, highlight the appropriate variable, right-click and
choose Properties.
-or-

•

On the Process—Variables tab, highlight the appropriate variable, click Properties.

The [Variable] Properties dialog box displays.
Step 2

Modify the variable properties, as necessary.

Step 3

Click OK to close the dialog box.

Modifying a String Global Variable
Use the Definitions Global Variables view to view or modify a string global variable.
Step 1

On the Definitions—Global Variables view, highlight the appropriate string variable, right-click and
choose Properties.
The [Variable] Properties dialog box displays.

Step 2

On the General tab, modify the variable properties, as necessary.
Field

Description

Display name

Name assigned to the variable

Owner

User name of the owner of the object. This is typically the
person who created the object.
Click Browse to launch the Select User or Group dialog
box to change the owner.

Data type

Display-only. Data type used to specify the variable value

Value

Value assigned to the variable
Note

If the Multiline check box is checked, press Enter
to add a new line to the string.

Description

Brief description of the variable

Multiline

Check this check box to indicate the string value can
contain multiple lines of text.
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Step 3

Click OK to close the dialog box.

Modifying Table Variable Properties
Use the following steps to modify a table variable.
Step 1

Use one of the following methods, as necessary:
•

On the Definitions—Global Variables view, highlight the appropriate table variable, right-click and
choose Properties.
-or-

•

On the Process—Variables tab, highlight the appropriate variable, click Properties.

The [Variable] Properties dialog box displays.
Step 2

On the General tab, modify the general variable information, as necessary.

Step 3

Click the Value tab to perform the following tasks, as necessary, and click OK.
Button

Description

Columns > Add

Adds a new column to the variable

Columns > Edit

Modify existing column information

Columns > Remove

Remove a column from the variable

Rows > Add

Add additional rows to the variable

Rows > Remove

Removes rows from the variable

Adding a Table Column
Use the Table Column dialog to define the properties for a new column or modify the name of an existing
column. The column data type cannot be modified after the initial selection.
To add a table column:
Step 1

On the Table tab, click Column.
The Table Column dialog box displays.
Figure 11-22

Table Column Dialog Box
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Note

Step 2

Step 3

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Specify the following information:
Field

Description

Display name

Name of the column

Data type

The data type specified for the column
•

Boolean—Indicates elements should be as true or false

•

String (Default)—Sequence of characters such as
letters, numbers, and punctuation marks

•

Integer—Must be whole numbers and contain only
digits from 0 to 9. Can be positive or negative
(Examples: 0. 10, 345, -689)

•

Decimal—Numeric value expressed as a decimal

•

Identity—Value of a user or group identity

Click OK to return to the Table tab.

Adding a Table Row
The Row options on the Table tab are not available until after a column has been added.
To add a row:
Step 1

On the Table tab, click Row > Add.
A single row is added to the table.

Step 2

Repeat the step for additional rows to be added to the table.

Creating a Copy of a Global Variable Definition
Use the copy option to make a copy an existing global variable.
Step 1

On the Definitions—Global Variables view, highlight the appropriate variable, right-click and choose
Copy.

Step 2

Return to the Definitions—Global Variables view, right-click and choose Paste.
A copy of the defined global variable is pasted into the Results pane.

Step 3

To rename the copied variable, right-click and choose Properties.

Step 4

Modify the variable name, as appropriate, and click OK to close the dialog box.
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Deleting Variables
Before deleting a variable, access the properties, and click the Used By tab to view objects that are
referenced by the variable. This ensures that deleting the variable does not affect any processes or
activities.

Deleting a Global Variable
Use the Definitions—Global Variables view to delete variables that are no longer used by other objects
in TEO.
To delete a global variable:
Step 1

On the Definitions—Global Variables view, highlight the appropriate variable, and use one of the
following methods:
•

On the toolbar, click the Delete

tool.

-or•

Right-click and choose Delete.

The Confirm Variable Delete dialog box displays.
Figure 11-23

Step 2

Confirm Variable Delete Dialog Box

Click Yes to delete the global variable.

Deleting a Process Variable
Use the Variables tab to delete variables that are no longer used by the process.
On the Variables tab, highlight the appropriate variable, and click Delete.
The process variable is removed from the list of variables. The process variable is not completely deleted
from the process until after the process has been saved.

Viewing Variable Used By Properties
Use the Used By tab to display the objects that directly reference the selected variable in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
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Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Definitions—Global Variables view, highlight the appropriate variable, right-click and choose
Properties.
The [Variable] Properties dialog box displays.

Step 2

Click the Used By tab to view the objects that are referenced by the variable.

Step 3

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 4

Click OK to close the dialog box.

Viewing Variable History
Use the History tab to view a history of changes that have been made to the variable.
Step 1

On the Definitions—Global Variables view, highlight the appropriate variable, right-click and choose
Properties.
The [Variable] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the global variable.
The following information about the history of the variable is displayed:
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action

Change type

The action that occurred

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Calendars
When defining a process, you can specify when the process will execute. One option is to execute the
process based on a schedule. For example, you can define a calendar for Saturdays. When defining a
process that you want to run on Saturdays, you reference the Saturday calendar. The calendars feature
defines the calendar to be associated with a schedule, time, or condition. This feature simplifies:
•

Re-using calendar definitions across processes

•

Building complex calendars from other calendars

•

Viewing the processes that run based on a specific calendar

Tidal Enterprise Orchestrator ships with some pre-defined calendars for the most commonly use
scenarios. However, you can create your own calendar or copy and modify the pre-defined calendars
based on your organizational requirements.
This chapter describes the steps used view, create new calendars, and modify the properties of a calendar,
and delete calendars.
•

Definitions—Calendars Overview, page 12-2

•

Creating a Date List Calendar, page 12-4

•

Creating a Group Calendar, page 12-6

•

Creating a Recurring Calendar, page 12-9

•

Managing Calendar Definitions, page 12-12
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Definitions—Calendars Overview
Use the Definitions—Calendars view to display the defined calendars. This section is used to provide
instructions on how to access calendar information.

Accessing Definitions—Calendars
To access the calendar views:
On the Definitions pane, choose Calendars.
The Results pane displays.
Figure 12-1

Definitions—Calendars

Information about each calendar can be displayed in the following columns:
Column

Description

Display Name

Name of the calendar

Type

Calendar type (Date List, Group, Recurring, Group)

Owner

Owner of the calendar definition. This is typically the user
name of the person who created the calendar.

Last Modified Time

Time at which the calendar was last modified

Last Modified By

User name of the person who last modified the calendar

Id

Unique ID of the calendar

Description

Brief description of the calendar
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Note

Column

Description

Type Description

Brief overview of the type associated with the calendar

Created Time

Time the calendar was created

Created By

User name of the person who created the calendar

Automation Pack

Name of the automation pack

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Actions Menu and Toolbar Options
The Calendars Actions menu and toolbar provide the option to create new calendars to associate with a
process. The New option is also available by right-clicking Calendars on the Definitions workspace.
Figure 12-2

Definitions—Calendars View Actions Menu

Details Pane
The Calendars Details pane displays additional information about the selected item. The hyperlinks on
each of the detail pages launch the property pages for the selected calendar.
Tab

Description

General

Displays general information about the item including the
name, type, value, and a brief description of the calendar.

Attributes

Displays the dates, times and process owner associated
with the creation and modification of the calendar.

Viewing Calendar Properties
To view calendar properties
On the Definitions—Calendars view, highlight the appropriate calendar, and use one of the following
methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.
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Calendar Types
The following table describes the calendars available for defining.
Calendar

Description

Date List

Contains an explicit list of dates which can be assigned to
a process. The processes to which this calendar is assigned
will execute on the specified dates in the calendar.
See Creating a Date List Calendar, page 12-4.

Group

Specify a collection of other defined calendars that are to
be included or excluded in a group calendar.
See Creating a Group Calendar, page 12-6.

Recurring

Specify the start and end date for a recurring calendar and
the number of days in the recurrence cycle. The time period
and duration indicates when the process repeats execution
See Creating a Recurring Calendar, page 12-9.

Creating a Date List Calendar
The Date List calendar contains an explicit list of dates. The processes to which this calendar definition
is assigned will execute on the specified dates in the calendar. You may want to use this type of calendar
for processes that run on specific days of a specific month.
To create a date list calendar:
Step 1

On the Definitions—Calendars view, right-click and choose New > Date List Calendar.
The New Date List Calendar Properties dialog box displays.
Figure 12-3

New Date List Calendar Properties Dialog Box—General Tab
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Step 2

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the calendar

Type

Display-only. Type of object

Owner

The owner of the object. This is typically the creator of the
object.
Click Browse to launch the Select User or Group dialog
box and change the owner.

Description
Step 3

Click the Dates tab to continue.
Figure 12-4

Step 4

Brief description of the calendar

New Date List Calendar Properties—Dates Tab

On the calendar to the right, choose the appropriate date(s) on the calendar for when the activity will
execute.
The selected dates display in a list on the left side of the page.

Step 5

Column

Description

Name

Date in mm/dd/yyyy format

Day of Week

Day of the week the selected date occurs

Details

Detailed display of the selected day and date

Review the list of dates displayed and click OK to close the dialog box.
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Note

For information on removing dates from the list, see Removing Dates from Calendar Date List,
page 12-12.

Creating a Group Calendar
The Group calendar is a collection of other defined calendar types, such as inclusion of date list or a
recurring calendar within the group calendar definition. The group calendar can contain defined
recurring calendars, other group calendars, and date list calendars. You choose the calendars to include
or exclude in the group calendar definition.
To define a group calendar:
Step 1

On the Definitions—Calendars, right-click and choose New > Group Calendar.
The New Group Calendar Properties dialog box displays.
Figure 12-5

Step 2

New Group Calendar Properties—General Tab

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the calendar

Type

Display-only. Type of object
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Field

Description

Owner

The owner of the object. This is typically the creator of the
object.
Click Browse to launch the Select User or Group dialog
box and change the owner.

Description
Step 3

Click the Calendars tab to continue.
Figure 12-6

Step 4

Brief description of the calendar

New Group Calendar Properties—Calendars Tab

On the Calendars tab, specify the list of dates to be included or excluded in the group calendar.
Buttons

Description

Add Inclusion

Click this button to launch the Add Inclusion dialog box to
specify from the list of calendars which dates will be
included in the group calendar.
See Adding Dates to Group Calendar, page 12-13.

Add Exclusion

Click this button to launch the Add Exclusion dialog box to
specify from the list of calendars which dates will be
excluded from the group calendar.
See Excluding Dates from Group Calendar, page 12-14.

Remove

Select a calendar and click this button to remove it from the
list.
See Removing Calendars from Group Calendar,
page 12-15.
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Step 5

Click the Preview tab to display the list of dates that are included in the calendar. The calendar
highlighting the dates displays on the right side of the page.
Figure 12-7

Step 6

New Group Calendar Properties—Preview Tab

Review the list of dates displayed and click OK to close the dialog box.
Column

Description

Name

Date in mm/dd/yyyy format

Day of Week

Day of the week the selected date occurs

Details

Detailed display of the selected day and date
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Creating a Recurring Calendar
The Recurring calendar allows you to specify a starting date for the subsequent dates and duration that
the process repeats execution. You can specify the calendar to repeat on a daily, weekly, monthly, or
yearly basis.
To create a recurring calendar:
Step 1

On the Definitions—Calendars, right-click, and choose New > Recurring Calendar.
The New Recurring Calendar Properties dialog box displays.
Figure 12-8

Step 2

New Recurring Calendar Properties—General Tab

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the calendar

Type

Display-only. Type of object

Owner

The owner of the object. This is typically the creator of the
object.
Click Browse to launch the Select User or Group dialog
box and change the owner.

Description

Brief description of the calendar
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Step 3

Click the Recurrence tab to continue.
Figure 12-9

Step 4

New Recurring Calendar Properties—Recurrence Tab

Under Recurrence Pattern, choose the type of recurrence.
The selected recurrence pattern settings display at the bottom of the page.

Step 5

Step 6

Under Time Period, specify the effective dates for when a recurring calendar begins and when it expires,
as necessary:
•

Start date—On the drop-down calendar, choose the date on which this calendar begins. This field is
automatically populated with the current date.

•

End date—Check the check box, and then on the drop-down calendar, choose the date on which this
calendar is to end.

Complete the appropriate recurrence pattern setting. The displayed settings are dynamic and change
upon the selection of the recurrence pattern. See the following sections to complete the settings:
•

Completing the Daily Recurrence Pattern Settings, page 12-15

•

Completing the Weekly Recurrence Pattern Settings, page 12-16

•

Completing the Monthly Recurrence Pattern Settings, page 12-17

•

Completing the Yearly Recurrence Pattern Settings, page 12-18
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Step 7

Click the Preview tab to display the list of dates that are included in the calendar. The calendar
highlighting the dates displays on the right side of the page.
Figure 12-10

Step 8

New Recurring Calendar Properties—Preview Tab

Review the list of dates displayed and click OK to close the dialog box.
Column

Description

Name

Date in mm/dd/yyyy format

Day of Week

Day of the week the selected date occurs

Details

Detailed display of the selected day and date
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Managing Calendar Definitions
The following sections provide instructions on modifying calendar definitions from the
Definitions—Calendars view.

Modifying Calendar Definitions
Calendar definitions can be modified when accessing the Calendar Properties dialog box. Before
modifying a calendar, access the properties, and click the Used By tab to view where objects are being
used by the calendar. This ensures that the modification will not conflict with other processes that are
using the calendar.
To modify calendar properties:
Step 1

On the Definitions—Calendars view, highlight the appropriate calendar, right-click and choose
Properties.
The Calendar Properties dialog box displays.

Note

Certain features of the property pages may display as display-only if the calendar definition is shipped
as part of an automation pack or the user does not have the appropriate rights.

Step 2

On the General tab, modify the name and description, as necessary.

Step 3

Click the appropriate tab to modify the calendar definition. The tab that displays (Recurrence, Dates,
Calendars) depends on the calendar type.

Step 4

Click the Preview tab to review the schedule.

Step 5

Click OK to close the dialog box.

Removing Dates from Calendar Date List
To remove dates:
Step 1

On the Definitions—Calendars view, highlight the appropriate date list calendar, right-click and choose
Properties.
The Calendar Properties dialog box displays.

Step 2

On the General tab, modify the name and description, as necessary.

Step 3

Click the Dates tab, highlight the appropriate date, and drag it onto the calendar displayed to the right.

Step 4

Click the Preview tab to review the schedule.

Step 5

Click OK to close the dialog box.
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Adding Dates to Group Calendar
Use the following steps to add calendars to a group calendar.
To add calendars:
Step 1

Under the Include dates from the following calendars box, click Add Inclusion to add the appropriate
calendars to the group.
The Add Inclusion dialog box displays.
Figure 12-11

Step 2

Add Inclusion Dialog Box

Choose the appropriate calendar from the list and click OK.
The calendar is added to the Include dates from the following calendars box.

Note

To select multiple objects, press CTRL and holding the key while making the appropriate selections.
When completed selecting objects, click OK.

Step 3

Repeat Steps 1-2 to include additional calendars to the group calendar.

Step 4

Click the Preview tab to review the schedule.

Step 5

Click OK to close the dialog box.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

12-13

Chapter 12

Managing Calendars

Managing Calendar Definitions

Excluding Dates from Group Calendar
Use the following steps to exclude specific calendars from a group calendar.
To exclude calendars:
Step 1

Under the Include dates from the following calendars box, click Add Exclusion to exclude the
appropriate calendars from the group.
The Add Exclusion dialog box displays.
Figure 12-12

Step 2

Add Exclusion Dialog Box

Choose the appropriate calendar(s) from the list and click OK.
The calendar is added to the Exclude dates section from the calendars box.

Note

To select multiple objects, press CTRL and holding the key while making the appropriate selections.
When completed selecting objects, click OK.

Step 3

Repeat Steps 1-2 to exclude additional calendars to the group calendar.

Step 4

Click the Preview tab to review the schedule.

Step 5

Click OK to close the dialog box.
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Removing Calendars from Group Calendar
Use the following steps to remove calendars from the Include/Exclude dates section from the calendars
box.
To remove calendars:
Step 1

On the Calendars tab, under the Include/Exclude dates section from the calendars box, highlight the
appropriate calendar, click Remove.
The calendar is removed from the list.

Step 2

Click the Preview tab to review the schedule.

Step 3

Click OK to close the dialog box.

Completing the Daily Recurrence Pattern Settings
Use the following steps to define the daily recurring calendar settings.

Repeat a recurrence for a specific number of days
Step 1

On the Recurrence tab, choose Daily, complete the Recurrence Pattern and Time Period settings, as
necessary, and then continue to the Daily Recurrence settings.
Figure 12-13

New Recurring Calendar Properties—Daily Recurrence Settings

Step 2

Under Daily Recurrence, select the Every [_] day(s) radio button to specify the number of days in the
recurrence cycle.

Step 3

In the text field, enter the number of days the recurrence is to repeat.
For example, to have the recurrence repeat every other day, enter 2 in the text field.

Note

Use commas to separate when entering multiple dates.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

12-15

Chapter 12

Managing Calendars

Managing Calendar Definitions

Repeat a recurrence during a specific period of days
Step 1

Under Daily Recurrence, choose the For every [_] day period, on the days radio button to specify the
number of days in the recurrence cycle.

Step 2

In the text field, enter the number of days the recurrence is to repeat or click Select to choose the specific
days within the day period from the Select Days dialog box.
Example:
To have the recurrence to repeat every seven days on the first and last day of this time
period, enter [7] in the text field and then click Select to select Day 1 and Day 7 on the
Select Days dialog box.

Note

Use commas to separate when entering multiple dates.

Completing the Weekly Recurrence Pattern Settings
Use the following steps to define the weekly recurring calendar settings.
Step 1

On the Recurrence tab, choose Weekly, complete the Recurrence Pattern and Time Period settings, as
necessary, and then continue to the Weekly Recurrence settings.
Figure 12-14

New Recurring Calendar Properties—Weekly Recurrence Settings

Step 2

Under Weekly Recurrence, in the Every [_] week(s) on the following day(s) text field, enter the number
of weeks of the recurrence cycle.

Step 3

Check the check boxes for the day(s) of the week the recurrence should occur.
Example:
To have the recurrence repeat every week on Monday and Friday, enter [1] in the text field
and check the Monday and Friday check boxes.
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Completing the Monthly Recurrence Pattern Settings
Use the following steps to define the monthly recurring calendar settings.
Step 1

On the Recurrence tab, choose Monthly, complete the Recurrence Pattern and Time Period settings, as
necessary, and then continue to the Monthly Recurrence settings.
Figure 12-15

Step 2

New Recurring Calendar Properties—Monthly Recurrence Settings

Under Monthly Recurrence, in the Every [_] month (s) text field, enter the number of months in the
recurrence cycle and then use one of the following methods:
•

To specify which day(s) the recurrence is to repeat, select the On the following day(s) radio button
and in the text field, enter the appropriate numeric date(s) of the month. Click Select to choose the
days from the Select Days dialog box.

Example:
To have the recurrence to repeat every day within the month, enter [1-31] or in
the Select Days dialog box, select Day 1 through Day 31.

-or•

To specify which week(s) and day(s) of the week the recurrence is to repeat, select the For the
specified week(s) radio button.
– In the text field, enter which weeks the recurrence is to repeat. Click Select to choose the days

from the Select Days dialog box.
Example:
To have the recurrence to repeat every week within the month, enter [1-4] or on
the Select Weeks dialog box, select Week 1 through Week 4.

– Check the check boxes for the day(s) of the week the recurrence should occur.

Note

Use commas to separate when entering multiple dates.
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Completing the Yearly Recurrence Pattern Settings
Use the following steps to define the yearly recurring calendar settings.
Step 1

On the Recurrence tab, choose Yearly, complete the Recurrence Pattern and Time Period settings, as
necessary, and then continue to the Yearly Recurrence settings.
Figure 12-16

Step 2

New Recurring Calendar Properties—Yearly Recurrence Settings

Under Yearly Recurrence, in the For the month(s) of text field, enter which months the recurrence is to
repeat within a one year period. Click Select to choose the months from the Select Months dialog box.
Example:
To have the recurrence repeat every month within the year, enter [1-12] or in the
Select Months dialog box, select Month 1 through Month 12.

Step 3

Use one of the following methods:
•

To specify which day(s) of the month the recurrence is to repeat, select the On the following day(s)
radio button and in the text field, enter the appropriate numeric date(s) of the month. Click Select
to choose the days from the Select Days dialog box.

Example:
To have the recurrence to repeat every day within the month, enter [1-31] or in
the Select Days dialog box, select Day 1 through Day 31.

•

To specify which week(s) and day(s) of the month the recurrence is to repeat, select the On the radio
button and then specify the following:
– In the first drop-down list, choose the appropriate week of the month (First, Second, Third,

Fourth, Fifth, Last).
– In the second drop-down list, choose the appropriate day of the week.

Example:
To have the recurrence repeat the first Monday of every month that is specified,
select First and Monday.

Note

Use commas to separate when entering multiple dates.

Cisco Tidal Enterprise Orchestrator Reference Guide

12-18

OL-24928-01

Chapter 12

Managing Calendars
Managing Calendar Definitions

Creating a Copy of a Calendar Definition
The copy option is used when there is an existing calendar that contains properties that can be used for
defining a new calendar without creating a completely new calendar.
To create a copy a calendar definition:
Step 1

On the Definitions—Calendars view, highlight the appropriate calendar, right-click and choose Copy.

Step 2

Return to the Definitions—Calendars view, right-click and choose Paste.
A copy of the calendar is pasted at the bottom of the list of calendars on the Results pane.

Step 3

To rename the copied calendar, right-click and choose Properties.

Step 4

Modify the calendar properties, as appropriate, and click OK to close the dialog box.

Deleting Calendars
Use the Definitions—Calendars view to delete calendars that are no longer used. Before deleting a
calendar, access the properties, and click the Used By tab to view the objects that use the calendar. The
calendar deletion process will fail if the calendar is used by another object.

Note

If the calendar definition is shipped as part of the product or the user does not have the appropriate rights,
the Delete option will be disabled.
To delete a calendar:

Step 1

On the Definitions—Calendar view, highlight the appropriate calendar, and use one of the following
methods:
•

On the toolbar, click the Delete

tool.

-or•

Right-click and choose Delete.

The Confirm [Calendar] Delete dialog box displays.
Figure 12-17

Step 2

Confirm Calendar Delete Dialog Box

Click Yes to delete the calendar.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

12-19

Chapter 12

Managing Calendars

Managing Calendar Definitions

Viewing Used By Properties
Use the Used By tab to display the objects that use the selected calendar in their configuration. Because
the Used By tab displays objects in a tree view, users can also display the objects which directly
reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view objects that the use calendar:
Step 1

On the Definitions—Calendar view, highlight the appropriate calendar, right-click and choose
Properties.
The [Calendar] Properties dialog box displays.

Step 2

Click the Used By tab to view the objects used by the calendar.

Step 3

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 4

Click OK to close the dialog box.

Viewing Calendar History
Use the History tab to view a history of changes that have been made to the calendar.
To view calendar history:
Step 1

On the Definitions—Calendars view, highlight the appropriate calendar, right-click and choose
Properties.
The [Calendar] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the calendar.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action

Change Type

The action that occurred

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Targets
The Targets feature defines specific environments where activities, triggers and processes can be
executed. You can define a target to run a process or activity on a specific computer, database connection,
or application server.
Using targets simplifies specifying where certain processes, activities, or triggers will run. The target
can be defined once and reused in several processes. The targets created depend on the adapters that are
installed. You can create a target for a specific Windows computer or Active Directory domain.
The sections in this chapter guides you through managing targets.
•

Definitions—Targets Overview, page 13-2

•

Defining Targets, page 13-7

•

Managing Target Definitions, page 13-9
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Definitions—Targets Overview
The Definitions—Targets displays all the existing defined targets. You also use this view to create new
targets, modify the properties of a target, and delete targets.

Accessing Definitions—Targets View
To access the Targets view:
In the Definitions workspace, choose Targets.
The Results pane displays.
Figure 13-1

Definitions—Targets

Information about the target can be displayed in the following columns:
Column

Description

Name

The name assigned to the target

Enabled

Indicates whether the target is enabled (True) or disabled
(False). A disabled target is unavailable for execution.

Type

The type of target based on the associated adapter
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Note

Column

Description

Status

Indicates the status of the target. The status is used to
determine whether the target is available or is not available
for process or activity execution.
•

Unknown—Status of the target unknown

•

Normal—No known problems with this target

•

Unreachable—No known problems with this target

•

Disabled—Target is disabled and is not available for
activity execution

Status Information

Detailed information regarding the target status and the
reasons for target being unreachable

Automation Pack

Name of the automation pack associated with the target

Customizable

Indicates the customization setting for the object in the
automation pack

Owner

The user name of the person who created the target

Last Modified Time

The time the target was last modified

Last Modified By

The user name of the person who last modified the target

Id

The unique identification number of the target definition

Description

A brief description of the target

Type Description

A brief overview of the target type

Created Time

The time at which the target was created

Created By

The user name of the person who created the target

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Actions Menu and Toolbar Options
The Targets Actions menu and toolbar provide the option to create new targets to associate with a
process. The New option is also available by right-clicking Targets on the Definitions workspace.
Figure 13-2

Definitions—Targets Area Actions Menu

If a target is selected from the Definitions—Target view, the following options are available on the
Actions menu and toolbar provide the ability to enable and disable a target.
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Figure 13-3

Definitions—Targets Toolbar

Menu Option

Description

Enable

Click this item to enable a target. A target must be enabled
before a process can be executed against the target

Disable

Click this item to disable a target. This item will continue
to display in the Targets area, but it will not be available for
execution.

Details Pane
The Targets Details pane displays additional information about the selected item. The hyperlinks on each
of the detail pages launch the property pages for the selected target.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the target, and the
ability to enable or disable a target.

Attributes

Displays the dates, times and process owner associated
with the creation and modification of the target.

Viewing Target Properties
To view target properties:
Step 1

On the Definitions—Targets view, highlight the appropriate target, and use one of the following
methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.

Note

Step 2

The property pages may display as display-only if the target definition is shipped as part of the product
or the user does not have the appropriate rights.
Review the properties and click OK to close the dialog box.
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Target Descriptions
The following table provides a listing of the targets that are associated with the product. It is important
to note that not all targets can be created manually because they will be discovered automatically based
on the information specified by other targets.
For additional information on defining a target not included in this chapter, please refer to the associated
adapter guide.
Target

Description

Active Directory Domain

Connection information for an Active Directory domain
target
See Active Directory Adapter Guide.

Cisco UCS Manager

Specify the connection information used to connect to the
Cisco UCS Manager instance
See Cisco UCS Software Adapter Guide.

DB2 Database

Connection target information for a DB2 database
See DB2 Database Adapter Guide.

Email Account (IMAP)

Specify the connection information to the IMAP email
server
See Email Adapter Guide.

Email Account (POP3)

Specify the connection information to the POP3 email
server
See Email Adapter Guide.

Generic Data Source (OLEDB)

Specify the connection information for a data source such
as an Excel spreadsheet or a database not supported by
other target types
See Generic Data Source (OLEDB) Database Adapter
Guide.

Oracle Database

Specify the connection information for an Oracle database
See Oracle Database Adapter Guide.

Remedy Server

Specify the connection information to a Remedy server
which is used for processes to run against
See Remedy Adapter Guide.

SAP BI Warehouse

Represent the connection to an SAP BI Warehouse server
See SAP ABAP Adapter Guide.

SAP System

SAP System wizard to specify the connection and logon
information for the SAP system
See Incident Analysis for SAP Getting Started Guide.

SCOM Management Server

Specify the information about the SCOM management
server
See SCOM Adapter Guide.
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Target

Description

SQL Server Database

Specify the connection information for a SQL server
database
See SQL Server Database Adapter Guide.

Terminal

Specify the connection information used to access the
device used for processes to run against
See Terminal Adapter Guide.

Unix/Linux System

Specify the connection information used to access the
device used for processes to run against
See Terminal Adapter Guide.

VMware ESX Server

Specify the connection information to an ESX/ESXi server
See VMware Adapter Guide.

VMware Virtual Center Server

Specify the connection information to the virtual center
server
See VMware Adapter Guide

Windows Computer

Specify the connection information for the Windows
computer
See Windows Adapter Guide.

Target Algorithms
The following table displays the list of target algorithms that may display for an activity.
Algorithm

Description

Choose target associated with
SCOM 2007 Alert trigger

Runs target specified in SCOM 2007 Alert trigger

Choose the target with the
specified name

Runs the process on the member of the group specified in
the Name to match text field.

Choose all target that specifies
the specified criteria

Executes the process on all targets defined by the criteria
specified in the Target Selection dialog box.
See Defining Target Criteria, page 13-11.

Choose any targets with the
specified criteria

Executes the process on any targets defined by the criteria
specified in the Target Selection dialog box.

Select database connection of
the process SAP System

Runs target against the SAP System database connection
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Defining Targets
Tidal Enterprise Orchestrator provides several types of targets on which processes and activities can
execute against.
Use the following steps to define a target. The property pages displayed depend on the type of target
selected.
Step 1

On the Definitions workspace, right-click Targets, and choose New > [Target].
The [Target] Properties dialog box displays.

Note

Step 2

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

On the General tab, enter the appropriate general information:
Field

Description

Display Name

Name of the target

Type

Display-only. Type of target

Service Type

Type of target representing an IT or a business service

Owner

User name of the owner of the category. This is typically
the person who created the category.
Click Browse to launch the Select User or Group dialog
box to change the owner.

Status

Step 3

Note

Step 4

Status of the target
•

Unknown—Status of the target unknown

•

Normal—No known problems with this target

•

Unreachable—No known problems with this target

•

Disabled—Target is disabled and is not available for
activity execution

Status Information

Detailed information regarding the target status and the
reasons for target being unreachable

Organization

Name of the company which supports the target

Description

Brief description of the target

On the target-specific Connection tab, enter the appropriate target information.

Each target will have one or more target-specific property pages, see the appropriate adapter guide for
information on defining the individual properties.
Click OK to close the dialog box.
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Defining a Service Target
Use the Service target to create a target that represents an IT or business service. The service target can
be used by process authors when creating content within TEO. Extended target property values can be
assigned to the service target.
The Service target is a specialized target that cannot be used against any activities or triggers in TEO.
To create a service target:
Step 1

On the Definitions—Targets view, right-click and choose New > Service Target.
The New Service Wizard launches.
Figure 13-4

Note

Step 2

Step 3

Service Target Wizard—General Information Panel

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

On the General Information panel, enter the appropriate general information:
Field

Description

Display Name

Name of the service target

Service Type

Enter the type of target representing an IT or a business
service

Description

Brief description of the service target

Click Next to continue.
The Completing the New Service Target Wizard panel displays.

Cisco Tidal Enterprise Orchestrator Reference Guide

13-8

OL-24928-01

Chapter 13

Managing Targets
Managing Target Definitions

Step 4

Click Finish to complete the procedure.

Managing Target Definitions
Use the Definitions—Targets view to modify and review target information. This view can be used to
perform the following functions:
•

Enable/Disable targets

•

Modify target properties

•

Review the objects in the product that use the target

•

Review a history of changes made to the target

•

Delete the target

Enabling a Target
A target is enabled by default. If a target is manually disabled, the target must be enabled before it is
available for execution.
To enable a target:
On the Definitions—Target view, highlight the target, and then use one of the following methods:
•

On the Results pane, right-click and choose Enable.
-or-

•

On the Details pane, choose the Click here to enable option.

The Enabled column on the Results pane changes to True. If necessary, click the Refresh
update the view.

tool to

Disabling a Target
Disabling a target prevents the item from being available for execution. The disabled target is not
removed from the list of targets in the in the Definitions—Target Results pane.
To disable a target:
On the Definitions—Target view, highlight the target, and then use one of the following methods:
•

On the Results pane, right-click and choose Disable.
-or-

•

On the Details pane, choose the Click here to disable option.

The Enabled column on the Results pane changes to False. If necessary, click the Refresh tool to update
the view.
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Modifying Targets
Use the Definitions—Targets view to modify the configured targets. After the initial creation, not all
fields are available for updating.
To modify a target:
Step 1

On the Definitions—Targets view, highlight the appropriate target, right-click and choose Properties.
The [Target] Properties dialog displays.

Step 2

On the General tab, modify the information, as necessary.
Field

Description

Display Name

Name of the target

Type

Display-only. Type of target

Service Type

Type of target representing an IT or a business service

Owner

User name of the owner of the category. This is typically
the person who created the category.
Click Browse to launch the Select User or Group dialog
box to change the owner.

Status

Display-only. Status of the target
•

Unknown—Status of the target unknown

•

Normal—No known problems with this target

•

Unreachable—No known problems with this target

•

Disabled—Target is disabled and is not available for
activity execution

Status Information

Display-only. Detailed information regarding the target
status and the reasons for target being unreachable

Organization

Name of the company which supports the target

Description

Brief description of the target

Enabled

Check or uncheck the check box to enable or disable the
target. The check box is selected by default which makes it
available immediately upon creation.
If you uncheck the check box, the target is disabled and will
be unavailable for execution.

Step 3

Modify the appropriate information on the tabs, as necessary.
Tab

Description

General

Modify the general information about the target

Connection

Modify the connection properties for the defined target
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Step 4

Step 5

Review the information on the following tabs.
Tab

Description

Member Of

Displays the target groups to which the target belongs. This
tab will remain blank until added to a target group.

Extended Properties

Displays the list of all extended target properties defined
for a specific target type. This tab will remain blank until
an extended target property is defined for the target type.

Used By

Display the objects which reference the target. This tab will
remain blank until the target is used by an object.

History

Display the history of actions taken against the target. This
tab remains blank until after the initial target creation.

Click OK to save the changes and close the dialog box.

Defining Target Criteria
When configuring target properties for a process or activity, users can specify whether the target group
should be executed based on when specific criteria is matched.
Use the Target Selection Criteria dialog box to specify the matching criteria for the selected target group.
To define the target selection criteria:
Step 1

On the Target tab, select the Execute on this target group radio button, and then choose the appropriate
target group from the drop-down list.
Figure 13-5

Target Tab—Execute on this target group Section

Step 2

From the Choose a target using this algorithm drop-down list, choose Choose the target that satisfies
the specified criteria.

Step 3

On the Criteria box, click Browse.
The Target Selection Criteria dialog box.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

13-11

Chapter 13

Managing Targets

Managing Target Definitions

Figure 13-6

Step 4

Target Selection Criteria Dialog Box

On the Properties pane, specify the following information, as necessary:
Field

Description

Text field

Choose the appropriate property to match within the target.
Click the Reference tool to select the variable from the
Insert Variable Reference dialog box.

Operators

The displayed operators depend on the selected property.
Note

Value
Step 5

Step 6

For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter the appropriate value for the target

To modify the list of criteria, click one of the following buttons:
Button

Description

Add

Click this button to add a new Properties pane to complete
with criteria for the target.

Remove

Click this button to remove the selected Properties pane in
the display.

Click OK to return to the Target tab.
The defined criteria displays in the display-only box.
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Creating a Copy of a Target
The copy option is used when there is an existing target that contains properties that can be used for
defining a new target without creating a completely new target. The following steps may not be available
for all targets.
To create a copy a target:
Step 1

On the Definitions—Targets view, highlight the appropriate target, right-click and choose Copy.

Step 2

On the Results pane, right-click and choose Paste.
A copy of the defined target is pasted into the Results pane.

Step 3

To rename the copied target or other properties, right-click and choose Properties.
Modify the target name, as appropriate, and click OK to close the dialog box.

Deleting a Target
Use the Definitions—Target view to delete targets that are no longer referenced. Before deleting a target,
access the properties, and click the Used By tab to view where objects are being used by the target. This
ensures that deleting the target does not affect any processes or activities. The following steps may not
be available for all targets, such as those that are discovered and automatically created.
To delete a target:
Step 1

On the Definitions—Targets view, highlight the appropriate target, right-click and choose Delete.
The Confirm Delete dialog box displays.

Step 2

Click Yes to delete the target.

Viewing Member Of Properties
Use the Member of tab to view the target groups to which a target belongs. The name and type of target
group displays in the list box.
To view the member of targets:
Step 1

On the Definitions—Targets view, highlight the appropriate target, right-click and choose Properties.
The [Target] Properties dialog box displays.

Step 2

Click the Member Of tab to view the target groups.
Field

Description

Display Name

Name of the target group

Type

Display-only. Type of target group

Description

Brief description of the target
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Step 3

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 4

Click OK to close the dialog box.

Viewing Used By Properties
Use the Used By tab to display the objects that directly reference the selected target in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Definitions—Targets view, highlight the appropriate target, right-click and choose Properties.
The [Target] Properties dialog box displays.

Step 2

Click the Used By tab to view the objects used by the target.
Object

Description

Display Name

Name of the object

Type

Type of object

Step 3

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 4

Click OK to close the dialog box.

Viewing Targets History
Use the History tab to view a history of changes that have been made to the target.
Step 1

On the Definitions—Targets view, highlight the appropriate target, right-click and choose Properties.
The [Target] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the target.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred
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Column

Description

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Step 3

To view the details for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Extended Target Properties
Extended target properties allow users to define a specific target property value and provides flexibility
for others to set or access the values to be used to customize process behavior.
Target properties also provides the ability to store data that is collected during the process execution
against a target. For example, a networking process might gather configuration data about each device
on a daily basis, then other workflows which run ad-hoc might consume that information. A target
property can be used to store this collected data which is associated with some targets.
Refer to the following sections for more information on managing extended target properties:
•

Accessing Definitions—Extended Target Properties, page 14-2

•

Creating a Boolean Target Property, page 14-5

•

Creating a Hidden String Target Property, page 14-8

•

Creating an Identity Target Property, page 14-10

•

Creating a Numeric Target Property, page 14-12

•

Creating a String Target Property, page 14-14

•

Creating a Table Target Property, page 14-16

•

Creating a Target Reference Property, page 14-19

•

Managing Extended Target Property Definitions, page 14-23
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Accessing Definitions—Extended Target Properties
The Definitions—Extended Target Properties view displays all the defined extended target properties in
the console. Additional features from this view include creating a new extended target property,
modifying and deleting a extended target.
TEO no longer enforces uniqueness of object names. That means that two content authors could create
and ship automation packs with identically named variables. As a result, customer importing both
automation packs will have 2 seemingly identical variables. To avoid confusion to the customer, the
documentation of best practices should recommend the use of a namespace (unique prefix) when naming
variables, processes, knowledge base articles as well. Note that this is not required, as there are no
technical issues with having duplicate variable names.
To access the Extended Target view:
On the Definitions pane, choose Extended Target Properties. The Results pane displays.
Figure 14-1

Definitions—Extended Target Properties

Information about the defined target properties is displayed in the following columns:
Column

Description

Display name

Name assigned to the target property

Description

Description of the target property

Value

Displays the value of the target property

Data type

Type of value being used for the target property (Boolean,
Hidden String, Identity, Numeric, String, Target Reference,
or Table)
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Note

Column

Description

Target Types

Indicates the target types associated with the target
property

Last Modified Time

Time the target property was last modified

Last Modified By

User name of the person who last modified the target
property

Id

The unique identification number of the target property

Owner

The user name of the owner of the target property. This is
typically the person who created the target property.

Created Time

The time at which the target property was created

Created By

The user name of the person who created the target
property

Automation Pack

Name of the automation pack associated with the target
property. This field may be empty if the target property
does not belong to an automation pack.

Customizable

Indicates the customization setting for the object in the
automation pack

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Extended Target Property Descriptions
The following table provides a listing target property types supported by the product. Target properties
are available for defining from within the Definitions—Extended Target Properties view.
For information on defining extended target properties, see the appropriate section included later in this
chapter.
Target Property

Description

Boolean

Indicates whether a set of elements should be true or false
See Creating a Boolean Target Property, page 14-5.

Hidden String

Holds data that must be protected from other TEO users
and from auditing operations performed by TEO
See Creating a Hidden String Target Property, page 14-8.

Identity

Represents the value of a user identity
See Creating an Identity Target Property, page 14-10.

Numeric

Single whole or decimal number (positive and negative)
See Creating a Numeric Target Property, page 14-12.

String

Defines a target property containing a string of text
See Creating a String Target Property, page 14-14.
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Target Property

Description

Table

Stores a set of records in a table format
See Creating a Table Target Property, page 14-16.

Target Reference

Assigns a reference from one target to another target
See Creating a Target Reference Property, page 14-19.

Actions Menu
The Extended Target Properties Actions menu and toolbar provide the option to create new target
properties. The New item is also available by right-clicking Extended Target Properties on the
Definitions workspace.

Details Pane
The Extended Target Properties Details pane displays additional information about the selected item.
The hyperlinks on each of the detail pages launch the property pages for the selected target properties.
Tab

Description

General

Displays general information about the item including the
name, type, value, and a description of the target property

Attributes

Displays the dates, times and process owner associated
with the creation and modification of the target property

Viewing Extended Target Properties
To view extended target properties:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property, and use
one of the following methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.

Note

Step 2

The property pages may display as display-only if the extended target properties definition is shipped as
part of the automation pack or the user does not have the appropriate rights.
Click the appropriate tab to review.
Tab

Description

General

Displays general information about the item including the
name, type, value, and a description of the extended target
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Step 3

Tab

Description

Values

Displays the specific values assigned to cells and rows of a
table target property

Target Types

Displays the target types which apply to the target property

Target Values

Displays the specific targets and related values assigned to
the target property

Used By

Displays the objects referenced by the target property

History

Displays when the target property was created or modified.
The column also displays audit log entries that are relevant
to the target property

Review the properties and click OK to close the dialog box.

Creating a Boolean Target Property
Use the Boolean extended target property to define a value that should be interpreted as true or false.
To create a boolean target property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > Boolean Property.
The New Boolean Property Wizard launches.
Figure 14-2

Step 2

New Boolean Property Wizard—General Information Panel

On the General Information panel, specify the following information:
Field

Description

Display name

Name assigned to the target property

Description

Brief description of the property
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Step 3

Click Next to continue.
The Target Types panel displays.
Figure 14-3

Step 4

Note

New Boolean Property Wizard—Target Types Panel

On Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
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The Default Property Value panel displays.
Figure 14-4

Step 6

Step 7

New Boolean Property Wizard—Default Property Value Panel

On the Default Property Value panel, specify the default value for the Boolean target property to be
assigned to the selected target types.
Field

Description

Default Value

Value assigned to the target property (e.g., true, false)

Click Next to continue.
The Completing the New Boolean Property Wizard displays.
Figure 14-5

Step 8

New Boolean Property Wizard—Completing the New Boolean Property Panel

Click Finish to complete the procedure.
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Creating a Hidden String Target Property
Use the Hidden String target property to define a value that must be protected from other TEO users and
from auditing operations performed by TEO.
The encryption protection provided by TEO extends only to the adapter level. The values are not visible
anywhere in TEO during the definition or execution stages. In the audit logs, the user cannot see the
values of the hidden string target properties or encrypted activity properties.
To create an hidden string target property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > Hidden String
Property.
The New Hidden String Property Wizard launches.
Figure 14-6

Step 2

Step 3

New Hidden String Property Wizard—General Information Panel

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the target property

Description

Brief description of the target property

Click Next to continue.
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Step 4

Note

On the Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
The Default Property Value panel displays.
Figure 14-7

Step 6

New Hidden String Property Wizard—Default Property Value Panel

On the Default Property Value panel, specify the default value for the Hidden String target property to
be assigned to the selected target types.
Field

Description

Default Value

Hidden string value(s) assigned to the target property
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Step 7

Click Next to continue.
The Completing the New Hidden String Property Wizard panel displays.

Step 8

Click Finish to complete the procedure.

Creating an Identity Target Property
Use the Identity target property to store the value of a user or group identity.
To create an identity target property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > Identity Property.
The New Identity Property Wizard launches.
Figure 14-8

Step 2

Step 3

New Identity Property Wizard—General Information Panel

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the target property

Description

Brief description of the target property

Click Next to continue.
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Step 4

Note

On the Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
The Default Property Value panel displays.
Figure 14-9

Step 6

New Identity Property Wizard—Default Property Value Panel

On the Default Property Value panel, specify the default user target property to be assigned to the
selected target types.
Field

Description

Default value

Value assigned to the target property.
Click Browse to launch the Select User or Group dialog
box to select the identity to assign to the target property.
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Step 7

Click Next to continue.
The Completing the New Identity Property Wizard displays.

Step 8

Click Finish to complete the procedure.

Creating a Numeric Target Property
Use the Numeric target property to define a value to contain a single whole or decimal number (positive
and negative).
To create a numeric target property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > Numeric Property.
The New Numeric Property Wizard launches.
Figure 14-10

Step 2

Step 3

New Numeric Property Wizard—General Information Panel

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the target property

Description

Brief description of the target property

Click Next to continue.
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Step 4

Note

On the Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
The Default Property Value panel displays.
Figure 14-11

Step 6

Step 7

New Numeric Property Wizard—Default Property Value Panel

On the Default Property Value panel, specify the default numeric value to be assigned to the selected
target types.
Field

Description

Default value

Numeric value assigned to the target property

Click Next to continue.
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The Completing the New Numeric Property Wizard panel displays.
Step 8

Click Finish to complete the procedure.

Creating a String Target Property
Use the String target property to define a value containing a string of text.
To create a string target property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > String Property.
The New String Property Wizard launches.
Figure 14-12

Step 2

Step 3

New String Property Wizard—General Information Panel

On the General tab, specify the following information, and click OK.
Field

Description

Display name

Name assigned to the target property

Description

Brief description of the target property

Click Next to continue.
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Step 4

Note

On the Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
The Default Property Value panel displays.
Figure 14-13

Step 6

New String Property Wizard—Default Property Value Panel

On the Default Property Value panel, specify the default string to be assigned to the selected target types.
Field

Description

Default value

String of text value(s) assigned to the target property.

Multiline

Check this check box to expand the text box to allow
multiple lines of values to the string.
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Step 7

Click Next to continue.
The Completing the New String Property Wizard panel displays.

Step 8

Click Finish to complete the procedure.

Creating a Table Target Property
Use the Table target property to define a table to be used to store a set of records. This panel can be used
to define the values to be included in the cells of a table as well as add new rows and columns for the
table.
For information on modifying the format of the tables, see Appendix D, “Using Table Activities.”
To create a table target property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > Table Property.
The New Table Property Wizard launches.
Figure 14-14

Step 2

Step 3

New Table Property Wizard—General Information Panel

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the target property

Description

Description of the target property

Click Next to continue.
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Step 4

Note

On the Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
The Default Property Value panel displays.
Figure 14-15

Note

New Table Property Wizard—Default Property Value Panel

The table must contain at least one column.
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Step 6

On the Default Property Value panel, specify the row and cell values to be included in the table property
assigned to the selected target types.
Field

Description

Rows

Click Rows to modify the number of rows to be included in the table.

Columns

•

Add—Adds a new row to the table. See Adding a Table Row,
page 14-27.

•

Remove—Removes selected rows from table. The Remove option is
enabled when the user chooses one or more rows within the data
table.

Click Columns to modify the columns to be included in the table.
•

Add—Launches the Table Columns Properties dialog box to allow
the user to define the name and data type for the new column. See
Adding a Table Column, page 14-26.

•

Edit—Allows the user to modify the name for the selected column.
The Edit option is enabled when the user has one column or one cell
in the table selected.

•

Remove—Removes the selected columns from the table. The
Remove option is enabled when the user chooses one or more
columns within the table.

Note

Step 7

Menu items under the Columns option are not available if the
target property belongs to a third-party automation pack.

Click Next to continue.
The Completing the New Table Property Wizard panel displays.

Step 8

Click Finish to complete the procedure.
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Creating a Target Reference Property
Use the Target Reference target property to specify one target as a reference to another target. This target
property is then available in the Insert Variable reference dialog box as a reference and allow users to
execute against a specific target.
Example:

A Service Target type has a new extended property called Database that references a SQL Server target.
If a process is set up to execute against the Service target, the user can select the Database target property
as a reference within that process.
To create a target reference property:
Step 1

On the Definitions—Extended Target Properties view, right-click and choose New > Target Reference
Property.
The New Target Reference Property Wizard launches.
Figure 14-16

Step 2

Step 3

New Target Reference Property Wizard—General Information Panel

On the General tab, specify the following information:
Field

Description

Display name

Name assigned to the target property

Description

Description of the target property

Click Next to continue.
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Step 4

Note

On the Target Types panel, determine which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to specific target types in the product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.
This includes target types that may be added in future.

Step 5

Click Next to continue.
The Target Reference Type panel displays.
Figure 14-17

New Target Reference Property Wizard—Reference Type Panel
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Step 6

On the Reference Type panel, select the appropriate target type to use as a reference.
Option

Description

Refers to the following type

Select this radio button to indicate the target reference
property should refer to the selected target types in the
product.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Refers to any target type

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate the target reference
property can refer to any target type.
This includes target types that may be added in future.

Note
Step 7

For information on the available target types, see Chapter 13, “Managing Targets.”
Click Next to continue.
The Default Property Value panel displays.
Figure 14-18

New Table Property Wizard—Default Property Value Panel

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

14-21

Chapter 14

Managing Extended Target Properties

Creating a Target Reference Property

Step 8

Step 9

On the Default Property Value panel, specify the defined target for the target reference property to be
assigned to targets.
Default Value Options

Description

Text field

Display-only. Display name for the selected target(s)

Delete

Highlight the appropriate target and click the Delete
the target from the list.

Browse

Click Browse to launch the Select Targets dialog box to select defined
targets to assign to the reference property.

Properties

tool to
Highlight the appropriate target and click the Properties
view and/or modify the properties of the defined target assigned to the
reference property.

tool to remove

Click Next to continue.
The Completing the New Target Reference Property Wizard panel displays.

Step 10

Click Finish to complete the procedure.
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Managing Extended Target Property Definitions
The following sections provide instructions on modifying table property definitions from the
Definitions—Extended Target Properties view.

Modifying Extended Target Properties
Use the Definitions Extended Target Properties view to review or modify the target property values and
applicable targets of a target property.
To modify a target property:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.
The [Extended Target Property] Properties dialog box displays.

Step 2

On the General tab, modify the target property, as necessary.
Field

Description

Display Name

Name assigned to the target property

Owner

User name of the owner of the object. This is typically the person who
created the object.
Click Browse to launch the Select User or Group dialog box to change
the owner.

Data Type

Display-only. Type of data used to specify the target property

Value

Value assigned to the target property.
The value displayed depends on the specific target property.

Description
Step 3

Step 4

Brief description of the target property

Modify the following tabs, as necessary, and click OK to close the dialog box.
•

Target Types—Specify which target types will apply to the extended target property. See Assigning
Target Types to a Target Property, page 14-27.

•

Target Values—Specify a target property value for a specific target. This values overrides the default
target property value. See Applying a Value to a Target-Specific Target Property, page 14-29.

Click OK to close the dialog box.
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Modifying String Target Properties
Use the Definitions Extended Target Properties view to review or modify string target property values.
To modify a string target property:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate string target property,
right-click and choose Properties.
The [String Target Property] Properties dialog box displays.
Figure 14-19

Step 2

String Properties Dialog Box—General Tab

On the General tab, modify the target property, as necessary.
Field

Description

Display Name

Name assigned to the target property

Owner

User name of the owner of the object. This is typically the person who
created the object.
Click Browse to launch the Select User or Group dialog box to change
the owner.

Data Type

Display-only. Type of data used to specify the target property

Description

Brief description of the target property

Value

String of text value(s) assigned to the target property.

Multiline

Check the checkbox to expand the text box modify the string value to
contain multiple lines of text.
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Step 3

Step 4

Modify the following tabs, as necessary, and click OK to close the dialog box.
•

Target Types—Specify which target types will apply to the extended target property. See Assigning
Target Types to a Target Property, page 14-27.

•

Target Values—Specify a target property value for a specific target. This values overrides the default
target property value. See Applying a Value to a Target-Specific Target Property, page 14-29.

Click OK to close the dialog box.

Modifying Table Target Properties
Use the following steps to modify a table target property.
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.
The [Table Target Property] Properties dialog box displays.

Step 2

On the General tab, modify the general target property information, as necessary.

Step 3

Click the Value tab to continue.
Figure 14-20

Step 4

Table Properties Dialog Box—Value Tab

On the Table tab, perform the following tasks, as necessary, and click OK.
Button

Description

Columns > Add

Adds a new column to the target property

Columns > Edit

Modify existing column information

Columns > Remove

Remove a column from the target property
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Step 5

Button

Description

Rows > Add

Add additional rows to the target property

Rows > Remove

Removes rows from the target property

Modify the following tabs, as necessary, and click OK to close the dialog box.
•

Target Types—Specify which target types will apply to the extended target property. See Assigning
Target Types to a Target Property, page 14-27.

•

Target Values—Specify a target property value for a specific target. This values overrides the default
target property value. See Applying a Value to a Target-Specific Target Property, page 14-29.

Adding a Table Column
Use the Table Column dialog to define the properties for a new column or modify the name of an existing
column. The column data type cannot be modified after the initial selection.
To add a table column:
Step 1

On the Table tab, click Column.
The Table Column dialog box displays.
Figure 14-21

Note

Table Column Dialog Box

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Step 2

Step 3

Specify the following information:
Field

Description

Display name

Name of the column

Data type

The data type specified for the column
•

Boolean—Indicates elements should be as true or false

•

String (Default)—Sequence of characters such as
letters, numbers, and punctuation marks

•

Integer—Must be whole numbers and contain only
digits from 0 to 9. Can be positive or negative
(Examples: 0. 10, 345, -689)

•

Decimal—Numeric value expressed as a decimal

•

Identity—Value of a user or group identity

Click OK to return to the Table tab.

Adding a Table Row
The Row options on the Table tab are not available until after a column has been added.
To add a row:
Step 1

On the Table tab, click Row > Add.
A single row is added to the table.

Step 2

Repeat the step for additional rows to be added to the table.

Assigning Target Types to a Target Property
Use the Definitions Extended Target Properties view to assign specific target types to a target property.
To assign a target type to a target property:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.
The [Target Property] Properties dialog box displays.

Step 2

Click the Target Types tab to continue.
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Figure 14-22

Step 3

Note

New Boolean Property Dialog Box—Target Types Tab

On the Target Types tab, specify which target types will apply to the extended target property.

For information on the available target types, see Chapter 13, “Managing Targets.”
Option

Description

Applies only to targets of the
following types

Select this radio button to indicate the target property
should apply to all target types in the product. This
includes target types that may be added in future.
Check the check box to the left of the target types to
indicate that the selected target type should be applied to
the extended target property.
Note

Applies to all targets

Step 4

Click Select All to select all the available target
types. Click Unselect All to uncheck the target
types check boxes and remove them from the
extended target property.

Select this radio button to indicate that the all target types
in TEO will be applied to the extended target property.

Click OK to close the dialog box.
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Applying a Value to a Target-Specific Target Property
Use the Target Values tab to specify a target property value for a specific target. This values overrides
the default target property value.
To modify a target value:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.
The [Target Property] Properties dialog box displays.

Step 2

Click the Target Values tab to specify a target property value for a specific target.

Step 3

Click New to launch the Target Properties dialog box.
Figure 14-23

Target Property Values Dialog Box

Step 4

To add a specific target to the extended target, click Add to launch the Select Targets dialog box.

Step 5

On the Select Targets dialog box, select the targets to be added to the target property.

Note

To select multiple targets, press CTRL and hold the key while making the appropriate selections. When
completed selecting targets, click OK.
The selected target(s) display in the list of targets on the Target Property Value dialog box.
Column

Description

Display Name

Name of the target

Type

Type of target

Description

Description of the target

Step 6

Use the Value field to modify the value assigned to the targets assigned to the target property. The fields
displayed depend on the type of extended target property.

Step 7

Click OK to close the dialog box.
The target-specific value is displayed on the Target Values tab.
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Creating a Copy of a Target Property
Use the copy option to make a copy an existing extended target property.
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Copy.

Step 2

Return to the Definitions—Extended Target Properties view, right-click and choose Paste.
A copy of the defined extended target is pasted into the Results pane.

Step 3

To rename the copied target property, right-click and choose Properties.

Step 4

On the General tab, modify the target property name, as appropriate, and click OK to close the dialog
box.

Copying a Target-Specific Value
Use the copy option to leverage the value assigned to a specific target on the target property and use the
existing settings to apply to a different defined target.
To copy a target value:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.

Step 2

Click the Target Values tab to continue.

Step 3

On the Target Values tab, highlight the appropriate target-specific value(s), and click Copy.
The Target Property Value dialog box launches to allow user to define the properties for the new
target-specific value.

Step 4

Complete the appropriate fields on the dialog box and click OK.
The target-specific value is displayed on the Target Values tab.

Removing an Assigned Target
Use the following steps to remove an assigned target and its related values from the list of target property
values. Using these steps does not delete the target or extended target property from the product.
The Remove button is enabled when one or more items are selected in the Target-specific values list box.
To remove an assigned target:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.

Step 2

Click the Target Values tab to continue.

Step 3

On the Target Values tab, highlight the appropriate target-specific value(s), and click Remove.
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The selected target-specific values are removed from the target property.

Deleting Target Properties
Use the Definitions—Extended Target Properties view to delete target properties that are no longer
referenced by other objects in TEO.
Before deleting a target property, access the properties, and click the Used By tab to view objects that
are referenced by the target property. This ensures that deleting the target property does not affect any
processes or activities.
To delete a extended target property:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property, and use
one of the following methods:
•

On the toolbar, click the Delete

tool.

-or•

Right-click and choose Delete.

The Confirm Target Property Delete dialog box displays.
Step 2

Click Yes to delete the target property.

Viewing Target Property Used By Properties
Use the Used By tab to display the objects that directly reference the selected target property in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.
The [Target Property] Properties dialog box displays.

Step 2

Click the Used By tab to view the objects that are referenced by the target property.

Step 3

To view the properties for a specific object, highlight the object, right-click and choose Properties.
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Step 4

Click OK to close the dialog box.

Viewing Target Property History
Use the History tab to view a history of changes that have been made to the target property.
Step 1

On the Definitions—Extended Target Properties view, highlight the appropriate target property,
right-click and choose Properties.
The [Target Property] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the target property.
The following information about the history of the target property is displayed:
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action

Change type

The action that occurred

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Target Groups
The Target Groups feature enable users to define specific environments or groups of environments that
are appropriate for the processes that execute on them. You can define a target group that includes a
collection of targets on which to execute processes at the same time.
When you create a process, you must specify where you want the process to run. You can specify that
the process runs on a specific target group. If you specify to execute the process on a target group, you
can further specify to run the process on all the objects that are included in the target group or run the
process on a specific object within the target group.
Using target groups simplifies specifying where certain processes will run. The target group can be
defined once and reused in several processes. For example, you may have a database maintenance
process that is scheduled to run every month on all database servers. Instead of scheduling the process
multiple times to run on each database server, you can create a target group that includes all the database
servers and schedule the process to run on all the servers at the same time.
The target groups that can be created depend on the adapters that are installed. You can create a target
group for an Active Directory Organizational Unit, Active Directory Group, Target Type Group, or a
Virtual Group that can contain any target that has been created in Enterprise Orchestrator.
The sections in this chapter provides instructions on managing target groups.
•

Definitions—Target Groups Overview, page 15-2

•

Creating a Target Type Group, page 15-5

•

Creating a Virtual Target Group, page 15-8

•

Managing Target Group Definitions, page 15-10
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Definitions—Target Groups Overview
Use Definitions—Target Groups to view the defined target groups. From this view, the user can create
new target groups, modify the properties of a target group, and delete target groups.

Accessing—Target Groups View
To access the Target Groups views:
On the Definitions workspace, select Target Groups.
The results pane displays.
Figure 15-1

Definitions—Target Groups

Information about the target group can be displayed in the following columns:
Field

Description

Display name

The name assigned to the target group

Enabled

Indicates whether the target is enabled (True) or disabled
(False)

Type

The type of target group (Active Directory Group, Active
Directory Organizational Unit, Target Type Group or
Virtual group)

Owner

The user name of the person who created the target group

Last Modified Time

The time the target group was last modified
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Field

Description

Last Modified By

The user name of the person who last modified the target
group

Id

The unique identification number of the target group
definition

Description

A brief description of the target group

Type Description

A brief overview of the target group type

Created Time

The time at which the target group was created

Created By

The user name of the person who created the target group

Version

Version number of the automation pack

Publish Date

Date the automation pack was exported

Automation Pack

Name of the automation pack associated with the target
group

Target Groups Descriptions
The following table provides a listing of the target groups that are associated with the product. For
additional information on defining an Active Directory target group, refer to the Active Directory
Adapter Guide.
Target Group

Description

Active Directory Group

Specifies the targets in a group within an Active Directory
domain

Active Directory OU

Specifies targets that belong to an organizational unit or
container within an Active Directory domain

Target Type Group

Contains TEO targets of a specified type that satisfy an
optional criteria type of target to be included

Virtual Groups

Target group includes a collection of any defined target

Actions Menu and Toolbar Options
The Target Group Actions menu and toolbar provide the option to create new target groups to associate
with a process. The New option is also available by right-clicking Target Group on the Definitions
workspace.
Figure 15-2

Definitions—Target Group View Actions Menu

If a target is selected from the Definitions—Target Group view, the following items are available on the
Actions menu and toolbar provide the ability to enable and disable a target.
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Figure 15-3

Definitions—Target Group Toolbar

Menu Option

Description

Enable

Click this item to enable a target group. A target must be
enabled before a process can be executed against the target
group.

Disable

Click this item to disable a target group. This target group
will continue to display in the Target Group view, but it will
not be available for execution.

Details Pane
The Target Group Details pane displays additional information about the selected item. The hyperlinks
on each of the detail pages launch the property pages for the selected target group.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the target group,
and the ability to enable or disable a target group.

Attributes

Displays the dates, times and owner associated with the
creation and modification of the target group.

Viewing Target Group Properties
To view target group properties:
Step 1

On the Definitions workspace, highlight the appropriate target group definition, and use one of the
following methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog displays.

Note

The property pages may display as display-only if the target group definition is shipped with the product

or the user does not have the appropriate rights.
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Step 2

Step 3

Click the appropriate tab to review the properties.
Tab

Description

General

Displays general information about the target group

Criteria

For Target Type Group only, the tab displays specific type
of target and define the criteria based on the target
properties

Members

Displays the target members included with the target group

Used by

Displays the objects that reference the target group

History

Displays when the target group was created or modified.
The column also displays audit log entries that are relevant
to the target group.

Click OK to close the dialog.

Creating a Target Type Group
A Target Type Group is configured to contain targets of a specified type that satisfy optional criteria. Use
the following steps to run processes on multiple targets from a target type group.
To create a target group:
Step 1

In the Definitions—Target Groups view, right-click and choose New > Target Type Group.
The New Target Type Group Properties dialog displays.
Figure 15-4

New Target Type Group Properties—General Tab
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Step 2

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the target group that displays in the product

Owner

User name of the owner of the category. This is typically
the person who created the category.
Click Browse to launch the Select User or Group dialog to
change the owner

Description

Brief description of the target

Enabled

The check box is checked by default, which indicates the
target group is available for execution.
Check the check box to disable the object. If the check box
is empty, the object is disabled and will be unavailable for
execution.

Step 3

Note

Click the Criteria tab to continue.

The Required Value
a value.
Figure 15-5

icon displayed on a tab or page indicates that the field is required and is missing

New Target Type Group Properties—Criteria Tab

Step 4

On the Criteria tab, from the Include targets of type drop-down list, select the appropriate target type to
include in the group.

Step 5

To add criteria for the targets that match the criteria, click Add.
A new Property pane displays each time Add is clicked.
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Step 6

On the Property pane, specify the following information, as necessary:
Field

Description

Text field

Choose the appropriate property to match within the target
group.
Click the Reference tool to select the variable from the
Insert Variable Reference dialog box.

Operators

The displayed operators depend on the selected property.
Note

Value

For information on the displayed operators, see
Comparison Operators, page 10-3.

Enter the appropriate value for the target group.

Step 7

Click the Members tab to review the members included in the target type group. Information on the
Members tab will not populate until the target type is matched on the Criteria tab.

Step 8

Click the Used By tab to display the objects that directly reference the target group. This tab will remain
blank until the target group is referenced by an object.

Step 9

Click the History tab to view the history of actions taken against the target group.

Step 10

Click OK to close the dialog box.
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Creating a Virtual Target Group
A virtual target group contains a collection of any type of target or target group that has been defined.
To create a Virtual target group:
Step 1

In the Definitions —Target Groups view, right-click and choose New > Virtual Group.
The New Virtual Group Properties dialog displays.
Figure 15-6

Step 2

New Virtual Group Properties—General Tab

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the target group that displays in the product

Type

Display only. Type of target group

Owner

User name of the owner of the category. This is typically
the person who created the category.
Click Browse to launch the Select User or Group dialog to
change the owner

Description

Brief description of the target

Enabled

The check box is selected by default, which indicates the
target group is available for execution.
Clear the check box to disable the object. If the check box
is empty, the object is disabled and will be unavailable for
execution.
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Step 3

Click the Members tab to add, view, or remove the members from the target group.
Figure 15-7

New Virtual Group Properties—Members Tab

Step 4

Click Add to add members to the group.

Step 5

To remove target group members, highlight the appropriate member, and click Remove.
Review the list of items displayed on the Members tab.

Step 6

Click the Used By tab to display the objects which use the target group. This tab will remain blank until
the target group is used by an object.

Step 7

Click the History tab to view the history of actions taken against the target group.

Step 8

Click OK to close the dialog.
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Managing Target Group Definitions
Use the Definitions—Target Group view in the console to modify and review target group information.
This view can be used to perform the following functions:
•

Enable/Disable target groups

•

Modify target group properties

•

Delete a target group

•

Review the objects in the product that use the target group

•

Review a history of changes made to the target group

Enabling a Target Group
A target group is enabled by default. If a target group is manually disabled, the target must be enabled
before it is available for execution.
To enable a target group:
On the Definitions—Target Groups view, highlight the target group, and then use one of the following
methods:
•

In the Results pane, right-click and click Enable.
-or-

•

In the Details pane, click the Click here to enable option.

The Enabled column on the results pane changes to True. If necessary, click the Refresh
update the view.

tool to

Disabling a Target Group
Disabling a target group prevents the item from being available for execution. The disabled target group
is not removed from the list of target groups in the in the Definitions—Target Groups Results pane.
To disable a target group:
On the Definitions—Target Groups view, highlight the target group, and then use one of the following
methods:
•

On the Results pane, right-click and click Disable.
-or-

•

On the Details pane, click the Click here to disable option.

The Enabled column on the results pane changes to False. If necessary, click the Refresh
update the view.

tool to
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Modifying Target Groups
Use the Definitions—Target Groups view to modify the configured target groups. After the initial
creation, not all fields are available for updating.
To modify a target group:
Step 1

On the Definitions—Target Groups view, highlight the appropriate target group, right-click and choose
Properties.
The [Target Group] Properties dialog displays.

Step 2

Modify the information on the appropriate tabs, as necessary.

Step 3

Click OK to save the changes and close the dialog.

Adding a Target to a Virtual Target Group
The following steps are used when adding a target to a virtual target group.
To select a target group member:
Step 1

On the Member tab, click Add.
The Select Target Group Members dialog displays.
Figure 15-8

Select Target Group Members Dialog
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Step 2

Use one of the following methods when selecting objects:
•

If the appropriate object is displayed in the list, select the objects, as necessary, and click OK.
-or-

•

If the appropriate object is not displayed, click New, and then choose one of the following, as
necessary:
– Target > [Target Name]
– Target Group > [Target Group Name]

Define the properties of the new object and click OK.
Step 3

Note

Select the targets or target groups to be included in the group, and click OK.

To select multiple items, press and hold CTRL while selecting the items in the list.
The selected items display on the Members tab.

Creating a Copy of a Target Group
The copy option is used when there is an existing target group that contains properties that can be used
for defining a new target group without creating a target group from scratch.
To create a copy a target group:
Step 1

On the Definitions—Target Groups view, highlight the appropriate target group, right-click and choose
Copy.

Step 2

On the Results pane, right-click and choose Paste.
A copy of the defined target group is pasted into the Results pane.

Step 3

To rename the copied target group or other properties, right-click and choose Properties.

Step 4

Modify the target group name, as appropriate, and click OK to close the dialog.

Deleting a Target Group
Use the Definitions—Target Groups view to delete target groups that are no longer used. Before deleting
a target group, it is recommended that you verify that it is no longer associated with any processes.
To delete a target group:
Step 1

On the Definitions—Target Groups view, highlight the appropriate target group, right-click and choose
Delete.
The Confirm Delete dialog displays.

Step 2

Click Yes to delete the target group and complete the procedure.
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Viewing Member Properties
Use the Members tab to view the targets included in the target group.
Step 1

On the Definitions—Target Groups view, highlight the appropriate target group, right-click and choose
Properties.
The [Target Group] Properties dialog displays.

Step 2

Note
Step 3

Click the Members tab to view the objects included in the target group:
Column

Description

Display name

Displays the names of the members included in the target
group

Type

Display only. Object type

Description

Brief description of the target group

To view the properties of a displayed object, right-click the object and choose Properties.
Click OK to close the dialog.

Viewing Used By Properties
Use the Used By tab to display the objects that directly reference the selected target group in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Definitions—Target Groups view, highlight the appropriate target group, right-click and choose
Properties.
The [Target Group] Properties dialog displays.

Step 2

Click the Used By tab to view the objects which use the target group.
Object

Description

Display name

Name of the object

Type

Display only. Type of object
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Step 3

To view information about an object, highlight the object, right-click and choose Properties.
The display-only dialog displays the properties of the object.

Step 4

Click OK to close the dialog.

Viewing Target Group History
Use the History tab to view a history of changes that have been made to the target.
Step 1

On the Definitions—Target Groups view, highlight the appropriate target group, right-click and choose
Properties.
The [Target Group] Properties dialog displays.

Step 2

Click the History tab to view the changes made to the target.
The following information about the history of the target group is displayed:
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog.
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Managing Runtime Users
Many operating system and application activities require credentials for proper execution. The Runtime
Users feature is used to create a runtime user record to store the information about the user security
context and to pass this information to the adapters for activity execution, event monitoring and some
target operations (such as availability monitoring and discovery). When defining a process or certain
activities, you can use the runtime user records that are defined in the product to assign credentials for
the process or activity.
The following sections in this chapter describe instructions on managing the runtime users:
•

Definitions—Runtime Users Overview, page 16-2

•

Defining Runtime Users, page 16-5

•

Managing Runtime User Definitions, page 16-8
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Definitions—Runtime Users Overview
Use the Definitions—Runtime Users view to display the credentials of the runtime users and to specify
new runtime user credentials, update the credentials of users, or delete users.

Accessing Definitions—Runtime users
To access the Runtime Users properties:
In the Definitions workspace, choose Runtime Users.
The Results pane displays.
Figure 16-1

Definitions—Runtime Users

Information about the runtime user accounts can be displayed in the following columns:
Column

Description

Display Name

The display name assigned to the runtime user account

Type

The type of user account

User Name

The user name assigned to the account

Owner

The user name of the person who created the account

Last Modified Time

The time the credentials were last modified

Last Modified By

The user name of the person who last modified the
credentials
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Column

Description

Id

The unique identification number of the runtime user
definition

Description

A brief overview of the runtime user definition

Type Description

A brief description of the information in the Type column

Created Time

time the runtime user account was created

Created By

The user name of the person who created the runtime user
definition

Automation Pack

Name of the automation pack from which the runtime user
record was imported

Runtime User Accounts
The following table provides a listing of the runtime users that are available in the product. For additional
information on defining a runtime user not included in this chapter, please refer to the associated adapter
guide.
Runtime User

Description

Public-key Authenticated
Admin Runtime User

Specify the credentials required to allow public key
authentication and an administrative password to
perform privileged operations.
See Cisco TEO Adapter Guide for Terminal Adapter
Guide.

Runtime Admin User

Specify the user administrative credentials required to
access a Cisco IOS Device.
See Cisco TEO Adapter Guide for Terminal Adapter
Guide.

Runtime User

Specify the credentials for a generic runtime user
record consisting of a user name and password pair.
See Creating a Runtime User, page 16-6.

SAP User

Specify the credentials for a SAP user.
See Cisco TEO Getting Started Guide for Incident
Analysis for SAP.

SNMP User

Specify the credentials for a SNMP runtime user.
See Cisco TEO Adapter Guide for SNMP.

Tidal Server Provisioner
User

Specifies the user credentials for the user account that
connects to the Tidal Server Provisioner target
See Cisco TEO Adapter Guide for Tidal Server
Provisioner.

Windows User

Specify the credentials for a Windows user.
See Cisco TEO Adapter Guide for Microsoft Windows.
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Actions Menu and Toolbar
The Runtime Actions menu and toolbar provide the option to create new runtime users to hold the
security credentials that are assigned to processes and activities. The New item is also available by
right-clicking Runtime Users on the definitions pane.
Figure 16-2

Runtime Actions Menu

Runtime User Details Pane
The Details pane in the lower portion of the page displays detailed information about the selected
runtime user. Clicking a link on a tab page opens the Properties dialog box for the runtime user.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the runtime user

Attributes

Displays the dates, times and owner associated with the
creation and modification of the runtime user
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Defining Runtime Users
Runtime user records hold the security credentials that are assigned to processes and activities. This
section provides instructions on creating a record for runtime users for different adapters.
Use the following steps to define a runtime user. The property pages displayed depend on the type of
runtime user selected.
Step 1

Note

On the Definitions—Runtime User view, right-click and choose New > [Runtime User] for the
appropriate runtime user account.

Each runtime user has an associated property page. See the appropriate sections for information on
defining the individual properties.
The [Runtime User] Properties dialog box displays.

Note

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Step 2

On the General tab, enter the appropriate runtime user-specific information.

Step 3

The Used By tab displays objects which reference the runtime user. This tab will remain blank until the
runtime user is used by an object.

Step 4

The History tab displays the history of actions taken against the runtime user. This tab remains blank
until after the initial creation.

Step 5

Click OK to close the dialog box.
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Creating a Runtime User
The credentials specified for the runtime user are used to store the information about the simple user
security context consisting of a user name and password pair and to pass this information to the adapters.
This runtime user can be used for database targets when needing database authentication.
To create a Runtime User:
Step 1

On the Definitions—Runtime Users view, right-click and choose New > Runtime User.
The New Runtime User Properties dialog box displays.
Figure 16-3

Note

Step 2

New Runtime User Properties Dialog Box—General Tab

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

On the General tab, specify the following information:
Field

Description

Display Name

This field is populated with the information specified in the
Domain and User name text fields.

Type

Display-only. Object type

User name

The user name assigned to the user account

Cisco Tidal Enterprise Orchestrator Reference Guide

16-6

OL-24928-01

Chapter 16

Managing Runtime Users
Defining Runtime Users

Field

Description

Password

The password assigned to the user account
Note

For existing runtime user records, check the check
box to enter the new password assigned to the user
account. If the password entered is incorrect, then
a confirmation dialog box displays stating:

"Logon failure: unknown user name or bad password."

Note

Description
Step 3

Step 4

There is no password verification that is done for
the simple (generic) runtime user. Therefore, the
above message will NEVER be displayed for the
runtime user object.

A description of the runtime user account

Click the Used By tab to display the objects which reference the runtime user. This tab will remain blank
until the runtime user is used by an object.
Object

Description

Display name

Name of the object

Type

Type of object

To view information about an object, highlight the object, right-click and choose Properties.
The dialog box displays the properties of the object.

Step 5

Step 6

Click the History tab to display the history of actions taken against the target. This tab remains blank
until after the initial target creation.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Click OK to exit the dialog box.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

16-7

Chapter 16

Managing Runtime Users

Managing Runtime User Definitions

Managing Runtime User Definitions
Use the following procedures to view and modify runtime user definitions.

Modifying a Runtime User Record
Use the Definitions—Runtime Users view to display the runtime user properties and modify the runtime
user records.
To modify a runtime user credentials:
Step 1

On the Definitions—Runtime Users view, highlight the appropriate runtime user record, right-click and
choose Properties.
The [Runtime User] Properties dialog box displays.

Step 2

On the General tab, modify the appropriate information, as necessary.

Step 3

Confirm the changes, and then click OK to close the dialog box.

Deleting a Runtime User
Use the Definitions—Runtime Users view to delete a runtime user record.
Step 1

On the Definitions—Runtime Users view, highlight the appropriate runtime user, right-click and choose
Delete.
The Confirm Delete dialog box displays.
Figure 16-4

Step 2

Confirm Delete Dialog Box

Click Yes to confirm the deletion.
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Viewing Used By Properties
Use the Used By tab to display the objects that directly reference the selected runtime user in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Definitions—Runtime Users view, highlight the appropriate runtime user, right-click and choose
Properties.
The [Runtime User] Properties dialog box displays.

Step 2

Step 3

Click the Used By tab to view the objects which reference the runtime user.
Object

Description

Display Name

Name of the object

Type

Type of object

To view information about an object, highlight the object, right-click and choose Properties.
The display-only dialog box displays the properties of the object.

Step 4

Click OK to close the dialog box.

Viewing Runtime User History
Use the History tab to view a history of changes that have been made to the runtime user.
Step 1

On the Definitions—Runtime Users view, highlight the appropriate runtime user, right-click and choose
Properties.
The [Runtime User] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the runtime user.
The following information about the history of the runtime is displayed:
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action
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Column

Description

Type

The action that occurred

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Knowledge Base Articles
The knowledge base articles provide information to help understand the results of an activity, including
a summary of what has occurred, the possible cause of the result, and suggested actions to take to resolve
issues with an activity.
Knowledge base articles are referenced by specific activities and can be viewed in the following
locations in TEO:
•

Operations Workspace—When viewing activity instance properties, users can view the display-only
properties of the associated knowledge base articles by selecting the Knowledge Base tab.

•

Process Editor—Users can reference a knowledge base article to an activity when defining the
activity properties in the Process Editor.

•

Automation Summary—All referenced knowledge base articles will display on the automation
summary.

The following sections provide instructions on managing knowledge base articles in TEO:
•

Definitions—Knowledge Base Articles Overview, page 17-2

•

Creating a Knowledge Base Article, page 17-5

•

Managing Knowledge Base Articles, page 17-7
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Definitions—Knowledge Base Articles Overview
This Definitions—Knowledge Base view displays the available knowledge base articles that can be
assigned to a process activity. When Knowledge Base Articles is selected in the Navigation pane, the
defined knowledge base articles display in the Results pane.

Accessing Definitions—Knowledge Base Articles
To access the Knowledge Base Articles view:
On the Definitions workspace, choose Knowledge Base Articles.
The Results pane displays.
Figure 17-1

Definitions—Knowledge Base Articles

Information about the defined knowledge base articles can be displayed in the following columns:
Column

Description

Display Name

The name of the knowledge base article

Type

The object type (Knowledge Base Article)

Owner

The user name of the owner of the knowledge base article.
This is typically the person who created the knowledge
base article.

Last Modified Time

The time at which the knowledge base article was last
modified
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Column

Description

Last Modified By

The user name of the person who last modified the
knowledge base article

Id

Unique ID of the knowledge base article

Description

A brief description of the knowledge base article

Type Description

A brief overview of the object type

Created Time

The time at which the knowledge base article was created

Created By

The user name of the person who created the knowledge
base article

Automation Pack

Name of the automation pack that contains the knowledge
base article

Knowledge Base Details Pane
The Knowledge Base Articles Details pane displays additional information about the selected knowledge
base article. The hyperlinks on each of the detail pages launch the property pages for the selected
knowledge base article.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the knowledge
base article

Knowledge Base

Displays summary information about the selected
knowledge base article, including the possible cause and
resolution of the issue type, value, a brief description of the
knowledge base article

Attributes

Displays the dates, times and owner associated with the
creation and modification of the knowledge base article
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Viewing Knowledge Base Article Properties
Use the Definitions—Knowledge Base Articles view to access the properties of the knowledge base
article.
Step 1

On the Definitions—Knowledge Base Article view, highlight the appropriate knowledge base article,
and use one of the following methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.

Note

Step 2

The property pages may display as display-only if the knowledge base article is shipped as part of the
project or the user does not have the appropriate rights.
Review the properties and click OK to close the dialog box.
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Creating a Knowledge Base Article
Knowledge base articles provide information to help understand the results of an activity, including a
summary of what has occurred, the possible cause of the result, and suggested actions to take to resolve
issues with an activity.
TEO ships with pre-defined knowledge base articles or you can create your own knowledge base articles
to associate with activities in the process.
To create a knowledge base article
Step 1

On the Definitions—Knowledge Base view, right-click and choose New > Knowledge Base.
The New Knowledge Base Properties dialog box displays.
Figure 17-2

Step 2

New Knowledge Base Properties—General Tab

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the knowledge base article

Type

Display-only. Type of object

Owner

The owner of the knowledge base article. This is typically
the creator of the knowledge base article.
Click Browse to launch the Select User or Group dialog
box and change the owner.

Description

Brief description of the knowledge base article
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Step 3

Click the Knowledge Base tab to continue.
Figure 17-3

Step 4

New Knowledge Base Properties—Knowledge Base Tab

On the Knowledge Base tab, enter the following knowledge base content. Enter as much information as
possible to expedite the resolution.
Field

Description

Summary

A concise description of the issue

Possible cause

An explanation of the condition that may be causing the
issue. You may enter multiple possible causes so that all
possibilities are investigated

Possible resolution

List of actions that can be performed to attempt to resolve
the issue manually

Related information

Additional information that may be relevant to the issue

Step 5

Click the Used By tab to display the objects which reference the knowledge base article. This tab will
remain blank until the knowledge base article is used by an object.

Step 6

Click the History tab to display the history of actions taken against the knowledge base article. This tab
remains blank until after the initial target creation.

Step 7

Click OK to close the dialog box.
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Managing Knowledge Base Articles
This section provides steps on how to modify the knowledge base article.

Modifying a Knowledge Base Article
Users can modify the properties of a knowledge base article from the Definitions—Knowledge Base
Articles view as well as in the Process Editor. When you modify a knowledge base article, the changes
made will be updated in all activities that use the knowledge base article.
To modify a knowledge base article
Step 1

On the Definitions—Knowledge Base view, highlight the appropriate knowledge base article, right-click
and choose Properties.
The Knowledge Base Properties dialog box displays.

Note

Certain features of the property pages may display as display-only if the knowledge base article is
shipped as part of the product or the user does not have the appropriate rights.

Step 2

Modify the information on the knowledge base property tabs, as necessary.

Step 3

Click OK to close the dialog box and complete the procedure.

Creating a Copy of a Knowledge Base Article
The copy option is used when there is an existing knowledge base article that contains properties that
can be used for defining a new knowledge base article without creating a completely new entry.
To create a copy of a knowledge base article:
Step 1

On the Definitions—Knowledge Base Articles view, highlight the appropriate knowledge base article,
right-click and choose Copy.

Step 2

On the Definitions—Knowledge Base Articles view, right-click and choose Paste.
A copy of the defined knowledge base article is pasted into the Results pane.

Step 3

Modify the knowledge base article properties, as appropriate, and click OK to close the dialog box.
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Deleting a Knowledge Base Article
Use the Definitions—Knowledge Base Articles view to delete knowledge base articles that are no longer
used.
Step 1

On the Definitions—Knowledge Base Articles, highlight the appropriate knowledge base article,
right-click and choose Delete.
The Confirm Knowledge Base Article Delete dialog box displays.
Figure 17-4

Step 2

Confirm Delete Dialog Box

Click Yes to delete the knowledge base article.

Viewing Used By Properties
Use the Used By tab to display the objects that directly reference the selected knowledge base article in
their configuration. Because the Used By tab displays objects in a tree view, users can also display the
objects which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Definitions—Knowledge Base Articles view, highlight the appropriate knowledge base article,
right-click and choose Properties.
The [Knowledge Base Article] Properties dialog box displays.

Step 2

Click the Used By tab to view the objects referenced by the knowledge base article.
Object

Description

Display name

Name of the object

Type

Type of object
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Step 3

To view information about an object, highlight the object, right-click and choose Properties.
The dialog box displays the properties of the object.

Step 4

Click OK to close the dialog box.

Viewing Knowledge Base Article History
Use the History tab to view a history of changes that have been made to the knowledge base article.
To view knowledge base article history:
Step 1

On the Definitions—Knowledge Base Articles view, highlight the appropriate knowledge base article,
right-click and choose Properties.
The [Knowledge Base Articles] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the knowledge base articles.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action

Type

The action that occurred

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Categories
The Categories feature provides a way to organize your processes based on your organizational or
functional requirements. Tidal Enterprise Orchestrator ships with pre-defined categories but provides the
functionality for you to create your own business specific categories. When creating a process, you can
assign the process to a category. You can also add other categories to a category to create a hierarchy.
The following sections provide instructions on managing categories in TEO:
•

Definitions—Categories Overview, page 18-2

•

Creating Categories, page 18-4

•

Managing Category Definitions, page 18-6
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Definitions—Categories Overview
Use the Definitions—Categories view to display the defined categories. This section is used to provide
instructions on how to access category information.

Accessing Definitions—Categories
To access the categories views:
On the Definitions pane, choose Categories.
The Results pane displays.
Figure 18-1

Definitions—Categories View

Information about each category can be displayed in the following columns:
Column

Description

Display Name

The name assigned to the category

Type

The type of category

Owner

The user name of the person who created the category

Last Modified Time

The time the category was last modified

Last Modified By

The user name of the person who last modified the category

Id

The unique identification number of the category definition
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Column

Description

Description

A brief overview of what the category contains

Type Description

A brief description of the type associated with the category

Created Time

The time the category was created

Created By

The user name of the person who created the category

Automation Pack

Name of the automation pack

Categories Actions Menu and Toolbar
The Categories Actions menu and toolbar provide the option to create new categories to which processes
are assigned. The New option is also available by right-clicking Categories on the Definitions
workspace.

Categories Details Pane
The Categories Details pane displays additional information about the selected category. The hyperlinks
on each of the detail pages launch the property page for the selected category.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the selected
category

Attributes

Displays the dates, times and process owner associated
with the creation and modification of the category
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Creating Categories
Categories can be used to organize your processes based on your business-specific requirements. Use
the Definitions—Categories view to create a new category and add members to the category. Users can
also add members to a category when defining a process.
For additional information on defining a process, see Authoring Processes, page 7-1.
To create a category:
Step 1

In the Definitions—Categories view, right-click and choose New > Category.
The New Category Properties dialog box displays.
Figure 18-2

Step 2

New Category Properties—General Tab

On the General tab, enter the following information, as necessary:
Field

Description

Display name

Name of the category

Type

Display-only. Type of object

Owner

The owner of the object. This is typically the creator of the
object.
Click Browse to launch the Select User or Group dialog
box and change the owner.

Description

Brief description of the category
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Step 3

Click the Members tab to continue.
Figure 18-3

Step 4

New Category Properties Dialog—Members Tab

On the Members tab, review the existing category members.
Field

Description

Display Name

The name of the object that is the member of the category

Type

Display-only. Type of object (Process or Category)

Description

Brief description of the object

Step 5

To add members or processes to the category, click Add. See Adding Objects to a Category, page 18-6.

Step 6

To remove a member from the category, click Remove. See Removing Members from the Category,
page 18-7.

Step 7

Click the Used By tab to display the objects which reference the category. This tab will remain blank
until the category is used by an object.

Step 8

Click the History tab to view the history of actions taken against the category.

Step 9

Click OK to close the dialog box.

Viewing Process Properties from Members Tab
The properties for the process added to the Members tab can be viewed in a separate dialog box
depending on the process type. If the user does not have the proper rights, then a display-only viewer is
displayed. If viewing a user-defined process, and the user has the appropriate permissions, then the
properties display in the Process Editor.
To view process properties:
Click the Members tab, highlight the appropriate process, right-click and choose Properties.
•

If the user does not have the proper rights, the process viewer displays.

•

If the user has proper rights, the Process Editor displays.
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Managing Category Definitions
Users can view the category properties and modify a category using the Category Properties dialog box.
Use the Definitions—Categories view in the console to manage the categories, including:
•

Modifying categories

•

Viewing history of when the category has been modified

•

Deleting categories

Modifying Category Properties
To modify category:
Step 1

On the Definitions—Categories view, highlight the appropriate category, right-click and choose
Properties.
The Category Properties dialog box displays.

Step 2

On the General tab, modify the name of the category and description, as necessary.

Step 3

On the Members tab, modify the list of categories and processes, as necessary.

Step 4

Click OK to complete.

Adding Objects to a Category
Use the Objects Available for Category Membership dialog box to choose the objects to be included as
members of a category. Both processes and categories can be included as members of a category.
To add a member to the category:
Step 1

On the Members tab, click Add.
The Objects available for category membership dialog box displays the objects available for the
category.
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Figure 18-4

Step 2

Objects Available for Category Membership Dialog Box

Use one of the following methods when selecting objects:
•

If the appropriate objects are listed under Select Category Members, choose the appropriate
categories or processes to be included in the category, and click OK.

Note

To choose multiple items, press and hold CTRL while selecting the items in the list.

•

If the appropriate objects are not listed, click one of the following to create a new object, and click
OK:
– New > Categories—Define the properties of a new category
– New > Processes—Define the properties of a new process.

The new object displays in the Select Category Members list. Highlight the new object and any
other objects, as necessary.
The selected items display on the Members tab.
Step 3

Click OK to close the dialog box and complete the procedure.

Removing Members from the Category
Use the following steps to remove an object from a category. Removing the object does not delete the
object from the system.
Step 1

Click the Members tab, choose the object to be removed from the category and click Remove.
The object is removed from the Members tab.

Step 2

Click OK to close the dialog box.
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Creating a Copy of a Category Definition
The copy option is used when there is an existing category that contains properties that can be used for
defining a new category without creating a completely new category.
To create a copy a category definition:
Step 1

On the Definitions—Categories view, highlight the appropriate category, right-click and choose Copy.

Step 2

On the Definitions—Categories view, right-click and choose Paste.
A copy of the defined category is pasted into the Results pane.

Step 3

To modify the copied category, right-click and choose Properties.

Step 4

Modify the properties, as appropriate, and click OK to close the dialog box.

Deleting Categories
Use the Definitions—Categories view to delete categories that are no longer used. Before deleting a
category, access the properties, and click the Used By tab to view where objects are being referenced by
the category. The category deletion process fails if the category is referenced by other objects.

Note

If the category definition is shipped as a part of product or the user does not have the appropriate rights,
the Delete option will be disabled.
To delete a category:

Step 1

On the Definitions—Categories view, highlight the appropriate category, and use one of the following
methods:
•

On the toolbar, click the Delete

tool.

-or•

Right-click and choose Delete.

The Confirm Category Delete dialog box displays.
Figure 18-5

Step 2

Confirm Category Delete Dialog Box

Click Yes to delete the category.
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Viewing Used By Properties
Use the Used By tab to display the objects that use the selected category in their configuration. Because
the Used By tab displays objects in a tree view, users can also display the objects which directly
reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view the objects that use a category:
Step 1

On the Definitions—Categories view, highlight the appropriate category, right-click and choose
Properties.
The [Categories] Properties dialog box displays.

Step 2

Step 3

Click the Used By tab to view the objects used by the category.
Object

Description

Display Name

Name of the object

Type

Type of object

To view information about an object, highlight the object, right-click and choose Properties.
The display-only dialog displays the properties of the object.

Step 4

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 5

Click OK to close the dialog.

Viewing Category History
Use the History tab to view a history of changes that have been made to the category. This tab displays
information about when the category was created or modified, and the audit log entries that are relevant
to the category.
Step 1

On the Definitions—Categories view, highlight the appropriate category, right-click and choose
Properties.
The [Category] Properties dialog displays.

Step 2

Click the History tab to view the changes made to the category.
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The following information about the history of the category is displayed:
Field

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog.
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Managing Task Rules
Task rules are used to manage task assignment and notifications for various customer-specific tasks. By
enforcing a task rule, one change can affect tasks created by multiple processes. By default, the ability
to create task rules is not applicable to everyone as only users with administrative rights can create task
rules from this view in TEO. The permission to create or modify a task rule on the Definitions—Task
Rules view is not available to all users. However, the security settings can change, if necessary, by the
TEO administrator.
The Definitions—Task Rules view displays all task rules have been configured to assign, notify, or
update tasks based on specific settings. The display can be filtered to display task rules by properties
such as, name, description, and automation pack. The user can determine which task rule view to display.
Refer to the following sections for information on managing task rules in the Definitions workspace:
•

Task Rules Overview, page 19-2

•

Creating an Assign Task Rule, page 19-5

•

Creating a Notify Task Rule, page 19-10

•

Creating an Update Task Rule, page 19-13

•

Managing Task Rule Definitions, page 19-16
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Task Rules Overview
The broad responsibilities of task rules are to streamline process creation and ease task administration
by providing a mechanism to perform routine activities on tasks, such as notification and assignments,
on newly-created tasks. Task rules are created and displayed in an ordered list on the Definitions—Task
Rules view. On this list, users can view default assignments, notifications, and properties to be updated
according to the following defined rule types:
Task Rules

Description

Assign Task Rule

Assigns users to the task
See Creating an Assign Task Rule, page 19-5.

Notify Task Rule

Adds an entry to the notification list of a task
See Creating a Notify Task Rule, page 19-10.

Update Task Rule

Specifies the properties to update in a task
See Creating an Update Task Rule, page 19-13.

Whenever a task is created, TEO goes through the settings and conditions of each task rule listed and
enabled. If the conditions and settings in the rule are satisfied, then the task rule is executed. Task rules
are executed according to the order in which they are displayed in the list.

Rule Triggers
Task rules can not be manually run by the user. Task rules can only execute after the Task Created trigger
logic is triggered and any conditions and settings in the rule are met. If the task created trigger, for any
task type, and rule conditions are met, then the action of the task rule is executed in the order in which
it is listed in the Definitions—Task Rules view.
Any processes that are triggered based on the Task Created trigger will only execute after the appropriate
task rules have executed.

Notifications
The notification concept of the task rule is that beyond notifications of when a user is assigned, often the
same or separate people need to be notified in response to a task. The task rule notification would
identify which person or group to notify and a process would email the notice.
Each task contains a list of notification recipients in addition to task assignees. The notification task rule
adds to this list of notification recipients. A process can react to a task create event or task change event
and then appropriately notify the notification recipients by email or any other mechanism.

Automation Pack Rule Management
Task rules can be included in automation packs in order to easily transfer default task rules from one
system to another, such as transferring task rules from a development system into a production system.
Task rules also allow users to manage tasks within the default TEO automation packs without modifying
the properties within the automation packs. Users can setup task rules to assign tasks, notify users or
groups, or update properties within a task, without changing the process in which the task resides.
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Some Cisco automation packs include default tasks and task activities within processes to manage alerts
and notifications. Users can create task rules to manage these objects without editing the process or task.

Accessing Definitions—Task Rules
The Definitions Task Rules view displays the defined task rules used for task assignments and
notifications.
To access the Task Rules view:
In the Definitions workspace, choose Task Rules > [Selected Task Rules View].
The Results pane displays.
Figure 19-1

Definitions Workspace—Task Rules

The selected view displays in the Results pane. The displayed columns depend on the selected task rule.
Information about the task rules display in the following columns:
Column

Description

Display Name

The name assigned to the task rule

Enabled

Indicates whether the task rule is enabled (True) or
disabled (False). A disabled task rule is unavailable for
execution.

Type

Type of task rule based on the associated adapter

Owner

User name of the person or group who assigned the task
rule
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Note

Column

Description

Last Modified Time

The date and time the contents were last modified

Last Modified By

The object or user name that last modified the contents

Id

Unique ID of the task rule

Description

Brief description of the task rule

Type Description

Brief overview of the task rule type

Created Time

Time at which the task rule was created

Created Date

User name of the person who created the task rule

Automation Pack

Name of the automation pack associated with the task rule

To add, remove, or sort column headings on the display, see Configuring Columns, page 1-29.

Viewing Task Rule Properties
To view task rule properties:
Step 1

On the Definitions—Task Rule Views, highlight the appropriate task rule, and use one of the following
methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.

Note

Step 2

The property pages may display as display-only if the task rule definition is shipped as part of the
product or the user does not have the appropriate rights.
Review the properties and click OK to close the dialog box.
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Creating an Assign Task Rule
Use the Assign Task Rule to specify the users to be assigned to the task after the task rule has executed.
To create an assign task rule:
Step 1

On the Definitions—Task Rules view, use one of the following methods:
•

On the toolbar, choose New > [Assign Task Rule].
-or-

•

From the Actions menu, choose New > [Assign Task Rule].

The New Assign Task Rule Properties dialog box displays.
Figure 19-2

Step 2

New Assign Task Rule Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Type

Display only. Shows the type of object

Trigger

Display only. Type of trigger associated with the task
rule

Owner

User name of the owner of the task rule. This is
typically the person who created the task rule.
Click Browse to launch the Select User or Group
dialog box to change the owner.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

19-5

Chapter 19

Managing Task Rules

Creating an Assign Task Rule

Field

Description

Description

A brief description of the task rule

Enabled

The check box is checked by default. The checked box
indicates the task rule is available for execution.
Uncheck the check box to disable the task rule. If the
check box is unchecked, the object is disabled and
will be unavailable for execution.

Step 3

Click the Task Types to continue.
Figure 19-3

Step 4

New Assign Task Rule Properties Dialog Box—Task Types Tab

Click the Task Types tab to select the task types to be executed by the rule.
Task Type

Description

Alert

Alerts reflect potential problems that a user may want
to investigate and possibly diagnose the problem

Approval Request

Specifies the message and choices for the assignee
who is approving the task

Guided Operation

Details the steps a user takes to complete an assigned
task

Incident

Task requires an operator to take action in order to
resolve an issue

Input Request

Task requires input from an individual or group

Review

Task assigns a document for review

Step 5

To add or remove a task type from the rule, check the check box to the left of the task type.

Step 6

Click the Conditions tab to continue.

Cisco Tidal Enterprise Orchestrator Reference Guide

19-6

OL-24928-01

Chapter 19

Managing Task Rules
Creating an Assign Task Rule

Note

The Required Value
a value.
Figure 19-4

icon displayed on a tab or page indicates that the field is required and is missing

New Rule Properties Dialog Box—Conditions Tab

Note

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.

Step 7

On the Conditions tab, click the appropriate panel to indicate the type of condition equation to be used
to trigger the task rule.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.
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Panel

Description

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.

Note
Step 8

For additional information on creating a condition, see Chapter 10, “Managing Conditions.”
Click the Assign tab to continue.
Figure 19-5

New Rule Properties Dialog Box—Assign Tab
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Step 9

On the Assign tab, specify the assignees for task rule.
Field

Description

Add

Click this button to launch the Select Assignee to Add
dialog box to specify the assignees.
On the Select Assignee to Add dialog box, to right of
the Assignee field, use one of the following methods:
•

Click the Reference tool to select the appropriate
variable reference containing the assignee or list
of assignees from the Insert Variable Reference
dialog box.
-or-

•

Step 10

Step 11

Click Browse to launch the Select User or Group
dialog box to add user to the list of assignees.

Edit

Highlight the appropriate assignee in the list and click
this button to view or modify the assignee of the task
rule.

Remove

Highlight the appropriate assignee and click this
button to remove the assignee from the list.

Remove All

Click this button to remove all specified assignees
from the list.

Click the History tab to display the history of actions taken against the task rule. This tab remains blank
until after the initial task rule creation.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Click OK to close the dialog box.
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Creating a Notify Task Rule
Use the Notify Task Rule to specify the recipients to be notified after the task rule is executed.
To create a notify task rule:
Step 1

On the Definitions—Task Rules, use one of the following methods:
•

On the toolbar, choose New > Notify Task Rule.
-or-

•

From the Actions menu, choose New > Notify Task Rule.

The New Task Rule Properties dialog box displays.
Figure 19-6

Step 2

New Task Rule Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Type

Display only. Shows the type of object

Trigger

Display only. Type of trigger associated with the task
rule

Owner

User name of the owner of the task rule. This is
typically the person who created the task rule.
Click Browse to launch the Select User or Group
dialog box to change the owner.
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Field

Description

Description

A brief description of the task rule

Enabled

The check box is checked by default. The checked box
indicates the task rule is available for execution.
Uncheck the check box to disable the task rule. If the
check box is unchecked, the object is disabled and
will be unavailable for execution.

Step 3

Click the Notify tab to continue.
Figure 19-7

Step 4

New Task Rule Properties—Notify Tab

On the Notify tab, modify the recipients to be notified after the task rule has executed.
Field

Description

Add specified recipients

Displays list of users to be notified by the task rule
•

Add—Click this button to launch the Select
Notification to Add dialog box to specify the
assignees.
On the dialog box, click the Reference tool to
select the appropriate variable reference
containing the assignee or list of assignees from
the Insert Variable Reference dialog box.

•

Edit—Highlight the appropriate recipient in the
list and click this button to view or modify the
recipient of the task rule.

•

Remove—Highlight the appropriate recipient in
the list and click this button to remove the
recipient from the list.

•

Remove All—Click this button to remove all
specified recipients from the list.
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Step 5

Field

Description

Add notification recipient list

Click the Reference tool to select the appropriate
variable reference containing list of recipients from the
Insert Variable Reference dialog box.

Complete the appropriate information in the following tabs, as necessary, and then click the OK tool to
complete the task rule definition.
•

Task Type—Click the tab to select the task types to be executed by the rule. See Step 4 in Creating
an Assign Task Rule, page 19-5.

•

Conditions—Click the tab to specify the conditions on when the task rule action should be taken.
See Step 7 in Creating an Assign Task Rule, page 19-5.

•

History—Click the tab to display the history of actions taken against the task rule.
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Creating an Update Task Rule
Use the Update Task Rule to specify properties to be updated on the task after the task rule has executed.
To create an Update Task Rule:
Step 1

On the Definitions—Task Rules, use one of the following methods:
•

On the toolbar, choose New > Update Task Rule.
-or-

•

From the Actions menu, choose New > Update Task Rule.

The New Update Task Rule Properties dialog box displays.
Figure 19-8

Step 2

New Update Task Rule Properties Dialog Box—General Tab

On the General tab, enter the following information:
Field

Description

Display Name

Name of the task

Type

Display only. Shows the type of object

Trigger

Display only. Type of trigger associated with the task
rule

Owner

User name of the owner of the task rule. This is
typically the person who created the task rule.
Click Browse to launch the Select User or Group
dialog box to change the owner.
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Field

Description

Description

A brief description of the task rule

Enabled

The check box is checked by default. The checked box
indicates the task rule is available for execution.
Uncheck the check box to disable the task rule. If the
check box is unchecked, the object is disabled and
will be unavailable for execution.

Step 3

Note

Click the Update tab to continue.

The Required Value
a value.
Figure 19-9

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

New Update Task Rule Properties—Update Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Update tab, specify the properties to be updated after the task rule has executed.
Field

Description

Add

Click this button to add a new Property drop-down list to
the Properties to Update section.

Remove

Click this button to remove the last property added to the
Properties to Update section.
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Field

Description

Properties to update

From the Property drop-down list, choose the item to
update within the task. The properties displayed depend on
the selected item.
Note

List action

Value
Step 5

For additional information on the properties in the
list, see Common Task Properties, page 4-4.

Select the appropriate item from the drop-down list to
determine which action to take with the selected property.
•

Add Item—Adds item to task

•

Remove item—Removes item from task.

•

Clear—Removes property value from task

Enter new value for the property

Complete the appropriate information in the following tabs, as necessary, and then click the OK tool to
complete the task rule definition.
•

Task Type—Click the tab to select the task types to be executed by the rule. See Step 4 in Creating
an Assign Task Rule, page 19-5.

•

Conditions—Click the tab to specify the conditions on when the task rule action should be taken.
See Step 7 in Creating an Assign Task Rule, page 19-5.

•

History—Click the tab to display the history of actions taken against the task rule.
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Managing Task Rule Definitions
The ability to modify task rules is not applicable to everyone as only users with administrative rights can
update task rules from the Definitions—Task Rules view in Tidal Enterprise Orchestrator. However, the
security settings can change, if necessary, by the TEO administrator.
This section provides instructions on modifying task rules in the Definitions—Task Rule view.

Enabling a Task Rule
A task rule is enabled by default. If a task rule is manually disabled, the task rule must be enabled before
it is available for execution.
To enable a task rule:
On the Definitions—Task Rules view, highlight the task rule, and then use one of the following methods:
•

On the Results pane, right-click and choose Enable.
-or-

•

On the Details pane, select Click here to enable.

The Enabled column on the Results pane changes to True. If necessary, click the Refresh tool to update
the view.

Disabling a Task Rule
Disabling a task rule prevents the item from being available for execution. The disabled task rule is not
removed from the list of task rules on the Definitions—Task Rules Results pane.
To disable a task rule:
On the Definitions—Task Rule view, highlight the task rule, and then use one of the following methods:
•

On the Results pane, right-click and choose Disable.
-or-

•

On the Details pane, select Click here to disable.

The Enabled column on the results pane changes to False. If necessary, click the Refresh tool to update
the view.
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Creating a Copy of a Task Rule
The copy option is used when the user wants to leverage an existing task rule to define a new task rule
using existing properties. This option may not be available for task rules imported in the default product
automation packs.
To create a copy a task rule:
Step 1

On the Definitions—Task Rules view, highlight the appropriate task rule, right-click and choose Copy.

Step 2

On the Results pane, right-click and choose Paste.
A copy of the defined task rule is pasted onto the Results pane.

Step 3

To rename the copied task rule or other properties, right-click and choose Properties.

Step 4

Modify the task rule name, as appropriate, and click OK to close the dialog box.

Adding Conditions to a Task Rule
To add a condition to a task rule:
Step 1

On the Definitions—Task Rule view, use one of the following methods:
•

On the toolbar, choose New > [Task Rule].
-or-

•

Highlight an existing task rule, right-click and select Properties.

The appropriate task rule dialog box displays.
Step 2

Click the Conditions tab.
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Step 3

To add a specific condition, click the appropriate panel.
Panel

Description

Basic

Creates simple conditions using variables to match to
operator criteria.
See Adding Basic Conditions to an Object, page 10-4.

Advanced

Creates a TEO-based condition.
•

Compound Condition—Compiles other conditions
(time condition, prior process instance condition,
variable condition, or another compound condition)
into a single condition. The Compound Condition is
created by the addition of another True/False option in
the Advanced Panel.

•

Prior Process Instance Condition—Determines that
when a process has occurred within a specific time
interval, the condition will evaluate to false. If no
process instance is selected, then the trigger will
search for all process instances.

•

Time Condition—Specify a condition based on a
defined calendar.

•

Variable Condition—Specify a variable to be used as
the condition under which the variable should evaluate
as true.

See Adding Advanced Conditions to an Object, page 10-6.
Step 4

Click OK to close the dialog box.

Removing Conditions from Task Rule
Use the following steps to remove a condition from a task rule.
To remove a condition:
Step 1

On the Definitions—Task Rules views, highlight the appropriate task, right-click and choose Properties.
The [Task Rule] Properties dialog box displays.

Step 2

On the Conditions tab, click the appropriate category, and then click Delete.
The Delete button removes the condition from the task rule.

Cisco Tidal Enterprise Orchestrator Reference Guide

19-18

OL-24928-01

Chapter 19

Managing Task Rules
Managing Task Rule Definitions

Adding Task Properties to an Update Task Rule
Use the following steps to add task properties to update after the task rule is executed.
To add a task property:
Step 1

On the Definitions—Task Rules views, highlight the appropriate task, right-click and choose Properties.
The [Task Rule] Properties dialog box displays.

Step 2

On the Update tab, click Add to add a new Property drop-down list to the Properties to Update section.

Step 3

From the Property drop-down list, select the item to update within the task. The properties displayed
depend on the selected item.

Note
Step 4

For additional information on the properties in the list, see Common Task Properties, page 4-4.
Complete the following fields, as necessary.
Field

Description

List action

Select the appropriate item from the drop-down list to
determine which action to take with the selected property.

Value
Step 5

•

Add Item—Adds item to task

•

Remove item—Removes item from task.

•

Clear—Removes value from task

Enter new value for the property

When completed selecting the categories, click OK to close the dialog box.

Removing Task Properties from a Task Rule
The Remove button removes the last property added to the list. For example, the user cannot remove
Property 4 without removing Property 5 from the list.
If the user wants to keep Property 5, then update Property 4 with the information from Property 5, and
then click Remove to remove Property 5 from the list.
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Modifying the Assignees in Assign Task Rule
Use the following steps to modify the list of assignees in a configured task rule.
To modify an Assign task rule:
Step 1

On the Definitions—Task Rules views, highlight the appropriate task, right-click and choose Properties.
The [Task Rule] Properties dialog box displays.

Step 2

Click the Assign tab to modify the assignees for the task rule.
Field

Description

Add

Click this button to launch the Select Assignee to Add
dialog box to specify the assignees.
On the Select Assignee to Add dialog box, to right of
the Assignee field, use one of the following methods:
•

Click the Reference tool to select the appropriate
variable reference containing the assignee or list
of assignees from the Insert Variable Reference
dialog box.
-or-

•

Step 3

Click Browse to launch the Select User or Group
dialog box to add user to the list of assignees.

Edit

Highlight the appropriate assignee in the list and click
this button to view or modify the assignee of the task
rule.

Remove

Highlight the appropriate assignee and click this
button to remove the assignee from the list.

Remove All

Click this button to remove all specified assignees
from the list.

Click OK to close the dialog box.
The modified task rule displays in the list of task rules on the Definitions—Task Rules view.
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Modifying the Recipients in Notify Task Rule
Use the following steps to modify the recipients to be notified during the after the task rule execution.
To modify a Notify task rule:
Step 1

On the Definitions—Task Rules view, highlight the appropriate task, right-click and choose Properties.
The [Task Rule] Properties dialog box displays.

Step 2

Click the Notify tab to modify the recipients for the task rule.
Field

Description

Add specified recipients

Displays list of users to be notified by the task rule
•

Add—Click this button to launch the Select
Notification to Add dialog box to specify the
assignees.
On the dialog box, click the Reference tool to
select the appropriate variable reference
containing the assignee or list of assignees from
the Insert Variable Reference dialog box.

Add notification recipient list

Step 3

•

Edit—Highlight the appropriate recipient in the
list and click this button to view or modify the
recipient of the task rule.

•

Remove—Highlight the appropriate recipient in
the list and click this button to remove the
recipient from the list.

•

Remove All—Click this button to remove all
specified recipients from the list.

Click the Reference tool to select the appropriate
variable reference containing list of recipients from the
Insert Variable Reference dialog box.

Click OK to close the dialog box.
The modified task rule displays in the list of task rules on the Definitions—Task Rules view.

Modifying Task Types in Task Rule
Use the following steps to modify the list of task types affected by the task rule.
To modify the list of task types:
Step 1

On the Definitions—Task Rules view, highlight the appropriate task rule, right-click, and choose
Properties.
The [Task Rule] Properties dialog box displays.

Step 2

Click the Task Type tab and then use one of the following methods:
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Step 3

•

To add a task type to the list, check the check box to the left of the appropriate task type.

•

To remove a task type from the list, uncheck the check box to the left of the appropriate task type.

•

To include all the task types into the task rule, click Select All.

•

To exclude all the task types, click Unselect All.

Click OK to close the dialog box.

Sorting the Task Rules
The task rules are executed according to the order they are listed on the Definitions—Task Rules view.
To sort the task rules
On the Definitions—Task Rules view, highlight the appropriate task rule, and use one of the following
methods:
•

Drag and drop the task rule into the appropriate position in the list.

•

On the Actions toolbar, choose Move Up or Move Down.

•

From the Actions menu, select Move Up or Move Down.

•

Right-click and choose Move Up or Move Down.

The list of task rules are sorted according to the selected action.

Deleting a Task Rule
Use the Definitions—Task Rules view to delete task rules that are no longer used.
Before deleting a task rule, access the properties, and click the Used By tab to view where objects are
being referenced by the task rule. This ensures that deleting the task rule does not affect any processes
or activities.
To delete a task rule:
Step 1

On the Definitions—Task Rules view, highlight the appropriate task, right-click and choose Delete.
The Confirm Delete dialog box displays.

Step 2

Click Yes to confirm.
The task is deleted from the system.
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Viewing Task Rules History
Use the History tab to view a history of changes that have been made to the task rule.
To view task rule history:
Step 1

On the Definitions—Task Rules view, highlight the appropriate task rule, right-click and choose
Properties.
The [Task Rule] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the task rule.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Administration Workspace
The Administration workspace is used to perform administrative tasks within the product, including:
•

Configuring security groups to have access to certain objects within the product

•

Enabling time zones to be used when configuring processes

•

Managing the adapters that are installed in the product

•

Creating and managing the report database, and running reports

The following sections guide you through accessing the Administration workspace and using the
features in this view.
•

Administration—Getting Started, page 20-2

•

Navigation Menu, page 20-3

•

Administration—Time Zones, page 20-5

•

Administration—Adapters, page 20-8

•

Administration—Database Settings, page 20-13

•

Collecting TEO Diagnostics, page 20-19
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Administration—Getting Started
The Administration—Getting Started view is the default view upon the initial access to the
Administration pane.
Figure 20-1

Administration—Getting Started

The following administrative tasks are available:
Options

Description

View Security

Launches the Administration—Security view to display the
rules that ship with the product

Create or Modify the IT Service
Database

Launches the Administration—Database Settings view
where you can view reports, create or modify the report
database
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Viewing TEO Ports
Use the following steps to display all ports that are open on the TEO server.
On the Administration—Getting Started toolbar, click View Ports.
The Tidal Enterprise Orchestrator Server Ports dialog box displays.
Figure 20-2

Tidal Enterprise Orchestrator Server Ports Dialog Box

The following information is displayed on the dialog box:
Column

Description

Port Number

Port number of the internet protocol

Protocol

Internet protocol for transferring data (HTTP, SMTP)

Listener

Port listener

Navigation Menu
The Administration workspace contains navigation items that perform the various tasks that are available
for the user.
The Administration Results pane contains the following column headings.
Navigation Item

Function

Security

The Administration—Security view displays the security
rules that are shipped with the product and/or defined by the
user.
For additional information on managing security rules, see
Chapter 21, “Configuring TEO Security.”

Time Zones

The Administration—Time Zones view to displays the time
zones that ship with the product.
For additional information on viewing the time, see
Administration—Time Zones, page 20-5.

Adapters

The Administration—Adapters view displays the adapters
that are installed with the product and their associated
objects.
For additional information on viewing adapter properties,
see Administration—Adapters, page 20-8.
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Navigation Item

Function

Database Settings

The Administration—Database Settings view displays the
reporting and processes databases associated with TEO.
For additional information on managing the TEO databases,
see Administration—Database Settings, page 20-13.

Automation Packs

The Administration—Automation Pack view displays the list
of automation packs that are currently in TEO.
For additional information on managing automation packs,
see Chapter 22, “Managing Automation Packs.”
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Administration—Time Zones
Use the Administration—Time Zones view to displays the time zones that ship with the product. The
time zones are used when specifying a schedule trigger for a process. The time zones cannot be modified.
However, you can add a description to the time zone properties and enable or disable the time zones. If
a time zone is disabled, it will not be available for selection when defining schedule properties.

Accessing Administration—Time Zones
When the Administration—Time Zones view is selected, the time zones display in the Results pane.
To access the Time Zone view:
On the Administration workspace, choose Time Zones.
The Results pane displays.
Figure 20-3

Administration—Time Zones View

The following information can be displayed for each time zone:
Column

Description

Display Name

Greenwich Mean Time (GMT) name for the time zone and
the location where the time zone is in effect

Type

Object type

Time

Current date and time in the local time zone

Id

Unique ID of the time zone
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Column

Description

Enabled

Indicates whether the time zone is enabled (True) or
disabled (False). If the time zone is disabled, it is not
available for selection when creating a schedule trigger for
a process.

Description

Brief description of the time zone

Owner

Owner of the time zone definition. This is typically the
creator of the definition.

Type Description

Brief overview of the type associated with the time zone
definition

Created Time

Time the time zone was created

Created By

User name of the person or who created the time zone
definition

Last Modified Time

The time the time zone definition was last modified

Last Modified By

The user name of the person who last modified the time
zone definition

Time Zone Details Pane
The Time Zone Details pane displays additional information about the selected item. The hyperlinks on
each of the detail pages launch the property pages for the selected time zone.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the time zone, and
the ability to enable or disable a time zone.

Attributes

Displays the dates, times and process owner associated
with the creation and modification of the time zone.

Enabling a Time Zone
A time zone is enabled by default. If a time zone is manually disabled, the time zone must be enabled
before it is available for execution.
To enable a time zone:
On the Administration—Time Zone view, highlight the time zone, and then use one of the following
methods:
•

On the Results pane, right-click and choose Enable.
-or-

•

On the Details pane, choose the Click here to enable option.

The Enabled column on the Results pane changes to True. If necessary, click the Refresh
update the view.

tool to
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Disabling a Time Zone
Disabling a time zone prevents the item from being available for execution. The disabled time zone is
not removed from the list of time zones in the in the Administration—Time Zones Results pane.
To disable a time zone:
On the Administration—Time Zones view, highlight the time zone, and then use one of the following
methods:
•

On the Results pane, right-click and choose Disable.
-or-

•

On the Details pane, choose the Click here to disable option.

The Enabled column on the Results pane changes to False. If necessary, click the Refresh tool to update
the view.

Viewing Time Zone Properties
You can view the properties of a specific time zone using the Time Zone Properties dialog box. From
this dialog box, you can enter a description for the time zone and enable or disable the time zone. Click
the Used By tab to display the processes or schedule definitions that reference the time zone.
Use the following steps to view the properties of each security rule.
Step 1

On the Administration—Time Zones view, highlight the appropriate time zone, and use one of the
following methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Time Zone Properties dialog box displays.
Step 2

Review or modify the properties and click OK to close the dialog box.
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Administration—Adapters
The Administration—Adapters view contains the adapters that are installed with the product and their
associated objects. For example, the Windows adapter displays the objects that are provided with the
adapter, such as the Windows computer target, Windows runtime user, and Windows-related activities.

The primary adapter for Tidal Enterprise Orchestrator is the Core Function Adapter. This adapter
provides the core features and objects to be used to manage IT processes. For information on configuring
the Core Functions adapter, see the Appendix A, “Managing Core Activities.”

Accessing Administration—Adapters View
When the Administration—Adapters in the Navigation pane is selected, the adapters that are installed
display in the Results pane. From this view, general information about the functionality provided by the
adapter, version number, release date and install date is displayed.
To access the Administration—Adapters view
On the Administration workspace, choose Adapters.
The Results pane displays.
Figure 20-4

Administration—Adapters View
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The following information displays for each adapter:
Column

Description

Display Name

Name of the adapter

Enabled

Indicates whether an adapter is enabled (True) or disabled
(False). If an adapter is disabled, its functionality is not
available in the product.

Prerequisites

Displays whether the prerequisites for the adapter for the
adapter are installed

Version

Version number of the adapter

Install Date

Date and time the adapter was installed

Release Date

Date the adapter is available in the product

Description

Brief overview of the functionality provided by the adapter

TEO Adapters
The following are a list of available adapters.
Adapter

Description

Active Directory Adapter

Provides access to Active Directory groups, containers and
organizational units.
See the Active Directory Adapter Guide

Cisco UCS Manager Adapter

Provides activities to automate Cisco Unified Computing
System Manager tasks.
See the Cisco UCS Manager Adapter Guide.

Core Functions Adapter

Provides core functionality that is required by the
Automation Server.
See the Appendix A, “Managing Core Activities.”

DB2 Database Adapter

Provides activities to access DB2 database objects and
execute SQL queries.
See the DB2 Database Adapter Guide.

Email Adapter

Provides support for sending email via SMTP and
receiving email via POP3 and IMAP email accounts.
See the Email Adapter Guide.

Generic (OLEDB) Adapter

Provides activities to access database objects and execute
SQL queries.
See the Generic Database Adapter Guide.

OLAP Database Adapter

Provides activities to access OLAP database cubes and
execute MDX queries.
See the OLAP Database Adapter Guide.

Oracle Database Adapter

Provides activities to access Oracle database objects and
execute SQL queries.
See the Oracle Database Adapter Guide.
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Adapter

Description

Remedy Adapter

Provides activities for creating, querying, and updating
Remedy incidents.
See the Remedy Adapter Guide.

SAP ABAP Adapter

Provides activities to access SAP monitoring objects and
execute SAP ABAP functions.
For more information, refer to the SAP ABAP Adapter
Guide.

SAP Java Adapter

Provides activities to access SAP monitoring objects and
execute SAP Java functions.
See the SAP Java Adapter Guide.

SCOM 2007 Adapter

Provides access to alerts and performance counters in
SCOM 2007.
See the SCOM 2007 Adapter Guide.

SNMP Adapter

Provides access to SNMP alerts and performance metrics.
See the SNMP Adapter Guide.

SQL Server Database Adapter

Provides activities to access SQL Server database objects
and execute SQL queries.
See the SQL Server Database Adapter Guide.

Terminal Adapter

Provides support for executing commands and scripts using
SSH and Telnet connections.
See the Terminal Adapter Guide.

VMware Adapter

Provides users with activities to connect a virtual
infrastructure and automate the process of managing their
virtual machines and hosts.
See the VMware Adapter Guide.

Web Service Adapter

Provides activities to execute Web Services.
See the Web Service Adapter Guide.

Windows Adapter

Provides access to Windows activities and objects.
See the Windows Server Adapter Guide.
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Viewing Adapter Properties
Use the adapter-specific properties dialog box to view the properties of the selected adapter, including
the specific functions the adapter provides and the history of changes made to the adapter. The property
dialog box for each adapter varies. This section provides brief information about the properties for each
adapter. The displayed adapters are determined by the product license.
To view adapter properties:
Step 1

On the Administration—Adapters view, highlight the appropriate adapter, and use one of the following
methods:
•

Right-click and choose Properties.
-or-

•

On the Details pane, click the hyperlink name on any of the tabs.

The Properties dialog box displays.
The General tab displays the following information about the adapter:

Step 2

Field

Description

Display Name

Name of the adapter

Type

Object type

Description

Brief overview of the adapter

Company

Name of company that created or supplied the adapter

Version

Version number of the adapter

Release date

Date and time the adapter was available in the product

Install date

Date and time the adapter was installed

Review the properties and click OK to close the dialog box.

Viewing Adapter-Supported Objects
Use the Provides tab to view the name and type of component for each item the adapter supports.
To view adapter-provided objects:
Step 1

On the Administration—Adapters view, highlight the appropriate adapter, right-click and choose
Properties.
The Properties dialog box displays.

Step 2

Click the Provides tab to view the functionality that is provided by the adapter.
Column

Description

Name

Name of activities, processes, and objects for which the
adapter provides support

Type

Type of object provided by the adapter
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Step 3

Review the list of objects and click OK to close the dialog box.

Viewing Adapter History
Use the History tab to view a history of changes that have been made to the adapter.
Step 1

On the Administration—Adapters view, highlight the appropriate adapter, right-click and choose
Properties.
The Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the adapter.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Administration—Database Settings
The Administration—Database Settings view is used for creating and managing the database
connections included in the product. The automation database and reporting database is displayed by
default.
•

Database Settings—Contains the database grooming settings properties for the processes database.
Refer to the following sections on configuring the automation master database properties.

•

Report Database—Allows users to view and manage the report database connection, and viewing
audit process changes.

When selected, the user can import reports, view database properties, and delete the database from the
product.
To view the database properties, highlight the appropriate database, right-click and choose Properties
to view the database properties.

Accessing the Administration—Database Settings
Use the following settings to options that reside in the Administration—Database Settings view.
On the Administration workspace, choose Database Settings.
The Results pane displays.
Figure 20-5

Administration—Database Settings View
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The following are the default databases:
Database

Description

Process Database

TEO Processes Database displays the properties for the
TEO performance database.
For information on configuring the grooming settings of
the process database, see Configuring Process Database
Properties, page 20-14.

Report Database

TEO Reporting database generates reports for viewing
process execution history and to audit process changes.
Note

You must be logged in with an account that has
administrator privileges on the machine where the
report database is being created, whether it is the
local machine or a remote machine. The user
account must also have Reporting Services
privileges to create or modify the reports.

For more information on managing reports, see Chapter 23,
“Configuring Reports.”
The following information displays for each database:
Column

Description

Display name

Name of the database

Description

Brief description of the database

Configuring Process Database Properties
The Process Database is created during the installation process, but only the default size of the data files
are determined. Use the Process Database Properties dialog box to determine the amount of data that is
archived in the database files before being deleted from the system.
To configure the database settings:
Step 1

On the Administration—Database Settings view, highlight Process Database, right-click and choose
Properties.
The Process Database Properties dialog box displays.

Step 2

Click the Configuration tab to modify the database grooming settings for the automation database
server.
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Figure 20-6

Step 3

Process Database Properties—Configuration Tab

On the Configuration tab, specify a value for the following fields:
Field

Description

Configuration Audit Grooming

Check the Groom configuration audit data older than
check box and in the numeric field, enter the number of
days before configuration audit data is deleted from the
database.

Process Instances Grooming

Check the Groom completed process instances older
than check box and in the numeric field, enter the number
of days before completed process instance data is deleted
from the database.

Task Grooming

Check the Groom completed tasks older than check box
and in the numeric field, enter the number of days before
completed task data is deleted from the database.
Check the Groom task audit data older than check box
and in the numeric field, enter the number of days before
the task audit data is deleted from the database.

Step 4

Click OK to close the dialog box.
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Viewing Report Database Properties
The Administration—Report Database contains the properties for the report database connection. For
additional information on managing the report database connection, see Chapter 23, “Configuring
Reports.”
To view report database properties:
Step 1

On the Administration—Report Database view, highlight Report Database, right-click and choose
Properties.
The Report Database Properties dialog displays.

Step 2

Click the Connection tab to review the credentials to the reporting database.
Figure 20-7

Report Database Properties—Connection Tab

The following information displays on the Connection tab:
Field

Description

Database Type

From the drop-down list, choose the database type for the
credentials:
•

SQL Server (Integrated Windows Authentication
Credentials)—Uses the credentials of the user logged
into Microsoft Windows.

•

SQL Server (SQL Authentication)—Enter the SQL
server credentials to use for creating the database
(Login ID and Password)

Server name

Display-only. Name of the database server

Database name

Display-only. Name of the report database (default
TEOReporting)
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Field

Description

User

User name assigned to the user account

Password

Password assigned to the user account
Note

For Integrated Windows Authentication Credential
passwords, check the check box to enter the new
password assigned to the user account. If the
password entered is incorrect, then a confirmation
dialog box displays stating:
"Logon failure: unknown user name or bad
password.”

Domain

Windows domain in which the user account resides
Note

Reports URL
Step 3

File path to the report server to where the reports reside

Click the Configuration tab to review the database grooming settings.
Figure 20-8

Step 4

When SQL Server authentication is selected, this
field is display-only.

Report Database Properties—Configuration Tab

Review the following database grooming settings:
Groom Setting

Description

Groom event data older than

Number of days before event data is deleted from the
database

Groom performance data older than Number of days before performance data is deleted from
the database
Groom alert data older than

Number of days before alert data is deleted from the
database
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Groom Setting

Description

Groom incident data older than

Number of days before incident data is deleted from the
database

Groom process audit data older than Number of days before the audit data is deleted from the
database

Step 5

Groom configuration audit data
older than

Number of days before configuration audit data is deleted
from the database

Groom task audit older than

Number of days before the task audit data is deleted from
the database

Click OK to close the dialog box.
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Collecting TEO Diagnostics
The Tidal Enterprise Orchestrator Diagnostic Utility is used to collect various information about the
server environment, installation, as well as any errors or exceptions. The information is compiled into a
zip file and saved according to the user preference. The user can then send the information to Tidal
Software Technical Support to help diagnose the problem with the TEO installation.
The following data is collected by the Utility:
•

Diagnostic logs written by the Tidal Enterprise Orchestrator Service, console and other components
(*.log files)

•

Information about the computer: including memory, processors, OS versions, installed hotfixes and
applications (ComputerInfo.txt)

•

Information about files installed in the TEO installation folder (FileInfo.txt)

•

Snapshots of the Windows Event logs (Application, System, as well as TEO-specific logs) (.evt
files)

•

Snapshots of the TEO registry key (.reg files)

•

TEO component configuration files (.config files)

The log folders also contain files with information about the computer, including memory, processors,
OS versions, installed OS hotfixes and applications.
To generate diagnostic logs:
Step 1

Choose Start > All Programs > Cisco > Tidal Enterprise Orchestrator > Diagnostic Utility.
The Tidal Enterprise Orchestrator Diagnostic Utility Wizard displays.
Figure 20-9

Tidal Enterprise Orchestrator Diagnostic Utility Wizard—Information to Collect Panel
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On the Information to Collect panel, check the check box of the appropriate logs.
Field

Description

General information

Generates log information from the TEO server

Server Information

Client Information

Step 2

•

Tidal IA registry key

•

Tidal IA configuration files

•

Installed file information

•

Application event log—Log information of application
events

•

Tidal IA event log(s)—Log information of the TEO
server

•

Server debug logs—Server log information containing
debug logs produced by the TEO server

•

System event log—Event information of system logs

•

Client debug logs—Contains debug logs produced by
the Automation Pack Import Wizard.

•

Cached client file information—These log files are
collected on client-only computers. These files contain
information about files that were downloaded by the
Console Loader from the server. The information also
includes time stamps and version numbers for all files
in the loader cache.

•

Console settings file—Contains debug logs produced
by the TEO console

Click Next to continue.
The Archive Location panel displays.
Figure 20-10

Tidal Enterprise Orchestrator Diagnostic Utility—Archive Location Panel
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Step 3

In the Full path to the diagnostics archive file, use one of the following methods:
•

Verify the default file path.
-or-

•

Click Browse to modify the file path.

Step 4

Click Next to continue.

Step 5

After the information is collected and saved to the appropriate directory, click Close to close the dialog
box.
Figure 20-11

Finishing Collect Tidal Enterprise Orchestrator Panel
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Configuring TEO Security
This section provides basic information on managing the security administration for the users, objects
accessed and controlled by the processes of TEO.
Security roles determine what permissions are granted to users. Users can be assigned to the appropriate
groups in Windows Computer Management using the TEO Security function. On the Security view,
customers can determine what TEO objects, users are allowed to view, create, or modify. A TEO
administrator can limit users access to only a subset of TEO processes or limit a whole group to
read-only access for specific objects.
For example, the TEO admin can configure members of the Accounting Process Authors group with the
ability to only create, delete, modify or schedule processes in the Accounting category. However, those
members of that group will not be allowed to view or modify any other processes in TEO.
If the user has permissions to view (or edit) only a subset of TEO objects, when the TEO user interfaces
(Console, CLI or Web Service) display TEO objects to the user, the display will only show those objects
that the user has permissions to view or modify.
When the user does not have sufficient permissions in TEO to perform an operation and then attempts
to perform that operation, TEO will generate an error, as well as log an audit failure event to the event
log.
The following sections provide details on the Security feature in TEO:
•

Accessing the Administration—Security View, page 21-2

•

Creating a New Security Role, page 21-6

•

Managing Security Role Definitions, page 21-9
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Accessing the Administration—Security View
When the Administration—Security view is selected, the pre-defined security rules display in the
Results pane.
To access the Security view:
On the Administration workspace, choose Security.
The Results pane displays.
Figure 21-1

Administration—Security View

Information about each security rule can be displayed in the following columns:
Column

Description

Display Name

The name of the security role

Type

The security type

Role

The security role to which the principal is assigned

Principal

Name of the user account or group whose members have
been assigned the role within the product

Last Modified Time

The time the security rule was last modified

Last Modified By

The user name of the person who last modified the security
rule

Id

The unique ID of the security rule

Description

A brief overview of the security rule properties

Owner

The owner of the security rule
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Column

Description

Type Description

A brief overview of the type associated with the security
rule

Created Time

The time the security rule was created

Created By

The user name of the person or object who created the
security rule

Pre-defined Security Roles
The Administration—Security view displays pre-defined security roles that ship with the product and
cannot be modified. When TEO is installed, the installation creates several local computer groups on the
TEO server, which are then used in the pre-defined security roles.
Role

Description

Administrators Role

When assigned to this group, you have access to everything
in the product. Users can view or modify any definition,
process, or setting.

Operators Role

When assigned to this group, users have full access to all
processes. All processes can be viewed, started, and
canceled, but cannot be modified.

Create Ownership Role

All users are assigned to this group. This role provides
users with full control over any objects that they own.

Auditors Role

When assigned to this group, the user can view any
definition, such as running processes.

Definition Role

When assigned to this group, the user can view or modify
any definition or workflow.

Pre-defined Security Permissions
When accessing the Security Role Properties dialog box, the Operations tab displays the list of
permissions included and/or available for inclusion into the security role. Check the check boxes for the
appropriate powers for the security role.
Permission

Function

Cancel

Allows the user to cancel process or activity instances

Change Owner

Allows the user to change the owner of the object. Change
ownership permission includes the Read permission and
requires the Update permission to change ownership on an
object.

Create

Allows the user to create new objects and specify all
properties of the object. Create permission includes
Change Owner and Read permissions. This permission is
required to perform Copy or Import functions.

Delete

Allows the user to delete objects
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Permission

Function

Update

Allows the user to modify all properties of the object,
except the owner. Change Owner is the permission
required to change the owner of an object.

Read

Allows the user to view all properties of an object. The
Read permission along with the Create permission is the
minimum level of permissions required to copy an object.
However, the two permissions do not have to be over the
same object.
For example, to copy object X, permission must be granted
over object X and create permission assigned over objects
of the same type as object X.

Start

Allows the user to start processes ad-hoc

Use

Allows the user to reference objects. This permission is not
available to all objects, but only for those that can be
referenced.
For example, this permission on a target or target group
would allow the user to run activities and processes against
the target group.

Security Details Pane
The Security Details pane displays additional information about the selected item. The hyperlinks on
each of the detail pages launch the property pages for the selected rule.
The following information is displayed on the Details pane:
Field

Description

General

Displays general information about the item including the
display name, principal, role, and a brief description of the
security rule.

Attributes

Displays the dates, times and owner associated with the
creation and modification of the security rule.
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Viewing Security Role Properties
The properties of each security rule can be accessed from the Security view in the Console.
To view security role properties:
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Properties.
The Security Role Properties dialog box displays.
Figure 21-2

Step 2

Administrator Role Properties—General Tab

Click the following tabs to display the security role information:
Tab

Description

General

Displays the general information about the security role

Permissions

Security permissions and objects to be included in the
security role

User Assignment

Binds the security principal (either a user or group) and the
defined security permissions for the security role

Used By

Displays objects that directly reference the selected object
in their configuration

History

Displays the history of changes made to an object
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Creating a New Security Role
A security role is a list of permissions that enhances product use through logical groupings of powers
and objects for reuse in multiple places. A security permission is a pairing of a scope that defines the
objects and powers over those objects. After a security role is defined, it is available in a list of available
security roles on the Administration—Security view.
To create a new security role:
Step 1

On the Administration—Security view, right-click and choose New > Role.
The New Role Properties dialog box displays.
Figure 21-3

Step 2

Step 3

New Role Properties Dialog Box—General Tab

On the General tab, complete the following information, and click OK.
Field

Description

Display Name

Name of the new security role

Owner

Click Browse to launch the Select User or Group dialog
box and modify the owner for the security role.

Description

Brief description of the security role

Click the Permissions tab to modify the list of security permissions and associated powers to be included
in the security role. A security permission is a security object that defines the type of access granted to
the TEO user or group over an object.
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Figure 21-4

Security Role Properties Dialog Box—Permissions Tab

The Permissions tab displays the following information:

Step 4

Column

Description

Operations

Displays the access associated with the security permission

Objects

List of objects associated with the security permission

Type

The type of security permission

Click one of the following buttons to modify the list of permissions:
Button

Description

Add

Launches the security permissions dialog box containing
the appropriate security permissions and objects to be
included in the security role
•

Object List Security Permission—Pairs security
permissions with specific objects.
See Defining Object List Security Permission,
page 21-16.

•

Object Type Security Permission—Pairs security
permissions with the top-level object types, such as
adapters, processes, targets, and global variables.
See Defining Object Type Security Permission,
page 21-18.

•

Owner Security Permission—Pairs security
permissions for an owner with specific objects.
See Defining Owner Security Permission, page 21-19.

Edit

Launches the Permission properties dialog box to display
the selected security permission

Remove

Removes the selected permission from the list of security
permissions included in the security role
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Step 5

Click the User Assignments tab to define the security role information between the security principal
and the permissions.
Figure 21-5

Step 6

Security Role Properties Dialog Box—User Assignments Tab

Click one of the following buttons to modify the list of permissions:
Button

Description

Add

Click this button to launch the Select User or Group dialog
box and change the owner.

Remove

Removes the selected principal from the list of owners
assigned to the security role

The Principal column displays the name of the group to which users can be assigned so that they have
access to the functionality provided by the authority.
Step 7

Step 8

Click the following tabs to view security role references and history.
•

Used By—Displays the objects that directly reference the selected object in their configuration. See
Viewing Used By Properties, page 21-22.

•

History—Displays the history of changes made to the security role. See Viewing Security Role
History, page 21-23.

Click OK to complete the security role definition process.
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Managing Security Role Definitions
Use the following procedures to modify the security role definitions for TEO.

Viewing Pre-Defined Security Rules Assigned to Local User Groups
The installation creates several local computer groups on the TEO server, which are then used in the
pre-defined security rules.
To view TEO Users and Groups:
Step 1

On My Computer, right-click and choose Manage.
The Computer Management dialog box displays.
Figure 21-6

Step 2

Computer Management Dialog Box

Under Local Users and Groups, choose Groups to view the following Tidal Enterprise Orchestrator user
groups:
User Group

Description

TEO Operators

View all Operations information (Activity Views, Process
Views and Auditing)
•

Start processes in adhoc manner

•

Cancel running processes

•

Cannot view or update Definition and Administration
information
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User Group

Description

TEO Auditors

View all Operations information (Activity Views, Process
Views and Auditing)

TEO Definition Authors

TEO Administrators

•

Cannot start processes in an adhoc manner

•

Permission to view all Operation and audit logs

•

View, but cannot modify or create product objects such
as process definitions, target definition or
administration information

View all Operations information (Activity Views, Process
Views and Auditing)
•

Start processes in adhoc manner

•

Cancel running processes

•

Permission to view, create, edit, or control product
definitions such as process definitions and target
definitions.

•

Permission to view but not update administration
information.

Full rights to every view on the console and the ability to
create and update all process definitions.
Note

Local administrators of the machine where TEO is
installed will automatically have TEO
administrator rights, even if they do not have
specifically granted TEO administrator rights.

Assigning Users to Local Computer Groups from Windows
Users can be assigned to security role groups using the Windows Computer Management dialog box.
Only administrators on the local computer can assign users to the groups.
To assign users to security rules:
Step 1

On the computer where TEO is installed, choose Start > Programs > Administrative Tools >
Computer Management.
The Computer Management dialog box displays.
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Figure 21-7

Step 2

Computer Management Dialog Box

Expand the Local Users and Groups node and double-click Groups.
The Groups display in the Details pane.
Figure 21-8

Step 3

Groups Displayed In Details Pane

On the Details pane, double-click the appropriate TEO group.
The Group Properties dialog box displays.
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Figure 21-9

Step 4

Administrators Group Properties Dialog Box

Click Add.
The Select Users, Computers, or Groups dialog box displays.
Figure 21-10

Step 5

Select Users, Computers, or Groups Dialog Box

Enter the user name (domain\user name) in the text field and click OK.
The newly added user name displays on the Group Properties dialog box.

Step 6

Click Apply and then click OK to close the dialog box.
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Modifying Security Role Permission Properties
To modify security role properties:
Step 1

On the Administration—Security view, highlight an existing security role, right-click and choose
Properties.
The Security Role Properties dialog box displays.

Step 2

On the General tab, modify the appropriate information, as necessary.

Step 3

On the Permissions tab, choose the appropriate security permission, and then click Edit to continue.
The Permission 'All' over 'All' Properties dialog box displays.

Step 4

On the Powers tab, uncheck the check box to the left of the appropriate powers.

Step 5

Modify the appropriate objects and object types for the permission and click OK.
The modified security role is displayed on the Select Role dialog box.

Changing Owner of Security Role
With the appropriate rights, ownership of a security role can be changed using the TEO security feature.
To modify the owner or principal of a security role:
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Properties.
The Security Role Properties dialog box displays.

Step 2

On the General tab, scroll to the Owner field, and to the right of each field, click Browse.
The Select User or Group dialog box displays.
Figure 21-11

Step 3

Select User or Group Dialog Box

To change the default object type in the Select this object type field, click Object Types.
The Object Types dialog box displays.
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Figure 21-12

Object Types Dialog Box

Step 4

Check the check box to the left of the appropriate object types, and click OK.

Step 5

To change the server location for querying a user or group, click Locations on the Select User or Group
dialog box.
The Locations dialog box displays.
Figure 21-13

Locations Dialog Box

Step 6

Expand the appropriate server name, choose the user or group, and click OK.

Step 7

In the Enter the object name to select text field, enter the user name (domain\user name) or group and
click Check Names.

Note

If there is a matching user name or group, it is displayed in the field. If there is not a match, the following
message displays.
Figure 21-14

Step 8

Select User or Group Error Message

Click Advanced to enter additional query information.
The Advanced pane displays.
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Figure 21-15

Step 9

Note
Step 10

Select User or Group—Advanced Pane

In the Name field, enter the appropriate terms, and click Find Now.

To generate more search results, leave the Name field blank and then click Find Now.
In the Search Results pane, choose the appropriate user or group, and click OK.
The selected added user name or displays in the Enter the object name to select text field.

Step 11

Click OK to return to the Security Role Properties dialog box.
The selected user name or group is displayed in the appropriate Owner field.
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Defining Object List Security Permission
Use the Object List Security Permission to pair security permissions with specific objects within TEO.
To define object list security permissions;
Step 1

On the Security Role dialog box, click the Permissions tab.

Step 2

Click Add > Object List Security Permission.
The Permission 'All' over 'All' Properties dialog box displays.
Figure 21-16

Permission "All" Over "All" Properties Dialog Box—Operations Tab

Step 3

On the Operations tab, check the check boxes for the appropriate powers for the security role. Refer to
the Pre-defined Security Permissions, page 21-3 for list of available permissions.

Note

Click Select All to choose all the permissions on the list. Click Unselect All to remove all the selected
permissions from the security role.

Step 4

Click the Objects tab to continue.
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Figure 21-17

Step 5

Permission 'All' over 'All' Properties Dialog Box—Objects Tab

Click Add to add the appropriate objects to the permissions.
The Select Objects dialog box displays.
Figure 21-18

Step 6

Note

Select Objects Dialog Box

Choose the appropriate objects for the permission and click OK.

Use the Filter by Object Type drop-down list to filter the list of displayed objects.
The defined object list permissions display on the Permissions tab of the New Role Properties dialog
box.
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Defining Object Type Security Permission
Use the Object Type Security permission to pair security permissions with the top-level object types
within TEO, such as adapters, processes, targets, and global variables.
To define object list security permissions:
Step 1

On the Select Role dialog box, click the Permissions tab.

Step 2

Click Add > Object Type Security Permission.
The Permission 'All' over 'All' Properties dialog box displays.

Step 3

On the Operations tab, check the check boxes to the left of the appropriate permissions for the object
types within the security role.

Step 4

Click the Object Types tab to continue.
Figure 21-19

Step 5

Permission 'All' over 'All' Properties Dialog Box—Object Types Tab

On the Object Types tab, check the check boxes to the left of the appropriate object types to be included
in the permissions of the security role, and click OK.
The defined object type permissions display on the Permissions tab of the Security Role Properties
dialog box.
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Defining Owner Security Permission
Use the Owner Security Permission to pair security permissions for an owner with specific objects within
TEO.
To define owner security permissions:
Step 1

On the Select Role dialog box, click the Permissions tab.

Step 2

Click Add > Object Type Security Permission.
The Permission 'All' over 'All' Properties dialog box displays.

Step 3

On the Operations tab, check the check boxes for the appropriate permissions for the objects within the
security role.

Step 4

Click the Object Types tab, and then check the check boxes for the appropriate objects to included in
the permissions of the security role.

Step 5

Click the Owner tab to continue.
Figure 21-20

Step 6

Step 7

Permission 'All' over 'All' Properties Dialog Box—Owner Tab

On the Owner tab, choose one of the following radio buttons to assign the Windows security principal
(either a user or a group) the associated with the permission.
Field

Description

The Connected user

Click this button to assign the permission to the currently
connected Windows user.

Exactly the specified user

Click Browse to launch the Select User Or Group dialog
box and change the security principal for the permission.

Click OK to close the dialog box.
The defined object type permissions display on the Permissions tab of the Security Role Properties
dialog box.
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Assigning a User or Group as Principal to a Security Role
Use the following steps to quickly assign a user or group to a security role.
To assign a principal to a security role:
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Assign.
The Select User or Group dialog box displays.
Figure 21-21

Step 2

Note

Step 3

Select User or Group Dialog Box

In the Enter the object name to select text field, enter the user name (domain\user name) or group and
click Check Names.

If there is a matching user name or group, it is displayed in the field. If there is not a match, an error
message displays.
On the Search Results pane, choose the appropriate user or group, and click OK.
The selected added user name is added as a security principal to the security role.

Viewing Security Role User Assignments
Use the following steps to review the list of users and groups assigned as principals to the security role.
To view user assignments;
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Properties.

Step 2

Click the User Assignments tab to review the list of users and groups.
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Removing Security Permissions
With the appropriate rights, security permissions can be removed when modifying the list of security
authorities.
To remove security permissions:
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Properties.
The Security Role Properties dialog box displays.

Step 2

Click the Permissions tab to continue.
Figure 21-22

Step 3

Security Role Properties—Permissions Tab

Highlight the appropriate security permission, and click Remove.
The selected permission is removed from the list of security permissions.

Note

The removal of the security permission from the list is permanent. Click Add to create a new security
permission.

Removing Security Objects
With the appropriate rights, security objects can be removed when modifying the object list security
permission.
To remove a security object:
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Properties.
The Security Role Properties dialog box displays.

Step 2

Click the Permissions tab, highlight the appropriate object list security permission, and click Edit.
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The Permission 'All' over 'All' Properties dialog box displays.
Step 3

Click the Objects tab, highlight the appropriate object in the list, and click Remove.
The selected object is removed from the list of objects.

Step 4

Note

Click OK to return to the Permissions tab of the Security Role Properties dialog box.

The removal of the object from the list is permanent. Click Add to add a new object to the security
permission.

Deleting a Security Role
Use the following steps to delete a security role. Deleting the role deletes all associated permissions.
Step 1

On the Administrations—Security view, highlight the appropriate security role, right-click and choose
Delete.
The Confirm Security Role Delete dialog box displays.
Figure 21-23

Step 2

Confirm Role Delete Dialog Box

Click Yes to delete the security role.
The security role is deleted from the list of security roles.

Note

The removal of the security role from the list is permanent. On the Administration—Security view,
right-click and choose New > Role to add a new security role.

Viewing Used By Properties
Use the Used By tab to display the objects that directly reference the selected security role in their
configuration. Because the Used By tab displays objects in a tree view, users can also display the objects
which directly reference the top level objects for the selected object.
The objects at the top level are the objects that reference the selected object directly, but users can expand
the listed objects and see their referenced objects.
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Example:
If object A is used by objects X and Y and object X is used by object Q, then on the
property pages of object A, the user will see X and Y listed. If a user expands (+) object
X, then object Q will display.

To view used by objects:
Step 1

On the Administration—Security view, highlight an existing security role, right-click and choose
Properties.
The [Security Role] Properties dialog box displays.

Step 2

Click the Used By tab to view the objects used by the security role.
Object

Description

Display Name

Name of the object

Type

Type of object

Step 3

To view the properties for a specific object, highlight the object, right-click and choose Properties.

Step 4

Click OK to close the dialog box.

Viewing Security Role History
Use the History tab to view a history of changes that have been made to the security role.
Step 1

On the Administration—Security view, highlight an existing security role, right-click and choose
Properties.
The [Security Role] Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the security role.
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

User

The user name of the person that performed the action

Type

The action that occurred

Description

Information about the action that was performed

Step 3

To view the audit history for a specific action, highlight the appropriate time, right-click and choose
Properties.

Step 4

Click OK to close the dialog box.
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Managing Automation Packs
Automation packs can encompasses everything related to representation, storage, import, packaging and
management of content within TEO. Tidal automation pack files are a collection of TEO configuration
objects, such as processes, variables, categories, targets, target groups, and more, all stored in one file.
Tidal Enterprise Orchestrator ships automation packs that provide default objects associated with
adapters installed in the product. The automation packs shipped with the company are dependent upon
the licensing for the company.
The Administration workspace includes an Automation Pack view, which displays the list of automation
packs that have been imported.
In order for users to be able to create or import an automation pack, users will need to be a TEO
Administrator.
To be able to edit, delete, re-import, or upgrade automation pack, the user will need to be a TEO
Administrator on the automation pack object.
The following sections provide instructions on how to import, export, and create new automation packs.
•

Accessing Administration—Automation Packs, page 22-2

•

Importing Automation Packs, page 22-7

•

Creating Automation Packs, page 22-16

•

Exporting Automation Packs, page 22-20

•

Managing Automation Pack Files, page 22-28

•

Core Automation Pack Objects, page 22-35
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Accessing Administration—Automation Packs
To access the Automation Pack views:
On the Administration workspace, choose Automation Packs.
The Results pane displays.
Figure 22-1

Administration—Automation Packs View

Information about the following columns are displayed:
Column

Description

Company Name

Name of the company that releases the automation pack

Publish Date

Date the automation pack was exported to a file

Version

Version number of the automation pack

Display Name

The name of the automation pack

ID

Identification number of the automation pack

Import Date

Date the automation pack was imported into the product

Licensed

Indicates whether the automation pack is a licensed
product of TEO

Description

Brief description of the automation pack
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Tidal Automation Packs
Tidal Enterprise Orchestrator provides automation packs that provide default objects associated with
adapters installed in the product. The following table provides the available automation packs and their
descriptions:
Automation Pack

Description

Product Guide

Core

Contains default TEO objects to support
other automation packs

Core Automation Pack Objects,
page 22-35

Core Automation for
SAP

Contains core objects for the SAP adapter Cisco TEO Process Automation
Guide for Core Automation for
SAP

Microsoft Active
Directory

Contains objects used to support Active
Directory environments

Cisco TEO Process Automation
Guide for Microsoft Active
Directory

Microsoft Windows
Server

Objects support Windows environments
as well as content used in other
automation packs, such as Active
Directory.

Cisco TEO Process Automation
Guide for Microsoft Windows
Server

BMC Remedy

Contains the content to support
synchronization of TEO incidents with
the corresponding Remedy incidents

Cisco TEO Process Automation
Guide for BMC Remedy

Automation for SAP
BW and BWA

Contains the content used to automate
Cisco TEO Process Automation
best practices for monitoring BW
Guide for SAP BW and BWA
availability, operations and performance.
In addition, the BWA content provides
assessment and remediation tools to
assess, implement and maintain a BWA
system.

Automation for SAP
BOBJ Accelerator

Contains the content used to automate
monitor BWA TREX (non BW
environment) and Business Objects XI
Data Services Content

Cisco UCS

Contains the content information used to Cisco TEO Process Automation
Guide for Cisco UCS
support task automation on Cisco UCS
Software instances

Assessment for SAP
BWA

Provides information on importing and
using the Assessment for SAP BWA
automation pack in TEO

Cisco TEO Process Automation
Guide for Assessment for SAP
BWA

Incident Analysis for
SAP

Contains the content used to automate
best practices for identifying and
analyzing availability and performance
problems within your SAP environment.

Cisco TEO Process Automation
Guide for Incident Analysis for
SAP

Task Automation for
SAP

Contains the content used to support task Cisco TEO Process Automation
automation for SAP
Guide for Task Automation for
SAP

Cisco TEO Process Automation
Guide for SAP BOBJ
Accelerator
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Automation Pack

Description

Product Guide

System Copy for SAP
Systems

Contains the content used to automate
your system copy procedures for SAP
systems

Cisco TEO Process Automation
Guide for System Copy for SAP

Cloud Physical Server
Automation

Contains the infrastructure related
processes for creating and managing
physical machines

Cisco TEO Process Automation
Guide for Cloud

Cloud Service
Orchestration

Contains processes for orchestrating
fulfillment of cloud service requests

Cisco TEO Process Automation
Guide for Cloud

Cloud Virtual Server
Automation

Contains the infrastructure related
processes for creating and managing
virtual machines

Cisco TEO Process Automation
Guide for Cloud

Cloud newScale Service Contains all processes and objects
Catalog
required to integrate newScale service
catalog with cloud content

Cisco TEO Process Automation
Guide for Cloud

Automation Pack Details Pane
The Details pane displays detailed information about the selected automation pack. Clicking a link on a
tab page opens the Properties dialog box for the automation pack. All the fields on the property pages of
a third-party automation pack will be display-only except for the author.
Tab

Description

General

Displays general information about the item including the
name, type, value, a brief description of the automation
pack, and the ability to enable or disable an automation
pack.
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Viewing Automation Pack Properties
Use the Automation Packs Properties dialog box to view or modify the processes and objects in an
automation pack.
To view automation pack properties:
Step 1

On the Administration—Automation Packs view, highlight the appropriate automation pack, and
right-click and choose Properties.
The Automation Pack Properties dialog box displays.

Step 2

Click the appropriate tab to review the properties
Tab

Description

General

Displays general information about the automation pack

Objects

Displays the list of objects contained in the automation
pack

Dependencies

Displays the list of automation packs and adapters
referenced by the objects in the automation pack

History

Displays when the automation pack was created or
modified. The column also displays audit log entries that
are relevant to the automation pack.

Customization Properties
The fields on the following objects are available for editing when customizing an object from a TAP.
Object

Editable Property

Adapter
Calendar

Category

The following fields are editable:
•

All fields on the Dates tab for the Date List Calendar

•

All fields on the Calendars tab for the Group Calendar

•

All fields on the Recurrence tab for the Recurring Calendar

All fields on the Members tab are editable.
Users can add any process that they can customize. This
includes processes created by the user or third-party processes
with any customization other than No.
Users can remove the processes that they add. They cannot
remove the processes that came with the category regardless of
its customization setting.

Extended Target Property

If the customization setting is Limited, only the Target Value
field is editable.

Global Variable

Variable value is customizable
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Object

Editable Property

Knowledge Base Article

The following fields are editable:

Process

•

Summary

•

Possible cause

•

Possible resolution

•

Related information

If the customization setting is Limited, then the following fields
are editable.
•

Users can change the Enabled setting

•

Users can change the Execution & Archival option

•

Users can change the default target and runtime user

•

Users can change input variable value

•

Users can create new trigger or enable/disable third party
trigger

•

Users can delete any trigger they created

•

Users can add any category that has customization level not
set to No

•

Users can remove any category they personally added.
Users can not remove the category that came with the
process.

If the customization setting is Workflow, then users will be able
to edit everything that is set to Limited as well as the following:

Runtime User

•

Full control over the process workflow

•

Create local or definition scope variable

•

Delete variable that they create

All fields on the Members tab are editable.
Users can add any process that they can customize. This
includes any processes created by them or third party processes
with any customization other than No.
Users can remove the processes that they add, but cannot
remove the processes that came with the category regardless of
its customization setting.

Security Role

Target

The following properties are editable:
•

Permissions tab is customizable.

•

User Assignments tab is customizable

Everything is customizable except the target display name and
description
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Object

Editable Property

Target Group

Target group membership or criteria is customizable

Task Rule

The following properties are editable:
•

On the General tab, the Enabled check box and Owner field
are customizable

•

Conditions tab is editable

•

Assign tab (for Assigned Task Rule) is editable

•

Notify tab (for Notify Task Rule) is editable

•

Update tab (for Update Task Rule) is editable

Importing Automation Packs
Use the Automation Pack Import Wizard to import product objects that are required to create and manage
processes. The wizard automatically launches after the installation is complete and the automation pack
initialization is completed. The wizard does not fully launch until after the automation server has started.
Use the following steps to import Tidal Automation Packs immediately after the complete product
installation. The following steps feature the Core automation pack initial import.
Step 1

After the automation pack initialization is complete, the Select Automation Packs dialog box displays.
Figure 22-2

Step 2

Select Automation Packs Dialog Box

Check the check box to the left of each appropriate automation pack to be imported and click OK.
The available automation packs for import are dependant upon the product license. The Core automation
pack will be imported first.

Note

See Tidal Automation Packs, page 22-3 for details on the available automation packs.
The Welcome to the Automation Pack Import Wizard panel displays.
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Figure 22-3

Note

Welcome to the Automation Pack Import Wizard Panel

If you do not want to display the Welcome panel the next time the wizard is launched, check the Do not

show this page next time check box.
Step 3

Click Next to continue.
The General Information panel displays.
Figure 22-4

Automation Pack Import Wizard—General Information Panel
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Step 4

Check the Disable all imported processes check box to indicate that all processes from this tab should
be disabled by default after being imported.

Step 5

Review the display-only information about the automation pack and click Next to continue.
The Email Configuration panel displays.
Figure 22-5

Note

Step 6

Step 7

Automation Pack Import Wizard—Email Configuration Panel

The settings in this panel can be manually changed when configuring a specific email activity that
requires a different SMTP server or sender email address.
On the Email Configuration panel, specify the default SMTP server and sender’s email address to be
used for email activities.
Field

Description

Default SMTP server

Name of the SMTP server that is used as the default server
for sending email messages.

Default SMTP port

Port number for the SMTP server. This field is
automatically populated with port number 25.

Default sender

Email address of the sender that is designated as the default
sender for email activities.

Click Next to continue.
The Automation Summary Configuration panel displays.
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Figure 22-6

Step 8

Automation Pack Import Wizard—Automation Summary Configuration Panel

On the Automation Summary Configuration panel, specify where the automation summary reports that
are generated by activities are to be saved and how long the reports are to be retained.
The file paths specified indicate the path that will be used when viewing the automation summary
reports.

Step 9

Verify or enter the appropriate default file path for the automation summary directory.
Field

Description

Automation summary directory

Verify the default file path that the TEO server will use
when creating automation summary reports.
Click Browse to determine the file path for the automation
summary.
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Step 10

Select the appropriate directory mapping option from the drop-down list to map the automation summary
to a shared directory or IIS Virtual Directory to allow end-users easier access to automation summaries
using email or the TEO Web Console.
Option

Description

Share

Select this option to indicate the automation summary
should be saved on the specified file path.
In the Share Path field, enter the UNC path to a share
directory. This path will be used when viewing the
automation summary reports.
Example:
(\\servername\sharename\path\filename)

•

Verify share—Click this button to verify that the
current file path in the text field is a valid UNC share
directory. If a valid file path exists, a confirmation
dialog box displays.

•

Create share—Click this button to create the directory
on the TEO server where the automation summary
reports should be created.

Note

Use IIS Virtual Directory

Verify that the UNC share file path is on a network
where the TEO service account has write
permissions.

Select this option to indicate the file path is on an IIS
Virtual Directory.
In the Virtual directory path field, enter the http:// path that
corresponds to a virtual directory in IIS.

Do not map the path

Select this option to indicate that the automation summary
should not be saved to a shared or IIS virtual directory.
If this option is selected, then the automation summary will
not be available for view from the Web Console.

Delete automation summary reports Check this check box and in the text field, and enter the
number of days that the automation summary files should
older than
be retained in the text field.
Automation summary files that have been retained for a
period past the specified number of days will be deleted.
Step 11

Configure the archiving settings for the automation summary reports.
Option

Description

Delete automation summary reports Check this check box and in the text field, and enter the
number of days that the automation summary files should
older than
be retained in the text field.
Automation summary files that have been retained for a
period past the specified number of days will be deleted.
Step 12

Click Next to continue.
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The Default Windows Credentials panel displays.
Figure 22-7

Step 13

Step 14

Automation Pack Import Wizard—Default Windows Credentials Panel

On the Default Windows Credentials panel, specify the default credentials for the Windows automation
server target.
Field

Description

Domain

Name of the domain in which the user account that is used
to connect to the Windows server

User name

Name of the user account

Password

Password assigned to the user account

Click Next to continue.
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The Data Extraction panel displays.

Note

The Required Value
a value.
Figure 22-8

icon displayed on a tab or page indicates that the field is required and is missing

Automation Pack Import Wizard—Data Extraction Panel

Step 15

Under Specify location to extract data files, verify the default location for where the TEO-provided data
files should be copied. Click Browse to specify a different location.

Step 16

Under Select data to extract, check the appropriate check boxes:
Option

Description

Business Objects Reports

Check this check box to indicate that BIAR report files
should be copied.
The files are available for importing later into Business
Objects.

Microsoft SCOM Management
Packs

TEO provides management packs for integration with the
Microsoft System Center Operations Manager 2007
framework.
Check this check box to indicate that the SCOM
management pack files should be copied.

SQL Server Reporting Services
Reports

Check this check box to indicate that the report files should
be copied.
The files are available for importing later into SQL Server
Reporting Services.

Note

Reports should be imported after the Automation Pack Import Wizard is completed.
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Step 17

Click Next to continue.
The Review Prerequisites panel displays.
Figure 22-9

Automation Pack Import Wizard—Review Prerequisites Panel

The green check mark verifies that the prerequisite was located on the computer.
The red X determines that the prerequisite is not available on the computer. When this occurs, the import
progress is stopped and cannot continue until all prerequisites have been met.
If you click Cancel during the import, the wizard will close and the automation pack will not be
imported.
Column

Description

Name

Name of the prerequisite

Status

Status shows whether the prerequisite was located on the
computer
•

Passed—Correct item or version of item was on the
computer

•

Failed—Correct item or version of item was not on the
computer

Complete

Percentage of computer checked when verifying
prerequisite

Description

Displays description of the prerequisite information or
instructions to further requirements for the prerequisites to
be installed.

If all prerequisites are passed, the wizard automatically continues to the next panel which displays the
status of the automation pack objects being imported.
After the objects have been imported, the importing of the Core automation pack is complete.
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Figure 22-10

Completing the Import Objects Wizard Panel

If other automation packs were selected to be imported, the wizard will relaunch for the next automation
pack. Refer to the appropriate guide for additional information.

Overwriting Existing Objects
The Overwrite Objects dialog box displays if the Tidal Enterprise Orchestrator server contains existing
objects with the same unique ID. The Overwriting Existing Objects dialog box will display if the current
user is the author of the object. If the object belongs to a third-party automation pack, the object will be
updated automatically. Any changed value of the object will be preserved.
Use the Overwrite Objects dialog box to confirm whether to overwrite existing objects that currently
reside in TEO. To keep the existing version of the object, remove the check mark, and click OK.
Information about the following objects are displayed:
Column

Description

Name

Display name for the existing object in TEO

Type

Type of object

Version

New version number of the object that is being imported

Description

Brief description of the existing object, including the
current version number of the object in TEO
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Creating Automation Packs
Tidal Automation Package (*.tap) files include processes and other defined objects for TEO. The defined
automation packs included with the product are located in the install directory on the machine where the
product was installed. Individual-created automation packs may be exported and re-imported on an
as-needed basis.
Use the following steps to create an automation pack:
Step 1

In the Administration—Automation Pack view, right-click and choose New > Automation Pack.
The New Automation Pack Properties dialog box displays.
Figure 22-11

Step 2

New Automation Pack Properties Dialog Box—General Tab

On the General tab, enter the following information:
Column

Description

Display name

Name of the automation pack

Type

Type of object

Company name

Name of the company that releases the automation pack

Version

Version number of the automation pack

Publish date

Date the automation pack was exported to a file

Import Date

Date the automation pack was imported into the product

Owner

Owner of the automation pack. This is typically the creator
of the automation pack.
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Column

Description

Description

Brief description of the automation pack

Community Automation Pack

This check box is available only when creating new
automation packs. Check this check box to indicate the
TAP file is a community automation pack. This allows
anyone the ability to modify and export the TAP.
After the automation pack is created, the check box will no
longer be available and the TAP file cannot be made
private.
If the check box remains unchecked, then the TAP file
becomes private and can be modified and exported only by
the author.

Step 3

Click the Objects to continue.
Figure 22-12

New Automation Pack Properties—Objects Tab
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Step 4

On the Objects tab, use the following radio buttons to add objects to the automation pack.
Option

Description

Select a replacement for runtime
users and discovered targets during
import

Select this radio button to indicate that the runtime users
and discovered targets will be replaced during the import
process.

Runtime users and discovered
targets are not allowed

Select this radio button to indicate users will not be able to
save the automation pack until the object is removed from
the automation pack.
All the runtime users and discovered targets will be flagged
with an action stating that the objects should be removed.
Note

Add

To remove a runtime user or a discovered target,
remove the object that references the items first
before removing the object from the automation
pack.

Click this button to launch the Select Object dialog box and
select an object from the list of exportable objects.
Objects that already belong to an automation pack will be
filtered from this dialog.
Note

Remove

Highlight the object and then click this button to remove an
object from the list.

Refresh References

Click this button to update the list of references associated
with the object.
Note

Step 5

For information on adding an object, see Adding
Objects to Automation Packs, page 22-30.

The objects (except Runtime Users or Discovered
Targets) in the automation pack will be stamped
with the automation pack ID after the automation
pack has been updated.

Information about the objects are displayed in the following columns.
Columns

Description

Display Name

Name of the automation pack

Type

Object type

Action Required

Action required to successfully import or export the objects

Description

Brief description of the automation pack.
Marketing information for the automation pack can be
displayed as well as a hyperlink to marketing information.

Version
Step 6

Version number of the product

Click the Dependencies tab to continue.
The dependent automation pack and required adapter lists will be updated when the automation pack
properties is first opened or when there is a change to the Objects page, such as adding or removing an
object.
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Figure 22-13

Step 7

New Automation Pack Properties—Dependencies Tab

Review the list of automation packs and adapter information referenced and required by the objects in
the automation pack.
Automation Pack Dependencies
Columns

Description

Display Name

Name of the automation pack

Company Name

Name of the company that released the automation pack

Version

Version number of the product

Publish Date

Date the automation pack was exported to a file

ID

Identification number of the automation pack

Description

Brief description of the automation pack.
Marketing information for the automation pack can be
displayed as well as a hyperlink to marketing information.

Required Adapters

Step 8

Display Name

Name of the adapter

Company name

Name of the company that licensed the product

Version

Version number of the product

Release date

The date and time the adapter is available in the product

Install date

The date and time the adapter was installed

Description

A brief overview of the adapter

Click OK to close the dialog box.
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Exporting Automation Packs
The processes and objects included in Tidal Automation Packs (TAP) that have been imported into TEO
or created by a user can also be exported onto your computer. Exporting processes and objects moves
the processes from one environment to another, creates backups of the processes, and shares the
processes with another organization.

Note

Third-party automation packs cannot be exported. Users can only export self-authored or community
automation packs.
Use the Automation Pack Export Wizard to export a TAP file to a designated file path on your computer.
To export an automation pack:

Step 1

On the Administration—Automation Packs view, highlight the appropriate automation pack, right-click
and choose Export.
The Welcome to the Automation Pack Export Wizard panel displays.
Figure 22-14

Step 2

Welcome to Automation Pack Export Wizard Panel

Click Next to continue.
The Objects to Export panel displays.
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Figure 22-15

Step 3

Automation Pack Export Wizard—Objects to Export Panel

On the Objects to Export panel, review the list of objects associated with the process being exported and
click Next.
Columns

Description

Select a replacement for runtime
users and discovered targets during
import

Display-only. Selected radio button indicates the runtime
users and discovered targets will be replaced during the
import process.

Runtime users and discovered
targets are not allowed

Display-only. Selected radio button indicates users will not
be able to save the automation pack until certain objects are
removed from the automation pack.

Display Name

The name of the objects that are associated with the
exported automation pack. The objects are grouped by type
(Processes, Target, Runtime User, Knowledge Base)

Type

Type of object

Action Required

Action required to successfully import or export the objects
Note

For additional information, see Adding Objects to
Automation Packs, page 22-30 or Removing
Objects from Automation Packs, page 22-33.
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Columns

Description

Customization Setting

Displays the customization setting for the automation pack

Description

•

No—Indicates the author of the object prefers the
object to remain unchanged whenever a new
automation pack is imported.

•

Limited—Indicates the author has granted editing
permission to some properties of the object and any
changes made will be preserved whenever a new
automation pack is imported.

•

Workflow—Indicates the author has granted editing
permission to the process properties and the objects
within the process workflow.

Brief description of the automation pack.
Marketing information for the automation pack can be
displayed as well as a hyperlink to marketing information.

Step 4

Click Next to continue.
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The Dependencies panel displays.
Figure 22-16

Step 5

Automation Pack Export Wizard—Dependencies Panel

Review the list of automation packs and adapter information referenced and required by the objects in
the automation pack.
Automation Pack Dependencies
Columns

Description

Display Name

Name of the automation pack

Company Name

Name of the company that released the automation pack

Version

Version number of the product

Publish Date

Date the automation pack was exported to a file

Description

Brief description of the automation pack
Marketing information for the automation pack can be
displayed as well as a hyperlink to marketing information.

Required Adapters

Step 6

Display Name

Name of the adapter

Company name

Name of the company that licensed the product

Version

Version number of the product

Release date

The date and time the adapter is available in the product

Install date

The date and time the adapter was installed

Description

A brief overview of the adapter

Click Next to continue.
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Step 7

The General Information panel displays.
Figure 22-17

Step 8

Step 9

Automation Pack Export Wizard—General Information Panel

On the General Information panel, modify the version number for the automation pack, as necessary.
Field

Description

Name

Display-only. Name of the automation pack

Company

Display-only. Name of the company that releases the
automation pack

Version

Version number of the automation pack

Description

Display-only. Brief description of the automation pack

Click Next to continue.
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The Export Location panel displays.
Figure 22-18

Step 10

Note
Step 11

Export Location Panel

On the Export Location panel, in the File name text box, specify the name of the file and where the
automation pack will be exported onto the computer.

Click Browse to specify the appropriate file location.
Click Next to continue.
The Validate Objects panel displays the progress of the object validation.
Figure 22-19

Automation Pack Export Wizard—Validate Objects Panel
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Step 12

Step 13

On the Validate Object panel, the following information is displayed about the objects being validated:
Column

Description

Severity

Indicates the severity of the error

Name

Name of the questionable object

Type

Type of object in question

Description

Brief description of the error

Click Next to continue.
The Export Objects panel displays while exporting the automation pack.
The Completing the Export Objects Wizard panel displays.
Figure 22-20

Step 14

Completing the Export Objects Wizard Panel

Click Close to complete the automation pack export process.
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Extracting Data Files
Data files are embedded in some TEO-provided automation packs. By the default, users can extract these
data files during the automation pack import process. However, if the user decides not to extract the files
at that time, they can use the following steps to extract the files in the automation pack to a location on
the computer.
To extract the data files:
Step 1

On the Administration—Automation Packs view, right-click and choose Extract.
The Open dialog box displays the list of available automation packs.

Step 2

Highlight the appropriate automation pack, and then click Open.
The Data Extraction dialog box displays.
Figure 22-21

Step 3

Note

Data Extraction Dialog Box

In the Specify the destination for the extracted to extract data files field, verify the default location for
where the selected files are to be copied.

Click Browse to specify a different location.

Step 4

Check the check box to the left of the appropriate data file to indicate that the data file should be
extracted.

Step 5

Click OK.
The files are copied to the selected location.
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Managing Automation Pack Files
The content of the user-created automation packs can only be modified within the console. Automation
packs provided by TEO cannot be exported by the user. Most objects provided as content by TEO cannot
be modified. Some properties of objects, such as global variables and targets can be modified.
Use the following instructions to modify automation pack files.

Reviewing Automation Pack Dependencies
To review automation pack dependencies:
Step 1

On the Administration—Automation Pack view, highlight the appropriate automation pack, right-click
and choose Properties.

Step 2

Click the Dependencies tab to view the dependent automation pack and required adapter lists for the
automation pack.
The dependencies will be updated when the automation pack properties is first opened or when there is
a change to the Objects tab, such as adding or removing an object.
Figure 22-22

New Automation Pack Properties—Dependencies Tab
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Step 3

Review the list of automation packs and adapter information referenced and required by the objects in
the automation pack.
Automation Pack Dependencies
Columns

Description

Display Name

Name of the automation pack

Company Name

Name of the company that released the automation pack

Version

Version number of the product

Publish Date

Date the automation pack was exported to a file

Description

Brief description of the automation pack.
Marketing information for the automation pack can be
displayed as well as a hyperlink to marketing information.

Required Adapters

Step 4

Display Name

Name of the adapter

Company name

Name of the company that licensed the product

Version

Version number of the product

Release date

The date and time the adapter is available in the product

Install date

The date and time the adapter was installed

Description

A brief overview of the adapter

Click OK to close the dialog box.
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Adding Objects to Automation Packs
Use this option to add more objects to an automation pack file.
To add objects to an automation pack:
Step 1

In the Administration—Automation Packs view, highlight the appropriate automation pack, right-click
and choose Properties.

Step 2

Click the Objects tab to continue.
Figure 22-23

Step 3

New Automation Pack Properties—Objects Tab

Click Add to add objects to the automation pack.
The Select Object dialog box displays.

Note

Objects that already belong to an automation pack will be filtered from this dialog box.
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Figure 22-24

Select Object Dialog Box

Step 4

From the Filter by Object Type drop-down list, choose the appropriate object type to filter the list of
objects.

Step 5

Under Select Object, highlight the appropriate object(s) and click OK.

Note

To choose multiple objects, press Shift-Click to choose objects in sequence or Ctrl-Click to choose
objects in non-sequential order.

Step 6

If the object is not displayed in the list, click New to create an object to add to the automation pack.
The objects display on the Objects tab.

Step 7

Click OK to close the dialog box.

Customizing the Settings for Automation Packs
Use the Settings dialog box to define the customization settings for the objects included in an automation
pack. These settings can only be modified by the automation pack author.
When the automation pack author imports a newer version of the TAP, the objects in the automation pack
will replace the objects in the database.
When a third-party user imports a newer version of the TAP, the customization setting of an object will
determine whether users customized values will be preserved.
The following are instances where an object customization will be lost.
•

The author of the object no longer allows users to customize the object. Any customization of the
object will be lost on upgrade.
For example, the global variable customization level is set to Limited. Users change the variable
value. However, in the updated TAP, the author no longer allows users to change the variable value,
because the TAP must have a particular value. Therefore, the customization level is now set to No.

•

The object customization level is unchanged, but the schema of the object is changed. The old object
is now obsolete and needs to be replaced.
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Note

For information on the properties of the objects that can be customized, see Customization Properties,
page 22-5.
To change the customization of an object:

Step 1

On the Administration Automation Pack view, highlight the appropriate automation pack, right-click and
choose Properties.

Step 2

Click the Objects tab to continue.

Step 3

Highlight the appropriate object, and then click Settings.
The Settings dialog box displays.
Figure 22-25

Step 4

Settings Dialog Box

From the Customizable drop-down list, choose the appropriate option.
Option

Function

No

Choose this option to indicate the author of the object prefers
the object to remain unchanged whenever a new automation
pack is imported.
Therefore, any changes made to the existing object on the
database will be lost when replaced by the object in the TAP.
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Option

Function

Limited (Default)

Choose this option to indicate that the author has granted
editing permission to some properties of the object and any
changes made will be preserved whenever a new automation
pack is imported.
If the customization level of an object being imported is set to
Limited, the author of the object grants the users editing
permission to some properties of the object. Those properties,
if modified on the existing object in the database, will be
preserved.
Note

If the previous version of a process has the
customization level set to Workflow, but the updated
process is set to Limited, all properties that users can
customize with the Limited customization level will be
preserved.
The rest of the modified properties will be replaced
because the setting by the author has dictated that the
properties cannot be modified when setting is Limited.
See the Customization Properties, page 22-5.

Workflow

This setting is only available for a process, which contains the
process properties and the workflow.
Choose this option to indicate that any changes made to the
process properties and workflow will be preserved whenever a
new automation pack is imported.
If the workflow is not modified, then the workflow will be
replaced when an updated automation pack is imported.

Step 5

Click OK to close the dialog box.
The selected option displays in the Objects tab.

Removing Objects from Automation Packs
Use this option to remove objects from an automation pack file. Removing objects from the list of objects
in the automation pack does not delete the object from the system.
To remove objects from automation pack:
Step 1

On the Administration—Automation Pack view, highlight the appropriate automation pack, right-click
and choose Properties.

Step 2

Click the Objects tab to continue.

Step 3

Highlight the appropriate object and then click Remove to remove the object from the list.
The object is removed from the list of objects displayed on the Objects tab.

Step 4

Click OK to close the dialog box.
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Refreshing References in Automation Pack View
Use the following instructions to update list of objects in the Objects tab.
To refresh the objects list:
Step 1

On the Administration—Automation Packs view, highlight the appropriate automation pack, right-click
and choose Properties.

Step 2

Click the Objects tab to continue.

Step 3

Click Refresh References to update the list of references associated with the object.

Step 4

Click OK to close the dialog box.

Deleting Automation Packs
Use the following steps to delete an automation pack from TEO. Automation packs that have objects
with dependencies cannot be deleted.
To delete an automation pack:
Step 1

On the Administration—Automation Packs view, highlight the appropriate automation pack, right-click
and choose Delete.
The Delete Confirmation dialog box displays.
Figure 22-26

Delete Automation Pack Dialog Box

Step 2

Uncheck the Select the checkbox to delete all member objects check box to keep all member objects
in the product. If the check box remains checked, then all objects in the automation pack will also be
deleted.

Step 3

Click OK to delete the automation pack.
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Core Automation Pack Objects
This section describes the objects that are added to the product after the Core automation pack is
imported. The Core automation pack is provided by TEO and is a required prerequisite for all other
automation packs included in the TEO installation.
The Core automation pack cannot be exported. However, the users are able to customize the majority of
the objects within the automation pack. Refer to the Customization Properties, page 22-5 for information
on which properties of the objects are available for modification.

Imported Calendars
The calendar objects included in the automation pack are default calendar definitions provided by the
Core automation pack and cannot be modified by the user. Many of the calendar definitions are based on
U.S. holidays, as well as other standard calendar recurrences.
These calendar objects may be used when creating a schedule trigger or a time condition. Refer to the
Chapter 8, “Managing Triggers” and Chapter 10, “Managing Conditions” for additional information.
For information on creating a calendar, see Chapter 12, “Managing Calendars.”
The following table contains the calendars that were imported by the Core automation pack.
Calendar Name

Type

Customization Setting

Christmas

Recurring Calendar

No

Daily

Recurring Calendar

No

Easter (US)

Date List Calendar

No

Every Friday

Recurring Calendar

No

Every Monday

Recurring Calendar

No

Every Saturday

Recurring Calendar

No

Every Sunday

Recurring Calendar

No

Every Thursday

Recurring Calendar

No

Every Tuesday

Recurring Calendar

No

Every Wednesday

Recurring Calendar

No

Good Friday (US)

Date List Calendar

No

Holidays (US)

Group Calendar

No

Independence Day (US)

Recurring Calendar

No

Labor Day (US)

Recurring Calendar

No

Memorial Day (US)

Recurring Calendar

No

New Years Day

Recurring Calendar

No

Presidents Day (US)

Recurring Calendar

No

Thanksgiving (US)

Recurring Calendar

No

Weekdays

Recurring Calendar

No

Weekend

Recurring Calendar

No

Workdays

Group Calendar

No
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Imported Categories
The category objects included in the automation pack are default category definitions provided by the
Core automation pack. Categories can be assigned to objects and are used to organize different objects
throughout TEO. The categories included in the Core automation pack have the Limited customization
setting and some properties can be modified.
For information on modifying category definitions, see Chapter 18, “Managing Categories.”
The following table contains the categories that are imported by the Core automation pack.
Category Name

Description

Customization Setting

Ad Hoc

Assigned to objects which can be started Limited
on ad hoc basis

Examples

Assigned to objects which are example
objects

Limited

Monitoring

Assigned to objects used to monitor the
TEO service

Limited

Notification

Assigned to objects used to notify users
via email as part of the process

Limited

Imported Expect Templates
Expect properties are used to configure the parameters which manage the Terminal target command
output. Generic expect templates included in the Core automation pack are available for use in the targets
provided by the Terminal adapter. The properties of the expect template cannot be modified from the
Terminal adapter properties dialog box. However, the expect properties can be modified when used with
a target.
For information on modifying the expect properties, refer to the Cisco TEO Adapter Guide for Terminal
Adapter.
The following table contains the expect templates that are imported by the Core automation pack.
Expect Template Name

Description

Customization Setting

Cisco IOS Device

Generic Expect Template for Cisco IOS
Device

Limited

Unix/Linux System

Generic Expect Template for Unix/Linux Limited
Systems

Imported Global Variables
Variables can be used as a reference value used for multiple objects. They can also be used to store or
pass a value between executions of a process or between steps within a single process. The global
variables included in the Core automation pack have the Limited customization setting, but only the
variable value property can be modified.
For information on modifying global variable definitions, see Chapter 11, “Managing Variables.”
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The following table contains the global variables that are imported by the Core automation pack.
Global Variable Name

Description

IT Operations Approver(s)

This is the AD account for the default IT Approver. This is
used in "Example—Approval Process"

IT Operations Manager(s)

This is the AD account for the IT Manager. This is used in
the "Example—Approval Escalation" Process

Task Time Period Due

The length of time (hours) a task has before it becomes
overdue.
This is only used in the Example—Approval Process and is
not the default value when creating new approval tasks
within a custom authored process.

Imported Processes
The processes included in the Core automation pack have the Limited customization setting, but only
the specified properties listed in the Customization Properties, page 22-5, can be modified.
For information on modifying process definitions, see Chapter 7, “Authoring Processes.”
The following table contains the processes that are imported by the Core automation pack.
Process Name

Description

Customization Setting

Close Expired Alerts

Default process to close alerts
that have expired

Limited

Close Expired Approval
Requests

Default process to close approval Limited
requests that have expired

Close Expired Guided
Operations Tasks

Default process to close guided
operations tasks that have
expired

Limited

Close Expired Incidents

Default process to close
incidents that have expired

Limited

Close Expired Input Requests

Default process to close input
requests that have expired

Limited

Close Expired Review Requests

Default process to close review
requests that have expired

Limited

Default Alert Notification

Default process to send email
when an alert gets assigned

Limited

Default Alert Notification Based Default process to send email
on Assignment
when an alert gets assigned

Limited

Default Approval Request
Notification

Default process to send email
when a guided operation has a
new notification recipient

Limited

Default Approval Request
Notification based on
Assignment

Default process to send email
when an alert gets assigned

Limited
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Process Name

Description

Customization Setting

Default Guided Operation
Request Notification

Default process to send email
when a guided operation task
gets assigned

Limited

Default Guided Operation
Request Notification based on
Assignment

Default process to send email
when a guided operation task
gets assigned.

Limited

Default Incident Notification

Default process to send email
when an incident gets assigned

Limited

Default Input Request
Notification

Default process to send email
when an input request gets
assigned

Limited

Default Review Request
Notification

Default process to send email
when a review request gets
assigned

Limited

Default SNMP Trap Notification Default process to send SNMP
traps when an alert is created

Limited

Publish Core Alerts on Windows Alerts created by processes in
Limited
Event Log
the Core automation package
will create events in the
Windows event log in the
Automation Server machine. It is
necessary for integration with
management frameworks like
Microsoft SCOM 2007.
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Configuring Reports
The Report Database feature offers the ability to run reports for viewing process execution history and
to audit process changes. The database can be created on the machine where Tidal Enterprise
Orchestrator is installed or a different machine.
Administrative rights are only required when creating a report database. Administrative rights are not
required to manage either BO reports nor SQL Server Reporting Services (SSRS) reports. To create
reports in the report database, the user must be logged in with an account that has Administrator rights
on the machine where the report database is being created, whether it is the local machine or a remote
machine.
If using SSRS, the user account must also have Reporting Services permission to create or modify the
reports as create or modify permission over the Report Database object within TEO.
The following sections provide instruction on managing reports in TEO:
•

Configuring Report Database, page 23-2

•

SQL Server Reporting Services, page 23-11

•

Business Objects Reporting Services, page 23-15
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Configuring Report Database
Use the following sections to configure report database settings.

Core Reports
Tidal Enterprise Orchestrator provides several tracking reports. The following table lists the Core reports
that can be accessed from SQL Server Reporting Services and Business Objects Reports.
Reports

Description

Auditing Reports

Configuration Audit

Use this report to identify changes to the process
definitions during a specific date range and the user who
made the changes.

Process Audit

Use this report to view the status of all process instances
that were run during a specific date range

Task Audit

Use this report to view the status of all tasks that were run
during a specific date range

Operations

All TEO Incidents

Displays a history of all TEO Monitoring incidents that
meet the specified incident level.
Click the link in the Time column to view detailed
information about the incident.

Process Weekly Summary

Use this report to view the overall status of process
instances that were run during a specific date range.

ROI Report

Use this report to view the return on investment (ROI)
during a specific date range.

TEO Incident Detail

Displays details about the TEO incidents generated in the
TEO Incidents report
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Configuring Reporting Database Settings
The Report Database is created during the installation process, but only the default size of the data files
are determined. Use the Report Database Properties dialog box to modify the connection properties and
determine the amount of data that is archived in the database files before being deleted from the system.
To configure the report database settings:
Step 1

In the Administration—Database Settings view, highlight Report Database, right-click and choose
Properties.
The Report Database Properties dialog box displays. The Connection tab displays by default.
Figure 23-1

Step 2

Report Database Properties—Connection Tab

On the Connection tab, modify the credentials to the reporting database:
Field

Description

Database type

From the drop-down list, choose the database type for the
credentials:
•

SQL Server (Integrated Windows Authentication
Credentials)—Uses the credentials of the user logged
into Microsoft Windows. However, users can also
specify the credentials of another user.

•

SQL Server (SQL Authentication)—Enter the SQL
server credentials to use for creating the database
(Login ID and Password)

Server name

Display-only. Name of the database server

Database name

Display-only. Name of the report database (default
TEOReporting)

User

User name assigned to the user account
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Field

Description

Password

Password assigned to the user account
Note

For Integrated Windows Authentication Credential
passwords, check the check box to enter the new
password assigned to the user account. If the
password entered is incorrect, then a confirmation
dialog box displays stating:
"Logon failure: unknown user name or bad
password.”

Domain

Windows domain in which the user account resides
Note

Reports URL
Step 3

When SQL Server authentication is selected, this
field is display-only.

File path to the report server to where the reports reside

Click Next to continue.
The Configuration tab displays.
Figure 23-2

Step 4

Report Database Properties—Configuration Tab

On the Configuration tab, review the following database grooming settings:
Groom Setting

Description

Groom event data older than

Number of days before event data is deleted from the
database

Groom performance data older than Number of days before performance data is deleted from
the database
Groom alert data older than

Number of days before alert data is deleted from the
database

Cisco Tidal Enterprise Orchestrator Reference Guide

23-4

OL-24928-01

Chapter 23

Configuring Reports
Configuring Report Database

Groom Setting

Description

Groom incident data older than

Number of days before incident data is deleted from the
database

Groom process audit data older than Number of days before the audit data is deleted from the
database

Step 5

Groom configuration audit data
older than

Number of days before configuration audit data is deleted
from the database

Groom task audit older than

Number of days before the task audit data is deleted from
the database

Click OK to close the dialog box.

Creating TEO Reporting Database Connection
The TEO Reporting database is initially created during the installation process. There are occasions
when the report database connection may need to be removed and then re-connected.
To create the report database connection, the user must be logged in with an account that has
Administrator rights on the machine where the report database is being created, whether it is the local
machine or a remote machine.
The user account must also have Reporting Services permission to create or modify the reports as create
or modify permission over the Report Database object within Tidal Enterprise Orchestrator.

Note

In SQL Server Express 2008 Advanced Services, report models are not supported. Therefore customers
using SQL Server Express 2008 cannot create their own reports.
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Use the following steps to create the report database connection:
Step 1

On the Administration—Database Settings view, right-click Report Database and choose Create TEO
Reporting Database.
The Welcome to the Report Database Configuration Wizard panel displays.
Figure 23-3

Note

Step 2

Welcome to the TEO Report Database Configuration Wizard Panel

To skip the Welcome panel the next time the wizard is launched, check the Do not show this page next
time check box.
Click Next to continue.
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The New TEO Reporting Database panel displays.

Note

The fields on this panel (excluding the Password field) are automatically populated with the name of the
local server and the credentials of the currently logged in user.
Figure 23-4

Step 3

TEO Reporting Database Configuration Wizard—New TEO Reporting Database Panel

On the New TEO Reporting Database panel, use one of the following methods:
•

To use the credentials that are auto-populated for the default user, enter the password in the
Password field.
-or-

•

To specify credentials for a different user, specify the following information:

Field

Description

Database type

From the drop-down list, choose the database type for the
credentials:
•

SQL Server (Integrated Windows Authentication
Credentials)—Uses the credentials of the user logged
into Microsoft Windows. However, users can also
specify the credentials of another user.

•

SQL Server (SQL Authentication)—Enter the SQL
server credentials to use for creating the database
(Login ID and Password)

Server name

Name of the SQL server where the database resides

User

User name assigned to the user account
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Field

Description

Password

Password assigned to the user account
Note

For Integrated Windows Authentication Credential
passwords, check the check box to enter the new
password assigned to the user account. If the
password entered is incorrect, then a confirmation
dialog box displays stating:
“Logon failure: unknown user name or bad
password.”

Domain

Windows domain in which the user account resides
Note

Step 4

When SQL Server authentication is selected, this
field is not displayed.

Click Next to continue.
The Database Settings panel displays.

Note

The fields on this panel are automatically populated with the default locations and data grooming
settings for the database.
Figure 23-5

TEO Reporting Database Configuration Wizard—Database Settings Panel
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Step 5

On the Database Settings panel, use one of the following methods:
•

To use the information that is auto-populated, click Next to continue.
-or-

•

To modify the data and transaction log file settings for the new database, specify the following
information:

Field

Description

Data file location

File path to the database data file

Log file location

File path to the database transaction log file

Groom event data older than

Check the check box and in the numeric field, enter the
number of days before event data is deleted from the
database.

Groom performance data older than Check the check box and in the numeric field, enter the
number of days before performance data is deleted from
the database.
Step 6

Click Next to continue.
The Creating Database panel displays.

Step 7

When the dialog box indicates that the database has been successfully created, click Next.
The Review Configuration panel displays.
Figure 23-6

TEO Reporting Database Configuration Wizard—Review Configuration Panel
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Step 8

Verify the information and click Finish to complete the procedure and close the wizard.
The Report Database is enabled in the Results pane on the Console.

Note

To import reports, see Importing Reports, page 23-11.

Removing a Report Database Connection
Use the following steps to remove the report database connection from TEO. These steps are useful when
changing report database connections.
To remove the report database connection:
Step 1

On the Administration—Database Settings view, right-click Report Database and choose Remove TEO
Reporting Database Connection.
The Confirm Removing TEO Reporting Database Connection dialog box displays.
Figure 23-7

Step 2

Confirm Removing TEO Reporting Database Connection Dialog Box

Click Yes to remove the database connection.
The database connection is removed from the TEO configuration, but still remains on the SQL Server
database server. The Report Database option will appear as disabled in the Administration—Database
Settings view while there is no report database connection.
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SQL Server Reporting Services
This section describes reports and the process for importing reports into Tidal Enterprise Orchestrator
using SQL Server Reporting Services.

Importing Reports
Use the import reports process to import new reports into the report database.
To import reports, the user must be logged in with an account that has Administrator rights on the
machine where the report database is being created, whether it is the local machine or a remote machine.
The user account must also have Reporting Services permission to create or modify the reports as create
or modify permission over the Report Database object within TEO.
To import reports:
Step 1

On the Administration—Database Settings view, right-click Report Database and choose Import
Reports.
The Report Settings panel displays.
Figure 23-8

Import Reports Wizard—Report Settings Panel
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Step 2

On the Report Settings panel, specify the following information, as necessary.
Field

Description

Reports Server URL

Address or file path for the SQL Server Reporting Services
reports server

Access Reports Server via Secure
Socket Layer (SSL)

Check the check box if the SSL protocol is used to connect
to the Reports Server

Database type

From the drop-down list, choose the database type for the
credentials:
•

SQL Server (Integrated Windows Authentication
Credentials)—Uses the credentials of the user logged
into Microsoft Windows. However, users can also
specify the credentials of another user.

•

SQL Server (SQL Authentication)—Enter the SQL
server credentials to use for creating the database
(Login ID and Password)

User

User name assigned to the user account

Password

Password assigned to the user account
Note

For Integrated Windows Authentication Credential
passwords, click the check box to enter the new
password assigned to the user account. If the
password entered is incorrect, then a confirmation
dialog box displays stating:
“Logon failure: unknown user name or bad
password.”

Domain or local computer

Windows domain in which the user account resides
Note

Step 3

When SQL Server authentication is selected, this
field is not displayed.

Click Next to continue.
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The Reports Files Location panel displays.
Figure 23-9

Step 4

Import Report Wizard—Report Files Location Panel

Click Browse to modify the default report file location.
C:\Documents and Settings\<user>\My Documents\Cisco\Tidal Enterprise Orchestrator\Extracted
Data\SQL Server Reporting Services Reports
If the wrong path is selected, the report folders will affect future upgrades.
If the report folder already exists, the Report Folder dialog box displays asking to confirm whether the
existing folder should be overwritten. Click Yes to continue.
The Creating Reports dialog box displays while the reports are being imported.
After the reports have been imported, the Review Configuration panel displays.

Step 5

Note

Click Finish to close the dialog box.

For more information on accessing SQL Service Reports, see Accessing SQL Server Reporting Services
Reports, page 23-14.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

23-13

Chapter 23

Configuring Reports

SQL Server Reporting Services

Accessing SQL Server Reporting Services Reports
TEO provides database reports required by managers and auditors as well as reports required by
developers of process automation. In general, the data that is provided for these diverse audiences is the
same. What differs is the granularity and level of aggregation of this data and the specific data that is the
focus of a given report.
Access to any automation summary is controlled and available only to authorized users. Automation
summary reports are accessed through a web browser using Microsoft SQL Server Reporting Services.
Users are able to access reports from a web browser using SQL Server Reporting Services.
To access reports from your web browser:
Step 1

Open your web browser and in the Address bar, enter the following address:
http://<ReportServer>/Reports

where <ReportServer> is the name of the server hosting the reports.
The SQL Reporting Services Report Manager web page displays.
Step 2

Click the Tidal Enterprise Orchestrator TEO Reporting—<Report Server> hyperlink.
The TEO Reporting Database Report Manager home page displays.
Figure 23-10

Step 3

Tidal Enterprise Orchestrator TEO Reporting <Report Server> Home

Click Core to view the Core TEO report folders.
The available reports and a brief description of the information that is generated by each report is
displayed.

Step 4

Click the report name to enter the search criteria and generate the report.
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Business Objects Reporting Services
Although TEO supports SQL Server Reporting Services, Business Objects Reports is the recommended
reporting tool for TEO reports.
During the Core Automation Pack import process, BIAR files are copied to the file path determined on
the Core Report panel. The BIAR file must be imported onto the Business Objects server using the
Business Objects Import Wizard in order to view the reports in Business Objects InfoView.
To import BIAR files, the user must be logged in with an account that has the appropriate permissions
on the Business Object server, whether it is the local machine or a remote machine.
This section provides the steps to use when importing the reports onto a Business Objects server and
configuring the connection for viewing the reports onto the SQL Server Reporting Services.

Importing Reports into Business Objects
Use the following steps to import reports into Business Objects.
Step 1

Choose Start > All Programs > Business Objects X1.3.1 > Business Objects Enterprise > Import
Wizard.
The Welcome to the Import Wizard panel displays.
Figure 23-11

Business Objects Import Wizard—Welcome to the Import Wizard Panel

Step 2

From the Language drop-down list, choose the appropriate language to use to import the reports. English
is the default.

Step 3

Click Next to continue.
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The Source environment panel displays
Figure 23-12

Step 4

Business Objects Import Wizard—Source Environment Panel

On the Source environment panel, specify the environment for where the wizard will import the
appropriate user and object information.
The fields in the lower pane changes upon the selection.

Step 5

Field

Description

Source

From the drop-down list, choose Business Intelligence
Archive Resource (BIAR) File.

BIAR file

Enter the appropriate file path or click Browse to locate the
BIAR file on the computer.

Click Next to continue.
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The Destination environment panel displays.
Figure 23-13

Step 6

Business Objects Import Wizard—Destination Environment Panel

On the Destination environment panel, specify the appropriate information for Business Object
Enterprise XI 3.1.
Field

Description

CMS Name

Enter the name of the Business Object Enterprise XI 3.1
destination CMS
Note

User Name

If the CMS is running a particular port, add a colon
and the port number to the end of the CMS name.

Enter the name of a user with import permissions
The default is typically an administrator.

Step 7

Password

Enter the password of the associated user name

Authentication

Choose the type of authentication appropriate for the CMS
and the user who will be used to import the reports. The
default is Enterprise.

Click Next to continue.
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The Loading BIAR files progress dialog box displays and then transitions to the Select objects to import
panel.
Figure 23-14

Business Objects Import Wizard—Select Objects to Import Panel

Step 8

On the Select objects to import panel, choose the appropriate items to import into your Business Object
Enterprise XI 3.1 server.

Step 9

Click Next to continue.
The Import scenario panel displays.
Figure 23-15

Business Objects Import Wizard—Import Scenario Panel
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Step 10

On the Import Scenarios panel, select the appropriate radio button for handling scenarios where the
objects already exist in the destination environment.
Import Scenarios

Description

Update the destination object. In
case of name conflict, rename it.

If the Import Wizard finds an object in the destination
environment with the same source objects unique identifier
(CUID), it updates the destination object.
If the Import Wizard does not find an object in the
destination environment with the same CUID but it finds an
object with the same name, the Import Wizard imports the
object from the source environment and then renames the
object.

If the Import Wizard finds an object in the destination
Update the destination object. In
case of name conflict, do not import environment with the same CUID, it updates the
it.
destination object.
If the Import Wizard finds an object in the destination
environment with the same name but different CUID, the
Import Wizard does not import the object from the source
environment.
Do not import the object.

Step 11

If the Import Wizard finds an object in the destination
environment with the same CUID, the Import Wizard does
not import the object.

Click Next to continue.
The Incremental import panel displays.
Figure 23-16

Business Objects Import Wizard—Incremental Import Panel
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Step 12

Step 13

On the Incremental import panel, uncheck the check boxes next to options which perform the following
as appropriate:
•

To import report objects without overwriting dependent objects that already exist in the destination
environment.

•

To import report objects without importing a universe or connection that would overwrite a universe
or connection in the destination environment.

Click Next to continue.
The A note on importing server groups panel displays.
Figure 23-17

Step 14

Business Objects Import Wizard—A Note on Importing Server Groups Panel

Review the information on the panel and then click Next.
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The Users and groups panel displays.
Figure 23-18

Business Objects Import Wizard—Users and Groups Panel

Step 15

On the Users and groups panel, check the check boxes to import the appropriate specific users and
groups.

Step 16

Click Next to continue.
The Custom Access Levels panel displays.
Figure 23-19

Business Objects Import Wizard—Custom Access Levels Panel
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Step 17

On the Custom Access Levels panel, check the appropriate check boxes to import custom access level.

Note

If you import a user and an object, the Import Wizard imports the rights of that imported and does not
exist in the destination environment, the Import Wizard gives the individual rights specified in the level
on the object for the user.

Step 18

Click Next to continue.
The Categories panel displays.
Figure 23-20

Step 19

Business Objects Import Wizard—Categories Panel

Choose the appropriate categories to be imported.
For large document domains, you can import incrementally and import documents one category at a
time.

Step 20

To import all the objects associated with the category, check the Import all objects that belong to the
selected categories check box.

Step 21

Click Next to continue.
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The Folders and objects panel displays.
Figure 23-21

Business Objects Import Wizard—Folders and Objects Panel

Step 22

To import folders and objects for Tidal Enterprise Orchestrator, click Select All to check all check boxes
of the folders and objects displayed.

Step 23

To import all instances of each selected object, check the Import all instances of each selected object
check box.

Step 24

Click Next to continue.
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The Select application folders and objects panel displays.
Figure 23-22

Step 25

Note

Step 26

Business Objects Import Wizard—Select Application Folders and Objects Panel

To import application folders and objects, check the appropriate check boxes.

If the selected folders and objects exist on the destination system, they will be updated using the source
system as a reference.
Click Next to continue.
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The Import options for universes and connections panel displays.
Figure 23-23

Step 27

Step 28

Business Objects Import Wizard—Import Options for Universes and Connections
Panel

Select one of the following import radio buttons for universe objects.
•

Import all universes and connection objects (Default)

•

Import all universes and only connection objects used by these universes

•

Import the universes and connections that the selected Web Intelligence and Desktop Intelligence
documents use directly. In the next dialog box, you can select additional universes that are not used
by any imported document.

To import universe overloads, check the Keep universe overloads for imported users and groups
check box.
If you are importing universe overloads, you must also choose the users, groups, and universes during
previous steps in the Import Wizard. You must also choose Overwrite existing objects in the Incremental
import panel. If you did not choose these options, click Back until you get to the appropriate panel.
If you choose to import users and groups, universe overloads, and other objects and do not want to
overwrite all of the object rights for the users and groups and objects that you’ve selected, use one of the
following methods:
•

Ensure that you choose only the universes that you want to import and then import the other objects
in another import process.

•

Delete the universe overload in the destination environment and then uncheck the Overwrite
existing objects and Overwrite object rights check boxes in the Incremental import panel. In this
case, the Import Wizard imports only the universe overloads that do not already exist in the
destination environment.
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Step 29

Click Next to continue.
If either of the first two radio buttons are selected, the Import options for publications panel displays.
Skip to Step 32 to continue.
Figure 23-24

Business Import Wizard—Import Options for Publications Panel

If the third radio button is selected, the Universe folder and universes panel displays.
Figure 23-25

Business Objects Import Wizard—Universe Folder and Universes Panel
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Step 30

On the Universe folder and universes panel, choose the appropriate universes and universe folders.
If the selected source environment is other than BusinessObjects 5.x or 6.x, the universes that are linked
to specific documents cannot be cleared from the list. Users can choose additional universes that are not
used by any imported document.
If no universe is found, the associated documents will not be imported and a warning message appears.
If this occurs, link the documents to a universe, republish the documents to the repository, and retry the
import.

Step 31

Click Next to continue.
The Import options for publications panel displays.

Step 32

On the Import Options for Universes panel, choose the appropriate profile and publication recipient
radio buttons.
Option

Step 33

Description

Select import option for importing
profiles

•

Import all profiles

•

Import profiles used by selected publications

Select import option for importing
publication recipients

•

Import recipients used by selected publications

•

Do not import recipients

Click Next to continue.
The Remote Connections and Replication Jobs panel displays.
Figure 23-26

Business Objects Import Wizard—Remote Connections and Replication Jobs Panel

Step 34

On the Remote Connections and Replication Jobs panel, choose the appropriate remote connections and
replication jobs to import.

Step 35

Click Next to continue.
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The Ready to import panel displays.
Figure 23-27

Step 36

Business Objects Import Wizard—Ready to Import Panel

Click Finish.
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Configuring the BO Connection for SQL Server Reporting Services
Use the following steps to configure the BusinessObjects reporting connection to SQL Server Reporting
Services. Verify the following before configuring the BO reports connection:
•

Microsoft SQL native client is installed

•

On the reporting database, the named pipes are enabled. To enable the named pipes, use MS SQL
Configuration Manager.

For additional information on the prerequisites, refer to Microsoft SQL Server 2005 Feature Pack.
To configure the BO reports connection:
Step 1

Choose Start > All Programs > Business Objects X1.3.1 > Business Objects Enterprise > Designer.
The User ID dialog box displays.
Figure 23-28

Step 2

User Identification Dialog Box

Enter the appropriate credentials, and click OK.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

23-29

Chapter 23

Configuring Reports

Business Objects Reporting Services

The Universe Designer dialog box display.
Figure 23-29

Step 3

From the Tools menu, choose Connections.
Figure 23-30

Step 4

Universe Designer Dialog Box

Wizard Connection Dialog Box—Connections List

From the Connections List, highlight TEOReporting, and click Edit.
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The Edit TEOReporting Connection dialog box displays.
Figure 23-31

Edit TEOReporting Connection Dialog Box—Login Parameters

Step 5

In the Authentication Mode list, verify that Use specified username and password is selected.

Step 6

Specify the following information for the reporting database.
Field

Description

User name

User name to access report database

Password

Password of the associated user name

Server

Host or IP address of the report server

Database

Name of the reporting database. TEOReporting is the
default db created

Step 7

Click Next to continue.

Step 8

Verify the information on the Configuration Parameters and the Custom Parameters panels and then click
Finish.
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Accessing Reports in Business Objects InfoView
Using the recommended policy for Microsoft Windows may cause the Business Objects InfoView web
interface to be blocked due to the enhanced security configuration. The security error dialog box will
advise the user to add the site to the list of trusted web sites.
Use the following steps to access reports in Business Objects InfoView.
Step 1

In a web browser, in the Address bar, type the URL to the Business Objects InfoView website.
The Business Objects InfoView Login page opens.
Figure 23-32

Business Objects InfoView—Login Page

Step 2

Enter the appropriate credentials to access the BO reports.

Step 3

Click Log On to continue.
The Business Objects InfoView Dashboard page displays.

Step 4

On the Dashboard page, click Document List.
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The Document List Navigation page display.
Step 5

Expand Public Folders > Tidal Enterprise Orchestrator > Core to access the Core reports.
Figure 23-33

Step 6

Business Objects InfoView—Core Reports View

Double-click the appropriate report to view report details.
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Configuring Core Functions Adapter
The Core Functions Adapter provides the basic functionality in TEO. Use the Core Functions Adapter
Properties dialog box to configure default task settings, automation summary report location, and Return
on Investment (ROI) calculations.
This chapter provides instructions viewing and modifying the Core Functions Adapter properties.
•

Configuring Return on Investment Settings, page 24-2

•

Configuring Automation Summary Settings, page 24-4

•

Getting Task XSL Transforms, page 24-6

•

Configuring Task Expiration Settings, page 24-7

•

Viewing Adapter-Supported Objects, page 24-8

•

Viewing Adapter History, page 24-9
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Configuring Return on Investment Settings
When you create a process, you have the option to enter the equivalent time it would take to run the
process manually. This value is calculated against the hourly rate specified on this page to determine the
return on investment for the process.
To configure the ROI:
Step 1

On the Administration—Adapters view, right-click Core Functions Adapter and choose Properties.
The Core Functions Adapter Properties dialog box displays.
Figure 24-1

Core Functions Adapter Properties—General Tab
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The General display-only tab displays information about the installed adapter.

Step 2

Field

Description

Display name

The name of the adapter

Type

The object type

Description

A brief overview of the adapter

Company

The name of the company that created or supplied the
adapter

Version

The version number of the adapter

Release date

The date and time the adapter is available in the product

Install date

The date and time the adapter was installed

Click the ROI tab to continue.
Figure 24-2

Core Functions Adapter Properties—ROI Tab

Step 3

On the ROI tab, specify the hourly rate (in dollars) that it would cost to execute a process manually.

Step 4

Click OK to close the dialog box.
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Configuring Automation Summary Settings
Certain activities can generate an automation summary that provides information that can help resolve
any issues that may need attention. The Automation Summary settings of the Core Functions adapter
specify the location for automation summary files, automation summary sharing and grooming options.
To configure the automation summary settings
Step 1

In the Administration—Adapters view, right-click Core Functions Adapter and choose Properties.
The Core Functions Adapter Properties dialog box displays.

Step 2

Click the Automation Summary tab to continue.
Figure 24-3

Core Functions Adapter Properties—Automation Summary Tab
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Step 3

On the Automation Summary tab, specify where the automation summary reports that are generated by
activities are to be saved and how long the reports are to be retained.
The file paths specified indicate the path that will be used when viewing the automation summary
reports.

Step 4

Verify or enter the appropriate default file path for the automation summary directory.
Field

Description

Automation summary directory

Verify the default file path that the TEO server will use
when creating automation summary reports.
Click Browse to determine the file path for the automation
summary.

Step 5

Select the appropriate directory mapping option from the drop-down list to map the automation summary
to a shared directory or IIS Virtual Directory to allow end-users easier access to automation summaries
using email or the TEO Web Console.
Option

Description

Share

Select this option to indicate the automation summary
should be saved on the specified file path.
In the Share Path field, enter the UNC path to a share
directory. This path will be used when viewing the
automation summary reports.
Example:
(\\servername\sharename\path\filename)

•

Verify share—Click this button to verify that the
current file path in the text field is a valid UNC share
directory. If a valid file path exists, a confirmation
dialog box displays.

•

Create share—Click this button to create the directory
on the TEO server where the automation summary
reports should be created.

Note

Use IIS Virtual Directory

Verify that the UNC share file path is on a network
where the TEO service account has write
permissions.

Select this option to indicate the file path is on an IIS
Virtual Directory.
In the Virtual directory path field, enter the http:// path that
corresponds to a virtual directory in IIS.
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Option

Description

Do not map the path

Select this option to indicate that the automation summary
should not be saved to a shared or IIS virtual directory.
If this option is selected, then the automation summary will
not be available for view from the Web Console.

Delete automation summary reports Check this check box and in the text field, and enter the
number of days that the automation summary files should
older than
be retained in the text field.
Automation summary files that have been retained for a
period past the specified number of days will be deleted.
Step 6

Configure the archiving settings for the automation summary reports.
Option

Description

Delete automation summary reports Check this check box and in the text field, and enter the
number of days that the automation summary files should
older than
be retained in the text field.
Automation summary files that have been retained for a
period past the specified number of days will be deleted.
Step 7

Click OK to close the dialog box.

Getting Task XSL Transforms
Each task type has a specific XSL transform that converts the XML into HTML web pages for display
in the Web Console. Use the Task tab to display the default xslt transform file names. The files are
located in the TEO program Web Console folder under the following file path:
C://Install Directory/Web Console/Task XSL Transforms

Users can change the XSL file name for a specific task when modifying the task properties in the Process
Editor.
To get the task XSL transform:
Step 1

In the Administration—Adapters view, right-click Core Functions Adapter and choose Properties.
The Core Functions Adapter Properties dialog box displays.

Step 2

Click the Task tab to continue.
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Figure 24-4

Step 3

Core Functions Adapter Properties—Task Tab

On the Task tab, highlight the appropriate task, and use one of the following methods:
•

Right-click and choose Properties.

•

Click Properties.

The Task XSL Transform dialog box displays the default XSL transform file name for the specific task.
Figure 24-5

Task XSL Transform Dialog Box

To view the converted code, launch the appropriate XSLT file resides in the TEO install
directory/WebConsole folder using a web browser.
Step 4

Click OK to close the dialog box.

Configuring Task Expiration Settings
Use the Task Properties page to specify the default number of days used for the task expiration date. If
a task is opened on its expiration date, an internal event is raised which can be used to trigger a process.
Users will be able to modify the date manually on the appropriate task property page.
To define default task expiration:
Step 1

In the Administration—Adapters view, right-click Core Functions Adapter and choose Properties.
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The Core Functions Adapter Properties dialog box displays.
Step 2

Click the Task Properties tab to continue.
Figure 24-6

Core Functions Adapter Properties Dialog—Task Properties Tab

Step 3

On the Task Properties tab, under Task expiration days, modify the default task expiration date.

Step 4

Click OK to close the dialog box.

Viewing Adapter-Supported Objects
Use the Provides tab to view the name and type of component for each object the SNMP adapter
supports.
To view adapter-provided objects:
Step 1

On the Administration—Adapters view, highlight the Core Functions Adapter, right-click and choose
Properties.
The Properties dialog box displays.

Step 2

Click the Provides tab to view the functionality that is provided by the adapter.
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Figure 24-7

Step 3

Core Functions Adapter Properties Dialog Box—Provides Tab

Review the following information about the list of objects provided by the adapter and click OK to close
the dialog box.
Column

Description

Name

Name of the activities, processes, and objects for which the
adapter provides support

Type

Object type (Target, Runtime User, Activity, Event)

Viewing Adapter History
Use the History tab to view a history of changes that have been made to the adapter.
To view adapter history:
Step 1

In the Administration—Adapters view, highlight the Core Functions Adapter, right-click and choose
Properties.
The Properties dialog box displays.

Step 2

Click the History tab to view the changes made to the adapter.
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Figure 24-8

Core Function Adapter Properties Dialog Box—History Tab

The following information is displayed:
Column

Description

Created by

The user name of the person who created the object

Created time

The date and time the object was created

Time

The date and time the action occurred

Change Type

The action that occurred

User

The user name of the person that performed the action

Description

Information about the action that was performed
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Step 3

To view the audit history for a specific action, highlight the appropriate object, right-click and choose
Properties.
The Audit Properties dialog box displays.
Figure 24-9

Step 4

Step 5

[Name] Audit Properties Dialog Box

Review the Audit Log display-only properties dialog box for information about system-related events
that occurred and their status.
Field

Description

Type

Type of event logged by the system
•

Success Audit

•

Error

•

Information

Created By

System-generated record, such as an error condition, or the
user name of the person who initiated the process

Created Time

Date and time the event occurred

Description

Brief description of the event

Click OK to close the dialog box.
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Managing Core Activities
This appendix provides instructions for configuring Core Functions adapter properties, defining Core
activities, instructions for completing the property pages for each specific activity, and instructions on
viewing the activity results.
•

Defining Core Activities, page A-2

•

Defining the Calculate Date Activity, page A-12

•

Defining the Calculate Date Time Difference Activity, page A-14

•

Defining the Create Automation Summary Activity, page A-16

•

Defining the Find Target Activity, page A-20

•

Defining the Format Date Activity, page A-23

•

Defining the Insert Event Activity, page A-26

•

Defining the Insert Multiple Events Activity, page A-30

•

Defining the Match Regular Expression Activity, page A-33

•

Defining the Parse Date Activity, page A-36

•

Defining the Publish Metric Activity, page A-38

•

Defining the Publish Multiple Metrics Activity, page A-41

•

Defining the Set Target Reference Activity, page A-43

•

Defining the Set Variable Activity, page A-45

•

Defining the Sleep Activity, page A-48

•

Defining the Test FTP Destination Activity, page A-49

•

Defining the XPath Query Activity, page A-52

•

Defining the XSL Transform Activity, page A-55

•

Managing Core Activity Definitions, page A-58

•

Viewing Core Activity Instance Results, page A-67
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Defining Core Activities
When defining an activity in the process workflow, the properties pane contains property pages that are
specific to the selected activity. This section provides information on how to define each activity-specific
property page.

Core Functions Adapter Activities
When defining an activity in the process workflow, the properties pane contains property pages that are
specific to the selected activity.
The following table displays the activities that are provided by the Core Functions adapter.
Activity

Description

Calculate Date

Manipulates the values of a date/time variable
See Defining the Calculate Date Activity, page A-12.

Calculate Date Time Difference

Calculates the time difference between two different dates
See Defining the Calculate Date Time Difference Activity,
page A-14.

Create Automation Summary

Generates an automation summary for selected activities
See Defining the Create Automation Summary Activity,
page A-16.

Find Target

Queries all defined targets
See Defining the Find Target Activity, page A-20.

Format Date

Converts date time into a string text format
See Defining the Format Date Activity, page A-23.

Insert Event

Inserts one event into TEO Reporting Database
See Defining the Insert Event Activity, page A-26.

Insert Multiple Events

Inserts multiple events into TEO Reporting Database
See Defining the Insert Multiple Events Activity,
page A-30.

Match Regular Expression

Matches specified string against a specified regular
expression
See Defining the Match Regular Expression Activity,
page A-33.

Parse Date

Converts string text into a date/time format
See Defining the Parse Date Activity, page A-36.

Publish Metric

Publishes a single performance metric into the TEO
Reporting Database
See Defining the Publish Metric Activity, page A-38.
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Activity

Description

Publish Multiple Metrics

Publishes multiple performance metrics into the TEO
Reporting Database
See Defining the Match Regular Expression Activity,
page A-33.

Set Target Reference

Modifies the target ID assigned to a target reference
See Defining the Set Target Reference Activity, page A-43.

Set Variable

Modifies the values of a variable
See Defining the Set Variable Activity, page A-45.

Sleep

Specifies the time period to pause between activities in the
workflow
See Defining the Sleep Activity, page A-48.

Test FTP Destination

Tests the validity of a FTP file path
See Defining the Test FTP Destination Activity, page A-49.

XPath Query

Queries information based on XML path expressions,
nodes, as well as namespace definitions
See Defining the XPath Query Activity, page A-52.

XSL Transform

Applies XSLT transformation to specific XML text. XSLT
transformation can transform XML into plain text, HTML,
or other XML
See Defining the XSL Transform Activity, page A-55.

Common Regular Expressions
The following table describes special regular characters that can be used in the Match Regular
Expression activity.
Character

Description
*

Zero or more

.

Any single character

+

One or more

^

Beginning of line

$

End of line

<

Beginning of word

>

End of word

\n

Line break

[]

Any one character in the set

[^]

Any one character not in the set

|

Or

\

Escape Special Character

{}

Tag expression
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Character

Description
:|

C/C++ identifier

:q

Quoted string

:z

Integer

:b

Space or tab

Custom Date and Format Strings
The following are custom date and time format strings that are used to define the text representation of
a date or time.
Format

Description
d

Represents the day of the month as a number from 1
through 31. A single-digit day is formatted without a
leading zero.

dd

Represents the day of the month as a number from 01
through 31. A single-digit day is formatted with a leading
zero.

ddd

Represents the abbreviated name of the day of the week

dddd (plus any number of additional Represents the full name of the day of the week
d specifiers)
f

Represents the most significant digit of the seconds
fraction; that is, it represents the tenths of a second in a date
and time value.
If the f format specifier is used without other format
specifiers, it is interpreted as the f standard date and time
format specifier.

ff

Represents the two most significant digits of the seconds
fraction; that is, it represents the hundredths of a second in
a date and time value.

fff

Represents the three most significant digits of the seconds
fraction; that is, it represents the milliseconds in a date and
time value.

ffff

Represents the four most significant digits of the seconds
fraction; that is, it represents the ten thousandths of a
second in a date and time value.

fffff

Represents the five most significant digits of the seconds
fraction; that is, it represents the hundred thousandths of a
second in a date and time value.

ffffff

Represents the six most significant digits of the seconds
fraction; that is, it represents the millionths of a second in
a date and time value.

fffffff

Represents the seven most significant digits of the seconds
fraction; that is, it represents the ten millionths of a second
in a date and time value.
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Format

Description
F

Represents the most significant digit of the seconds
fraction; that is, it represents the tenths of a second in a date
and time value. Nothing is displayed if the digit is zero.
If the F format specifier is used without other format
specifiers, it is interpreted as the F standard date and time
format specifier.

FF

Represents the two most significant digits of the seconds
fraction; that is, it represents the hundredths of a second in
a date and time value. However, trailing zeros or two zero
digits are not displayed.

FFF

Represents the three most significant digits of the seconds
fraction; that is, it represents the milliseconds in a date and
time value. However, trailing zeros or three zero digits are
not displayed.

FFFF

Represents the four most significant digits of the seconds
fraction; that is, it represents the ten thousandths of a
second in a date and time value. However, trailing zeros or
four zero digits are not displayed.

FFFFF

Represents the five most significant digits of the seconds
fraction; that is, it represents the hundred thousandths of a
second in a date and time value. However, trailing zeros or
five zero digits are not displayed.

FFFFFF

Represents the six most significant digits of the seconds
fraction; that is, it represents the millionths of a second in
a date and time value. However, trailing zeros or six zero
digits are not displayed.

FFFFFFF

Represents the seven most significant digits of the seconds
fraction; that is, it represents the ten millionths of a second
in a date and time value. However, trailing zeros or seven
zero digits are not displayed.

g, gg (plus any number of additional Represents the period or era, for example, A.D. Formatting
ignores this specifier if the date to be formatted does not
g specifiers)
have an associated period or era string.
h

Represents the hour as a number from 1 through 12, that is,
the hour as represented by a 12-hour clock that counts the
whole hours since midnight or noon.
A particular hour after midnight is indistinguishable from
the same hour after noon. The hour is not rounded, and a
single-digit hour is formatted without a leading zero.
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Format

Description

hh, hh (plus any number of
additional h specifiers)

Represents the hour as a number from 01 through 12, that
is, the hour as represented by a 12-hour clock that counts
the whole hours since midnight or noon.
A particular hour after midnight is indistinguishable from
the same hour after noon. The hour is not rounded, and a
single-digit hour is formatted with a leading zero. For
example, given a time of 5:43, this format specifier
displays "05".

H

Represents the hour as a number from 0 through 23, that is,
the hour as represented by a zero-based 24-hour clock that
counts the hours since midnight. A single-digit hour is
formatted without a leading zero.

HH, HH (plus any number of
additional H specifiers)

Represents the hour as a number from 00 through 23, that
is, the hour as represented by a zero-based 24-hour clock
that counts the hours since midnight. A single-digit hour is
formatted with a leading zero.

K

Represents the time zone information of a date and time
value. When used with DateTime values, the result string is
defined by the value of the DateTime..::.Kind property.
For the local time zone (a DateTime..::.Kind property value
of DateTimeKind..::.Local), this specifier is equivalent to
the zzz specifier and produces a result string containing the
local offset from Coordinated Universal Time (UTC); for
example, "-07:00".
For a UTC time (a DateTime..::.Kind property value of
DateTimeKind..::.Utc), the result string includes a "Z"
character to represent a UTC date.
For a time from an unspecified time zone (a time whose
DateTime..::.Kind property equals
DateTimeKind..::.Unspecified, the result is equivalent to
String..::.Empty.
For DateTimeOffset values, the K format specifier is
equivalent to the zz format specifier, and produces a result
string containing the DateTimeOffset value's offset from
UTC.

m

Represents the minute as a number from 0 through 59. The
minute represents whole minutes that have passed since the
last hour. A single-digit minute is formatted without a
leading zero.

mm, mm (plus any number of
additional m specifiers)

Represents the minute as a number from 00 through 59.
The minute represents whole minutes that have passed
since the last hour. A single-digit minute is formatted with
a leading zero.

M

Represents the month as a number from 1 through 12. A
single-digit month is formatted without a leading zero.
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Format

Description
MM

Represents the month as a number from 01 through 12. A
single-digit month is formatted with a leading zero.

MMM

Represents the abbreviated name of the month as defined in
the current
DateTimeFormatInfo..::.AbbreviatedMonthNames
property.

MMMM
s

Represents the full name of the month as defined in the
current DateTimeFormatInfo..::.MonthNames property.
Represents the seconds as a number from 0 through 59. The
result represents whole seconds that have passed since the
last minute. A single-digit second is formatted without a
leading zero.

ss, ss (plus any number of additional Represents the seconds as a number from 00 through 59.
The result represents whole seconds that have passed since
s specifiers)
the last minute. A single-digit second is formatted with a
leading zero.
t

Represents the first character of the AM/PM designator
defined in the current
DateTimeFormatInfo..::.AMDesignator or
DateTimeFormatInfo..::.PMDesignator property.
The AM designator is used for all times from 0:00:00
(midnight) to 11:59:59.999. The PM designator is used for
all times from 12:00:00 (noon) to 23:59:59.99.

tt, tt (plus any number of additional Represents the AM/PM designator as defined in the current
DateTimeFormatInfo..::.AMDesignator or
t specifiers)
DateTimeFormatInfo..::.PMDesignator property.
The AM designator is used for all times from 0:00:00
(midnight) to 11:59:59.999. The PM designator is used for
all times from 12:00:00 (noon) to 23:59:59.99.
y

Represents the year as a one or two-digit number. If the
year has more than two digits, only the two low-order digits
appear in the result. If the first digit of a two-digit year
begins with a zero (for example, 2008), the number is
formatted without a leading zero.

yy

Represents the year as a two-digit number. If the year has
more than two digits, only the two low-order digits appear
in the result. If the two-digit year has fewer than two
significant digits, the number is padded with leading zeros
to achieve two digits.

yyy

Represents the year with a minimum of three digits. If the
year has more than three significant digits, they are
included in the result string. If the year has fewer than three
digits, the number is padded with leading zeros to achieve
three digits.
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Format

Description
yyyy

Represents the year as a four-digit number. If the year has
more than four digits, only the four low-order digits appear
in the result. If the year has fewer than four digits, the
number is padded with leading zeros to achieve four digits.

yyyyy (plus any number of
additional y specifiers)

Represents the year as a five-digit number. If the year has
more than five digits, only the five low-order digits appear
in the result. If the year has fewer than five digits, the
number is padded with leading zeroes to achieve five digits.
If there are additional y specifiers, the number is padded
with as many leading zeroes as necessary to achieve the
number of y specifiers.

z

With DateTime values, represents the signed offset of the
local operating system's time zone from Coordinated
Universal Time (UTC), measured in hours. It does not
reflect the value of an instance's Kind property. For this
reason, the z format specifier is not recommended for use
with DateTime values.
With DateTimeOffset values, represents the
DateTimeOffset value's offset from UTC in hours.
The offset is always displayed with a leading sign. A plus
sign (+) indicates hours ahead of and a minus sign (-)
indicates hours behind UTC. The offset ranges from -12
through +13. A single-digit offset is formatted without a
leading zero.

zz

With DateTime values, represents the signed offset of the
local operating system's time zone from UTC, measured in
hours. It does not reflect the value of an instance's Kind
property. For this reason, the zz format specifier is not
recommended for use with DateTime values.
With DateTimeOffset values, represents the
DateTimeOffset value's offset from UTC in hours.
The offset is always displayed with a leading sign. A plus
sign (+) indicates hours ahead of and a minus sign (-)
indicates hours behind UTC. The offset ranges from -12
through +13. A single-digit offset is formatted with a
leading zero.
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Format

Description

zzz, zzz (plus any number of
additional z specifiers)

With DateTime values, represents the signed offset of the
local operating system's time zone from UTC, measured in
hours and minutes. It does not reflect the value of an
instance's Kind property. For this reason, the zzz format
specifier is not recommended for use with DateTime
values.
With DateTimeOffset values, represents the
DateTimeOffset value's offset from UTC in hours and
minutes.
The offset is always displayed with a leading sign. A plus
sign (+) indicates hours ahead of and a minus sign (-)
indicates hours behind UTC. The offset ranges from -12
through +13. A single-digit offset is formatted with a
leading zero.

:

Represents the time separator defined in the current
DateTimeFormatInfo..::.TimeSeparator property. This
separator is used to differentiate hours, minutes, and
seconds.

/

Represents the date separator defined in the current
DateTimeFormatInfo..::.DateSeparator property. This
separator is used to differentiate years, months, and days.

"

Represents a quoted string (quotation mark). Displays the
literal value of any string between two quotation marks (").
Your application should precede each quotation mark with
an escape character (\).

'

Represents a quoted string (apostrophe). Displays the
literal value of any string between two apostrophe (')
characters.

%c

Represents the result associated with a c custom format
specifier, when the custom date and time format string
consists solely of that custom format specifier.
That is, to use the d, f, F, h, m, s, t, y, z, H, or M custom
format specifier by itself, the application should specify
%d, %f, %F, %h, %m, %s, %t, %y, %z, %H, or %M.

\c

Any other character

Represents the escape character, and displays the character
"c" as a literal when that character is preceded by the
escape character (\). To insert the backslash character itself
in the result string, the application should use two escape
characters ("\\").
Copies any other character to the result string, without
affecting formatting.
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Defining a Core Activity
Use the following steps to define an activity in the Process Editor. The property pages displayed depend
on the selected activity.
To define a core activity:
Step 1

On the Toolbox pane, under Core Activities, choose the appropriate activity, then drag and drop the
activity onto the Workflow pane.
The [Activity Name] Properties dialog box displays.

Step 2

Step 3

Note

Step 4

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the activity definition property page to define the properties specific to the activity. Refer to the
appropriate section for instructions on defining the activity property.

The Required Value
icon displayed on a tab or page indicates that the field is required and is missing
a value.
tool to choose a defined variable or reference an object within the process from
Click the Reference
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
Click the Knowledge Base tab to assign a knowledge base article to the object.
Knowledge Base Field Options

Description

Text field

Display-only. Display name for the selected knowledge base
article(s)

Delete

Highlight the appropriate knowledge base article and click the
Delete
tool to remove the knowledge base article from the
display.

Browse

Click Browse to launch the Select Knowledge Base dialog box
for a list of existing knowledge base articles.
For additional information on knowledge base articles, see
Chapter 17, “Managing Knowledge Base Articles.”

Properties

Highlight the appropriate knowledge base article and click the
Properties
tool to view and/or modify the properties of the
defined knowledge base article.
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The following information is displayed on the Knowledge Base tab.

Step 5

Step 6

Field

Description

Summary

Brief description of the issue

Possible Cause

Explanation of the condition that may be causing the issue

Possible resolution

List of actions that can be performed to attempt to resolve
the issue

Related information

Additional information related to the issue

On the Result Handlers tab, click one of the following buttons to manage the condition branches on the
workflow, as necessary:
Button

Description

Add

Adds a condition branch

Remove

Removes the condition branch from the activity

Move Up

Moves the condition up one position in the list of conditions

Move Down

Moves the condition down one position in the list of
conditions

Click the Save

tool to save the activity definition.
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Defining the Calculate Date Activity
Use the Calculate Date activity to manipulate the values of a date/time variable.
To define the Calculate Date activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Calculate Date activity, then drag and drop the
activity onto the Workflow pane.
The Calculate Date property pages display.
Figure A-1

Step 2

Step 3

Note

Calculate Date Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Calculate Date tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-2

Note

Step 4

Calculate Date Properties Page—Calculate Date Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Calculate Date tab, specify the properties to be used to adjust the date and time frame:
Field

Description

Original date

Click the Reference tool to select the appropriate date/time
variable reference, such as the Process > Start Time
reference variable, to be used to be used as the original
date.
Note

Adjustment

To customize the specific date/time of the variable
reference, it is recommended that the customer add
the Parse activity to the process and use that
activity to modify the selected date/time. See
Defining the Parse Date Activity, page A-36.

Enter the number of units to increase or decrease the time
frame. Enter minus (-) prior to the value in order to
decrease or enter plus (+) prior to the value to increase. (ex.
-5)
Note

Click the time unit link to change the modified
date/time (from seconds up to days).
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Step 5

Note

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

To view the calculated date adjustments, see Viewing Calculated Date Information, page A-70.

Defining the Calculate Date Time Difference Activity
Use the Calculate Date Time Difference activity to calculate the time difference between two different
dates.
To define the Calculate Date Time Difference activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Calculate Date Time Difference activity, then
drag and drop the activity onto the Workflow pane.
The Calculate Date Time Difference property pages display.
Figure A-3

Step 2

Calculate Date Time Difference Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Date Difference tab to continue.

The Required Value
a value.
Figure A-4

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Calculate Date Time Difference Properties Page—Date Difference Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Date Difference tab, specify the properties to be used to calculate date/time difference:
Field

Description

Date

Click the Reference tool to select the appropriate date/time
variable reference, such as the Process > Start Time
reference variable, to be used to be used as the original
date.
Note

Subtract Date

To customize the specific date/time of the variable
reference, it is recommended that the customer add
the Parse activity to the process and use that
activity to modify the selected date/time. See
Defining the Parse Date Activity, page A-36.

Click the Reference tool to select the appropriate date/time
variable reference to be calculated for the difference in
time frame.
Note

To customize the specific date/time of the variable
reference, it is recommended that the customer add
the Parse activity to the process and use that
activity to modify the selected date/time. See
Defining the Parse Date Activity, page A-36.
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Step 5

Note

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

To view the date difference results, see Viewing Calculated Date Difference Results, page A-71.

Defining the Create Automation Summary Activity
An automation summary is a collection of data summarizing the objects included in the process and the
data retrieved by the processing of the of the objects.
Use the Create Automation Summary activity to generate an automation summary for a selected activity
in a process. To generate the data output, choose the activity and then specify the section in the
automation summary in which to output the data.
The share path specified in the Core Functions Adapter properties will be used when viewing the
automation summary reports.
If the automation summary is set to not be shared, then only local users on the TEO server computer will
have access to the automation summary report. The automation summary will not display for users with
remote access, such as those accessing TEO from the Web Console or the remote client, unless a UNC
share or IIS Virtual directory sharing options have been selected.
To define the Create Automation Summary activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Create Automation Summary activity, then
drag and drop the activity onto the Workflow pane.
The Create Automation Summary property pages display.
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Figure A-5

Step 2

Step 3

Note

Create Automation Summary Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Automation Summary tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-6

Note

Step 4

Create Automation Summary Properties Page—Automation Summary Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Automation Summary tab, specify the following items for the generated automation summary:
Field

Description

Automation summary style sheet

Choose the type of template to be used for the automation
summary. By default, the Situation Analysis Report style
sheet is selected.

Include the following items

•

Table of Configuration Properties

•

Situation Analysis Report

Choose the activity or trigger/event, since events and
triggers can be included into the automation summary as
well, and specify the section of the automation summary to
include the reporting details and whether the activity is the
root cause of any issues that are detected.
•

Name—Name of the activities that are included in the
process

•

Section—Name of the section of the automation
summary where the data will be stored

•

Root cause—Yes indicates the Is root cause check box
is checked

Settings for [name] activity
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Field

Description

Section

Choose one of the following options to specify the section
of the automation summary template in which to export the
data:
•

SituationAnalysis—After a situation that requires
action is identified, the state and diagnostic
information is displayed in the Situation Analysis
section of the automation summary.

•

ContextAnalysis—After a situation is analyzed in
context with other situations, the symptom and cause
is displayed in the Context Analysis section of the
automation summary.

Is the root cause

Check this check box to list the activity or event at the top
of the automation summary, or identified as the root cause
of the problem.

Last instance information only

Check this check box to indicate that the automation
summary must include only information for the latest
execution of the activity instance.
Note

This setting is only for activities that are inside the
loop of a workflow component (While or For
Each). If this setting is not selected, the automation
summary will include information about all
instances of activity, for all iterations of the loop.

Step 5

On the Result Handlers tab, click the appropriate buttons to manage the condition branches on the
workflow. See Step 5 in Defining a Core Activity, page A-10.

Step 6

Click the Save

Note

tool to complete the activity definition.

For instructions on accessing automation summary reports, see Viewing Automation Summary Reports,
page A-68.
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Defining the Find Target Activity
Use the Find Target activity to query defined targets within TEO.
To define the Find Target activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Find Target activity, then drag and drop the
activity onto the Workflow pane.
The Find Target property pages display.
Figure A-7

Step 2

Step 3

Note

Find Targets Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Find Targets tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-8

Note

Step 4

Find Targets Properties Page—Find Targets Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Find Targets tab, specify the following information:
Field

Description

Target Type

Select the appropriate target type to be queried.

Choose a target group

Select the appropriate target group to be queried.
Only target groups defined in TEO, in which the user has
Use permission will be available.

Step 5

Under Properties to Match, click the appropriate button to modify the list of properties:
Field

Description

Add

Click this button to add a new Property drop-down list in
which the user can select additional criteria to match within
the query.

Remove

Click this button to remove the last set of Property criteria
from the list of properties to match within the query.
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Step 6

When the Properties pane displays, define the appropriate exposed target criteria to use to query a list of
defined targets in TEO.
Field

Description

Property

From the drop-down list, select the appropriate exposed
target property to query.

Operators

Select the appropriate to include to match to the criteria.
The displayed operators depend on the selected property.
For additional information, see Comparison Operators,
page 10-3.
Select the appropriate Wildcard expression to associate
with the selected operator.

Expression

For additional information, see Common Wildcard
Expressions, page 7-19.
Step 7

Step 8

Note

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

Click the Save

tool to complete the activity definition.

For instructions on viewing the matching targets, see Viewing the Matching Targets, page A-72.
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Defining the Format Date Activity
Use the Format Date activity to convert date and time into a string text format.
Example:

Format string
yyyyMMdd hh:mm:ss tt

Original Date/Time
10/23/2009 10:23:00 PM

Result
20091023 10:23:00 PM

To define the Format Date activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Format Date activity, then drag and drop the
activity onto the Workflow pane.
The Format Date property pages display.
Figure A-9

Step 2

Step 3

Format Date Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Calculate Date tab to continue.
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Note

The Required Value
a value.
Figure A-10

Note

icon displayed on a tab or page indicates that the field is required and is missing

Format Date Properties Page—Calculate Date Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, ssee Inserting Core Activity
Variable References, page A-65.
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Step 4

On the Calculate Date tab, specify the date format to be used to convert to string text:
Field

Description

Format string

Enter the appropriate format string. The following are
descriptions of what a format string can include:
•

Date and a time component

•

Date, but no time component

•

Time, but no date component

•

Includes time zone information and conforms to ISO
8601.

Note

For additional information on date string formats,
see Custom Date and Format Strings, page A-4.

Click the Reference tool to select the appropriate date/time
variable reference, such as the Process > Start Time
reference variable, to be used to format the string.

Original date

Note

Use local time zone

To customize the specific date/time of the variable
reference, it is recommended that the customer add
the Parse activity to the process and use that
activity to modify the selected date/time. See
Defining the Parse Date Activity, page A-36.

Check this check box to indicate that the date should be
formatted using the local time zone of the TEO server
instead of using Coordinated Universal Time (UTC).

Step 5

On the Result Handlers tab, click the appropriate buttons to manage the condition branches on the
workflow. See Step 5 in Defining a Core Activity, page A-10.

Step 6

Click the Save

Note

tool to complete the activity definition.

For instructions on viewing the formatted date, see Viewing the Formatted Date Result, page A-73.
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Defining the Insert Event Activity
The Insert Event activity is considered an advanced activity and may not be available to all users due to
the licensing rights. Use the Insert Event activity to define the configuration properties to be used to
insert one event into TEO Reporting Database.
To define the Insert Event activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Insert Event activity, then drag and drop the
activity onto the Workflow pane.
The Insert Event property pages display.
Figure A-11

Step 2

Step 3

Note

Insert Event Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Event tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-12

Note

Step 4

Insert Event Date Properties Page—Event Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Event tab, specify the event properties to be used:
Field

Description

ID

Identifier to be used for the event

Subject

Name of the event

Event category

Choose the category for the event

Severity

Severity of the event
•

Error

•

Warning

•

Information (Default selection)

•

Success Audit

•

Failure Audit

Automation summary URL

Optional file path for the automation summary report
associated with this event

Description

Brief description of the event
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Step 5

Click the Event Parameters tab to continue.
Figure A-13

Step 6

Insert Event Property Page—Event Parameter Tab

On the Event Parameters tab, define the event parameters to be used in the event. The maximum number
of listed event parameters is 10.
Field

Description

Add

Click this button to create a blank field to be used to add
new event parameter to list.
Note

Remove

For information on adding a parameter, see
Specifying Event Parameters for an Activity,
page A-58.

Click this button to remove selected event parameter from
the list.
Note

For information on removing a parameter, see
Removing Event Parameters from an Activity,
page A-59.
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Step 7

Click the Affects tab to continue.
Figure A-14

Step 8

Insert Event Properties Page—Affects Tab

On the Affects tab, specify the organizations and configuration item elements that trigger the selected
target.
Field

Description

This event applies to the following
target

Check this check box to enable the options used to specify
the affected target.

Process target

Select this radio button to use the process target as the
affected target in the activity.

Activity target

Select this radio button to specify the affected target for a
specific task activity.
Choose the activity containing the target that will be used.

Specific target

Select this radio button to specify the affected target that
will be used.
To view the properties for the selected target, click the
Properties tool. To create a new target, click New >
[Target].

Specific target group

Select this radio button to specify the affected target group
that will be used. To view the properties for the selected
target group, click the Properties tool. To create a new
target group, click New > [Target Group].
•

From the Choose a target using this algorithm
drop-down list, specify which target will be chosen
from the eligible target group members:

•

Choose the target with the specified name—Runs the
process on the member of the group whose name is
specified in the Name to match text field.
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Step 9

Field

Description

This applies to the following
configuration item

Check this check box to specify the configuration item to
be used in the activity.

Name

Name of the configuration item (IT component) to which
the event pertains

Type

Type of ITIL configuration item (IT component)
•

Application Server

•

Database

•

Host

•

User

This is a CMDB reference

Check the check box to indicate that the true source of the
CI is in the CMDB, so the configuration item properties
reference a CMDB entry.

Object Key

ID for the specific record in the CMDB which contains the
configuration item

Object Source

Name of the CMDB which contains the configuration item

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

Defining the Insert Multiple Events Activity
The Insert Multiple Events activity is considered an advanced activity and may not be available to all
users due to the licensing rights. Use the Insert Multiple Events activity to insert a batch of events into
the TEO Processes database using one activity.
To define the Insert Multiple Events activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Insert Multiple Events activity, then drag and
drop the activity onto the Workflow pane.
The Insert Multiple Events property pages display.

Cisco Tidal Enterprise Orchestrator Reference Guide

A-30

OL-24928-01

Appendix A

Managing Core Activities
Defining the Insert Multiple Events Activity

Figure A-15

Step 2

Step 3

Note

Insert Multiple Events Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Event tab to continue.

The Required Value
a value.
Figure A-16

icon displayed on a tab or page indicates that the field is required and is missing

Insert Multiple Events Date Properties Page −Event Tab
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Note

Step 4

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Events tab, specify the appropriate data source and event properties:
Field

Description

Data source

Enter the data which contains data for several events to be
inserted

ID

Identifier to be used for the event

Subject

Name of the event

Event category

Choose the category for the event

Severity

Severity of the event
•

Error

•

Warning

•

Information (Default selection)

•

Success Audit

•

Failure Audit

Automation summary URL

File path for the automation summary report

Description

Brief description of the event
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Step 5

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Event Parameters—Click the tab to define the event parameters for the event. See Step 5 in Defining
the Insert Event Activity, page A-26.

•

Affects—Specify the organizations and configuration item elements that trigger the selected target.
See Step 7 in Defining the Insert Event Activity, page A-26.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

Defining the Match Regular Expression Activity
Use the Match Regular Expression activity to match to find matches for a regular expression within a
specified string.
To define the Match Regular Expression activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Match Regular Expression activity, then drag
and drop the activity onto the Workflow pane.
The Match Regular Expression property pages display.
Figure A-17

Step 2

Match Regular Expression Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity
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Step 3

Note

Field

Description

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Regular Expression tab to continue.

The Required Value
a value.
Figure A-18

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Match Regular Expression Properties Page—Regular Expression Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Regular Expression tab, specify the following properties:
Field

Description

Regular Expression

Specify a string to represent the regular expression to be
used in matching
Note

Click the Expression arrow to view frequently
used regular expression symbols. For descriptions
of the special characters, see Common Regular
Expressions, page A-3.
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Field

Description

Match case

Check the check box to specify whether regular expression
matching should be case-sensitive.

Input string

Specifies the input string for text to be parsed and matched
against the specified regular expression
Note

Step 5

Note

For examples of regular expression strings, see
Regular Expression Examples, page A-35.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

For instructions on viewing the matching expressions, see Viewing Match Regular Expression Activity
Results, page A-74.

Regular Expression Examples
The following are match regular expression examples which can be used in the Match Regular
Expression activity.
Description

Expression

String

Result

Split on simple space

\S+

aaa bbb ccc

"aaa", "bbb", "ccc"

Note

If you want the
location of the
whitespace
(space) use \s+

CSS definition split on
space or comma but
keep "" enclosed items

\s*("[^"]+"|[^ ,]+)

10pt "Times Roman",
Helvetica,Arial,
sans-serif

"10pt" ,"\"Times
Roman\"", "Helvetica"
,"Arial", "sans-serif"

Extract HTML <>
enclosed tags

<[^>]*>

<a href="#">A
link</a>

'<a href="#">', "</a>"

Find all double
characters

(.)\1

aabcdde

"aa" "dd"

Separate comma
delimted values into
groups (submatches or
backreferences)

ou=[^,]+,cn=([^,]+),dc= ou=people,cn=web,dc $1 variable will contain
=example,dc=com
"web" - first expression
example,dc=com
has no grouping ()
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Defining the Parse Date Activity
Use the Parse Date activity to convert string text into a date or time format.
Example:
Format string
yyyyMMdd hh:mm:ss tt
Original Date/Time
20091023 10:23:00 PM
Result
10/23/2009 10:23:00 PM

To define the Parse Date activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Parse Date activity, then drag and drop the
activity onto the Workflow pane.
The Parse Date property pages display.
Figure A-19

Step 2

Step 3

Note

Parse Date Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Parse Date tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-20

Note

Step 4

Parse Date Properties Page—Parse Date Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Calculate Date tab, specify the date format to be used to convert to string text:
Field

Description

Format string

Enter the appropriate format of the string. The following
are descriptions of what format strings could contain:
•

Date and a time component

•

Date, but no time component

•

Time, but no date component

•

Includes time zone information and conforms to ISO
8601.

Note

Step 5

For additional information on date string formats,
see Custom Date and Format Strings, page A-4.

Input string

Enter the date or time string to be parsed.

Use local time zone

Check this check box to indicate that the activity should be
formatted on the local time zone instead of using
Coordinated Universal Time (UTC).

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.
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Note

For instructions on viewing the parsed date, see Viewing Parsed Date Results, page A-75.

Defining the Publish Metric Activity
The Publish Metric activity is considered an advanced activity and may not be available to all users due
to the licensing rights. Use the Publish Metric activity to define the performance metric properties to be
published into the TEO Reporting Database and the Windows Management Instrumentation (WMI)
provider.
The metrics are published under the root\TEO name space through the WMI class,
TEO_PerformanceMetric. See TEO_PerformanceMetric Class Properties, page A-40 for a description
of the class properties.
To define the Publish Metric activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Publish Metric activity, then drag and drop the
activity onto the Workflow pane.
The Publish Metric property pages display.
Figure A-21

Step 2

Step 3

Publish Metric Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Metrics tab to continue.
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Note

The Required Value
a value.
Figure A-22

Note

Step 4

Step 5

icon displayed on a tab or page indicates that the field is required and is missing

Publish Metric Properties Page—Metrics Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Metrics tab, specify the properties of the performance metric to be inserted into the Reporting
database:
Field

Description

Object name

Object name of the metric

Counter name

Name of the metric

Instance name

Name of the instance

Value

Performance metric value

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Affects—Specify the organizations and configuration item elements that trigger the selected target.
See Step 7 in Defining the Insert Event Activity, page A-26.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.
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TEO_PerformanceMetric Class Properties
The TEO_PerformanceMetric class defines the following properties.
All the different published metrics will be cached in memory. If the same metric is published multiple
times, the cache will only keep the metric with the latest value.
Class Properties

Description

ObjectName

Object name of the metric

CounterName

Counter name of the metric

InstanceName

Instance name of the metric

Value

Value of the metric

TimeRaised

Time the metric is raised

ConfigurationItemName

Display name for the configuration item

ConfigurationItemKey

Key of the configuration item in the CMDB

ConfigurationItemType

Type of the configuration item in the CMDB

ConfigurationItemSource

CMDB Source location for the configuration item

AffectedTargetConfigurationItemName

Display name for the affected target configuration item

AffectedTargetConfigurationItemKey

Key of the affected target configuration item in the CMDB

AffectedTargetConfigurationItemType

Type of the affected target configuration item in the CMDB

AffectedTargetConfigurationItemSource

CMDB Source location for the affected target
configuration item
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Defining the Publish Multiple Metrics Activity
The Publish Multiple Metrics activity is considered an advanced activity and may not be available to all
users due to the licensing rights. Use the Publish Metric activity to define the properties to be used to
publish multiple performance metrics into the TEO Reporting Database and the Windows Management
Instrumentation (WMI) provider.
The metrics are published under the root\TEO name space through the WMI class,
TEO_PerformanceMetric. See TEO_PerformanceMetric Class Properties, page A-40 for a description
of the class properties.
To define the Publish Multiple Metrics activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Publish Multiple Metrics activity, then drag
and drop the activity onto the Workflow pane.
The Publish Multiple Metrics property pages display.
Figure A-23

Step 2

Step 3

Note

Publish Multiple Metrics Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Metrics tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-24

Note

Step 4

Step 5

Publish Multiple Metrics Properties Page—Metrics Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Metrics tab, specify the appropriate data source and metric properties:
Field

Description

Data source

References the data collection table containing data for
multiple metrics to be inserted

Object name

Object name of the metric

Counter name

Name of the metric

Instance name

Name of the instance

Value

Performance metric value

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Affects—Click the tab to define configuration properties associated with the metric(s). See Step 7
in Defining the Insert Event Activity, page A-26.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.
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Defining the Set Target Reference Activity
Use the Set Target Reference activity to modify the value of a defined target reference.
To define the Set Target Reference activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Set Target Reference activity, then drag and
drop the activity onto the Workflow pane.
The Set Target Reference property pages display.
Figure A-25

Step 2

Step 3

Note

Set Target Reference Properties Page—General Tab

On the General tab, specify the general information about the activity:
Field

Description

Display Name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Reference tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure A-26

Note

Step 4

Step 5

Step 6

Set Target Reference Properties Page—Reference Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Reference tab, specify the following:
Field

Description

Variable to update

Select the appropriate variable to be modified.

New target ID

Enter or select a variable containing the target ID for the
new target reference property.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

Click the Save

tool to complete the activity definition.
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Defining the Set Variable Activity
Use the Set Variable activity to modify the value of a defined variable. You must specify a name for the
activity, choose the defined variable that you want to modify and enter a new value for the variable.
Formulas can also be included to modify variable values. See below for examples of what can be entered:
Example:
5+10
-or[Activity.Reference1] / [Activity.Reference2] * 100) + [Activity.Reference3]
-or[Activity.PropertyName1] [Activity.PropertyName2]

Note

The Set Variable activity cannot modify table variables. To manipulate the values of table variables, see
the Defining the Add Row to Table Activity, page D-4, the Defining the Remove Row from Table
Activity, page D-18, the Defining the Set Table Variable Activity, page D-25, or the Defining the Update
Row in Table Activity, page D-27.
To define the Set Variable activity:

Step 1

On the Toolbox pane, under Core Activities, choose the Set Variable activity, then drag and drop the
activity onto the Workflow pane.
The Set Variable property pages display.

Note

The Required Value
a value.
Figure A-27

icon displayed on a tab or page indicates that the field is required and is missing

Set Variable Properties Page—General Tab
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Step 2

Step 3

Note

On the General tab, specify the general information about the activity:
Field

Description

Name

Name of the activity that will use this variable

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Variable tab to continue.

The Required Value
a value.
Figure A-28

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Set Variable Properties Page—Variable Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the Variable tab, specify the following:
Field

Description

Variable to update

Choose the appropriate variable to be modified
Note

Click the Reference
tool to choose a defined
variable or reference an object within the process
on Insert Variable Reference dialog box.
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Field

Description

Variable data type

Display-only. Data type assigned to the selected variable
•

Boolean—Indicates whether a set of elements should
be true or false

•

Hidden String—Holds data that must be protected
from other TEO users and from auditing operations
performed by TEO.

•

Identity—Represents the value of a user identity

•

Numeric—A single whole or decimal number assigned
(positive and negative)

•

String—Defines a variable containing a string of text

Current value

Display-only. Indicates the current value of the selected
variable

New value

Enter or choose a new value for the selected variable. This
field remains display-only until the variable to be updated
is selected.
Note

Step 5

Step 6

Note

For a Boolean variable, the text entered in this field
(true or false) is case-sensitive and must be entered
all lowercase.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

Click the Save

tool to complete the activity definition.

For instructions on viewing the results, see Viewing Set Variable Results, page A-77.
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Defining the Sleep Activity
Use the Sleep activity to specify the time period to pause between activities in the process.
To define the Sleep activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Sleep activity, then drag and drop the activity
onto the Workflow pane.
The Sleep property pages displays.
Figure A-29

Note

Step 2

Sleep Properties Page—General Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the General tab, specify the general information about the activity.
Field

Description

Name

Name for the activity

Sleep interval (in seconds)

Number of seconds in the sleep interval

Type

Displays the type of activity

Description

Brief description of the activity

Step 3

On the Result Handlers tab, click the appropriate buttons to manage the condition branches on the
workflow. See Step 5 in Defining a Core Activity, page A-10.

Step 4

Click the Save

tool to complete the activity definition.
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Defining the Test FTP Destination Activity
Use the Test FTP Destination activity to test the validity and availability of a FTP location.
To define the Test FTP Destination activity:
Step 1

On the Toolbox pane, under Core Activities, choose the Test FTP Destination activity, then drag and
drop the activity onto the Workflow pane.
The Test FTP Destination property pages display.
Figure A-30

Step 2

Test FTP Destination Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Click the Credentials tab to continue.
Figure A-31

Step 4

Test FTP Destination Properties Page—Credentials Tab

On the Credentials tab, specify the runtime user whose credentials should be used for activity execution:
Field

Description

Use process runtime user

Select this radio button to use the credentials for the
runtime user that was specified in the process properties

Override process runtime user

Select this radio button to specify different credentials than
what are used for the process. The selected runtime user
overrides the runtime user that was specified for the
process.
Note

Step 5

Note

To view the properties for the selected runtime
user, click the Properties
tool. To create a
runtime user record for the process, click New >
[Runtime User]. For additional information on
creating a runtime user, see Chapter 16, “Managing
Runtime Users.”

Click the FTP tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Cisco Tidal Enterprise Orchestrator Reference Guide

A-50

OL-24928-01

Appendix A

Managing Core Activities
Defining the Test FTP Destination Activity

Figure A-32

Note

Step 6

Step 7

Note

Test FTP Destination Properties Page—FTP Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the FTP tab, specify the file path used to test the response of a FTP site:
Field

Description

Destination

Path for the FTP site

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

For instructions on viewing the results of the FTP destination test, see Viewing Test FTP Destination
Response Time, page A-78.
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Defining the XPath Query Activity
Use the XPath Query activity to query information based on XML path expressions, nodes, as well as
namespace definitions.
To define the XPath Query activity:
Step 1

On the Toolbox pane, under Core Activities, choose the XPath Query activity, then drag and drop the
activity onto the Workflow pane.
The XPath Query property pages display.
Figure A-33

Step 2

XPath Query Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the XPath Query tab to continue.

The Required Value
a value.
Figure A-34

Note

icon displayed on a tab or page indicates that the field is required and is missing

XPath Query Properties Page—XPath Query Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
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Step 4

On the XPath Query tab, specify the following properties:
Field

Description

Source XML

Source XML text to query

Namespaces

Click the following buttons to modify the list of namespace
definitions.

XPath queries

•

New—Click this button to launch the Namespace
Dialog Box to enter the appropriate namespace
information to query. See Adding an XPath
Namespace Definition, page A-59.

•

Properties—Highlight the appropriate namespace
definition and click this button to view or modify the
properties of the namespace query definition.

•

Delete—Highlight the appropriate XPath query and
click this button to delete the XPath query definition
from the list. See Removing Namespace and XPath
Queries, page A-63.

•

Move Up— Highlight the appropriate XPath query and
click this button to move the XPath query definition up
the list.

•

Move Down— Highlight the appropriate XPath query
and click this button to move the XPath query
definition down the list.

Click the following buttons to modify the list of XPath
query definitions.
•

New— Click this button to launch the XPath Query
Dialog Box to enter the appropriate XPath information
to query. See Adding an XPath Query Definition,
page A-61.

•

Properties—Highlight the appropriate XPath query
and click this button to view or modify the properties
of the XPath query definition.

•

Delete—Highlight the appropriate XPath query and
click this button to delete the XPath query definition
from the list. See Removing Namespace and XPath
Queries, page A-63.

•

Move Up—Highlight the appropriate XPath query and
click this button to move the XPath query definition up
the list.

•

Move Down—Highlight the appropriate XPath query
and click this button to move the XPath query
definition down the list.
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Step 5

Note

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

For instructions on viewing the output results generated by the activity, see Viewing XPath Query
Activity Results, page A-79.

Defining the XSL Transform Activity
Use the XSL Transform activity to apply XSLT transformation to specific XML text. XSLT
transformation can transform XML into plain text, HTML, or other XML.
To define the XSL Transform activity:
Step 1

On the Toolbox pane, under Core Activities, choose the XSL Transform activity, then drag and drop the
activity onto the Workflow pane.
The XSL Transform property pages display.
Figure A-35

Step 2

XSL Transform Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity
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Step 3

Note

Field

Description

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the XSL Transform tab to continue.

The Required Value
a value.
Figure A-36

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

XSL Transform Properties Page—XSL Transform Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Core Activity
Variable References, page A-65.
On the XSL Transform tab, specify the following properties:
Field

Description

Specify XSL document

From the drop-down list, choose this option to specify the
text of the XSLT transform directly in the activity.
XSL transform
XSLT style sheet for the XSL document. This option
displays only when Specify XSL by document is selected.
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Field

Description

Specify XSL path

From the drop-down list, choose this option to read the
XSLT text from a specific file path.
XSL Location
Type the appropriate file path of the XSLT file that can be
accessed by the TEO server, as well as the client. This
option displays only when Specify XSL path is selected.
Click Browse to search for the file location.
See Specifying XSL File Path, page A-64.

Step 5

Note

Source XML to transform

Source XML text to be transformed

Output format

From the drop-down list, select the option to determine the
appropriate output in the automation summary and activity
instance.
•

HTML

•

XML

•

TEXT

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 4 in Defining a Core Activity, page A-10.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 5 in Defining a Core Activity, page A-10.

For instructions on viewing the output results generated by the activity, see Viewing XSL Transform
Activity Results, page A-80.
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Managing Core Activity Definitions
Use the following section to modify information in the Core activities. Use the activity-specific property
page to perform the following functions.

Modifying a Core Activity
Modifying process properties does not automatically modify an activity. Activity definitions are
included in a process definition and the activity properties must be modified separately from the process
properties.
Activities can only be modified in the Process Editor. With the appropriate rights from the Operations
view, the Process Editor is launched when accessing the process properties.
When user rights are restricted, the Process Viewer is launched with the properties displaying a
display-only view after determining that the user cannot edit the activity.
Step 1

To modify an activity, use one of the following methods:
•

On the Definitions—Process view, highlight the appropriate process, right-click and choose Edit.
-or-

•

On the Operations workspace, select a process from any of the four process views, right-click and
choose Edit.

The Process Editor displays.
Step 2

On the Workflow pane, select the appropriate activity, and modify activity properties, as necessary, and
click Save.

Step 3

Make any additional changes, as necessary, and click Exit to close the Process Editor.

Specifying Event Parameters for an Activity
The event generated by the Insert Event activity can include up to 10 parameters. Use the following steps
to modify the parameters for the event.
To modify the list of parameters:
Step 1

On the Insert Event property page, click the Event Parameters tab to modify the parameters assigned
the event.

Step 2

Click the Parameters tab to modify the event parameters.

Step 3

Click Add to add a new field for a parameter.

Step 4

Enter the appropriate information for the parameter.

Step 5

Click the Save

tool to save the changes.
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Removing Event Parameters from an Activity
The Remove button removes the last parameter added to the list. For example, the user cannot remove
Parameter 4 without removing Parameter 5 from the list.
If the user wants to keep Parameter 5, then update Parameter 4 with the information from Parameter 5,
and then click Remove to remove Parameter 5 in the list.

Adding an XPath Namespace Definition
An XML namespace is a collection of names, identified by a Uniform Resource Identifier (URI)
reference, which are used in XML documents as element and attribute names. See Namespace Examples,
page A-60 for additional information on entering the appropriate namespace properties.
To add an XPath namespace:
Step 1

On the XPath Query property page, click New.
The XPath Namespace Definition dialog box displays.
Figure A-37

Step 2

XPath Namespace Definition Dialog Box

Complete the following fields, and click OK.
Field

Description

Prefix

Enter the appropriate prefix element to associate with the
namespace URI reference in the attribute value

URI

Enter the uniform resource identifier (URI) used to identify
the attribute value of the namespace name or resource on
the internet.

The information displays in the Namespace box on the XPath Query property page.
Step 3

Click the Save

tool to save the changes.
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Namespace Examples
In this example, the elements prefixed with xdc are associated with a namespace whose name is
http://www.xml.com/books, while those prefixed with h are associated with a namespace whose name is
http://www.w3.org/HTML/1998/html4.
The prefixes are linked to the full names using the attributes on the top element whose names begin.
xmlns:. The prefixes don't mean anything at all - they are just shorthand placeholders for the full names.
Those full names, you will have noticed, are URLs, i.e. Web addresses.
Example XML
<h:html xmlns:xdc="http://www.xml.com/books"
xmlns:h="http://www.w3.org/HTML/1998/html4">
<h:head><h:title>Book Review</h:title></h:head>
<h:body>
<xdc:bookreview>
<xdc:title>XML: A Primer</xdc:title>
<h:table>
<h:tr align="center">
<h:td>Author</h:td><h:td>Price</h:td>
<h:td>Pages</h:td><h:td>Date</h:td></h:tr>
<h:tr align="left">
<h:td><xdc:author>Simon St. Laurent</xdc:author></h:td>
<h:td><xdc:price>31.98</xdc:price></h:td>
<h:td><xdc:pages>352</xdc:pages></h:td>
<h:td><xdc:date>1998/01</xdc:date></h:td>
</h:tr>
</h:table>
</xdc:bookreview>
</h:body>
</h:html>

Note

For additional examples, see http://www.xml.com/pub/a/1999/01/namespaces.html.
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Adding an XPath Query Definition
XPath queries navigate through XML documents and search through the document nodes. Use the XPath
Query dialog box to enter the XPath properties to query from the source XML code. See XPath Query
Example, page A-62 for additional information on entering the appropriate XPath Query properties.
To define XPath query properties:
Step 1

On the XPath Query property page, click New.
The XPath Query Definitions dialog box displays.
Figure A-38

Step 2

XPath Query Definitions Dialog Box

Complete the following fields, and then click OK:
Field

Description

XPath query

Enter the path expression to query.

Property name

Enter the property name to display on the Results tab after
the activity has run.

Property Type

From the drop-down list, select the data type associated
with the path expression to query.
•

String

•

Numeric

•

Boolean

•

DateTime

The information displays in the XPath Query box on the XPath Query property page.
Step 3

Click the Save

tool to save the changes.
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XPath Example Syntax
The following path expressions can be used when selecting nodes in a path expression of a XPath query.
Path Expression

Description

nodename

Selects all child nodes of the named node
/

Selects from the root node

//

Selects nodes in the document from the current node that
match the selection no matter where they are located

.

Selects the current node

..

Selects the parent of the current node

@

Selects attributes

XPath Query Example
The following is an example of XML query code.
Example XML
<?xml version="1.0" encoding="ISO-8859-1"?>
<bookstore>
<book>
<title lang="eng">Harry Potter</title>
<price>29.99</price>
</book>
<book>
<title lang="eng">Learning XML</title>
<price>39.95</price>
</book>
</bookstore>

Note

For additional examples, see http://www.w3schools.com/xpath/xpath_syntax.asp.
The following are example path expressions and related results based on the XPath Query Example.
Path Expression

Description

bookstore

Selects all child nodes of the bookstore element

/bookstore

Selects the root element bookstore
Note

If the path starts with a slash ( / ) it always
represents an absolute path to an element.

bookstore/book

Selects all book elements that are children of bookstore

//book

Selects all book elements no matter where they are in the
document
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Path Expression

Description

bookstore//book

Selects all book elements that are descendant of the
bookstore element, no matter where they are under the
bookstore element

//@lang

Selects all attributes that are named lang

Sorting the Namespace and XPath Queries
The XPath Query activity requires the listed namespaces and Xpath query definitions to be queried
according to the order in which their listed.
To sort the list of namespaces and XPath query definitions:
Step 1

On the XPath Query property page, under the following sections:
•

Namespaces

•

XPath queries

Step 2

To move the definition up the list, click Move Up.

Step 3

To move the definition down the list, click Move Down.

Step 4

Click the Save

tool to save the changes.

Removing Namespace and XPath Queries
Use the following steps to remove the namespace and/or XPath query definition from the XPath Query
activity.
To remove the definitions:
Step 1

On the XPath Query property page, under the following sections, highlight the appropriate definition,
and click Delete:
•

Namespaces

•

XPath queries

The selected definition is removed from the XPath Query property page.
Step 2

Click the Save

tool to save the changes.
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Specifying XSL File Path
Use the following steps to specify the file path for the XSL transform.
To specify the file path:
Step 1

On the XSL Transform property page, from the drop-down list, select Specify XSL path to read the
XSLT text from a specific file path.

Step 2

To the right of the XSL Location field, use one of the following methods:
•

Type the appropriate file path of the XSLT file that can be accessed by the TEO server, as well as
the client.
-or-

•

Click Browse to locate the appropriate file location.

The file path displays in the XSL Tranform property page.
Step 3

Click the Save

tool to save the changes.
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Inserting Core Activity Variable References
The Reference
icon to the right of a text field indicates that the field can be populated by referencing
a defined variable or the property of another activity or process. Use the Insert Variable Reference dialog
box to select a defined variable or object to populate a field.
Only variables valid for the selected field can be selected in this dialog box. The OK button does not
activate until a valid property or variable is selected.
To insert a variable reference:
Step 1

To the right of a field on a property page, click the Reference tool.
The Insert Variable Reference dialog box displays.
Figure A-39

Note

Step 2

Insert Variable Reference Dialog Box

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Check the Show Advanced check box to display all items that are available for referencing.
If the check box is not checked, then only the most commonly-used items are displayed for activities,
processes or events.

Step 3

Click the Workflow Activity Expand (+) to display the reference objects for the activities in the
Workflow pane. The properties in the Insert Reference Variable dialog box depend on the activities.

Step 4

From the list of displayed objects, select the appropriate property:
Reference Variable

Description

Name

Display name of the activity

Notes

Description for the activity

Created by

User name or the owner of the activity

Created Time

The date and time the activity was created

Modified by

User name of the individual who modified the activity
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Reference Variable

Description

Type

Type of activity

Description

Description of the activity

Audit Starts

Date and time the process audit starts

Audit Successes

Indicates the number of successful audits

End Time

Date and time the activity stopped

Error Information

Description of the error that has occurred

Group Name

Name of toolbox activity group

Instance Cancelled

Indicates the process was cancelled manually

Instance Failed

Indicates the process has failed

Instance Failed (Completed)

Indicates the process has failed but the process execution was
completed

Instance Failed (Not Completed) Indicates the process has failed and did not complete the
process execution
Start Time

Date and time the activity was started

Process Id

ID number of the TEO process

Process Instance Id

ID number of the TEO process instance

Result

Resolved date and time after adjustment

Days

Gets the value of the current TimeSpan structure expressed in
whole and fractional days

Hours

Gets the hours component of the time interval represented by
the current TimeSpan structure

Minutes

Gets the minutes component of the time interval represented
by the current TimeSpan structure

Seconds

Gets the seconds component of the time interval represented
by the current TimeSpan structure

Milliseconds

Gets the milliseconds component of the time interval
represented by the current TimeSpan structure

Automation Summary Path

File path for the automation summary

Formatted Date

Resolved string text for newly formatted date and/or time

Automation Summary

File path for the automation summary report associated with
this event

Event ID

Identifier to be used for the event

Subject

Name of the event

Description

Brief description of the event

Parameter

Event parameters to be used in the event

All Matches

All matches to the regular expression

First Match

First match of the regular expression

Match Count

Number of matches to the regular expression

Object

Object name of the metric
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Step 5

Reference Variable

Description

Counter

Name of the metric

Instance

Name of the metric instance

Value

Performance metric value

Seconds

Number of seconds in the sleep interval

Response Time

Time taken for site to respond to ping

Runtime User

User who tests the validity and availability of a FTP location

Source XML

Source XML text used in XPath Query

Output

Output of the XSL Transform in the automation summary and
activity instance

Source Text

Source XML text to be transformed

Transform Path

File path to the specific file to be transformed

XSL Document

XSL document to be transformed

Click OK to add the selected reference variable to the related text field.

Viewing Core Activity Instance Results
This section describes what the user should expect to see after a process with a Core activity is launched.
Certain activities display additional activity instance information for review by users.
For example, there will be certain activities that generate information based on the defined properties of
the activities. In those situations, the activity instance properties displayed from the
Operations—Activity View will show the display-only configuration properties as well as the generated
results of the configuration properties.
To view activity instance properties:
Step 1

On the Operations workspace, choose any of the four activity views to display the activity instances in
the Results pane.

Step 2

On the Results pane, expand the appropriate process instance to display the related activities.

Step 3

Highlight the appropriate activity, and use one of the following methods:
•

Double-click the appropriate activity instance.

•

Right-click and choose Properties.

•

On the Details pane, click the hyperlink of any item on tabs.

The [Activity Name] Properties dialog box displays.
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Viewing Automation Summary Reports
When the Create Automation Summary activity is launched, the file path for the summary details of the
relevant diagnostic and state information captured while performing the analysis is displayed from the
Operations Workspace activity instance view.
To view the automation summary report:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Highlight the Create Automation Summary activity instance, right-click and choose View
Automation Summary.
The Automation Summary report launches in the default web browser.
Figure A-40

Automation Summary

The displayed information depends on the data generated by the executed activity.
Step 3

To view the properties of an automation summary, highlight the Create Automation Summary activity
instance, right-click and choose Properties.
The Create Automation Summary Properties dialog box displays.

Step 4

Click the View Summary tab to display the file path for the generated automation summary.
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Figure A-41

Create Automation Summary Properties Dialog Box—View Summary Tab

The following information is displayed:
Field

Description

Report location

Display-only. File path for the automation summary

Situation Analysis

After TEO puts all data points in context to identify a
situation that requires action, it performs deep analysis
based on the type of situation identified.
During situation analysis, TEO captures volatile state and
diagnostic information that may otherwise be difficult or
impossible to capture manually.
The Situation Analysis section displays below the overview
information.
Click the link in the upper portion of the summary to
navigate directly to the Situation Analysis section or simply
scroll to the section.

Context Analysis

TEO analyzes all data points in context with each other to
identify a situation that may require action.
This information can be viewed in the Context Analysis
section of the summary. The Context Analysis displays the
symptom and possible causes.
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Viewing Calculated Date Information
When the Calculate Date activity is launched, the results of the adjusted values of a date or time variable
are displayed from the Operations Workspace activity instance view.
To view the Calculate Date results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Calculate Date activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Calculate Date Properties dialog box displays.
Step 3

Click the Calculate Date tab to display the adjusted date results.
Figure A-42

Calculate Date Instance Properties Page—Calculate Date Tab

The following information is displayed:
Field

Description

Original date

Original date or time of the variable

Adjustment

Number of units to increase or decrease the time frame
The plus (+) or minus (-) signs prior to the value indicate
the adjustment of the value.

Result

Resolved date and time after adjustment
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Viewing Calculated Date Difference Results
When the Calculate Date Time Difference activity is launched, the results of the adjusted values of a date
or time variable are displayed from the Operations Workspace activity instance view.
To view the Calculate Date Time Difference results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Calculate Date Time Difference activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Calculate Date Properties dialog box displays.
Step 3

Click the Date Difference display-only tab to view the results of the calculated time difference.
Figure A-43

Calculate Date Instance Properties Page—Date Difference Tab

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

A-71

Appendix A

Managing Core Activities

Viewing Core Activity Instance Results

The following information is displayed:
Field

Description

Date

Formatted date time to be offset by the subtract date

Subtract Date

Date used to subtract the difference in the time frame

Ticks

Gets the number of ticks that represent the value of the
current TimeSpan structure

Total Days

Gets the days component of the time interval represented
by the current TimeSpan structure

Total Hours

Gets the value of the current TimeSpan structure expressed
in whole and fractional hours

Total Minutes

Gets the value of the current TimeSpan structure expressed
in whole and fractional minutes

Total Seconds

Gets the value of the current TimeSpan structure expressed
in whole and fractional seconds

Total Milliseconds

Gets the value of the current TimeSpan structure expressed
in whole and fractional milliseconds

Days

Gets the value of the current TimeSpan structure expressed
in whole and fractional days

Hours

Gets the hours component of the time interval represented
by the current TimeSpan structure

Minutes

Gets the minutes component of the time interval
represented by the current TimeSpan structure

Seconds

Gets the seconds component of the time interval
represented by the current TimeSpan structure

Milliseconds

Gets the milliseconds component of the time interval
represented by the current TimeSpan structure

Viewing the Matching Targets
When the Find Targets activity is launched, the results of the matching targets is displayed from the
Operations Workspace activity instance view.
To view the Find Targets results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Find Targets activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Find Targets Properties dialog box displays.
Step 3

Click the Targets display-only tab to view the matching targets.
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Figure A-44

Find Targets Instance Properties Page—Targets Tab

The following information is displayed:

Step 4

Field

Description

Name

Display name of the target found

Type

Type of target

Description

Description of the target found

To view the properties of a displayed target, right-click and choose Properties to launch the [Target]
Properties dialog box.

Viewing the Formatted Date Result
When the Format Date activity is launched, the results of the formatted date or time is displayed from
the Operations Workspace activity instance view.
To view the Format Date results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Format Date activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Format Date Properties dialog box displays.
Step 3

Click the Format Date display-only tab to view the formatted date result.
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Figure A-45

Format Date Instance Properties Page—Format Date Tab

The following information is displayed:
Field

Description

Format date

Submitted format of the date or time string

Original date

Original date and/or time to be formatted

Use local time zone

Checked check box indicates the activity used local time
zone instead of Coordinated Universal Time (UTC)

Result

Resolved string text for newly formatted date and/or time

Viewing Match Regular Expression Activity Results
When the Match Regular Expression activity is launched, results are displayed from the Operations
Workspace activity instance view.
To view regular expression results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Match Regular Expression Properties dialog box displays.
Step 3

Click the Matches tab to view the matches for the expression.
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Figure A-46

Match Regular Expression Properties Page—Matches Tab

The following information is displayed:
Field

Description

Matches Found

Displays the number of total matches found by the activity

Viewing Parsed Date Results
When the Parse Date activity is launched, the results of the parsed date is displayed from the Operations
Workspace activity instance view.
To view the Parse date results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Parse Date activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Parse Date Properties dialog box displays.
Step 3

Click the Parse Date display-only tab to view the parse date results.
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Figure A-47

Parse Date Instance Properties Page—Parse Date Tab

The following information is displayed:
Field

Description

Format string

Submitted format of the string to be parsed

Input string

Original date or time string to be parsed

Use local time zone

Checked box indicates the activity used local time zone
instead of Coordinated Universal Time (UTC)

Result

Resolved string text for newly parsed date and/or time

Viewing Set Target Reference Results
When the Set Target Reference activity is launched, results are displayed from the Operations Workspace
activity instance view.
To view Set Target Reference results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Set Target Reference activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Set Target Reference Properties dialog box displays.
Step 3

Click the Reference display-only tab to view the updated values for the target reference specified in the
process.
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Figure A-48

Step 4

Set Target Reference Instance Properties Page—Reference Tab

The following information is displayed:
Field

Description

Variable Updated

Target reference property to update

New target ID

New target ID for the target reference property

Viewing Set Variable Results
When the Set Variable activity is launched, results are displayed from the Operations Workspace activity
instance view.
To view Set Variable results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Set Variable activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Set Variable Properties dialog box displays.
Step 3

Click the Variable display-only tab to view the updated values for the variable specified in the process.
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Figure A-49

Step 4

Set Variable Instance Properties Page—Variable Tab

The following information is displayed:
Field

Description

Variable Updated

Displays the selected variable specified in the process
definition

Variable data type

Data type assigned to the selected variable

Set variable to

Updated value of the selected variable

Variable value after execution

The new value of the variable after the process has been
executed.

Viewing Test FTP Destination Response Time
When the Test FTP Destination activity is launched, results are displayed from the Operations
Workspace activity instance view.
To view Test FTP Destination results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Test FTP Destination Properties dialog box displays.
Step 3

Click the FTP tab to view the results of FTP site verification specified in the activity properties.

Cisco Tidal Enterprise Orchestrator Reference Guide

A-78

OL-24928-01

Appendix A

Managing Core Activities
Viewing Core Activity Instance Results

Figure A-50

Test FTP Destination Instance Properties Page—FTP Tab

The following information is displayed:
Field

Description

Destination

File path for the FTP site

Response time (in milliseconds)

Time taken for site to respond to ping

Viewing XPath Query Activity Results
When the XPath Query activity is launched, results are displayed from the Operations Workspace
activity instance view.
To view XPath Query results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The XPath Query Properties dialog box displays.
Step 3

Click the Results tab to view the display-only tab with the results of the XPath query. Each query result
will be displayed under the property name assigned in the XPath Query definition.
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Figure A-51

XPath Query Properties Page—Results Tab

The following information is displayed:
Property Name
Result of the XPath query definition

Viewing XSL Transform Activity Results
When the XSL Transform activity is launched, results are displayed from the Operations Workspace
activity instance view.
To view XSL transform output results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The XSL Transform Properties dialog box displays.
Step 3

Click the Output tab to view the XSL transform results.
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Figure A-52

XSL Transform Properties Page—Output Tab

The following information is displayed:
Field

Description

XML

Click this option to display the output results in an XML
format.

HTML

Click this option to display the output results in an HTML
format.

Text

Click this option to display the output results in a text
format.
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Task Activities
The Task Activities appendix provides information on defining task activities in the Process Editor,
instructions for completing the property pages for each specific activity, and instructions on viewing the
activity results.
The following sections provide the instructions for defining task activities:
•

Task Activities Overview, page B-2

•

Defining an Assigned Task Activity, page B-7

•

Defining a Publish Task to Event Log Activity, page B-10

•

Defining an Update Task Activity, page B-12

•

Defining a Wait for Task to Enter State Activity, page B-14

•

Defining IT Record Task Activities, page B-17

•

Defining User Interaction Task Activities, page B-46

•

Managing Task Activity Definitions, page B-59

•

Viewing Task Activity Instance Information, page B-67
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Task Activities Overview
When defining an activity in the process, the properties pane contains property pages that are specific to
the selected activity. This section provides information on how to define each activity-specific property
page.
The following table displays the tasks that are provided by TEO.
Tasks

Description

Assign Tasks

Assigns a task to a user or group of users
See Defining an Assigned Task Activity, page B-7.

Correlate Alerts

Checks whether an alert occurred within a certain amount
of time of another problem
See Defining a Correlate Alerts Activity, page B-17.

Create Alert

Alerts reflect potential problems that a user may want to
investigate and possibly diagnose the problem
See Defining a Create Alert Activity, page B-20.

Create Approval Request

Specifies the message and choices for the assignee who is
approving the activity
See Defining a Create Approval Request Activity,
page B-46.

Create Change Request

Requests a modification to the configuration of an object or
system
See Defining a Create Change Request Activity,
page B-28.

Create Guided Operation

Details the steps a user takes to complete an assigned task
See Defining a Create Incident Activity, page B-32.

Create Incident

Task requires an operator to take action in order to resolve
an issue
See Defining a Create Incident Activity, page B-32.

Create Input Request

Task requires input from an individual or group
See Defining a Create Input Request Activity, page B-51.

Create Input Request from Table

Queries information from a data table for an input request
See Defining a Create Input Request from Table Activity,
page B-54.

Create Review Request

Task assigns a document for review
See Defining a Create Review Request Activity, page B-57.

Find Alerts

Queries alerts based on a for a specific task
See Defining a Find Alerts Activity, page B-38.

Find Change Requests

Queries change requests based on search criteria
See Defining a Find Change Requests Activity, page B-40.

Find Incidents

Queries incidents based on specific search criteria
See Defining a Find Incidents Activity, page B-43.
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Tasks

Description

Publish Task to Event Log

Specifies the task that should be used to publish the
information to the task event log
See Defining a Publish Task to Event Log Activity,
page B-10.

Update [Task] Activities

Updates the properties for a specific task activity
•

Alert

•

Approval Request

•

Change Request

•

Guided Operation

•

Incident

•

Input Request

•

Review Request

See Defining an Update Task Activity, page B-12.
Wait for Task to Enter State

Waits for a task to match a specific state before the activity
continues
See Defining a Wait for Task to Enter State Activity,
page B-14.

Defining a Task Activity
When defining a task activity in the Process Editor, the activity will contain property pages that are
specific to the selected task as well as property pages that are common to all the tasks.
Use the following steps to define a task activity in the Process Editor. Refer to the appropriate section
for instructions on completing the task-specific property pages.
To define a task activity:
Step 1

On the Toolbox pane, under Tasks, choose the appropriate activity, then drag and drop the activity onto
the Workflow pane.
The [Activity Name] Properties dialog box displays.

Step 2

Step 3

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the task-specific tabs to enter the appropriate information for the task. Refer to the appropriate
section for instructions on creating the task.
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Note

Step 4

The Required Value
icon displayed on a tab or page indicates that the field is required and is missing
a value.
tool to choose a defined variable or reference an object within the process on
Click the Reference
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
Click the Assignment tab to modify the general assignment properties for the task.
Field

Description

Assigned to

User name(s) assigned to the task

Priority

Step 5

•

Add—Click Add to choose the name of the person to
assign to the activity. See Adding an Assignee to a
Task Activity, page B-60.

•

Remove—Choose the user name and click this button
to remove the user from list. See Removing an
Assignee from Task Activity, page B-61.

Indicates the priority of the task
•

Low

•

Medium (Default)

•

High

Set [task] due time period

Check this check box and choose appropriate date the task
should be completed from the drop-down calendar.

Set [task] expiration time period

Choose the appropriate date the task should expire from the
drop-down calendar.

Click the Parameters tab to define parameters for a specific task.
Field

Description

Parameter

Enter the appropriate parameter

Add

Adds new row for parameter to be added

Remove

Removes selected parameter from task

Step 6

Click the Categories tab to assign a task to a category or modify an existing assigned category.

Step 7

On the Categories tab, check the Task should inherit process categories check box to inherit the
categories assigned to the process.
The following table displays the tasks that belong to the following categories:
Column

Description

Display name

The name of the category

Description

A description of the category

Type

Type of category
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Step 8

Use the following buttons to modify the list of categories:
Field

Description

Add

Click this button to launch the Select Categories dialog box
and choose the category to which the process is to be
assigned.
For more information, see Assigning a Category to a Task,
page 4-41.

Properties

Click this button to view or modify the properties of
category.

Remove

Click this button to remove a category from the list.
For more information, see Removing a Category from a
Task, page 4-41.

Step 9

Step 10

Step 11

Click the External tab to specify the external incident management system information to support the
synchronization between TEO and the system that the customer is using.
Field

Description

External System

Name or IP address for the incident management server

External ID

ID of the incident which corresponds to the TEO incident

Click the Web Form tab to apply a specific XSL transformation to the task XML. XSLT transformation
will be used to convert XML text to HTML web pages.
Field

Description

Web Form XSL Transform File

XSL file used to transform the task XML into HTML
content

Click the Knowledge Base tab to assign a knowledge base article to the object.
Knowledge Base Field Options

Description

Text field

Display-only. Display name for the selected knowledge base
article(s)

Delete

Highlight the appropriate knowledge base article and click the
Delete
tool to remove the knowledge base article from the
display.

Browse

Click Browse to launch the Select Knowledge Base dialog box
for a list of existing knowledge base articles.
For additional information on knowledge base articles, see
Chapter 17, “Managing Knowledge Base Articles.”

Properties

Highlight the appropriate knowledge base article and click the
Properties
tool to view and/or modify the properties of the
defined knowledge base article.
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The following information is displayed on the Knowledge Base tab.

Step 12

Step 13

Field

Description

Summary

Brief description of the issue

Possible Cause

Explanation of the condition that may be causing the issue

Possible resolution

List of actions that can be performed to attempt to resolve
the issue

Related information

Additional information related to the issue

On the Result Handlers tab, click one of the following buttons to manage the condition branches on the
workflow, as necessary:
Button

Description

Add

Adds a condition branch

Remove

Removes the condition branch from the activity

Move Up

Moves the condition up one position in the list of conditions

Move Down

Moves the condition down one position in the list of
conditions

Click the Save

tool to save the activity definition.
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Defining an Assigned Task Activity
Use the Assign Task activity to modify the list of assignees for a task. On this activity, tasks can be
assigned to a user or group of users. Users can also remove current assignees from tasks.
To define an assigned task:
Step 1

On the Toolbox pane, under Tasks, choose Assign Task and drag and drop the activity onto the Workflow
pane.
The Assign Task property page displays.
Figure B-1

Step 2

Assign Task Properties Page—General Tab

On the General tab, specify the following general information about the activity.
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Assign tab to continue.

The Required Value
a value.
Figure B-2

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Assign Task Properties Page—Assign Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Assign tab, enter the following information:
Field

Description

Task ID

ID of the task
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Field

Description

Remove Assignees

Check this check box and then click one of the following
buttons to manage the removal of the user names assigned
to the task:
•

Remove all assignees—Click this button to remove all
assignees from the task

•

Remove specified assignees—Click this button to
remove a specific user name that is assigned to the task
– Add—Click Add to launch the Select Assignee

dialog box to add a user name to the list of
removed assignees.
– Type the name of the assignee or click Browse to

launch the Select User or Group dialog box to
choose the name of the person designated as the
assignee.
– Edit—Click to edit the name of the assignee
– Remove—Choose the user name and click this

button to remove the user from list
– Remove All—Click this button to remove all user

names from the list
Add specified assignee

User name(s) assigned to the task
•

Add—Click Add to launch the Select Assignee dialog
box to add a user name to the list.
Type the name of the assignee or click Browse to
launch the Select User or Group dialog box to search
for the name of the assignee.

Add assignee list

Step 5

•

Edit—Click to edit the name of the assignee

•

Remove—Choose the user name and click this button
to remove the user from list

•

Remove All—Click this button to remove all user
names from the list

Adds list of assignees from a different task or user
identities from a table variable and assigns to the current
task

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Publish Task to Event Log Activity
Use the Publish Task to Event Log activity to retrieve task information and publish the information to
the task event log.
To define a Publish Task to Event Log activity:
Step 1

On the Toolbox pane, under Tasks, choose Publish Task to Event Log and drag and drop the activity
onto the Workflow pane.
The Publish Task to Event Log property page displays.
Figure B-3

Step 2

Step 3

Note

Publish Task to Event Log Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Task tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure B-4

Note

Step 4

Publish Task to Event Log Properties Page—Task Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Task tab, enter the task ID to publish to the event log.
Field

Description

Task ID

Enter the task ID or click the Reference tool to insert the
ID number for the task.

Event source name

Check this check box and enter the name of the event
source to use when logging the task.
The default event source in which the task will be
published is the TEO tasks event source.

Step 5

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining an Update Task Activity
Use the Update [Task] activity to update the properties for a specific task. The properties for the
following tasks may be updated using their respective activities in the Toolbox pane.

Note

•

Alert

•

Approval Request

•

Change Request

•

Guided Operation

•

Incident

•

Input Request

•

Review Request

For additional information on the properties that can be updated in the list, see Common Task Properties,
page 4-4.
To define an update task activity:

Step 1

On the Toolbox pane, under Tasks, choose Update [Task] and drag and drop the activity onto the
Workflow pane.
The Update [Task] property page displays.
Figure B-5

Step 2

Update [Task] Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Task tab to continue.

The Required Value
a value.
Figure B-6

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Update [Task] Properties Page—Task Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Task tab, enter the following information to use to update the activity.
Field

Description

Task ID

ID number for the task

Properties to update

From the Property drop-down list, choose the item to
update within the task. The properties displayed depend on
the selected item.
Note

List action

Value

For additional information on the properties in the
list, see Common Task Properties, page 4-4.

Choose the appropriate option to determine which action to
take with the selected property.
•

Add Item—Click this button to add a new property
field to the original property for the task.

•

Remove item—Click this button to remove a property
field from task.

Enter new value for the property
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Step 5

Step 6

To modify the list of properties to update on the Task tab, click one of the following buttons:
Button

Description

Add

Click this button to add a new Property field to be updated
on the task.

Remove

Click this button to remove the last Property field to be
updated from the task.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.

Defining a Wait for Task to Enter State Activity
Use the Wait for Task to Enter State activity to wait for a task to match a specific state before the activity
continues.
If the task reaches a completed state without matching, or if the duration expires without matching a
specified status, then the activity succeeds without matching.
To define a Wait for Task to Enter State activity:
Step 1

On the Toolbox pane, under Tasks, choose Wait for Task to Enter State and drag and drop the activity
onto the Workflow pane.
The Wait for Task to Enter State property page displays.
Figure B-7

Wait for Task to Enter State Properties Page—General Tab
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Step 2

Step 3

Note

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Task tab to continue.

The Required Value
a value.
Figure B-8

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Wait for Task to Enter State Properties Page—Task Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Task tab, enter the appropriate task information to use to monitor the task state changes.
Field

Description

Task ID

Enter the task ID or click the Reference tool to insert the
ID number for the task.

Task Types

Select the appropriate task type which state should be
monitored.
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Field

Description

Time to wait for matching status
value

Check this check box and enter the time period the the
activity should wait to match before timing out.
Note

Task statuses to match

The statuses displayed depend on the selected task.
Highlight the appropriate statuses to match.
Note

Step 5

See Common Task Statuses, page 4-6 for additional
information.

Click the Credentials tab to continue.
Figure B-9

Step 6

Click the time unit link to change the time interval.

Wait for Task to Enter State Properties Page—Credentials Tab

On the Credentials tab, specify the runtime user whose credentials should be used for activity execution:
Field

Description

Use target’s credential runtime user Select this radio button to use the default runtime user for
the target that is specified in the activity
Use process runtime user

Select this radio button to use the credentials for the
runtime user that was specified in the process properties

Override process runtime user

Select this radio button to specify different credentials than
what are used for the process. The selected runtime user
overrides the runtime user that was specified for the
process.
Note

To view the properties for the selected runtime
user, click the Properties
tool. To create a
runtime user record for the process, click New >
[Runtime User]. For additional information on
creating a runtime user, see Chapter 16, “Managing
Runtime Users.”
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Step 7

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.

Defining IT Record Task Activities
Use the following activities to create tasks that handle basic IT task functions.

Defining a Correlate Alerts Activity
Use the Correlate Alerts activity to check whether an alert occurred within a certain amount of time of
another problem.
To define a correlated alert activity:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Correlate Alerts and drag and drop the activity
onto the Workflow pane.
The Correlate Alerts property page displays.
Figure B-10

Step 2

Correlate Alerts Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity
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Step 3

Note

Field

Description

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Alert Criteria tab to continue.

The Required Value
a value.
Figure B-11

Note

icon displayed on a tab or page indicates that the field is required and is missing

Correlate Alerts Properties Page—Alert Criteria Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
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Step 4

On the Alert Criteria tab, specify the following event properties for the activity:
Field

Description

Correlate alerts that occur within

Enter a value and choose the time unit to indicate the length
of time to wait before or after the process start time. The
process start time is the default object used to correlate
alerts.
•

Time unit—Determines whether the value entered is in
minutes or seconds

•

Event occurrence—Determines whether the process
start time of the alert can occur within the following:
– Before
– After
– Before or after

Number of alerts to correlate

Select one of the following radio buttons to determine the
number of events to correlate before publishing the event
•

All alerts in the above time frame—Select this radio
button to wait for all events that match the specified
criteria before the process continues.

•

Number of alerts—Select this radio button to wait for
the specified number of alerts to occur before the
process continues. Enter the number of alerts to wait
for in the text field.

Alert Criteria

Properties

From the drop-down list, choose the appropriate property
to correlate.
Note

Value

Enter the appropriate value to be used to correlate the
selected property.
Note

Step 5

For additional information on the properties in the
list, see Common Task Properties, page 4-4.

The Expression arrow displayed to the right of the
Reference tool indicates that a Wildcard expression
is available. See Common Wildcard Expressions,
page 7-19.

Add

Click this button to add a new property.

Remove

Click this button to remove a property from the activity.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Create Alert Activity
Use the Create Alert activity to create an alert to reflect potential problems that a user may want to
investigate and possibly diagnose the problem.
To define a create alert activity:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Create Alert and drag and drop the activity onto
the Workflow pane.
The Create Alert property page displays.
Figure B-12

Step 2

Create Alert Properties Page—General Tab

On the General tab, specify the following general information about the activity.
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Alert tab to continue.

The Required Value
a value.
Figure B-13

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Create Alert Properties Page—Alert Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Alert tab, enter the criteria for the alert.
Field

Description

Alert display name

Name of the alert

Alert class

String or numeric value indicating the class of the alert

Severity

Severity of the alert
•

High—Interruption to critical business processes

•

Normal—Interruption to the work of individual
employees

•

Low—Hindrance to the work of individual employees,
continuation of work possible by means of a
circumvented solution
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Step 5

Click the Automation Summary tab to continue.
Figure B-14

Step 6

Create Alert Properties Page—Automation Summary Tab

On the Automation Summary tab, specify the criteria to use to generate an automation summary when
an alert or incident is created.
To generate the data output, choose the object and then specify the section in the automation summary
in which to output the data.
Field

Description

No automation summary

Select this radio button to indicate that an automation will
not be generated for the task

Automation Summary URL

Enter the URL of the automation summary. Enter the file
path for the related automation summary that was
generated.

Create automation summary

From the Automation summary style sheet drop-down list,
choose the type of template to be used for the automation
summary. By default, the Situation Analysis Report style
sheet is selected.
•

Table of Configuration Properties

•

Situation Analysis Report
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Field

Description

Select the details for each activity

From the drop-down list, choose the activity and specify
the section of the automation summary to include the
reporting details and whether the activity is the root cause
of any issues that are detected.

Settings for [name] activity

•

Name—Name of the objects that are included in the
process

•

Section—Name of the section of the automation
summary where the data will be stored

From the Section drop-down list, choose one of the
following options to specify the section of the automation
summary template in which to export the data:
•

SituationAnalysis—After a situation that requires
action is identified, the state and diagnostic
information is displayed in the Situation Analysis
section of the automation summary.

•

ContextAnalysis—After a situation is analyzed in
context with other situations, the symptom and cause
is displayed in the Context Analysis section of the
automation summary.

Is the root cause

Check this check box to generate the automation summary
name with the same name as the knowledge base article
that is associated with the selected activity.

Last instance information only

Check this check box to indicate that the automation
summary must include only information for the latest
execution of the activity instance.
Note

This setting is only for activities that are inside the
loop of a workflow component, such as While or
For Each.
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Step 7

Click the Affects tab to continue.
Figure B-15

Step 8

Create Alert Properties Page—Affects Tab

On the Affects tab, organizations and configuration item elements that trigger the selected target.
Field

Description

This alert applies to the following
target

Check this check box to enable the options used to specify
the affected target to be used in the activity.

Process target

Select this radio button to use the process target as the
affected target in the activity.
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Field

Description

Activity target

Select this radio button to specify the affected target for a
specific task activity.
•

Activity target—Choose the activity containing the
target that will be used. Only task activities will
display in the list.

•

Specified target—Specify the affected target that will
be used.
To view the properties for the selected target, click the
Properties tool. To create a new target, click New >
[Target].

•

Specific target group—Specify the affected target
group that will be used.
To view the properties for the selected target group,
click the Properties tool. To create a new target group,
click New > [Target Group].
– From the Choose a target using this algorithm

drop-down list, specify which target will be
chosen from the eligible target group members:
This applies to the following
configuration item

Check this check box to enable the options used to specify
the configuration item to be used in the activity.

Name

Name of the configuration item (IT component) to which
the alert pertains.
For example, the name of a database server which failed or
the name of a specific job which failed.

Type

Enter or choose the type of ITIL configuration item (IT
component) which the alert describes.
For example, the type of the specific application element
which failed:
•

Application Server

•

Database

•

Host

•

User

This is a CMDB reference

Check the check box to indicate the true source of the CI is
in the CMDB, so the configuration item properties
reference a CMDB entry.

Object Key

ID for the specific record in the CMDB which contains the
configuration item

Object Source

Name for the specific record in the CMDB which contains
the configuration item

Affected services

IT Service affected by the alert or incident

Affected organizations

Organizations that consume the IT service affected by the
alert or incident
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Step 9

Click the Duplicate tab to continue.
Figure B-16

Step 10

Create Alert Properties Page—Duplicate Tab

On the Duplicate tab to define the criteria used to search for previously submitted alerts.
If the alert is a duplicate, then the new alert is automatically resolved and linked to the original alert as
a related task.
Field

Description

Mark this alert as a duplicate if
matches another alert

Check the check box and enter the time period the alert
should be resolved.
Note

Properties to match

Choose the item to match for a duplicate within the alert.
The options displayed depend on the selected property.

List action

Choose the appropriate option to determine which action to
match with the selected property. The available options to
match depend on the property type.
•

Exactly matches this alert property

•

Matches the specified wildcard text

Note

Note

Click the time unit link to change the time interval.

The Expression arrow displayed to the right of the
Reference tool indicates that a Wildcard expression
is available. See Common Wildcard Expressions,
page 7-19.

Add

Click this button to add a new field to be completed to
match within the alert

Remove

Click this button to remove the property from the criteria to
match. One field will always remain.

For information on the matching properties, see Common Task Properties, page 4-4.
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Step 11

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Create Change Request Activity
Use the Create Change Request activity to request a modification to the configuration of an object or
system. Change requests are used to request system enhancements, report problems with a system, or
report changes from one system which affects another system.
To create a change request:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Create Change Request and drag and drop the
activity onto the Workflow pane.
The Create Change Request property page displays.
Figure B-17

Step 2

Create Change Request Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Change Request tab to continue.

The Required Value
a value.
Figure B-18

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Create Change Request Properties Page—Change Request Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Change Request tab, enter the criteria for the approval request.
Field

Description

Change request display name

Name of the change request

Change request identifier

TEO generated ID number for the change request task

Change request class

Numeric value indicating the class of the change
request

Reason for change

Describes the business justification for the request

Change timing

Enter the deadline date or time for the change
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Field

Description

Severity

Severity of the change request

Change Request description
Step 5

High—Interruption to critical business processes

•

Normal—Interruption to the work of individual
employees

•

Low—Hindrance to the work of individual
employees, continuation of work possible by
means of a circumvented solution

Brief description of the change request

Click the Automation Summary tab to continue.
Figure B-19

Step 6

•

Create Change Request Properties Page—Automation Summary Tab

On the Automation Summary tab, specify the criteria to use to generate an automation summary when a
change request is created.
To generate the data output, choose the object and then specify the section in the automation summary
in which to output the data.

Note

For additional information on the field descriptions on Step 6 in Defining a Create Alert Activity,
page B-20.
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Step 7

Click the Affects tab to continue.
Figure B-20

Step 8

Create Change Request Properties Page—Affects Tab

On the Affects tab, specify the organizations and configuration item elements that triggered the target
for the task.

Note

For additional information on the field descriptions on Step 8 in Defining a Create Alert Activity,
page B-20.

Step 9

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.
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•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.

Defining a Create Incident Activity
Use the Create Incident task to create a create a task which requires an operator to take action in order
to resolve an issue.
To define a create incident activity:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Create Incident and drag and drop the activity
onto the Workflow pane.
The Create Incident property page displays.
Figure B-21

Step 2

Create Incident Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Incident tab to continue.

The Required Value
a value.
Figure B-22

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Create Incident Properties Page—Incident Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Incident tab, enter the criteria for the incident.
Field

Description

Incident display name

Name of the incident

Incident identifier

ID of the incident

Incident class

String or numeric value indicating the class of the alert

Reporting user

User name of the individual who reported the incident and
contact information of the user who called IT to report the
problem

Reporting user details

Contact information of the individual who reported the
incident
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Field

Description

Severity

Severity of the alert

Incident description
Step 5

High—Interruption to critical business processes

•

Normal—Interruption to the work of individual
employees

•

Low—Hindrance to the work of individual employees,
continuation of work possible by means of a
circumvented solution

Brief description of the incident

Click the Automation Summary tab to continue.
Figure B-23

Step 6

•

Create Incident Properties Page—Automation Summary Tab

On the Automation Summary tab, specify the criteria to use to generate an automation summary when
an alert or incident is created.
To generate the data output, choose the object and then specify the section in the automation summary
in which to output the data.

Note

For additional information on the field descriptions on Step 6 in Defining a Create Alert Activity,
page B-20.
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Step 7

Click the Affects tab to continue.
Figure B-24

Step 8

Note

Create Incident Properties Page—Affects Tab

On the Affects tab, specify the organizations and configuration item elements that triggered the target
for the task.

For additional information on the field descriptions on Step 8 in Defining a Create Alert Activity,
page B-20.
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Step 9

Click the Related tab to continue.
Figure B-25

Step 10

Create Incident Properties Page—Related Tab

On the Related tab, specify or modify the list of alerts that originated the incident.
Field

Description

Add

Click this button to launch the Select Alerts to Add dialog
box and choose the alert ID to add to the list.

Edit

Highlight an alert, and then click this button to modify the
ID of the alert to add into the related alerts.

Remove

Highlight the appropriate alert and then click this button to
remove an alert from the list.
This does not delete the alerts permanently from the
system.

Remove all

Click this button to remove all alerts from the list.
This does not delete the alerts permanently from the
system.

Automatically resolve these alerts
when resolving the incident

Check this check box to indicate that the alerts in the list
should resolve automatically when the incident is resolved.
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Step 11

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Find Alerts Activity
Use the Find Alerts activity to query alerts based on specific search criteria.
To define a find alerts activity:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Find Alerts and drag and drop the activity onto
the Workflow pane.
The Find Alerts property page displays.
Figure B-26

Step 2

Find Alerts Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Search Criteria tab to continue.

The Required Value
a value.
Figure B-27

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Find Alerts Properties Page—Search Criteria Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Search Criteria tab, enter the appropriate query information:
Field

Description

Search tasks within the past:

Enter the time period to search for tasks.
Note

Search tasks that are in the
following state:

Properties to Match

Click the time unit link to change the time interval.

From the drop-down list, select the appropriate status to
query in the tasks.
•

Not Completed—Searches tasks that have not been
completed

•

Completed—Searches tasks that have been completed

•

Not Started—Searches tasks that have not been started

•

All—Searches all tasks regardless of the current state

From the Property drop-down list, select the item to match
within the alert for the query.
Note

For additional information on the properties in the
list, see Common Task Properties, page 4-4. For
information on wildcard expressions, see Common
Wildcard Expressions, page 7-19.
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Step 5

Field

Description

Add

Click this button to add a new Property drop-down list in
which the user can select another item to match within the
query.

Remove

Click this button to remove the last Property drop-down list
from the list of properties to match within the query

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.

Defining a Find Change Requests Activity
Use the Find Change Requests activity to query change requests based on specific search criteria.
To define a find change requests activity:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Find Change Requests and drag and drop the
activity onto the Workflow pane.
The Find Change Requests property page displays.
Figure B-28

Find Change Requests Properties Page—General Tab
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Step 2

Step 3

Note

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Search Criteria tab to continue.

The Required Value
a value.
Figure B-29

Note

icon displayed on a tab or page indicates that the field is required and is missing

Find Change Requests Properties Page—Search Criteria Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
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Step 4

On the Search Criteria tab, enter the appropriate query information:
Field

Description

Search tasks within the past:

Enter the time period to search for tasks.
Note

Search tasks that are in the
following state:

Properties to Match

From the drop-down list, select the appropriate status to
query in the tasks.
•

Not Completed—Searches tasks that have not been
completed

•

Completed—Searches tasks that have been completed

•

Not Started—Searches tasks that have not been started

•

All—Searches all tasks regardless of the current state

From the Property drop-down list, select the item to match
within the change request for the query.
Note

Step 5

Click the time unit link to change the time interval.

For additional information on the properties in the
list, see Common Task Properties, page 4-4. For
information on wildcard expressions, see Common
Wildcard Expressions, page 7-19.

Add

Click this button to add a new Property drop-down list in
which the user can select another item to match within the
query.

Remove

Click this button to remove the last Property drop-down list
from the list of properties to match within the query

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Find Incidents Activity
Use the Find Incidents activity to query incidents based on specific search criteria.
To define a find incidents activity:
Step 1

On the Toolbox pane, under Tasks - IT Records, choose Find Incidents and drag and drop the activity
onto the Workflow pane.
The Find Incidents property page displays.
Figure B-30

Step 2

Find Incidents Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Search Criteria tab to continue.

The Required Value
a value.
Figure B-31

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Find Incidents Properties Page—Search Criteria Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Search Criteria tab, enter the appropriate query information:
Field

Description

Search tasks within the past:

Enter the time period to search for tasks.
Note

Search tasks that are in the
following state:

Properties to Match

Click the time unit link to change the time interval.

From the drop-down list, select the appropriate status to
query in the tasks.
•

Not Completed—Searches tasks that have not been
completed

•

Completed—Searches tasks that have been completed

•

Not Started—Searches tasks that have not been started

•

All—Searches all tasks regardless of the current state

From the Property drop-down list, select the item to match
within the incident for the query.
Note

For additional information on the properties in the
list, see Common Task Properties, page 4-4. For
information on wildcard expressions, see Common
Wildcard Expressions, page 7-19.
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Step 5

Field

Description

Add

Click this button to add a new Property drop-down list in
which the user can select another item to match within the
query.

Remove

Click this button to remove the last Property drop-down list
from the list of properties to match within the query

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining User Interaction Task Activities
Use the following activities to require user interaction in order to complete the task activity.

Defining a Create Approval Request Activity
Use the Create Approval Request activity to specify to the approving assignee the choices and related
message associated with the task.
To create an approval request:
Step 1

On the Toolbox pane, under Tasks - User Interactions, choose Create Approval Request and drag and
drop the activity onto the Workflow pane.
The Create Approval Request property page displays.
Figure B-32

Step 2

Create Approval Request Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Approval tab to continue.

The Required Value
a value.
Figure B-33

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Create Approval Request Properties Page—Approval Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Approval tab, enter the criteria for the approval request.
Field

Description

Approval message

Enter the message that informs the approver what is being
requested.

Approval choices

Displays the choices available to the approver

Use the following automation
summary URL

•

Add—Enter approval choices in the Select Approval
Choice dialog box.

•

Modify—Highlight an existing item in the Approve
Choice text box and then click Modify to update the
approval item.

•

Remove—Choose an existing item in the Approve
Choice text box and then click Remove to remove the
approval item from the list.

Check this check box and enter the appropriate file path to
the automation summary.
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Step 5

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Create Guided Operation Task
Use the Guided Operation activity to provide detail instructions for a user or group to perform a guided
operation task.
To define a guided operation activity:
Step 1

On the Toolbox pane, under Tasks - User Interactions, choose Create Guided Operation and drag and
drop the activity onto the Workflow pane.
The Create Guided Operation Properties dialog box displays.
Figure B-34

Step 2

Create Guided Operation Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Guided Operation tab to continue.

The Required Value
a value.
Figure B-35

Note

Step 4

Step 5

icon displayed on a tab or page indicates that the field is required and is missing

Create Guided Operation Properties Page—Guided Operation Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Guided Operation tab, enter the criteria for the guided operation.
Field

Description

Instructions

Enter the step-by-step process for handling a task.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.
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•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.

Defining a Create Input Request Activity
Use the Create Input Request activity to gather information by providing a question or set of questions
requiring a user or group response.
To define a create input request activity:
Step 1

On the Toolbox pane, under Tasks - User Interactions, choose Create Input Request and drag and drop
the activity onto the Workflow pane.
The Create Input Request property page displays.
Figure B-36

Step 2

Create Input Request Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Input Request tab to continue.

The Required Value
a value.
Figure B-37

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Create Input Request Properties—Questions Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Questions tab, define the appropriate questions for the input request.
Field

Description

Input request message

Enter the introductory message for the input request.

Questions presented on the input
request

Displays the input request question properties
•

Label—Input request question

•

Type—Type of question (text, hidden text, check box,
select)

•

Default Value—Default answer for the question
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Step 5

Field

Description

New

Use this option to create a specific type of input request
question. Click New each time to create additional
questions for the input request.
•

Text—Launches the Text Question Properties dialog
box to allow the user to define a text question. See
Creating a Text Question, page 4-30.

•

Hidden text—Launches the New Hidden Text
Properties dialog box to allow the user to define a
question requiring an encrypted value as a response.
See Creating a Hidden Text Question, page 4-31.

•

Check box—Launches the Check box Question
Properties dialog box to allow the user to define a
question utilizing a check box. See Creating a Check
Box Question, page 4-32.

•

Select—Launches the Select Question Properties
dialog box to allow the user to define a text question.
See Creating a Select Question, page 4-33.

Properties

Highlight a question and click this button to modify the
properties for the question

Delete

Highlight a question and click this button to remove the
question from the list

Move Up

Highlight a question and click this button to move the
question up the list of questions

Move Down

Highlight a question and click this button to move the
question down the list of questions

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Create Input Request from Table Activity
Use the Create Input Request from Table activity to query information from a data table for an input
request which requires a user or group response.
To define a create input request from table activity:
Step 1

On the Toolbox pane, under Tasks - User Interactions, choose Create Input Request from Table and
drag and drop the activity onto the Workflow pane.
The Create Input Request from Table property page displays.
Figure B-38

Step 2

Create Input Request from Table Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Questions from Table tab to continue.

The Required Value
a value.
Figure B-39

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Create Input Request from Table Properties—Questions from Table Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Questions tab, define the appropriate questions for the input request.
Field

Description

Input request message

Enter the introductory message for the input request.

Type of Questions

From the drop-down list, select the specific type of input
request question to query from the source table.
•

Text—Input request question containing a text
question

•

Hidden text—Input request question requires an
encrypted value as a response

•

Check box—Input request question utilizing a check
box

Source Table

Click the Reference tool to select the appropriate variable
table containing the data to query.

Column containing question text

From the drop-down list, select the column containing the
input request question.
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Field

Description

Use the following column to set the Check this check box and in the enabled text field, select
question ids
the column to use when defining the ID number for the
question.
Use the following column to set
default answer values
Step 5

Check this check box and in the enabled text field, select
the column to use when defining the default answer values.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.

•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.
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Defining a Create Review Request Activity
Use the Review task to submit a document for review as well as provide a message for the reviewer.
To define a create review request activity:
Step 1

On the Toolbox pane, under Tasks - User Interactions, choose Create Review Request and drag and drop
the activity onto the Workflow pane.
The Create Review Request property page displays.
Figure B-40

Step 2

Create Review Request Properties Page—General Tab

On the General tab, specify the following information about the activity:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Click the Review tab to continue.
Figure B-41

Note

Step 4

Create Review Request Properties Page—Review Tab

Click the Reference
tool to choose a defined variable or reference an object within the process on
the Insert Variable Reference dialog box. For additional information, see Inserting Variable References,
page 7-21.
On the Review tab, enter the information required to submit a document for review.
Field

Description

Document to review

Click Browse to locate document or automation summary
to be reviewed.
The following example is the display for the file path for
the document.
Example:
C:/Documents and Settings/user name/My Documents/

Message

Step 5

Enter the message that informs the reviewer of why
document needs to be reviewed.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Assignment—Click the tab to modify the general assignment properties. See Step 4 in Defining a
Task Activity, page B-3.

•

Parameters—Click the tab to define parameters for the task. See Step 5 in Defining a Task Activity,
page B-3.

•

Categories—Click the tab to assign a category or modify an existing assigned category. See Step 6
in Defining a Task Activity, page B-3.

•

External—Click the tab to specify the external incident management system information to support
the synchronization between TEO and the system the customer is using. See Step 9 in Defining a
Task Activity, page B-3.
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•

Web Form—Click the tab to apply a specific XSL transformation to the task XML. See Step 10 in
Defining a Task Activity, page B-3.

•

Knowledge Base—Choose the appropriate knowledge base article to associate with the process. See
Step 11 in Defining a Task Activity, page B-3.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 12 in Defining a Task Activity, page B-3.

Managing Task Activity Definitions
The ability to modify tasks is not applicable to everyone as only users with administrative rights can
update task activities in TEO.
This section provides instructions on modifying assign task activity properties in the Process Editor.

Modifying Automation Summary Properties
An automation summary can be included in either the Create Alert activity or the Create Incident
activity.
The selections in the activity define the properties used to analyze relevant diagnostic and state
information captured while performing the situation analysis.
To modify automation summary properties:
Step 1

On the activity property page, click the Automation Summary tab to modify the automation summary
properties for the activity.
Field

Description

No automation summary

Select this radio button to indicate that an automation will
not be generated for the task

Automation Summary URL

Enter the URL of the automation summary. Enter the file
path for the related automation summary that was
performed.

Create automation summary

From the Automation summary style sheet drop-down list,
choose the type of template to be used for the automation
summary. By default, the Situation Analysis Report style
sheet is selected.
•

Table of Configuration Properties

•

Situation Analysis Report
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Field

Description

Select the details for each activity

From the drop-down list, choose the activity and specify
the section of the automation summary to include the
reporting details and whether the activity is the root cause
of any issues that are detected.

Settings for [name] activity

•

Name—Name of the objects that are included in the
process

•

Section—Name of the section of the automation
summary where the data will be stored

From the Section drop-down list, choose one of the
following options to specify the section of the automation
summary template in which to export the data:
•

SituationAnalysis—After a situation that requires
action is identified, the state and diagnostic
information is displayed in the Situation Analysis
section of the automation summary.

•

ContextAnalysis—After a situation is analyzed in
context with other situations, the symptom and cause
is displayed in the Context Analysis section of the
automation summary.

Is the root cause

Check this check box to generate the automation summary
name with the same name as the knowledge base article
that is associated with the selected activity.

Last instance information only

Check this check box to indicate that the automation
summary must include only information for the latest
execution of the activity instance.
Note

Step 2

Click the Save

This setting is only for activities that are inside the
loop of a workflow component, such as While or
For Each.

tool to save.

Adding an Assignee to a Task Activity
Use the following steps to change the assignee or other assignment properties for the activity. This
includes taking ownership of the task, if necessary.
To add an assignee:
Step 1

On the activity property page, click the Assignment tab to modify the assignee properties for the activity.

Step 2

Under [Activity Name] Assigned to, click Add to launch the Select Assignee dialog box.
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Figure B-42

Step 3

Step 4

Select Assignee Dialog Box

Use one of the following methods:
•

Click the Reference tool to search for a variable reference to assign to the task activity.

•

Click Browse to the right of the Reference tool to launch the Select User or Group dialog box to
search for the name of the user or group to be assigned.

After locating the appropriate assignee, click OK.
The assignee is displayed on the Assignment property page.

Step 5

Click the Save

tool to save.

Removing an Assignee from Task Activity
Removing an assignee does not delete the object, user, or group from the TEO system.
To remove an assignee:
Step 1

On the activity property page, click the Assignment tab to remove the assignee from the activity.

Step 2

Under [Activity Name] Assigned to, use one of the following methods:

Step 3

•

Highlight the appropriate assignee and click Remove.

•

Click Remove All to remove all assignees from the task activity.

Click the Save

tool to save.

Modifying the Assignment Priority Properties
Use the following steps to modify the task priority and time completion constraints.
To modify the task assignment properties:
Step 1

On the activity property page, click the Assignment tab to modify the assignment priority for the
activity.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

B-61

Appendix B

Task Activities

Managing Task Activity Definitions

Step 2

Step 3

Modify the following assignment properties, as necessary:
Field

Description

Priority

Indicates the priority of the task
•

Low

•

Medium (Default)

•

High

Due date

Check this check box and choose the appropriate date the
task should be completed from the drop-down calendar.

Expiration date

Choose the appropriate date the alert should expire from
the drop-down calendar.

Click the Save

tool to save.

Assigning Duplicate Criteria for Task
Use the Duplicate tab to define the criteria to mark the task as a duplicate. This tab is available only in
the Create Alert activity.
To define duplicate criteria:
Step 1

Note

Step 2

Note

On the activity property page, click the Duplicate tab to define the criteria used to indicate an alert is a
duplicate.

If the alert is a duplicate, then the new alert is automatically resolved as a duplicate and linked to the
original alert as a related task.
Check the Mark this alert as a duplicate if matches another alert check box and enter the time period
the alert should be resolved.

Click the time unit link to change the time interval.
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Step 3

Click Add to add a new field to be completed to match within the alert.
Property

Description

Properties to match

Select the property to match for a duplicate within the alert.
The options displayed depend on the selected property.
For information on the matching properties, see
Common Task Properties, page 4-4.

Note

List action

Choose the appropriate option to determine which action to
match with the selected property.
•

Exactly matches this alert property

•

Matches the specified wildcard text

Note

Step 4

Click the Save

The Expression arrow displayed to the right of the
Reference tool indicates that a Wildcard expression
is available. See Common Wildcard Expressions,
page 7-19.

tool to save.

Removing an Assigned Duplicate Property
Use the following steps to remove a task property from the duplicate criteria.
Step 1

On the activity property page, click the Duplicate tab to remove the criteria used to indicate a task is a
duplicate of another task.

Step 2

On the Duplicate tab, click Remove to remove the property from the criteria to match. One field will
always remain.
The Remove button removes the last property added to the list. For example, the user cannot remove
Parameter 4 without removing Parameter 5 from the list.
If the user wants to keep Parameter 5, then update Parameter 4 with the information from Parameter 5,
and then click Remove to remove Parameter 5 from the list.

Step 3

Click the Save

tool to save.

Adding a Related Alert
Use the Related tab to assign alerts that originated from the incident. Use the following steps to add a
related item to the Create Incident activity.
To add a related task:
Step 1

On the activity property page, click the Related tab to modify the list of alerts related to the Create
Incident activity.

Step 2

Click Add to launch the Select Alert to Add dialog box.
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Figure B-43

Select Alerts to Add Dialog Box

Step 3

On the Alert ID field, enter the Alert ID or click the Reference tool to search for the alert property to
add to the list.

Step 4

Click OK to close the dialog box.
The item is displayed on the Related tab.

Removing a Related Alert
The Remove option removes the item from the list, but it is not deleted from the system.
To remove a related alert:
Step 1

Step 2

On the Related tab, click one of the following buttons:
•

Highlight the appropriate alert or incident and click Remove.

•

Click Remove All to remove all alerts or incidents from the Create Incident activity.

Click the Save

tool to save.
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Inserting Task Activity Variable References
The Reference
icon to the right of a text field indicates that the field can be populated by referencing
a defined variable or the property of another activity or process. Use the Insert Variable Reference dialog
box to select a defined variable or object to populate a field.
Only variables valid for the selected field can be selected in this dialog box. The OK button does not
activate until a valid property or variable is selected.
To insert a variable reference:
Step 1

To the right of a field on a property page, click the Reference tool.
The Insert Variable Reference dialog box displays.
Figure B-44

Note

Step 2

Insert Variable Reference Dialog Box

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Check the Show Advanced check box to display all items that are available for referencing.
If the check box is not checked, then only the most commonly-used items are displayed for activities,
processes or events.

Step 3

Click the Workflow Activity Expand (+) to display the reference objects for the activities in the
Workflow pane. The properties in the Insert Reference Variable dialog box depend on the activities.

Step 4

From the list of displayed objects, select the appropriate property:
Reference Variable

Description

Name

Display name of the activity

Notes

Description for the activity

Created by

User name or the owner of the activity

Created Time

The date and time the activity was created

Modified by

User name of the individual who modified the activity
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Reference Variable

Description

Type

Type of activity

Description

Description of the activity

Audit Starts

Date and time the process audit starts

Audit Successes

Indicates the number of successful audits

End Time

Date and time the activity stopped

Error Information

Description of the error that has occurred

Group Name

Name of toolbox activity group

Instance Cancelled

Indicates the process was cancelled manually

Instance Failed

Indicates the process has failed

Instance Failed (Completed)

Indicates the process has failed but the process execution was
completed

Instance Failed (Not Completed) Indicates the process has failed and did not complete the
process execution
Start Time

Date and time the activity was started

Process Id

ID number of the TEO process

Process Instance Id

ID number of the TEO process instance

Event Count

Number of events correlated

First Event

First event correlated by the activity

Last Event

Last event correlated by the activity

Task

Available task properties to reference
For additional information, see Common Task Properties,
page 4-4.

Step 5

Time Stamp

Date and time of the correlated activity

Runtime User

Specified runtime user for the activity

Target

Available properties for the target

Match Status

Matching status for the task activity

Timed Out

Indicates whether the task activity timed out (e.g. True/False)

Click OK to add the selected reference variable to the related text field.
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Viewing Task Activity Instance Information
This section describes what the user should expect to see after a process with an assign task activity is
launched. Certain activities generate and display additional activity instance information for review by
users.
For example, there will be certain activities that generate information based on the defined properties of
the activities. In those situations, the activity instance properties will display the display-only
configuration properties as well as the generated results of the configuration properties.
Task activity instances can be viewed from two different locations in the Operations workspace

Operations—Tasks View
Task activities are available for view in the Operations—Task view after the activity in the process has
been run. This view displays only the properties relevant to the task.
To view task view instance properties:
Step 1

On the Operations workspace, choose any of the four task views to display the tasks in the Results pane.

Step 2

Highlight the appropriate task, and use one of the following methods:
•

Double-click the appropriate task instance.

•

Right-click and choose Properties.

•

On the Details pane, click the hyperlink of any item on tabs.

The [Task Name] Properties dialog box displays.

Operations—Activity View
The activity instance properties displayed from the Activity View are display-only.
To view activity instance properties:
Step 1

On the Operations workspace, choose any of the four activity views to display the activity instances in
the Results pane.

Step 2

On the Results pane, expand the appropriate activity instance to display the related activities.

Step 3

Highlight the appropriate activity, and use one of the following methods:
•

Double-click the appropriate activity instance.

•

Right-click and choose Observe.

•

On the Details pane, click the hyperlink of any item on tabs.

The [Activity Name] Properties dialog box displays.
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Viewing Correlated Alert Results
When the Correlate Alerts activity is launched, the alerts that were found by the activity are displayed
from the Operations Workspace activity instance view.
To view the correlated alerts results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Correlate Alerts activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Correlate Alerts dialog box displays.
Step 3

Click the Correlated Alerts display-only tab to view the alerts collected by the Correlate Alerts activity.
Figure B-45

Correlate Alerts Instance Properties Page—Correlated Alerts Tab

The following information is displayed for each alert:
Field

Description

Name

The name of the alert

Class

Value indicating the class of the alert

Created Time

Date and time the alert was created

Description

Description of the alert
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Viewing Find [Activity] Results
Use the following steps to review the results of the query generated by the Find Alerts, Find Change
Requests, and Find Incidents activities.
To view the Find [Activity] results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Find [Activity] activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The [Find Activity] Properties dialog box displays.
Step 3

Click the Results display-only tab to view the list of alerts, change requests, and incidents queried by
the Find activity.
The following columns provide information about the queried alerts, change requests, and incidents.
Task Property

Description

Affected Configuration Item

Name of the configuration item (IT component) to which the
alert pertains.
For example, the name of a database server which failed or
the name of a specific job which failed. A configuration item
is defined in ITIL as any component that needs to be
managed in order to deliver an IT Service. The true source of
the CI is in the CMDB, so the Configuration Item properties
reference a CMDB entry
•

Configuration Item Type—Type of ITIL configuration
item (IT component) which the alert describes. For
example, the type of the specific application element
which failed such as a server, database, host, or user.

•

Description—Brief description of the ITIL
configuration item (IT component) for the alert or
incident

•

Object Key—ID for the specific record in the CMDB
which contains the configuration item

•

Object Name—Name for the specific record in the
CMDB which contains the target configuration item

•

Source—Name for the specific record in the CMDB
which contains the configuration item.

Affected Organizations

Organizations that consume the IT service affected by the
alert or incident

Affected Services

IT Service affected by the alert or incident
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Task Property

Description

Affected Target Configuration Item

Name of ITIL configuration item (IT component) which the
alert or incident describes
•

Configuration Item Type—Type of ITIL configuration
item (IT component) which the alert describes

•

Description—Brief description of the ITIL
configuration item (IT component) for the alert or
incident

•

Object Key—ID for the specific record in the CMDB
which contains the target configuration item

•

Object Name—Name for the specific record in the
CMDB which contains the target configuration item

•

Source—Name of the specific CMDB containing the
target configuration item

Affects Configuration Item

Name of the configuration item (IT component) to which the
alert pertains.

Affects Target Configuration Item

Name of the system on which the condition was detected

Alert class

Numeric value indicating the class of the alert

Assignees

User name(s) or group assigned to the task

Automation Summary

File path for the related automation summary

Completed Time

Indicates the time period the task was completed
•

Local Time

•

Universal Time

Description

Brief description of the task

Due Date

Indicates the time period the task should be resolved
•

Local Time

•

Universal Time

Duplicate Task ID

Task ID of the duplicated alert

Expiration Date

Indicates the time period the task should expire
•

Local Time

•

Universal Time

Name

Display name of the task

Notes

Any notes related to the task

Parameter

Any parameters associated with a specific task

Priority

Indicates the priority of the task

Process Properties

•

Low

•

Medium

•

High

For the list of process columns, refer to Viewing Process
View Information, page 3-33.
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Task Property

Description

Process Target Properties

For information on the target properties, see Viewing
Activity Information, page 3-19.

Severity

Indicates the severity of the task
•

Low

•

Normal

•

High

Related Task IDs

Task ID of the related task

Task Status

Indicates status of the task. The statuses displayed depend on
the currently open task.
Note

Task URL

See Common Task Statuses, page 4-6 for additional
information.

URL of the task. This URL can be used to bring up the Web
Console for viewing and editing the task properties.
For example, this is the URL which could be placed in an
email to notify the user of the task, enabling them to connect
to the Web Console to view the task.

Web Form XSL File Name

Name of the source XML text file to transform the task XML
into HTML for viewing in the Web Console

Viewing Wait for Task to Enter State Results
When the Wait for Task to Enter State activity is launched, the matching sthat were found by the activity
are displayed from the Operations Workspace activity instance view.
To view the correlated alerts results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Wait for Task to Enter State activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Wait for Task to Enter State Properties dialog box displays.
Step 3

Click the Result display-only tab to view the statuses matched by the Wait for Task to Enter State
activity.
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Figure B-46

Wait for Task to Enter State Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Result

Values for the task state

Matching Status

•

Unknown—Indicates activity is running or has failed
to complete

•

Timed Out—Activity timed out without matching

•

Task Completed Without Matching—Task has reached
a completing state that was not a state that was not
included we were attempting to match on.

•

Matched—Status was matched by the task

Indicates the status that was matched
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Using String Activities
Tidal Enterprise Orchestrator provides the ability to manipulate string text and characters using String
activities. These activities allow users to globally search, replace, and modify string content in the
objects within TEO.
The following sections provide instructions for defining string activities, instructions for completing the
property pages for each specific activity, and instructions on viewing the activity results.
•

String Activities, page C-2

•

Defining the Find String Activity, page C-4

•

Defining the Replace String Activity, page C-7

•

Defining the Split String Activity, page C-10

•

Defining the String Escape Activity, page C-12

•

Defining the String Lowercase Activity, page C-14

•

Defining the String Uppercase Activity, page C-16

•

Defining the Substring Activity, page C-18

•

Defining the Trim String Activity, page C-20

•

Managing String Activity Definitions, page C-22

•

Viewing String Activity Instance Results, page C-25
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String Activities
The following table displays the string activities provided by TEO.
Activity

Description

Find String

Searches for specific content in a string
See Defining the Find String Activity, page C-4.

Replace String

Replaces specified string content
See Defining the Replace String Activity, page C-7.

Split String

Splits string characters
See Defining the Split String Activity, page C-10.

String Escape

Specifies escape characters in string content.
See Defining the String Escape Activity, page C-12.

String Lowercase

Lowers the text case in a string
See Defining the String Lowercase Activity, page C-14.

String Uppercase

Capitalize the text case in a string
See Defining the String Uppercase Activity, page C-16.
Retrieves the first and last occurrence of the specified
substring

Substring

See Defining the Substring Activity, page C-18.
Trim String

Trims characters from the content in a string
See Defining the Trim String Activity, page C-20.

Common String Escapes
The following table is a list of common string escapes.
The 'c' and 'C' escape may be qualified with a '0' to make screen use zero instead of space as fill character.
The '0' qualifier also makes the '=' escape use absolute positions. The 'n' and '=' escapes understand a
length qualifier (e.g. '%3n'), 'D' and 'M' can be prefixed with 'L' to generate long names, 'w' and 'W' also
show the window flags if 'L' is given.
Escape Character

Description

%

the escape character itself

a

either 'am' or 'pm'

A

either 'AM' or 'PM'

c

current time HH:MM in 24h format

C

current time HH:MM in 12h format

d

day number

D

weekday name

f

flags of the window

F

sets %? to true if the window has the focus
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Escape Character

Description
h

hardstatus of the window

H

hostname of the system

I

current load of the system

m

month number

M

month name

n

window number

s

seconds

t

window title

u

all other users on this window

w

all window numbers and names. With '-' qualifier: up to the
current window; with '+' qualifier: starting with the window
after the current one.

W

all window numbers and names except the current one

y

last two digits of the year number

Y

full year number

?

the part to the next '%?' is displayed only if a '%' escape
inside the part expands to a non empty string

:

else part of '%?'

=

pad the string to the display's width (like TeX's hfill). If a
number is specified, pad to the percentage of the window's
width. A '0' qualifier tells screen to treat the number as
absolute position.
You can specify to pad relative to the last absolute pad
position by adding a '+' qualifier or to pad relative to the
right margin by using '-'. The padding truncates the string
if the specified position lies before the current position.
Add the 'L' qualifier to change this.

<

same as '%=' but just do truncation, do not fill with spaces

>

mark the current text position for the next truncation. When
screen needs to do truncation, it tries to do it in a way that
the marked position gets moved to the specified percentage
of the output area. (The area starts from the last absolute
pad position and ends with the position specified by the
truncation operator.) The 'L' qualifier tells screen to mark
the truncated parts with '…'

{

attribute/color modifier string terminated by the next '}'

`

Substitute with the output of a 'backtick' command. The
length qualifier is misused to identify one of the
commands.
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Defining the Find String Activity
Use the Find String activity to search for specific content in a string.
To define the Find String activity:
Step 1

On the Toolbox pane, choose the Find String activity, then drag and drop the activity onto the Workflow
pane.
The Find String property pages display.
Figure C-1

Step 2

Find String Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Find String tab to continue.

The Required Value
a value.
Figure C-2

Note

Step 4

Step 5

icon displayed on a tab or page indicates that the field is required and is missing

Find String Activity—Find String Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the Find String tab, specify the content in a string to be queried:
Field

Description

Input string

Enter the string to be searched

Searched string

Enter the content of the string to be queried

Click the Knowledge Base tab to assign a knowledge base article to the object.
Knowledge Base Field Options

Description

Text field

Display-only. Display name for the selected knowledge base
article(s)

Delete

Highlight the appropriate knowledge base article and click the
Delete
tool to remove the knowledge base article from the
display.
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Knowledge Base Field Options

Description

Browse

Click Browse to launch the Select Knowledge Base dialog box
for a list of existing knowledge base articles.
For additional information on knowledge base articles, see
Chapter 17, “Managing Knowledge Base Articles.”
Highlight the appropriate knowledge base article and click the
Properties
tool to view and/or modify the properties of the
defined knowledge base article.

Properties

The following information is displayed on the Knowledge Base tab.

Step 6

Step 7

Note

Field

Description

Summary

Brief description of the issue

Possible Cause

Explanation of the condition that may be causing the issue

Possible resolution

List of actions that can be performed to attempt to resolve
the issue

Related information

Additional information related to the issue

On the Result Handlers tab, click one of the following buttons to manage the condition branches on the
workflow, as necessary:
Button

Description

Add

Adds a condition branch

Remove

Removes the condition branch from the activity

Move Up

Moves the condition up one position in the list of conditions

Move Down

Moves the condition down one position in the list of
conditions

Click the Save

tool to save the activity definition.

To view the string query results, see Viewing Find String Results, page C-25.
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Defining the Replace String Activity
Use the Replace String activity to replace substrings of an input string with replacement strings.
To define the Replace String activity:
Step 1

On the Toolbox pane, choose the Replace String activity, then drag and drop the activity onto the
Workflow pane.
The Replace String property pages display.
Figure C-3

Step 2

Replace String Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Replace String tab to continue.

The Required Value
a value.
Figure C-4

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Replace String Activity—Replace String Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the Replace String tab, specify the source table to analyze:
Field

Description

Input string

Enter the string to be searched

The summary table box contains the list of strings to be replaced.
Column

Description

Replaced String

String content to be replaced

Replacement String

New string content to use in replacement string

To modify the list of strings on the table, click the appropriate buttons:
Button

Description

New

Click this button to add replacement string properties.
Note

Properties

For additional information on the replacement
strings, see Adding Replacement String Properties,
page C-22.

Click this button to modify the replacement string
properties.
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Button

Description

Delete

Removes selected replacement string text to remove from
the list.
See Removing Replacement Strings, page C-23.

Step 5

Note

Move Up

Highlight the appropriate replacement string text and click
this button to move the properties up the list.

Move Down

Highlight the appropriate replacement string text and click
this button to move the properties down the list.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.

To view the replacement string results, see Viewing Replace String Results, page C-26.

Cisco Tidal Enterprise Orchestrator Reference Guide
OL-24928-01

C-9

Appendix C

Using String Activities

Defining the Split String Activity

Defining the Split String Activity
Use the Split String activity to split the string characters around matches of the given delimiter.
To define the Split String activity:
Step 1

On the Toolbox pane, choose the Split String activity, then drag and drop the activity onto the Workflow
pane.
The Split String property pages display.
Figure C-5

Step 2

Step 3

Note

Split String Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Split String tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure C-6

Note

Step 4

Split String Properties Page—Split String Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the Split String tab, specify the string characters to be split.
Field

Description

Input string

Enter the string to be split

Character delimiters

Click this button and in the text field, enter the character
delimiters to split the string array.

String delimiters

Click this button and in the text field, enter the string
delimiters to split strings.

Return empty

Check this check box to return empty substrings in the
output.
If the check box remains unchecked, then any empty string
in the result array will be removed.

Step 5

Note

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.

To view the split string results, see Viewing Split String Results, page C-27.
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Defining the String Escape Activity
Use the String Escape activity to specify escape characters to insert information into messages or file
names.
To define the String Escape activity:
Step 1

On the Toolbox pane, choose the String Escape activity, then drag and drop the activity onto the
Workflow pane.
The String Escape property pages display.
Figure C-7

Step 2

String Escape Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Escape character tab to continue.

The Required Value
a value.
Figure C-8

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

String Escape Properties Page—Escape character Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the Escape characters tab, specify the following information:
Field

Description

Input string

Enter the appropriate string to be queried.

Escape regular expression special
characters

Click the option to indicate the activity will escape a
built-in list of regular expression characters.

Escape the following characters

Click the option and then enter the characters to escape in
the string text.

Escape character

Enter the escape character to use in the string escape
activity.
Note

For a list of common string escape characters, see
Common String Escapes, page C-2.
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Step 5

Note

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.

To view the string query results, see Viewing String Escape Results, page C-28.

Defining the String Lowercase Activity
Use the String Lowercase activity to lower the text case in the string content.
To define the String Lowercase from activity:
Step 1

On the Toolbox pane, choose the String Lowercase activity, then drag and drop the activity onto the
Workflow pane.
The String Lowercase property pages display.
Figure C-9

Step 2

String Lowercase Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the String Lowercase tab to continue.

The Required Value
a value.
Figure C-10

Note

Step 4

Step 5

Note

icon displayed on a tab or page indicates that the field is required and is missing

String Lowercase Activity—String Lowercase Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the String Lowercase tab, specify the following:
Field

Description

Input string

Enter the string to be queried with text case to be lowered.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.

To view the lowercase string results, see Viewing String Lowercase Results, page C-29.
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Defining the String Uppercase Activity
Use the String Uppercase activity to capitalize the text case in the string content.
To define the String Uppercase activity:
Step 1

On the Toolbox pane, choose the String Uppercase activity, then drag and drop the activity onto the
Workflow pane.
The String Uppercase property pages display.
Figure C-11

Step 2

String Uppercase Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the String Uppercase tab to continue.

The Required Value
a value.
Figure C-12

Note

Step 4

Step 5

Note

icon displayed on a tab or page indicates that the field is required and is missing

String Uppercase Activity—String Uppercase Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the String Uppercase tab, specify the following the source table and the associated values:
Field

Description

Input string

Enter the string to be queried with text case to be
capitalized.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.

To view the uppercase string results, see Viewing String Uppercase Results, page C-30.
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Defining the Substring Activity
Use the Substring activity to retrieve the index within this string of the first and last occurrence of the
specified substring.
Example:
Input string = ‘dictionary’
Start position = 4
End position = 6
Dictionary
0123456 <- using 0 as the starting point
Positions 4 through 6 yield ‘ion

To define the Substring activity:
Step 1

On the Toolbox pane, choose the Substring activity, then drag and drop the activity onto the Workflow
pane.
The Substring property pages display.
Figure C-13

Step 2

Substring Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Substring tab to continue.

The Required Value
a value.
Figure C-14

Note

Step 4

Note
Step 5

icon displayed on a tab or page indicates that the field is required and is missing

Substring Activity—Substring Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the Substring tab, specify the following:
Field

Description

Input string

Enter the appropriate substring to be queried.

Start position

Enter the numeric string characters from where the query is
to start.

End position

Enter the numeric string characters from where the query is
to end.

Both Start and End positions start with zero(0), not one (1).
Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.
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Note

To view the substring results, see Viewing Substring Results, page C-31.

Defining the Trim String Activity
Use the Trim String activity to trim characters from the content in a string. When no character is
specified, the activity will trim all leading and trailing whitespace characters, including empty lines at
the beginning and at the end.
To define the Trim String activity:
Step 1

On the Toolbox pane, choose the Trim String activity, then drag and drop the activity onto the Workflow
pane.
The Trim String property pages display.
Figure C-15

Step 2

Trim String Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Trim String tab to continue.

The Required Value
a value.
Figure C-16

Note

Step 4

Step 5

icon displayed on a tab or page indicates that the field is required and is missing

Trim String Activity—Trim String Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting String Activity
Variable References, page C-23.
On the Trim String tab, specify the following:
Field

Description

Input string

Enter the string containing the content to be trimmed.

Trim leading characters

Checked check box indicates the lead characters in the
string will be trimmed

Trim trailing characters

Checked check box indicates the trailing characters in the
string will be trimmed

Characters to trim

Enter the list of characters to trim.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Find String Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Find String Activity.
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Note

To view the trimmed string results, see Viewing Trim String Results, page C-32.

Managing String Activity Definitions
Use the following section to modify information in the String activities. Use the activity-specific
property page to perform the following functions.

Adding Replacement String Properties
Use the following steps to add the string text and the replacement string to the Replace String activity.
To add a replacement string:
Step 1

On the activity property page, click the Replace String tab to modify the list of replacement strings for
the activity.

Step 2

Under Replace list, click New to launch the Replace string dialog box.
Figure C-17

Step 3

Step 4

Replace string Dialog Box

Complete the following fields:
Name

Description

Replaced string

The string text to be replaced

Replacement string

The string text use to replace the specified string

After defining the replacement string properties, click OK.
The new replacement string is displayed under Replace list on the Replace String property page.

Step 5

Click the Save

tool to save.
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Removing Replacement Strings
Use the following steps to remove a replacement string from the list.
Step 1

On the activity property page, click the Replace Strings tab to modify the replacement string properties
for the activity.

Step 2

Under Replace list, highlight the appropriate replacement string and click Delete.
The replacement string is removed from the table.

Step 3

Click the Save

tool to save.

Inserting String Activity Variable References
The Reference
icon to the right of a text field indicates that the field can be populated by referencing
a defined variable or the property of another activity or process. Use the Insert Variable Reference dialog
box to select a defined variable or object to populate a field.
Only variables valid for the selected field can be selected in this dialog box. The OK button does not
activate until a valid property or variable is selected.
To insert a variable reference:
Step 1

To the right of a field on a property page, click the Reference tool.
The Insert Variable Reference dialog box displays.
Figure C-18

Note

Step 2

Insert Variable Reference Dialog Box

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Check the Show Advanced check box to display all items that are available for referencing.
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If the check box is not checked, then only the most commonly-used items are displayed for activities,
processes or events.
Step 3

Click the Workflow Activity Expand (+) to display the reference objects for the activities in the
Workflow pane. The properties in the Insert Reference Variable dialog box depend on the activities.

Step 4

From the list of displayed objects, select the appropriate property:
Reference Variable

Description

Name

Display name of the activity

Notes

Description for the activity

Created by

User name or the owner of the activity

Created Time

The date and time the activity was created

Modified by

User name of the individual who modified the activity

Type

Type of activity

Description

Description of the activity

Audit Starts

Date and time the process audit starts

Audit Successes

Indicates the number of successful audits

End Time

Date and time the activity stopped

Error Information

Description of the error that has occurred

Group Name

Name of toolbox activity group

Instance Cancelled

Indicates the process was cancelled manually

Instance Failed

Indicates the process has failed

Instance Failed (Completed)

Indicates the process has failed but the process execution was
completed

Instance Failed (Not Completed) Indicates the process has failed and did not complete the
process execution
Start Time

Date and time the activity was started

Process Id

ID number of the TEO process

Process Instance Id

ID number of the TEO process instance

Count of Occurrences

Number of string occurrences

First Occurrence

Index of the first occurrence

Last Occurrence

Index of the last occurrence

Indices of all Occurrences

List of integers that are indices of all occurrences

Replaced Result

String content that successfully replaced the old strings

Results

String content that was successfully delimited by elements of
a specified string or character array

Result

String content that successfully escaped the strings

Lowercase Result

Queried string text content replaced with lowercase text

Uppercase Result

Queried string text content replaced with uppercase text

Trim Result

Displays the remaining string content not trimmed from the
activity
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Step 5

Click OK to add the selected reference variable to the related text field.

Viewing String Activity Instance Results
This section provides the results for the String activities after they have run in a process. The activity
instance properties shown from the Operations—Activity View are display-only.

Viewing Find String Results
When the Find String activity is launched, the results of the properties used to search for specific string
content are displayed from the Operations Workspace activity instance view.
To view the Find String results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Find String activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Find String Properties dialog box displays.
Step 3

Click the Result tab to display the output of the query in the Find String activity.
Figure C-19

Find String Properties Page—Result Tab

The following information is displayed:
Field

Description

Indices of all occurrences

List of integers that are indices of all occurrences

Count of occurrences

Number of string occurrences
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Field

Description

First occurrence

Index of the first occurrence

Last occurrence

Index of the last occurrence

Viewing Replace String Results
When the Replace String activity is launched, the results of the properties used to define the string that
need to be replaced and the associated replacement string properties. are displayed from the Operations
Workspace activity instance view.
To view the Replace String results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Replace String activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Replace String Properties dialog box displays.
Step 3

Click the Result tab to display output of the string properties in the Replace String activity.
Figure C-20

Replace String Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Replace Result

String content that successfully replaced the old strings
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Viewing Split String Results
When the Split String activity is launched, the results of the properties used to split the string characters
around matches of the given delimiter are displayed from the Operations Workspace activity instance
view.
To view the Split String results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Split String activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Split String Properties dialog displays.
Step 3

Click the Result tab to display the output of the delimited strings returned by in the Split String activity.
Figure C-21

Split String Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Split result

String content that was successfully delimited by elements
of a specified string or character array
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Viewing String Escape Results
When the String Escape activity is launched, the results of the properties used to insert information into
messages or file names are displayed from the Operations Workspace activity instance view.
To view the String Escape results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the String Escape activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The String Escape character Properties dialog box displays.
Step 3

Click the Result tab to display the output of the escaped results of the string properties in the String
Escape activity.
Figure C-22

String Escape Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Escape result

String content that successfully escaped the strings
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Viewing String Lowercase Results
When the String Lowercase activity is launched, the results of the properties used to lower the case in
the requested string content are displayed from the Operations Workspace activity instance view.
To view the String Lowercase results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the String Lowercase activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The String Lowercase Properties dialog box displays.
Step 3

Click the Result tab to display the lowercase text output of the requested string content in the String
Lowercase activity.
Figure C-23

String Lowercase Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Lowercase result

Queried string text content replaced with lowercase text
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Viewing String Uppercase Results
When the String Uppercase activity is launched, the results of the properties used to capitalize the case
in the requested string content are displayed from the Operations Workspace activity instance view.
To view the String Uppercase results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the String Uppercase activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The String Uppercase Properties dialog box displays.
Step 3

Click the Result tab to display the capitalized output of the requested string content in the String
Uppercase activity.
Figure C-24

String Uppercase Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Uppercase result

Queried string text content replaced with uppercase text
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Viewing Substring Results
When the Substring activity is launched, the results of the properties used to retrieve the first and last
occurrence of the specified substring are displayed from the Operations Workspace activity instance
view.
To view the Substring results:
Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Substring activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Substring Properties dialog box displays.
Step 3

Click the Result tab to display the output of the requested string content in the Substring activity.
Figure C-25

Substring Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Substring result

String content queried between start and end position
required in the activity
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Viewing Trim String Results
When the Trim String activity is launched, the results of the properties used to trim characters from the
content in a string. are displayed from the Operations Workspace activity instance view.

Note

When no character is specified, the activity will trim all leading and trailing whitespace characters,
including empty lines at the beginning and at the end.
To view the Trim String results:

Step 1

In the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Trim String activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Trim String Properties dialog box displays.
Step 3

Click the Trim String tab to display output of the requested string content trimmed in the Trim String
activity.
Figure C-26

Trim String Instance Properties Page—Result Tab

The following information is displayed:
Field

Description

Trim result

Displays the remaining string content not trimmed from the
activity
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Using Table Activities
Table activities allow users to modify the format for existing defined table variables. The available table
variables can be defined as either a global or process variable.
The sections in this appendix provide instructions for defining table activities, instructions for
completing the property pages for each specific activity, and instructions on viewing the activity results.
•

Table Activities, page D-2

•

Defining the Add Row to Table Activity, page D-4

•

Defining the Analyze Table Activity, page D-7

•

Defining the Highlight Row Activity, page D-10

•

Defining the Read Table from Text Activity, page D-12

•

Defining the Read Table from XML Activity, page D-14

•

Defining the Remove Row from Table Activity, page D-18

•

Defining the Select from Table Activity, page D-21

•

Defining the Set Table Variable Activity, page D-25

•

Defining the Update Row in Table Activity, page D-27

•

Managing Table Activity Definitions, page D-29

•

Viewing Activity Instance Information, page D-32
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Table Activities
The following table displays the table activities provided by TEO.
Activity

Description

Add Row to Table

Appends new row to table
See Defining the Add Row to Table Activity, page D-4

Analyze Table

Summarizes and analyzes data in a table variable or
property using basic aggregation functions
See Defining the Analyze Table Activity, page D-7.

Highlight Row

Highlights selected rows in a table. The selected tables
display as highlighted in the automation summary
See Defining the Highlight Row Activity, page D-10.

Read Table from Text

Reads a comma-separated value (CSV) file and convert the
text into a table
See Defining the Read Table from Text Activity,
page D-12.

Read Table from XML

Reads an XML snippet and convert the snippet into a table
See Defining the Read Table from XML Activity,
page D-14.

Remove Row from Table

Removes specified rows from a table
See Defining the Remove Row from Table Activity,
page D-18.

Select from Table

Queries information from specified table.
See Defining the Select from Table Activity, page D-21.

Set Table Variable

Modifies the value of a defined table variable.
See Defining the Set Table Variable Activity, page D-25.

Update Row in Table

Updates the selected rows of a table variable.
See Defining the Update Row in Table Activity, page D-27.

Cisco Tidal Enterprise Orchestrator Reference Guide

D-2

OL-24928-01

Appendix D

Using Table Activities
Table Activities

Common Table Activity Expressions
The expressions in the table below are available from the Analyze Table activity summary table option.
The Key menu item for a source column will be enabled only if there are no summary columns configured
based on that source column. The remaining menu item is enabled only if there is no key summary
column configured for the source column.
Table Expression
Key

Description
Key (unique) column instructing the Analyze Table activity
to summarize source table data according to the values in
that column.
A row will be created in the summary table for every
unique value of the key column in the source table.

Count

Aggregate column containing the count of values in the
source column and is available for source columns of all
data types.

Avg

Aggregate column containing the average of the values in
the source column and is available for source columns of
numeric data types (such as Integer and Decimal).

Min

Aggregate column containing the minimum of the values in
the source column and is available for source columns of
numeric data types (such as Integer and Decimal).

Max

Aggregate column containing the maximum of the values
in the source column and is available for source columns of
numeric data types (such as Integer and Decimal).

Sum

Aggregate column containing the sum of all the values in
the source column and is available for source columns of
numeric data types (such as Integer and Decimal).

StDev

Aggregate column containing the statistical standard
deviation of values in the source column and is available
for source columns of numeric data types (such as Integer
and Decimal).

Var

Adds an aggregate column containing the statistical
variance of values in the source column.
The menu item is available for source columns of numeric
data types (such as Integer and Decimal).
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Defining the Add Row to Table Activity
Use the Add Row to Table activity to append new rows to a table variable. The row is added to the end
of the table. This activity will not work on tables that are outputs of other activities.
To define the Add Row to Table activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Add Row to Table activity, then drag and drop
the activity onto the Workflow pane.
The Add Row to Table property pages display.
Figure D-1

Step 2

Add Row to Table Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Add Row tab to continue.

The Required Value
a value.
Figure D-2

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Add Row to Table Activity—Add Row Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the Add Row tab, specify the following the source table and the associated values:
Field

Description

Table variable

Enter the appropriate table variable.

New row values

This box remains empty until a data table variable is
selected.
After the table is selected, the name and data type of the
columns from the source table variable are displayed.

Step 5

Click the Knowledge Base tab to assign a knowledge base article to the object.
Knowledge Base Field Options

Description

Text field

Display-only. Display name for the selected knowledge base
article(s)

Delete

Highlight the appropriate knowledge base article and click the
Delete
tool to remove the knowledge base article from the
display.
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Knowledge Base Field Options

Description

Browse

Click Browse to launch the Select Knowledge Base dialog box
for a list of existing knowledge base articles.
For additional information on knowledge base articles, see
Chapter 17, “Managing Knowledge Base Articles.”
Highlight the appropriate knowledge base article and click the
Properties
tool to view and/or modify the properties of the
defined knowledge base article.

Properties

The following information is displayed on the Knowledge Base tab.

Step 6

Step 7

Field

Description

Summary

Brief description of the issue

Possible Cause

Explanation of the condition that may be causing the issue

Possible resolution

List of actions that can be performed to attempt to resolve
the issue

Related information

Additional information related to the issue

On the Result Handlers tab, click one of the following buttons to manage the condition branches on the
workflow, as necessary:
Button

Description

Add

Adds a condition branch

Remove

Removes the condition branch from the activity

Move Up

Moves the condition up one position in the list of conditions

Move Down

Moves the condition down one position in the list of
conditions

Click the Save

tool to save the activity definition.
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Defining the Analyze Table Activity
Use the Analyze Table activity to summarize and analyze data in a table variable or property using basic
aggregation functions.
To define the Analyze Table activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Analyze Table activity, then drag and drop the
activity onto the Workflow pane.
The Analyze Table property pages display.
Figure D-3

Step 2

Analyze Table Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Analyze Table tab to continue.

The Required Value
a value.
Figure D-4

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Analyze Table Activity—Analyze Table Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the Analyze Table tab, specify the source table to analyze:
Field

Description

Source Table

Enter the appropriate table variable or click the Reference
tool to search for a table variable.

The summary table box contains the list of columns configured for the summary table and remains empty
until a table variable is selected. Each summary column can be a key or an count column.
Column

Description

Name

Name of the source column from the table
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Column

Description

Type

Data type for the column

Expression

Expression associated with the column. The expression is
configured based on a column from the source data table
and one of the following:
•

Available aggregate SQL functions (Sum, Count, Avg,
Max, Min, StdDev, Var)

•

Values in the aggregate columns that are computed for
each unique combination of values in the key columns.

To modify the list of columns on the table, click the appropriate buttons:
Button

Description

Add

Adds a column to the list. The user adds summary columns
based on the source column.
This menu item is enabled only if there is no key summary
column configured for the source column. The remaining
menu items are enabled only if there is no key summary
column configured for the source column.
Note

Step 5

Note

For additional information on the table
expressions, see Adding a Column, page D-29.

Remove

Removes selected summary columns from the list

Move Up

Moves a summary column up the list

Move Down

Moves a summary column down the list

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

To view the table analysis results, see Viewing Analyze Table Results, page D-33.
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Defining the Highlight Row Activity
Use the Highlight Row table activity to highlight selected rows of a table variable. Highlighted rows can
only be displayed in an automation summary. Therefore the user will not see the highlighted rows in TEO
unless viewing the automation summary.
To define the Highlight Row activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Highlight Row activity, then drag and drop the
activity onto the Workflow pane.
The Highlight Row property pages display.
Figure D-5

Step 2

Highlight Row Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Table Format tab to continue.

The Required Value
a value.
Figure D-6

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Highlight Row Properties Page—Table Format Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the Table Format tab, specify the color to highlight the specified rows.
Field

Description

Table

Enter the appropriate table type variable or click the
Reference tool to search for a table variable.

Highlight Color

Choose the appropriate color to use to highlight the row.
Users can also type the color name or a RGB value (e.g.
#FF0000 for red) into the field.

Rows

Use the following options to specify the rows in the table
to be highlighted
•

Row at the specified index—Index number of the row
to highlight or clear highlighting

•

Rows with indices in the specified range—Enter the
beginning and end of index tows to be highlighted

•

Rows matching specified criteria—Enter the
appropriate criteria to indicate when to highlight rows
in the table.
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Step 5

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

Defining the Read Table from Text Activity
Use the Read Table from Text activity to read a comma-separated value (CSV) file and convert the text
into a table with a specified set of columns.
To define the Read Table from Text activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Read Table From Text activity, then drag and
drop the activity onto the Workflow pane.
The Read Table from Text property pages display.
Figure D-7

Step 2

Read Table from Text Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Read Table from Text tab to continue.

The Required Value
a value.
Figure D-8

icon displayed on a tab or page indicates that the field is required and is missing

Read Table from Text Properties Page—Read Table from Text Tab

Note

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.

Step 4

On the Read Table from Text tab, under Columns to read, the table displays the list of column names and
types for the result table to read from the XML.
Column

Description

Name

Name of the column

Type

Type of expression
Expression associated with the column

Expression
Step 5

To modify the list of columns to read and text to query, click the appropriate buttons:
Button

Description

Add

Launches Table Column dialog box to allow the user to
define the name and data type for the new column.
Note

Remove

For additional information, see Adding a Column,
page D-29.

Removes selected columns from the list.
Note

For additional information, see Removing a
Column from Table, page D-30.
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Step 6

Step 7

Button

Description

Move Up

Moves a column up the list

Move Down

Moves a column down the list

To convert specific text into a table, enter the following information.
Field

Description

Source text

Source values to convert into table

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

Defining the Read Table from XML Activity
Use the Read Table from XML activity to read an XML snippet and convert it into a table with a specified
set of columns.
Example:
Row XML Element Name:
MyRow
Columns to read:
Name String
Age Integer
Source XML:
<MyData>
<MyRow>
<Name>Jeff</Name>
<Age>32</Age>
</MyRow>
<MyRow>
<Name>Mark</Name>
<Age>31</Age>
</MyRow>
<MyRow>

<Name>Jay</Name>
<Age>30</Age>
</MyRow>
</MyData>
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This produces a table with two columns (name, age), with three rows.
To define the Read Table from XML activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Read Table From XML activity, then drag and
drop the activity onto the Workflow pane.
The Read Table from XML property pages display.
Figure D-9

Step 2

Read Table from XML Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Read Table tab to continue.

The Required Value
a value.
Figure D-10

icon displayed on a tab or page indicates that the field is required and is missing

Read Table from XML Properties Page—Read Table Tab

Note

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.

Step 4

In the Row XML element name field, enter the string that specifies the name of the XML element that
contains information for a single row.

Step 5

Under Columns to read, the table displays the list of column names and types for the result table to read
from the XML.
Column

Description

Name

Name of the column

Type

Type of expression
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Step 6

To modify the list of columns to read, click the appropriate buttons:
Button

Description

Add

Launches the Table Column dialog box to allow the user to
define the name and data type for the new column.
Note

Remove

Removes selected columns from the list.
Note

Step 7

Step 8

Note

For additional information, see Adding a Column,
page D-29.
For additional information, see Removing a
Column from Table, page D-30.

Move Up

Moves a column up the list

Move Down

Moves a column down the list

To convert specific XML into a table, enter the following information.
Field

Description

Source XML

XML snippet to convert into a table

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

To view the read XML table results, see Viewing Read Table from XML Results, page D-34.
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Defining the Remove Row from Table Activity
Use the Remove Row from Table activity to remove one or more rows from a table variable based on
specified criteria. This activity will not work on tables that are outputs of other activities.
To define the Remove Row from activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Remove Row from Table activity, then drag
and drop the activity onto the Workflow pane.
The Remove Row from Table property pages display.
Figure D-11

Step 2

Remove Row from Table Activity—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Remove Row tab to continue.

The Required Value
a value.
Figure D-12

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Remove Row from Table Activity—Remove Row Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the Remove Row(s) tab, specify the following the source table and the associated values:
Field

Description

Table variable

Enter the appropriate table variable or click the Reference
tool to search for a table variable.
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Field

Description

Rows

Use the following options to specify the rows in the table
to be removed:
•

All rows—All rows in the source table variable will be
removed

•

Row at the specified index—Index number of the row
to be removed

•

Rows with indices in the specified range—Enter the
beginning and end of index rows to be removed

•

Rows matching specified criteria—Enter the
appropriate criteria to indicate when to remove rows in
the table

Note

Step 5

Use a where clause-like criteria to specify which
rows from the source table to remove. For where
clause examples, see WHERE Clause Example,
page D-24.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

Cisco Tidal Enterprise Orchestrator Reference Guide

D-20

OL-24928-01

Appendix D

Using Table Activities
Defining the Select from Table Activity

Defining the Select from Table Activity
Use the Select From Table activity to query and select rows from a source table using specified criteria.
The user can also determine the order of the rows selected as well as limit the number of rows displayed.
To define the Select from Table activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Select from Table activity, then drag and drop
the activity onto the Workflow pane.
The Select from Table property pages display.
Figure D-13

Step 2

Select from Table Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity
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Step 3

Note

Click the Extract Rows tab to continue.

The Required Value
a value.
Figure D-14

Note

Step 4

icon displayed on a tab or page indicates that the field is required and is missing

Select from Table Activity—Extract Rows Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the Extract Rows tab, specify the following the source table and the associated values:
Field

Description

Source table

Enter the appropriate table variable or click the Reference
tool to search for a table variable.

Where Clause

Use a where clause-like criteria to specify which rows from
the source table to select.
Note

For a where clause examples, see WHERE Clause
Example, page D-24.

Cisco Tidal Enterprise Orchestrator Reference Guide

D-22

OL-24928-01

Appendix D

Using Table Activities
Defining the Select from Table Activity

Field

Description

Result columns

Displays the list of columns available in the selected source
table. Check this check box for the columns that is to be
included in the results.
At least one column item must be checked.

Note

Select All—Click this button to select all columns in
the table.

•

Unselect All—Click this button to remove the check
marks from all the columns.

No sort

Select this radio button to indicate the columns do not have
to be sorted.

Sort by

Select this radio button to indicate the columns should be
sorted by column name.

Column name

From the drop-down list, select the appropriate column as
the table heading and the order in which it is to be sorted.

Number of rows

Step 5

•

•

Ascending—Table to be sorted from the top row in
alpha-numeric order

•

Descending—Table to be sorted from the bottom
alpha-numeric order

Click the button to determine the number of rows to display
in the table.
•

All rows—Includes all rows that match the specified
criteria or where clause in the result table

•

At most—Enter the maximum number of rows
matching specified criteria that should be included in
the result table.

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

To view the table results, see Viewing Select from Table Activity Results, page D-35.
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WHERE Clause Example
The WHERE clause specifies join and filter conditions that determine the rows that the query returns.
Description
If the ColumnName, in an expression, for one column is "UnitPrice", and another "Quantity",
the expression containing a WHERE clause would be as follows:
"UnitPrice * Quantity < 1000"
If a column name satisfies a condition operator, it must be wrapped in either square
brackets or the "`" (grave accent) quotes. For example, to use a column named "Column#"
in an expression, use one of the following:
Total * [Column#]
or "`Column#`":
Total * `Column#`
If the column name is enclosed in square brackets then any ']' and '\' characters (but not any
other characters) in it must be escaped by prepending them with the backslash ("\") character.
If the column name is enclosed in grave accent characters then it must not contain any grave
accent characters in it. For example, a column named "Column[]\" would be written:
Total * [Column[\]\\]
or
Total * `Column[]\`
Source: MSDN: WHERE Clause
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Defining the Set Table Variable Activity
Use the Set Table Variable activity to modify the value of a defined table variable. You must specify a
name for the activity, choose the defined variable that you want to modify and enter a new value for the
table variable using a different table variable property.
The table variables used must match in their entirety, including the name of columns, number of
columns, and the type of columns or the activity will fail.
To define the Set Table Variable activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Set Table Variable activity, then drag and drop
the activity onto the Workflow pane.
The Set Table Variable property pages display.

Note

The Required Value
a value.
Figure D-15

Note

Step 2

icon displayed on a tab or page indicates that the field is required and is missing

Set Table Variable Properties Page—General Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Description

Brief description of the activity
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Step 3

Note

Field

Description

Variable to update

Choose the appropriate table variable to be modified.

New value

Choose the appropriate table variable or output property
containing the new value of the variable

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

To view the variable results, see Viewing Set Table Variable Activity Results, page D-36.
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Defining the Update Row in Table Activity
Use the Update Row in Table activity to update the selected rows of a table variable. The new rows
become part of the variable being modified. The user will not see the modified rows in the automation
summary, but will able to see the rows in the variable property pages in TEO.
To define the Update Row in Table activity:
Step 1

On the Toolbox pane, under Table Activities, choose the Update Row in Table activity, then drag and
drop the activity onto the Workflow pane.
The Update Row in Table property pages display.
Figure D-16

Step 2

Step 3

Note

Update Row in Table Properties Page—General Tab

On the General tab, enter the following information:
Field

Description

Display name

Name of the activity

Type

Display-only. Type of activity

Description

Brief description of the activity

Click the Update Row tab to continue.

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing
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Figure D-17

Note

Step 4

Update Row in Table Activity—Update Row Tab

Click the Reference
tool to choose a defined variable or reference an object within the process from
the Insert Variable Reference dialog box. For additional information, see Inserting Table Activity
Variable References, page D-31.
On the Update Row tab, specify the following the table variable and the associated values:
Field

Description

Table variable

Enter the appropriate table variable or click the Reference
tool to search for a table variable.

New Values

Displays the values of the selected table.
To modify the values of the table, check this check box and
then enter the new value for the selected column.

Rows

Use the following options to specify the rows in the table
to be updated:
•

All rows—Option updates all rows in the table

•

Row at the specified index—Index number of the row
to be updated

•

Rows with indices in the specified range—Enter the
beginning and end of index rows to be updated

•

Rows matching specified criteria—Enter the
appropriate criteria to indicate when to update rows in
the table

Note

Use a where clause-like criteria to specify which
rows from the source table to update. For where
clause examples, see WHERE Clause Example,
page D-24.
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Step 5

Complete the appropriate information in the following tabs, as necessary, and then click the Save
tool to complete the activity definition.
•

Knowledge Base—Choose the appropriate knowledge base article to associate with the activity. See
Step 5 in Defining the Add Row to Table Activity.

•

Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.
See Step 6 in Defining the Add Row to Table Activity.

Managing Table Activity Definitions
Modifying a process does not automatically modify an activity. Activity definitions are included in a
process definition and the activity properties must be modified separately from the process properties.
Activities can only be modified in the Process Editor. With the appropriate rights from the Operations
view, the Process Editor is launched when accessing the process properties.
When user rights are restricted, the Process Viewer is launched with the properties displaying a
display-only view after determining that the user cannot edit the activity.
Step 1

To modify an activity, use one of the following methods:
•

On the Definitions—Process view, highlight the appropriate process, right-click and choose Edit.
-or-

•

On the Operations workspace, select a process from any of the four process views, right-click and
choose Edit.

The Process Editor displays.
Step 2

On the Workflow pane, select the appropriate activity, and modify activity properties, as necessary, and
click Save.

Step 3

Make any additional changes, as necessary, and click Exit to close the Process Editor.

Adding a Column
Use the following steps to add a column to a table converted from an XML element or a CSV file. The
XML snippet is converted from XML code provided by the Read Table from XML activity. The CSV file
is converted to a table using the Read Table from Text activity.
To add a column:
Step 1

On the activity property page, click the Read Table tab to modify the list of columns to read for the
activity.

Step 2

Under Columns to read, click Add to launch the Table Columns dialog box.
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Figure D-18

Step 3

Step 4

Table Column Dialog Box

Complete the following fields:
Name

Description

Name

Name of the column

Data type

The data type specified for the column
•

Boolean—Indicates elements should be true or false

•

String (Default)—Sequence of characters such as
letters, numbers, and punctuation marks

•

Integer—Must be whole numbers and contain only
digits from 0 to 9. Can be positive or negative
(Examples: 0. 10, 345, -689)

•

Decimal—Requires exact numeric data values

•

Identity—Represents the value of a user identity

After defining the table column properties, click OK.
The new column is displayed under Columns to Read on the Read Table property page.

Step 5

Click the Save

tool to save.

Removing a Column from Table
Use the following steps to remove a column from the list of columns on the table.
Step 1

On the activity property page, click the Read Table tab to modify the assignee properties for the activity.

Step 2

Under Columns to read, highlight the appropriate column and click Remove.
The column is removed from the table.

Step 3

Click the Save

tool to save.
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Inserting Table Activity Variable References
The Reference
icon to the right of a text field indicates that the field can be populated by referencing
a defined variable or the property of another activity or process. Use the Insert Variable Reference dialog
box to select a defined variable or object to populate a field.
Only variables valid for the selected field can be selected in this dialog box. The OK button does not
activate until a valid property or variable is selected.
To insert a variable reference:
Step 1

To the right of a field on a property page, click the Reference tool.
The Insert Variable Reference dialog box displays.
Figure D-19

Note

Step 2

Insert Variable Reference Dialog Box

The Required Value
a value.

icon displayed on a tab or page indicates that the field is required and is missing

Check the Show Advanced check box to display all items that are available for referencing.
If the check box is not checked, then only the most commonly-used items are displayed for activities,
processes or events.

Step 3

Click the Workflow Activity Expand (+) to display the reference objects for the activities in the
Workflow pane. The properties in the Insert Reference Variable dialog box depend on the activities.

Step 4

From the list of displayed objects, select the appropriate property:
Reference Variable

Description

Name

Display name of the activity

Notes

Description for the activity

Created by

User name or the owner of the activity

Created Time

The date and time the activity was created

Modified by

User name of the individual who modified the activity
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Reference Variable

Description

Type

Type of activity

Description

Description of the activity

Audit Starts

Date and time the process audit starts

Audit Successes

Indicates the number of successful audits

End Time

Date and time the activity stopped

Error Information

Description of the error that has occurred

Group Name

Name of toolbox activity group

Instance Cancelled

Indicates the process was cancelled manually

Instance Failed

Indicates the process has failed

Instance Failed (Completed)

Indicates the process has failed but the process execution was
completed

Instance Failed (Not Completed) Indicates the process has failed and did not complete the
process execution

Step 5

Start Time

Date and time the activity was started

Process Id

ID number of the TEO process

Process Instance Id

ID number of the TEO process instance

New Row Index

Index number of the new row

Summary Table

Summary data from the analyst table results

Highlighted Row Count

Number of highlighted rows in the table

Result Table

Table containing results generated from the read activities

Removed Row Count

Number of rows removed from the table

Updated Row Count

Number of rows updated in the table

Click OK to add the selected reference variable to the related text field.

Viewing Activity Instance Information
This section describes what the user should expect to see after a process with a Table activity is launched.
Certain activities display additional activity instance information for review by users.
For example, there will be certain activities that generate information based on the defined properties of
the activities. In those situations, the activity instance properties displayed from the
Operations—Activity View will show the display-only configuration properties as well as the generated
results of the configuration properties.
To view activity instance properties:
Step 1

On the Operations workspace, choose any of the four activity views to display the activity instances in
the Results pane.

Step 2

On the Results pane, expand the appropriate process instance to display the related activities.
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Step 3

Highlight the appropriate activity, and use one of the following methods:
•

Double-click the appropriate activity instance.

•

Right-click and choose Properties.

•

On the Details pane, click the hyperlink of any item on tabs.

The [Activity Name] Properties dialog box displays.

Viewing Analyze Table Results
When the Analyze Table activity is launched, the summary information from the activity results are
displayed from the from the Operations Workspace activity instance view.
To view the analyze table results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the Analyze Table activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Analyze Table Properties dialog box displays.
Step 3

Click the Results tab to the display the output data in a new summary table.
The columns displayed in the Results tab are from the Name columns.
Figure D-20

Analyze Table Instance Properties Page—Results Tab
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Viewing Read Table from XML Results
When the Read Table from XML activity is launched, the source XML code that was entered on the Read
Table property page is generated into a table. The information from the activity results is displayed from
the Operations Workspace activity instance view.
To view the read table from XML results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The [Read Table] Properties dialog box displays.
Step 3

Click the Results tab to the display the output data in a new table.
The information displayed in the Results tab are the columns created in the Columns to read box which
displays the source XML code in a tabular form.
Figure D-21

Read Table from XML Instance Properties Page—Results Tab
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Viewing Select from Table Activity Results
When the Select from Table activity is launched, results are displayed from the Operations Workspace
activity instance view.
To view Select from Table results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Select from Table dialog box displays.
Step 3

Click the Results tab to display the related data in the columns selected in the Result Columns field on
the Select from Table activity.
Figure D-22

Select from Table Properties Page—Results Tab
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Viewing Set Table Variable Activity Results
When the Set Table Variable activity is launched, results are displayed from the Operations Workspace
activity instance view.
To view Set Table Variable results:
Step 1

On the Operations workspace, click the Activity Views folder.

Step 2

Use one of the following methods:
•

Highlight the activity instance, right-click and choose Properties.
-or-

•

Double-click the appropriate activity instance.

The Set Table Variable dialog box displays.
Step 3

Click the Variable tab to display the updated values for the table variable specified in the process
definition.
Figure D-23

Set Table Variable Properties Page—Variable Tab

The Variable tab displays the following information:
Field

Description

Variable updated

Displays the table variable specified in the process
definition

Set variable to

Updated value of the selected table variable
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A-17

18-4

Create Change Request properties, task

17-7

Set Target Reference

A-16

Create Change Request properties, automation
summary B-30

7-1

Define Process Properties, logic
copy

A-16

Create Automation Summary Activity, defining

Console, Tools menu
Console launch

8-13

Creating a Boolean Variable

14-5
11-6, 11-22
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Creating a Change Request Task

New TEO Reporting Database connection
properties 23-7

4-18

Creating a Check Box Question

4-32

Creating a compound condition

10-8

Creating TEO Reporting Database Connection

Creating a Copy of a Category Definition
Creating a Copy of a Target Group
Creating a Copy of a Task Rule

18-8

Custom Date and Format Strings

4-21

Creating a Hidden String Global Variable

11-8

Creating a Hidden String Target Property

14-8

11-23

Creating a Hidden Text Question
Creating an Alert Task

A-50

Criteria, Target Type Group properties

19-17

Creating a Hidden String Variable

7-15

Credentials, FTP properties

15-12

Creating a Guided Operation Task

Credential properties

Database settings

4-15

12-15

20-14

19-5

Database Settings properties

Creating a New Security Role

21-6

Data Extraction Panel

Creating an Identity Target Property

Date results

10-10

1-15

3-30

Default Windows Credential Panel

22-12

Default Windows Credential panel properties,
domain 22-12

4-33

Creating a String Target Property

14-14

11-14, 11-28

Creating a Table Target Property
Creating a Table Variable

12-5

A-73

day offset, select

11-12, 11-26

4-35

Creating a String Variable

12-4

Dates & Times Tab, Options dialog

14-12

Creating a Prior Process Instances Condition
Creating a Select Question

A-71

Date List Properties

19-10

Creating a Numeric Variable

22-13

date list calendar, creating
4-27

23-8

3-30

date difference

4-23

Creating a Numeric Target Property

Creating a Review Task

date, select

14-10

11-10, 11-25

Creating a Notify Task Rule

1-31

D

Creating an Assign Task Rule

Creating an Input Request Task

A-4

Customizing the Fonts and Colors

Daily Recurrence Pattern

Creating an Approval Request Task

Creating an Incident Task

15-6

4-31

4-11

Creating an Identity Variable

14-16

Creating a Target Reference Property
Creating a Task from Task View

Default Windows Credential panel properties,
password 22-12
Default Windows Credential panel properties, user
name 22-12
Default Windows Credentials panel

11-16, 11-29
14-19

4-7

22-12

Define Process Properties, adding activities
Define Process Properties, categories

4-30

Define Process Properties, child processes

Creating a time condition

10-12

Define Process Properties, credentials

Creating a variable condition
Creating processes
Creating Tasks

22-16
10-14

7-1

4-7

Creating TEO Reporting Database

Define Process Properties, general

7-17

7-9

7-4

Define Process Properties, modifying
Define Process Properties, options
Define Process Properties, target

7-14

7-13

Creating a Text Question
Creating Automation Packs

23-5

7-20

7-5
7-7

Define Process Properties, trigger
Define Process Properties, variables

7-12
7-10
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Defining a Core Activity

Defining the Find Target Activity

A-10

Defining a Create Alert Activity

Defining the Format Date Activity

B-20

Defining a Create Approval Request Activity

Defining the Parse Date Activity

B-51, B-54

Defining the Read Table from Text Activity

Defining a Find Change Requests Activity

Defining the Replace String Activity

B-3, B-7

Defining an Update Approval Request Activity

B-12

Defining the Set Table Variable Activity

Defining an Update Guided Operation Activity

B-12

Defining the Split String Activity

Defining an Update Input Request Activity

B-12

Defining an Update Review Request Activity

B-12

Defining a Publish Task to Event Log Activity
Defining a Service Target
Defining a Task Trigger

B-10

Defining a Wait for Task to Enter State Activity
Defining IT Record Task Activities

B-14

C-14

Defining the String Uppercase Activity

C-16

Defining the Substring Activity

Defining Owner Security Permission

Details Pane
Categories

7-4

12-3

17-3, 18-3

Getting Started, Processes

13-7

Defining the Analyze Table Activity

D-7

Action menu

11-4

Defining the Calculate Date Activity

A-12

Details Pane

11-4

Defining the Calculate Date Time Difference
Activity A-14

C-4

5-3

Global Variables

D-4

Knowledge Base Articles

17-2

Processes

B-17

Defining the Create Automation Summary activity

12-3

18-2

Actions menu

8-25

Defining the Correlate Alert activity

D-27

A-52

Actions menu and toolbar options

21-19

Defining the Add Row to Table Activity

C-20

Calendars

21-18

7-2

Defining Target Criteria for Trigger

A-49

Definitions

21-16

Defining Object Type Security Permission

Defining the Find String Activity

C-18

Defining the Update Row in Table Activity
Defining XPath Query activity

B-17

Defining Object List Security Permission

Defining Target Information

C-12

Defining the String Lowercase Activity

Defining the Trim String Activity

8-14, 8-16

Defining Process Property Pages

D-25

Defining the Test FTP Destination Activity

13-8

Defining Process Properties

D-21

C-10

Defining the String Escape Activity

B-12

D-18

C-7

Defining the Select from Table Activity

B-12

Defining an Update Incident Activity

D-14

Defining the Remove Row from Table Activity

B-43

Defining an Update Alert Activity

A-41

D-12

Defining the Read Table from XML Activity

B-40

A-33

A-38

Defining the Publish Multiple Metrics Activity

B-38

Defining an Assigned Task Activity

A-30

A-36

Defining the Publish Metric Activity

B-57

13-11

Defining a Find Incidents Activity

A-26

Defining the Match Regular Expression Activity

Defining a Create Review Request Activity
Defining a Find Alerts Activity

D-10

Defining the Insert Multiple Events Activity

B-49

B-32

Defining a Create Input Request Activity
Defining Activity Target Criteria

Defining the Insert Event Activity

B-28

Defining a Create Guided Operation Activity

A-23

Defining the Highlight Row Activity

B-46

Defining a Create Change Request Activity
Defining a Create Incident Activity

A-20

Details Pane
A-16

5-3, 6-5

Target Groups
Actions menu and toolbar options

15-3
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Targets
Actions menu and toolbar options
Definitions, navigation menu

Disable, time zone

5-4

Definitions, Processes View
Definitions - Details Pane

disable a target

5-3

5-2

1-21

12-19

Delete runtime user

Deleting a Security Role

11-35

21-22

4-43

Disabling a target group
Disabling a Task Rule

19-16

Disabling a Time Zone

20-7

8-21

2-10

Displaying Adapters

20-8

Displaying Administration - Automation Packs

20-19

Displaying Administration - Database Settings

20-13

Displaying Recent Servers

10-18

Deleting Conditions from Condition Branch
Component 10-18

Displaying Tasks Views

Deleting Conditions in Triggers

Duplicate properties

Deleting Processes

8-26

Deleting variable

11-35

Dependencies, review
Dependencies panel

Details pane

1-26

5-3

email address setting

18-3

4-42, B-63

6-8

22-9

Email Configuration panel properties

22-9

Email Configuration panel properties, default email
address 22-9
Email Configuration panel properties, default SMTP
port 22-9

6-5

Details pane, automation pack

22-4

12-3

Details Pane, General tab
Details pane, processes

B-26

Edit menu, process editor

Details Pane, Attributes tab
Details Pane, Calendars

B-26

E

22-23

Detail Pane, Attributes tab
5-3

3-11

4-42

Duplicate task, remove

14-31

22-28

Detail Pane, Categories

Duplicate alerts

20-5

1-27

Duplicate properties, task

Deleting target properties

Details Pane

10-18

7-24

Deleting triggers

15-10

Displaying Administration - Time Zones

19-22

Deleting Conditions

8-21

Display, refresh

11-35

Deleting a Process Variable

Deleting a Task Rule

13-9

Disabling a trigger

16-8

Deleting a Global Variable

Deleting a Task

7-21

disable a trigger

5-2

Definitions - Getting Started, Results Pane
delete calendar

20-7

disable a process

6-3

Definitions - Getting Started
Definitions Workspace

13-3

Determining New Server Setup Connection
Behavior 1-32

5-3, 6-5
6-5

Email Configuration panel properties, default SMTP
server 22-9
enable a process
enable a target

7-21
13-9

Details Pane, Run Options tab

5-3

enable a trigger

Details Pane, Run options tab

6-5

Enabling a target group

8-21
15-10

Details Pane, Runtime User

16-4

Enabling a Task Rule

19-16

Details Pane, Workflow tab

5-3, 6-5

Enabling a time zone

20-6

Enabling a trigger

8-21
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Event log, publish task
Event Log, task

Event parameters, remove

Find alerts

A-59

Find Alerts properties

12-14

Expanding workflow view

Find Change Requests properties

Export File Location panel

Find incidents

22-25

Exporting Automation Packs

Extended Property Value Updated trigger properties
Extended Target Properties

8-7

Find String properties

14-1

Find string results

14-7

Find Target

Hidden String target property

Find targets

Identity target property

14-9

14-11

Modify table target property
Numeric target property
String target property

14-15

Table target property

14-17

A-20

Find Target Activity, defining

Target Reference property, type

14-20

Extended Target Properties definition, copy
Extended Target Property Descriptions

A-20

14-30

14-4
14-3

A-72

Folder List Workspace

1-23

For Each Block, define

9-9

Format Date

A-23

Format date

A-73

Format Date properties

Format Date Property Page
Format date results

Extract Row from Table Properties

D-22

A-23

A-23, A-36
A-23, A-36

A-73

Formatting activity view

B-5

A-20

Format Date Activity, defining

14-31

Extended Target Properties Details Pane

A-20

A-72

Find Targets results

Target Reference property, Default Property Value
panel 14-21
Extended Target properties, delete

C-25

Find Targets Property Page

14-13

C-4

C-5

Find Targets properties
14-25

B-43

B-44

Find String Activity, defining

Creating a Copy of a Extended Target Properties
Definition 14-30

External properties

B-43

Find Incidents properties

22-20

B-40

B-41

Find Incidents Activity, defining

22-20

Boolean property

B-40

Find Change Requests Activity, defining

6-15

22-20

Exporting an object

B-38

B-39

Find change requests

12-14

2-12

B-38

Find Alerts Activity, defining

A-26

Excluding Dates to Group Calendar
export a process

2-12

Filtering Processes I Have Started Display

A-28

Event Property Page

2-10

Filtering Processes I Can Run Display

B-10

Event parameters

Excluding dates

Filtering My Tasks Display

B-10

3-25

FTP credential properties

A-50

G

F
Favorites Workspace

1-24

File menu, process editor
Filter Display
Time

3-21

6-8

General Information Panel

22-8

General Information panel

22-24

General task properties

4-7

General task rule properties
Get Task XSL transforms

19-5
24-6
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Task XSL transform

Highlight Row Properties

24-6

Getting Started, Operations workspace
Getting Started, Processes
global variable, delete

3-3

History, category

18-5

history, knowledge base article

5-3

History, Runtime User

11-35

global variable definition, copy

History, task rules

Boolean variable properties

History, tasks

11-7

15-9

19-9

4-10

History, viewing

11-5

17-6

16-7

History, Target Type group

11-34

Global Variables
Create global variables

D-11

4-10, 19-9

Creating a Copy of a Global Variable
Definition 11-34
Definitions - Global Variables

11-3, 14-2

Hidden String variable properties
Identity variable properties
Modify table variables

11-10

String variable properties

Table variable general properties

Global Variables Overview

Importing Reports
11-16

Guided Operation, create

Input Request, create

Guided Operation properties, create
Guided Operation Properties, task

Incident properties, task

B-36

4-24, B-33

Input Request, check box

4-22
B-50
4-22

4-27, B-51, B-54

Input Request, hidden text question
Input Request, select

4-30

4-28

Input Request Properties, task
6-9

14-8

11-8, 11-23

Hidden string variable, create
Hidden Text question

11-8

14-9

Hidden string target property, create
Hidden String variable

11-23

4-31

Highlight Row, defining

4-28

Insert Core Activity Variable Reference

Hidden string global variable, create
Hidden String target property

4-31

4-33

Input Request Properties

Help menu, process editor

4-25

4-32

Input Request, text question

H

D-10

Insert Event

23-15

4-24, B-33

Incident Task affects properties

4-21, B-49

23-11

4-23

Incident properties, related
12-14

12-7

Guided Operation Properties

23-15

Importing Reports into Business Objects
Incident properties

12-13

Group calendar properties

23-11

Importing Reports, business objects

Incident, create

12-6

Group Calendar dates, excluding

22-7

Importing Reports, Report Settings properties

11-4, 14-4

11-3

Group Calendar dates, add

14-10

11-10, 11-25

Importing Automation Packs

11-17

Global Variables Action Menu

14-11

Identity variable
11-12

11-14

Table variable properties

Identity property

Identity Target Propery, create

11-33

Numeric variable properties

group calendar, creating

11-8

I

A-65

A-26

Insert Event Activity, defining

A-26

Insert Event Affects properties

A-29

Insert Event properties

A-26

Insert Metric Affects properties

A-42

Insert Multiple Events Activity, defining
Insert Multiple Events properties

A-30

A-31
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Insert String Activity Variable Reference

C-23

Parallel Block

Insert Table Activity Variable Reference

D-31

Parallel Block, define

Insert Task Activity Variable Reference

9-10

Sequential Block

B-65

Insert Variable Reference

7-21

While Block

IT Record Task Activities

B-17

Lowercase properties

9-10

9-12

9-15
C-15

K

M

Knowledge Base Article

Managing Automation Pack Files

Create knowledge base article

Managing Automation Packs

17-5

22-28

22-1

knowledge base article, create

17-5

Managing Calendar Definitions

12-12

knowledge base article, delete

17-8

Managing Category Definitions

18-6

knowledge base article, modify

17-7

Managing Condition Definitions

Knowledge Base article, trigger

7-16, 8-9, A-10, B-5, C-5, D-5

Managing Core Activity Definitions

Knowledge Base Article, used by
Knowledge Base article properties

Managing Process Definitions

17-6

Managing Reports

Creating a Copy of a Knowledge Base Article
History

17-8

17-7

Modifying a Knowledge Base Article
17-6

Knowledge Base Details Pane
Knowledge Base View

17-3

17-7

7-20

16-8

21-1
21-9

Managing String Activity Definitions

C-22

Managing Table Property Definitions

14-23

Managing Target Definitions
Managing Targets

17-2

7-19

Managing Runtime User Definitions
Managing Security

13-9

13-1

Managing Task Activity Definitions
Managing Task Definitions

L

Launching the Console

1-2

License Agreement panel
Logic

1-6

2-2

1-27

Managing Trigger Definitions
Managing Variable Definitions
manual process execution

9-3

Condition Block
Condition Branch
For Each Block

9-4
9-7
9-9

Matching targets

19-16

19-1

Manually Changing the Status

9-1

Completed

Managing the Console

1-2

Launching the Web Console

Managing Task Rules

B-59

4-37

Managing Task Rule Definitions

Launching TEO Consoles

17-7

23-1

Managing Security Role

17-6

Properties

Managing Process Properties

17-4

17-1

Deleting a Knowledge Base Article

14-1

Managing Knowledge Base Article Definitions

17-9

Knowledge Base Article Properties, viewing
Knowledge Base Articles

A-58

Managing Extended Target Properties

17-6

Knowledge base article, viewing history

10-16

8-21
11-32
4-39

7-22

A-72

Match Regular Expression

A-3, A-33

match regular expression activities

A-34

Match Regular Expression Activity, defining

A-33
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Match Regular Expression results
member, category properties

Namespace, add

15-13

Members, Virtual target group
6-8

Menu bar, File menu

6-8

A-59

Namespace Examples

15-9

console

1-7

Navigating Process Editor

Menu bar, Tools menu

6-9

Normal Operators

Menu bar, View menu

6-8

Notes properties

Microsoft SCOM Integration

Modifying Activity Definition Properties

Notify task rule, create

7-20

Modifying Automation Summary

Numeric property

B-59

Numeric variable

14-23

Modifying Processes, process properties
Modifying Security Role Properties
Modifying String Activities

14-13
14-12

11-12, 11-26

O

7-20

Objects to Export panel

21-13

Modifying string variable properties

Access activity views

14-24

3-37

Access process views

Modifying Task Types in Task Rule

Access Tasks view

19-21

Modifying the Assignment Properties

Activities

B-61

Modifying the assignment properties for an activity
Modifying the assignment properties for a task
Modifying the Date and Time Appearance
Modifying the list of Recent Servers

B-60

4-39, 19-20

1-35

1-32

Modifying the recipients for a task rule

1-33

3-32

3-10

3-18

Activity View format, modifying
Activity Views details pane
Activity views header

3-20

Auditing details pane

3-38

Disabling a process

19-21

Modifying the Windows and Layout of the Console

Enabling a process

3-25

3-23

7-21
7-21

Filter Activity Display

8-21

Modifying variable properties

11-32

Modify runtime user definition

16-8

Multiple Events Property Page

3-18

Access auditing logs

11-32

15-11

Monthly Recurrence Pattern

22-20

Operations

C-22

Modifying String Target Properties

Modifying triggers

19-11

A-58

Modifying Extended Target Properties

Modifying target groups

4-8

19-10

Numeric Property, create

18-6

10-17

Modifying Core Activities

4-8

Notify task rule properties

D-29

Modifying Category Properties

4-9

Notification properties, task

A-58

Modifying a Table Activity

4-9

Notification properties

18-7

2-5

10-3

Notes properties, task

22-13

Modify category, Removing members
Modifying a Core Activity

6-8

Navigating Web Console

6-9

Modifying Conditions

A-60

navigating

6-9

Menu bar, Edit menu
Menu bar, Help menu

N

18-5

Members, viewing target groups
Menu bar, Actions menu

A-74

12-17
A-31

by Category, by Name, by Description, by
State 3-21
Filter Display
by Date

3-21
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by Time

View Triggered activities

3-21

Filtering the Activity View

Operations Workspace

3-26

Filtering the activity view, date

3-19, 3-33

1-20

Options dialog, Dates & Times Tab

3-27

Filtering the activity view, end time
Querying Activities by End Time Period

3-28

Filtering the activity view, navigating time
period 3-31
Filtering the activity view, specific date

1-16

Options dialog, Security Tab

1-13

Options Dialog, Windows and Layout Tab
Overriding Process Target

3-30

Owning a Task

Filtering the activity view, specific end time

1-14

2-15

Overwriting Existing Objects

Filtering the activity view, specific date,
selecting 3-30
Filtering the activity view, start time

Options dialog, Refresh Tab

1-15

22-15

2-13

3-29

3-26

P

Filter Process Display
Parameter properties

by Category, by Name, by Description, by
Automation Pack 3-33
Getting Started
Processes

Parameter properties, event

A-28

Parameter properties, task

3-3

Parse Date

3-32

Procedures

4-9, A-28, B-4

A-36

Parse Date, results

3-25

Processes View results pane

4-9, B-4

A-75

Parse Date Activity, defining

3-33

Processes View results pane, header

parse text

3-33

A-36

A-34

Processes Views results pane, activity instance

3-35

Performing Web Console Tasks

Processes Views results pane, process instance

3-34

Pre-defined Security Permissions

Process Viewer

Predefined Security Rules

3-24

Process Views details pane

Printing Workflows

3-35

2-10
21-3

21-3

6-14

Process Workflow Viewer

3-24

Prior Process Instances Condition, create

Search Tasks details pane

3-5

process, category

18-7

Process, deleting

7-24

Process authoring

7-1

Search Tasks view

3-4

Search Work details pane
Search Work view

3-15

Process definitions, modifying

3-13

Select Date Dialog, select date

Select Day Offset Dialog, select day offset
Starting a process

Process Editor

3-30
3-30

Tasks View details pane

Process Editor, collapse view
Process Editor, menu bar

3-12
3-31

Process Editor, navigating

View Activity View Information

3-19, 3-33

Process Editor, resize view

View All activities

6-15

3-19, 3-33

Process Editor, toggling
Process Editor, toolbox

3-19, 3-33

6-15

6-8

View activity instance properties
View Adhoc activities

6-8
6-16

6-15
6-11

Viewing Auditing Information

3-37

Process Editor, Using

Viewing Audit Log Properties

3-39

Process Editor Properties Pane

View Scheduled activities

3-19, 3-33

7-19

6-1

Process Editor, expand view

7-22

10-10

Process Editor Toolbar

6-13
6-12

6-9
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Process Editor Workflow pane

Properties, Assign Task

6-11

processes, viewing used by objects
Processes Details Pane
Processes view

properties, automation summary

7-25

Processes Action menu and toolbar options

6-4

6-5

Processes view header

A-12, A-15

Properties, change request

4-19, B-29

processes view results pane

Properties, Create Change Request

3-33

Process instance results pane

Properties, Create Incident

3-24
3-24

B-35

Properties, Create input request
Properties, credentials

6-12

Process properties, categories

7-13

Process properties, credentials

7-9

B-52

Properties, Extract Rows
Properties, Find String

D-22
C-5

7-4

Properties, Find Targets

A-20

Process properties, options tab

7-5

properties, Format Date

A-23, A-36

Properties, guided operation

7-7

properties, Highlight Row

7-12

Process properties, variables

Properties, input request

7-10

4-22
D-11

4-28

Process target, override

2-15

properties, Insert Event

process variable, delete

11-35

properties, Insert Multiple Events

A-31

properties, knowledge base article

17-6

Process Variables
Accessing Process Variables
Boolean variable properties
Identity variable properties

Product tasks

11-30

11-18

3-35

properties, activity instance

3-31

properties, Analyze Table
Properties, approval request

A-41

Properties, Remove row
properties, Replace String
Properties, review

D-5

D-8
4-16, B-47

properties, ROI

B-10

D-13

properties, Read Table from XML

D-16

D-19
D-19

C-8
7-16, A-11, B-6, C-6, D-6

4-36

Properties, review request

D-5

Properties, Add Row to Table

A-38

properties, Read Table from Text

Properties, result handler

4-7

Properties, add row

24-8

Properties, Remove Row from Table

3-32

Process Views details pane

19-11

Properties, Publish Task to Event Log

11-30

Process Variables Overview

A-34

properties, Publish Multiple Metrics

11-28

Table variable properties

Properties, Provides

properties, Publish Metric

11-26

Table variable general properties

Process views, accessing

11-23

11-25

Numeric variable properties
String variable properties

Properties, Notify task rule

11-22

Hidden String variable properties

A-26

properties, match regular expression

11-19

B-55

7-15

Process properties, General tab

Process properties, triggers

B-50

Properties, Create input request from Table

1-33

Process properties, target

A-17

B-31

Properties, Create Guided operation

3-34

process instance workflows, viewing
Process Launch Settings

B-18

properties, Create Automation Summary

3-33

process instances, viewing

24-4

properties, Calculate Date
properties, Correlate Alerts
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Resolving Tasks, web console

B-58

16-6

runtime user, viewing history

1-34
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D-35

Service Target, define

Set Table Variable properties
Set Table Variable results

3-23

C-1

String Escape results

A-43
A-43

String escapes
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start process, adhoc

1-27
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Specify Process Triggers
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Set Variable, results
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Split String Property Page
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Server connection
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Split String Properties
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3-30

Select question

A-64

Split String, defining
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Specifying XSL File Path

A-58
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Task, assigning category
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Task, delete
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8-14

Task external properties

Task XSL transform properties
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19-19
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1-19
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20-7
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Task rule, delete
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B-61
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4-24, B-33
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A-50
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Task Guided Operation properties
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Task View

4-19
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Tasks View details pane
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1-17
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Using the Tools menu

1-11
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Understanding the Navigation Bar, web console

2-5

variable, viewing used by objects

Understanding the Processes I Have Started page, web
console 2-8
Understanding the Run Processes page, web console
Understanding the Toolbars

1-18

Understanding the Workspaces
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